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ค าน า 
 เอกสารค าสอนวิชา การใช้โปรแกรมคอมพิวเตอร์ทางสถิติในด้านสังคมศาสตร์  (The 

Application of Statistical Package in Social Sciences) พัฒนาและใช้สอนนิสิตภาควิชาสังคม

วิทยาทั้งสาขาวิชาการพัฒนาชุมชนและสาขาวิชาการจัดการบริการสังคมในรหัสวิชาที่แตกต่างกันไป

ตามการปรับปรุงหลักสูตรจนถึงปัจจุบัน คือ รหัสวิชา 26234160 ตามหลักสูตรศิลปศาสตรบัณฑิต 

สาขาวิชาการจัดการบริการสังคม หลักสูตรปรับปรุง พ.ศ. 2560 ที่ให้นิสิตเรียนในภาคเรียนที่ 1 ปี

การศึกษา 2563 เป็นต้นไป 

 จุดมุ่งหมายของวิชานี้ คือ การปูพ้ืนฐานความรู้เกี่ยวกับการใช้โปรแกรมคอมพิวเตอร์ทางสถิติ

ในการวิเคราะห์ข้อมูลเชิงปริมาณด้านสังคมศาสตร์ เนื้อหาจึงประกอบด้วยความรู้เกี่ยวกับการวิจัย

ด้านสังคมศาสตร์ การวิจัยเชิงปริมาณ สถิติส าหรับการวิจัย การเตรียมข้อมูลเข้าโปรแกรม การติดตั้ง

และใช้โปรแกรมเบื้องต้น การจัดการข้อมูล การวิเคราะห์เครื่องมือการวิจัย การตรวจสอบข้อมูล การ

วิเคราะห์ข้อมูลด้วยสถิติเชิงพรรณนาและสถิติเชิงอ้างอิง (การทดสอบแบบอิงค่าพารามิเตอร์และไม่อิง

ค่าพารามิเตอร์) โดยเน้นการวิเคราะห์ตัวแปรไม่เกิน 2 ตัวแปร และในแต่ละบทยังมีแบบฝึกหัดท้าย

บทให้ทบทวนและศึกษาเพ่ิมเติมด้วย  

เนื้อหาในเอกสารค าสอนใช้โปรแกรม PSPP ที่เป็นโปรแกรมทางสถิติแบบรหัสเปิด (Open 

Source Statistical Software: OSSS) ภายใต้สัญญาอนุญาตให้ใช้ซอฟต์แวร์แบบสาธารณะทั่ว ไป 

(GNU General Public License: GNU-GPL) ที่สามารถหาดาวน์โหลดได้จากอินเทอร์เน็ตและติดตั้ง

ใช้งานได้ด้วยตนเอง เป็นเครื่องมือในการวิเคราะห์และทดสอบข้อมูล 

ผู้เขียนหวังว่าผู้เรียนจะได้ความรู้เบื้องต้นเกี่ยวกับการวิเคราะห์ข้อมูลเชิงปริมาณ น าเอา

ความรู้ที่ได้จากการเรียนไปใช้เป็นเครื่องมือวิเคราะห์ข้อมูลเพ่ือจัดท ารายงานระหว่างเรียนอยู่ใน

มหาวิทยาลัยและน าไปใช้ประโยชน์หลังเรียนจบไปแล้ว  

ผู้ช่วยศาสตราจารย์ ดร. เรวัต แสงสุริยงค์ 

กุมภาพันธ์ 2564 





 

 

ภาควิชาสังคมวิทยา คณะมนุษยศาสตรและสงัคมศาสตร ์

มหาวิทยาลัยบูรพา 

แผนการสอน 

1. รหัสและชื่อรายวิชา 

26234160 การใช้โปรแกรมคอมพิวเตอร์ทางสถิติในด้านสังคมศาสตร์ 

2. จ านวนหน่วยกิต 3 หน่วยกิต (2-2-5) 

3. หลักสูตรและประเภทของรายวิชา ศิลปศาสตรบัณฑิต สาขาวิชาการจัดการบริการสังคม เป็นวิชา

เลือก 

4. ค าอธิบายรายวิชา 

หลักการและฝึกปฏิบัติการใช้คอมพิวเตอร์ในการประมวลผลสถิติทางสังคมศาสตร์ โดยน าตัว

แปรและข้อมูลเกี่ยวกับประชากร ชุมชนและสังคมมาจัดเตรียมข้อมูล บันทึกข้อมูลและวิเคราะห์

ตลอดจนการแปลความหมายและน าเสนอรายงาน 

5. วัตถุประสงค์ของรายวิชา 

1. ผู้เรียนเข้าใจเกี่ยวกับการหาความรู้ด้านสังคมศาสตร์ รวมถึงสาขาวิชาสังคมวิทยา 

2. ผู้เรียนเข้าใจวิธีการวิจัยเชิงปริมาณท่ีเกิดจากความสัมพันธ์ระหว่างทฤษฎี สมมติฐาน และ

ตัวแปร 

3. ผู้เรียนเข้าใจและเลือกใช้สถิติแต่ละประเภทในการวิเคราะห์และทดสอบข้อมูลได้ถูกต้อง

และเหมาะสม 
4. ผู้เรียนสามารถแปลงข้อมูลจากแบบสอบถามไปเป็นแฟ้มข้อมูลได้ 

5. ผู้เรียนรู้จักโปรแกรมคอมพิวเตอร์ด้านสถิติส าหรับวิเคราะห์ข้อมูล สามารถติดตั้งและเริ่ม

ใช้งานเบื้องต้นได้ 



ง | ก า ร ใ ช้ โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร์ ท า ง ส ถิ ติ ใ น ด้ า น สั ง ค ม ศ า ส ต ร์  

6. ผู้เรียนสามารถน าข้อมูลจากแบบสอบถามกรอกเข้าโปรแกรม และน าข้อมูลที่เก็บอยู่ในรูป

ของแฟ้มข้อมูลเข้าโปรแกรม 

7. ผู้เรียนสามารถเลือกใช้ข้อมูลและเปลี่ยนรูปแบบข้อมูลให้ตรงกับวัตถุประสงค์ของการ

วิเคราะห์ข้อมูล 

8. ผู้เรียนสามารถวิเคราะห์คุณภาพของเครื่องมือการวิจัยได้ 

9. ผู้เรียนสามารถตรวจสอบความถูกต้องและความสมบูรณ์ของข้อมูล รวมถึงตรวจสอบ

ลักษณะของข้อมูลตามข้อตกลงเบื้องต้นของสถิติ 

10. ผู้เรียนสามารถใช้โปรแกรมประมวลผลการแจกแจงข้อมูลของตัวแปร 1 ตัวแปร ด้วย

สถิติเชิงพรรณนา และเขียนบรรยายผลการวิเคราะห์ได้ 

11. ผู้เรียนสามารถใช้โปรแกรมประมวลผลการเปรียบเทียบข้อมูลของตัวแปร 2 ตัวแปร 

ด้วยสถิติเชิงพรรณนา และเขียนบรรยายผลการวิเคราะห์ได้ 

12. ผู้เรียนสามารถใช้โปรแกรมประมวลผลทดสอบข้อมูลของตัวแปรด้วยสถิติเชิงอ้างอิงแบบ

อิงค่าพารามิเตอร์ และเขียนบรรยายผลการทดสอบได้ 

13. ผู้เรียนสามารถใช้โปรแกรมประมวลผลทดสอบข้อมูลของตัวแปร 1 ตัวแปร ด้วยสถิติเชิง

อ้างอิงแบบไม่อิงค่าพารามิเตอร์ และเขียนบรรยายผลการทดสอบได้ 

14. ผู้เรียนสามารถใช้โปรแกรมประมวลผลทดสอบข้อมูลของตัวแปร 2 ตัวแปร ด้วยสถิติเชิง

อ้างอิงแบบไม่อิงค่าพารามิเตอร์และเขียนบรรยายผลการทดสอบได้ 

6. อาจารย์ผู้รับผิดชอบรายวิชา ผู้ช่วยศาสตราจารย์ ดร. เรวัต แสงสุริยงค์    



แ ผ น ก า ร ส อ น | จ 

 

7. แผนการสอน 

สัปดาห์ที่ หัวข้อ/รายละเอียด 
จ านวน 

(ชั่วโมง) 
วิธีการสอน/ส่ือ ผลการเรียนรู้* 

1 

แนะน าการเรียนการสอน 

การวิจัยทางสังคมศาสตร์ 

1. การหาความรู้ด้านสังคมศาสตร์ 

- ศาสตร์ คือ อะไร 

- ความรู้เบื้องต้นเกี่ยวกับสังคมศาสตร์ 

- วิธีการหาความรู้ 

2. ประเภทการวิจัยด้านสังคมศาสตร์ 

- การจัดประเภทงานวิจัย 

- หลักเกณฑ์การจัดประเภทงานวิจัย 

3. กระบวนการวิจัยด้านสังคมศาสตร์ 

- การออกแบบการวิจัย 

- การวิจัยเชิงปริมาณและเชิงคุณภาพ 

- การวิจัยเชิงผสมผสาน 

4 

1. วิธีการสอน:- บรรยาย อธบิาย แสดงตัวอย่าง และท า

แบบฝึกหัด 

2. สื่อ:- เอกสารค าสอน ภาพเลื่อน คอมพิวเตอร์ 

โปรแกรมสอนออนไลน์ (สอนแบบออนไลน์) และเครื่อง

ฉาย (สอนในชั้นเรียน) 

2, 3, 6 

 



ฉ | ก า ร ใ ช้ โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร์ ท า ง ส ถิ ติ ใ น ด้ า น สั ง ค ม ศ า ส ต ร์  

สัปดาห์ที่ หัวข้อ/รายละเอียด 
จ านวน 

(ชั่วโมง) 
วิธีการสอน/ส่ือ ผลการเรียนรู้* 

การวิจัยเชิงปริมาณ 

1. ความรู้เบื้องต้นเกี่ยวกับการวิจัยเชิงปริมาณ 

2. ทฤษฎี 

- ทฤษฎี คือ อะไร 

- ประเภทของทฤษฎี 

- การเลือกใช้ทฤษีในการวิจัย 

3. สมมุติฐาน 

- สมมติฐาน คือ อะไร 

- ประเภทของสมมติฐาน 

4. ตัวแปร 

- ตัวแปร คือ อะไร 

- ประเภทตัวแปร 

- ระดับการวัดของตัวแปร 

5. ความสัมพันธ์ระหว่างสมมุติฐานกับตัวแปร 



แ ผ น ก า ร ส อ น | ช 

สัปดาห์ที่ หัวข้อ/รายละเอียด 
จ านวน 

(ชั่วโมง) 
วิธีการสอน/ส่ือ ผลการเรียนรู้* 

- ความสัมพันธ์เชิงสาเหตุ 

- ความสัมพันธ์เชิงสาเหตุในทิศทางตรงกันข้าม 

- ความสัมพันธ์เชิงหลายสาเหตุ 

2 

สถิติส าหรับการวิจัย 

1. สถิติ 

- ความหมายของสถิติ 

- ประเภทของสถิติ 

2. ความสัมพันธ์ระหว่างข้อมูลกับสถิติ 

- ข้อมูลกับสถิติเชิงพรรณนา 

- ข้อมูลกับสถิติเชิงอ้างอิง 

3. การทดสอบสมมติฐาน 

- ประเภทการทดสอบสมมติฐาน 

- กฎเชิงประจักษ์ 

- การยอมรับและปฏิเสธสมมติฐาน 

8 

1. วิธีการสอน:- บรรยาย อธบิาย แสดงตัวอย่าง และท า

แบบฝึกหัด 

2. สื่อ:- เอกสารค าสอน ภาพเลื่อน คอมพิวเตอร์ 

โปรแกรมสอนออนไลน์ (สอนแบบออนไลน์) และเครื่อง

ฉาย (สอนในชั้นเรียน) 

2, 3, 5, 6 

 



ซ | ก า ร ใ ช้ โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร์ ท า ง ส ถิ ติ ใ น ด้ า น สั ง ค ม ศ า ส ต ร์  

สัปดาห์ที่ หัวข้อ/รายละเอียด 
จ านวน 

(ชั่วโมง) 
วิธีการสอน/ส่ือ ผลการเรียนรู้* 

4. ความคลาดเคลื่อนของผลการวิจัย 

- ประเภทของความคลาดเคลื่อนของผลการวิจัย 

- ปัจจัยที่มีผลต่อความคลาดเคลื่อนของผลการวิจัย 

แบบสอบถามและข้อมูล 

1. ความสัมพันธ์ระหว่างแบบสอบถามกับแฟ้มข้อมูล 

- ค าถามแบบปลายปิด 

- ค าถามแบบปลายเปิด 

- ค าถามแบบเลือกตอบ 

- ค าถามแบบประเมินค่า 

- ค าถามแบบหลายค าตอบ 

- ค าถามแบบจัดอันดับ 

- ค าถามแบบเปรียบเทียบ 

- ค าถามแบบถูกผิด 

2. การสร้างตัวแปร 



แ ผ น ก า ร ส อ น | ฌ 

สัปดาห์ที่ หัวข้อ/รายละเอียด 
จ านวน 

(ชั่วโมง) 
วิธีการสอน/ส่ือ ผลการเรียนรู้* 

- ชื่อตัวแปร 

- ประเภทตัวแปร 

- จ านวนค่าตัวแปร 

- ค าอธิบายตัวแปร 

- ค าอธิบายค่าตัวแปร 

- ค่าขาดหลาย 

- ความกว้างของช่องค่าตัวแปรหรือสดมภ์ 

- การจัดต าแหน่งค่าตัวแปร 

- ระดับการวัด 

- บทบาทของตัวแปร 

3-4 

ความรู้เบื้องต้นเกี่ยวกับโปรแกรมทางสถิติ 

1. โปรแกรมส าเร็จรูปทางสถิติ 

- โปรแกรมเชิงพาณิชย์ 

- โปรแกรมแบบสาธารณะทั่วไป 

8 
1. วิธีการสอน:- บรรยาย อธบิาย แสดงตัวอย่าง แนะน า

การติดตั้งโปรแกรม และท าแบบฝึกหัดท้ายบท 

3, 5 

 



ญ | ก า ร ใ ช้ โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร์ ท า ง ส ถิ ติ ใ น ด้ า น สั ง ค ม ศ า ส ต ร์  

สัปดาห์ที่ หัวข้อ/รายละเอียด 
จ านวน 

(ชั่วโมง) 
วิธีการสอน/ส่ือ ผลการเรียนรู้* 

2. การตดิตั้งโปรแกรม PSPP 

- การค้นหาและดาวน์โหลด 

- วิธีการติดตั้ง 

3. การใช้โปรแกรม PSPP เบื้องต้น 

- การเปิดโปรแกรม 

- การเปิดแฟ้มข้อมูล 

- การปิดโปรแกรม 

4. ส่วนประกอบของโปรแกรม PSPP 

- ระบบจัดการข้อมูล 

- ระบบแสดงผลลัพธ์ 

- ระบบค าสั่งแบบข้อความ 

5. เมนูการใช้โปรแกรม PSPP 

- เมนูแบบรายการค าสั่ง 

- เมนูแบบปุ่มภาพ 

2. สื่อ:- เอกสารค าสอน ภาพเลื่อน คอมพิวเตอร์ 

โปรแกรม PSPP โปรแกรมสอนออนไลน์ (สอนแบบ

ออนไลน์) และเครื่องฉาย (สอนในชั้นเรียน) 
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สัปดาห์ที่ หัวข้อ/รายละเอียด 
จ านวน 

(ชั่วโมง) 
วิธีการสอน/ส่ือ ผลการเรียนรู้* 

5 

การน าข้อมูลเข้าโปรแกรม 

1. การน าข้อมูลเข้าจากแบบสอบถาม 

- การสร้างแฟ้มข้อมูล 

- การน าข้อมูลเข้าโปรแกรมแบบกรอกข้อมูล 

2. การน าข้อมูลเข้าจากแฟ้มข้อมูล 

- แฟ้มข้อมูลแบบตัวอักษร 

- แฟ้มข้อมูลจากโปรแกรมตารางค านวณ 

การจัดการข้อมูล 

1. การปรับข้อมูล 

- การจัดเรียงข้อมูล  

- การไขว้ตัวแปร  

- การรวมข้อมูล  

- การแบ่งข้อมูล  

- การเลือกข้อมูล  

4 

1. วิธีการสอน:- บรรยาย อธบิาย แสดงตัวอย่าง และท า

แบบฝึกหัดท้ายบท 

2. สื่อ:- เอกสารค าสอน ภาพเลื่อน คอมพิวเตอร์ 

โปรแกรม PSPP โปรแกรมสอนออนไลน์ (สอนแบบ

ออนไลน์) และเครื่องฉาย (สอนในชั้นเรียน) 

2, 3, 5, 6 



ฏ | ก า ร ใ ช้ โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร์ ท า ง ส ถิ ติ ใ น ด้ า น สั ง ค ม ศ า ส ต ร์  

สัปดาห์ที่ หัวข้อ/รายละเอียด 
จ านวน 

(ชั่วโมง) 
วิธีการสอน/ส่ือ ผลการเรียนรู้* 

- การก าหนดน้ าหนักข้อมูล 

2. การเปลี่ยนรูปแบบข้อมูล 

- การเปลี่ยนค่าของตัวแปร  

- การสร้างตัวแปรใหม่ 

6 

การวิเคราะห์เครื่องมือการวิจัย 

1. การวิเคราะห์ความถูกต้อง 

- การวิเคราะห์ความเที่ยงตรงด้วยดัชนีความสอดคล้อง 

  ระหว่างข้อค าถาม-วัตถุประสงค์ของการวิจัยค่า 

- การวิเคราะห์ความเที่ยงตรงด้วยค่าความเห็นสอดคล้องกัน 

2. การวิเคราะห์ความน่าเชื่อถือ 

- การวัดความสอดคล้องภายใน 

- การวัดความสอดคล้องภายนอก 

การวิเคราะห์ข้อมูลเชิงส ารวจ 

1. การตรวจสอบความถูกต้องและความสมบูรณ์ของข้อมูล 

4 

1. วิธีการสอน:- บรรยาย อธบิาย แสดงตัวอย่าง และท า

แบบฝึกหัดท้ายบท 

2. สื่อ:- เอกสารค าสอน ภาพเลื่อน คอมพิวเตอร์ 

โปรแกรม PSPP โปรแกรมสอนออนไลน์ (สอนแบบ

ออนไลน์) และเครื่องฉาย (สอนในชั้นเรียน) 

2, 3, 5, 6 
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สัปดาห์ที่ หัวข้อ/รายละเอียด 
จ านวน 

(ชั่วโมง) 
วิธีการสอน/ส่ือ ผลการเรียนรู้* 

- การตรวจสอบการออกแบบข้อมูล 

- การตรวจสอบความถูกต้องของข้อมูล 

- การตรวจสอบค่าสูญหาย 

- การตรวจสอบค่าผิดปกติและค่าต่างสุด 

2. การตรวจสอบข้อมูลตามข้อตกลงเบื้องต้น 

- การแจกแจงปกติ 

- ความเท่ากันของความแปรปรวน 

- ความเป็นเส้นตรง 

7-8 

การวิเคราะห์ข้อมูลด้วยสถิติเชิงพรรณนา 

การวิเคราะห์ข้อมูลเชิงพรรณนา 1 ตัวแปร 

1. การวิเคราะหข์้อมูลแบบค่าจัดประเภท 

- การวิเคราะห์ข้อมูลด้วยค่าร้อยละ 

- การวิเคราะห์ข้อมูลด้วยค่าฐานนิยม 

2. การวิเคราะห์ตัวแปรแบบค่าต่อเนื่อง 

8 

1. วิธีการสอน: บรรยาย อธิบาย แสดงตัวอย่าง และท า

แบบฝึกหัดท้ายบท 

2. สื่อ:- เอกสารค าสอน ภาพเลื่อน คอมพิวเตอร์ 

โปรแกรม PSPP โปรแกรมสอนออนไลน์ (สอนแบบ

ออนไลน์) และเครื่องฉาย (สอนในชั้นเรียน) 

2, 3, 5, 6 



ฑ | ก า ร ใ ช้ โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร์ ท า ง ส ถิ ติ ใ น ด้ า น สั ง ค ม ศ า ส ต ร์  

สัปดาห์ที่ หัวข้อ/รายละเอียด 
จ านวน 

(ชั่วโมง) 
วิธีการสอน/ส่ือ ผลการเรียนรู้* 

- การวิเคราะหข์้อมูลด้วยค่าเฉลี่ย (รายตัวแปร) 

- การวิเคราะหข์้อมูลค่าเฉลี่ย (ตัวแปรดัชนี) 

การวิเคราะห์ข้อมูลเชิงพรรณนา 2 ตัวแปร 

1. การวิเคราะห์ข้อมูลระหว่างตัวแปรแบบค่าแบ่งประเภท 

- การวิเคราะห์การเปรียบเทียบข้อมูลระหว่างตัวแปรแบบ 

  ค่าจัดประเภท 2 ตัวแปร 

- การวิเคราะห์เปรียบเทียบข้อมูลระหว่างตัวแปรแบบค่า 

  แบ่งประเภท 2 ตัวแปร โดยมีตัวแปรคุม 

2. การวิเคราะห์ข้อมูลระหว่างตัวแปรแบบค่าแบ่งประเภท 

   กับตัวแปรแบบค่าต่อเนื่อง 

- การวิเคราะห์เปรียบเทียบค่าเฉลี่ย 2 กลุ่ม 

- การวิเคราะห์เปรียบเทียบค่าเฉลี่ยมากกว่า 2 กลุ่ม 

- การวิเคราะห์เปรียบเทียบค่าเฉลี่ยโดยมีตัวแปรคุม 

9 สอบกลางภาค 4 สอบ 1, 2, 3, 5, 6 
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สัปดาห์ที่ หัวข้อ/รายละเอียด 
จ านวน 

(ชั่วโมง) 
วิธีการสอน/ส่ือ ผลการเรียนรู้* 

10-12 

การวิเคราะห์ข้อมูลด้วยสถิติเชิงอ้างอิง 

การทดสอบข้อมูลแบบอิงค่าพารามิเตอร์ 

1. การทดสอบค่าเฉลี่ย 1 กลุ่มตัวอย่าง  

2. การเปรียบค่าเฉลี่ยของกลุ่มตัวอย่างที่ไม่เป็นอิสระจากกัน 2 

กลุ่ม 

3. การเปรียบเทียบค่าเฉลี่ยของกลุ่มตัวอย่างที่เป็นอิสระจาก

กัน 2 กลุ่ม 

4. การเปรียบเทียบค่าเฉลี่ยของกลุ่มตัวอย่างที่เป็นอิสระจาก

กันมากกว่า 2 กลุ่ม 

5. การทดสอบความสัมพันธ์รายคู่แบบเพียร์สัน 

12 

1. วิธีการสอน:- บรรยาย อธบิาย แสดงตัวอย่าง และท า

แบบฝึกหัดท้ายบท 

2. สื่อ:- เอกสารค าสอน ภาพเลื่อน คอมพิวเตอร์ 

โปรแกรม PSPP โปรแกรมสอนออนไลน์ (สอนแบบ

ออนไลน์) และเครื่องฉาย (สอนในชั้นเรียน) 

2, 3, 5, 6 

13 

การทดสอบข้อมูลแบบไม่อิงค่าพารามิเตอร์ (1 ตัวแปร) 

1. การทดสอบสัดส่วนของกลุ่มตัวอย่าง 

2. การทดสอบการแจกแจงของกลุ่มตัวอย่าง 

4 
1. วิธีการสอน:- บรรยาย อธบิาย แสดงตัวอย่าง และท า

แบบฝึกหัดท้ายบท 
2, 3, 5, 6 



ณ | ก า ร ใ ช้ โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร์ ท า ง ส ถิ ติ ใ น ด้ า น สั ง ค ม ศ า ส ต ร์  

สัปดาห์ที่ หัวข้อ/รายละเอียด 
จ านวน 

(ชั่วโมง) 
วิธีการสอน/ส่ือ ผลการเรียนรู้* 

2. สื่อ:- เอกสารค าสอน ภาพเลื่อน คอมพิวเตอร์ 

โปรแกรม PSPP โปรแกรมสอนออนไลน์ (สอนแบบ

ออนไลน์) และเครื่องฉาย (สอนในชั้นเรียน) 

14-16 

การทดสอบข้อมูลแบบไม่อิงค่าพารามิเตอร์ (2 ตัวแปร) 

1. การทดสอบความเป็นอิสระของกลุ่มตัวอย่าง 

2. การทดสอบค่ากลางของกลุ่มตัวอย่างที่มีความสัมพันธ์กัน 2 

กลุ่ม 

3. การทดสอบค่ากลางของกลุ่มตัวอย่างที่มีความสัมพันธ์กัน

มากกว่า 2 กลุ่ม 

4. การทดสอบค่ากลางของกลุ่มตัวอย่างท่ีเป็นอิสระจากกัน 2 

กลุ่ม 

3. การทดสอบกลุ่มตัวอย่างที่เป็นอิสระจากกันมากกว่า 2 

กลุ่ม 

6. การทดสอบความสัมพันธ์รายคู่แบบสเปียร์แมน 

12 

1. วิธีการสอน:- บรรยาย อธบิาย แสดงตัวอย่าง และท า

แบบฝึกหัดท้ายบท 

2. สื่อ:- เอกสารค าสอน ภาพเลื่อน คอมพิวเตอร์ 

โปรแกรม PSPP โปรแกรมสอนออนไลน์ (สอนแบบ

ออนไลน์) และเครื่องฉาย (สอนในชั้นเรียน) 

2, 3, 5, 6 



แ ผ น ก า ร ส อ น | ด 

สัปดาห์ที่ หัวข้อ/รายละเอียด 
จ านวน 

(ชั่วโมง) 
วิธีการสอน/ส่ือ ผลการเรียนรู้* 

17 สอบปลายภาค 3 สอบ 1, 2, 3, 5, 6 

ผลการเรียนรู้ของรายวิชา* 

1. ด้านคุณธรรมจริยธรรม:- มีจรรยาบรรณทางวิชาการหรือวิชาชีพ (1.5)  

2. ด้านความรู้:- สามารถประยุกต์ความรู้จากทฤษฎีสู่การปฏิบัติ (2.2)  

3. ด้านทักษะทางปัญญา:- สามารถคิดวิเคราะห์อย่างเป็นระบบ  (3.3) 

4. ด้านทักษะความสัมพันธ์ระหว่างบุคคลและความรับผิดชอบ:- – 

5. ด้านทักษะการวิเคราะห์เชิงตัวเลข การสื่อสาร และการใช้เทคโนโลยีสารสนเทศ :- สามารถเลือกหรือประยุกต์เทคนิคทางคณิตศาสตร์ หรือสถิติที่เกี่ยวข้องใน

การศึกษาค้นคว้า เสนอแนะแนวทางในการแก้ปัญหาอย่างเหมาะสม  (5.3) 

6. ด้านทักษะพิสัย:- มีทักษะในการศึกษาและวิเคราะห์สถานการณ์ชุมชน/ องค์กรด้วยเครื่องมือทางการจัดการบริการสังคม (6.2) 





แ ผ น ก า ร ส อ น | ถ 

 

8. การวัดผลและการประเมินผล 

   8.1 การประเมินผลการเรียนรู้ 

ผลการเรียนรู้* วิธีการประเมิน สัปดาห์ที่ประเมิน   
สัดส่วนของการ

ประเมิน 
1 เวลาเรียน 1-16 10 

1, 2, 3, 5, 6 การท าแบบฝึกหัดท้ายบท           1-16 20 
1, 3, 5 สอบระหว่างภาค 9 30 

1, 3, 5, 6 สอบปลายภาค 17 40 
*หมายเหตุ 1. คุณธรรมจริยธรรม 2. ความรู้ 3. ทักษะทางปัญญา 4. ทักษะความสัมพันธ์ระหว่างบุคคล

และความรับผิดชอบ 5. ทักษะการวิเคราะห์เชิงตัวเลข การสื่อสาร และการใช้เทคโนโลยีสารสนเทศ 6. 

ทักษะพิสัย 

  8.2 ระดับคะแนน พิจารณาตามความเหมาะสม ดังนี้ 

       8.2.1 อิงเกณฑ์ ตามระดับคะแนนดังนี้ 

ระดับคะแนน ผลการเรียน 

80 – 100 A 

75 – 79 B+ 

70 – 74 B 

65 – 69 C+ 

60 – 64 C 

55 – 59 D+ 

50 – 54 D 

0 – 49 F 

       8.2.2 หรืออิงกลุ่ม แบบ T-score หรือ MEAN-SD     

 

 



ท | ก า ร ใ ช้ โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร์ ท า ง ส ถิ ติ ใ น ด้ า น สั ง ค ม ศ า ส ต ร์  

9. ทรัพยากรประกอบการเรียนการสอน 

   9.1 ต าราและเอกสารหลัก 

    เรวัต แสงสุริยงค์. เอกสารค าสอน รายวิชา 26234160 การใช้โปรแกรมคอมพิวเตอร์ทางสถิติในด้าน 

สังคมศาสตร์. ภาควิชาสังคมวิทยา คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยบูรพา. 

   9.2 ต าราและเอกสารแนะน า 

วรภูริ มูลสิน (2555). หลักการวิจัยและวิเคราะห์ข้อมูลทางสถิติด้วย PSPP. เข้าถึงได้จาก 

http://www.edu.ru.ac.th/coved/pdf/PSPP/คู่มือ_pspp-book-2555.pdf 

GNU. (2019). PSPP Users’ Guide. Retrieved from  

https://www.gnu.org/software/pspp/manual/pspp.pdf 

GNU. (2020). PSPP. Retrieved from  

https://www.gnu.org/software/pspp/manual/pspp.html#Introduction 

Halter, C. P. (2017). The PSPP Guide: An Introduction to Statistical Analysis. 2nd ed.  

CreativeMinds Press Group.



 

 

สารบัญ 
ค าน า ................................................................................................................................................ ก 

แผนการสอน .................................................................................................................................... ค 

สารบัญ ............................................................................................................................................ ธ 

สารบัญตาราง .................................................................................................................................. ม 

สารบัญภาพ ..................................................................................................................................... ย 

ส่วนที่ 1 ความรู้เบื้องต้นเกี่ยวกับการวิจัยเชิงปริมาณด้านสังคมศาสตร์ 

บทที ่1 การวิจัยด้านสังคมศาสตร์ .................................................................................................... 3 

เนื้อหา ..................................................................................................................................................... 4 

1. การหาความรู้ด้านสังคมศาสตร์ ........................................................................................................... 4 

1.1 ศาสตร์ คือ อะไร ............................................................................................................................... 4 

1.2 ความรู้เบื้องต้นเกี่ยวกับสังคมศาสตร์ ................................................................................................. 5 

1.3 วิธีการหาความรู้ ................................................................................................................................ 7 

2. ประเภทการวิจัยด้านสังคมศาสตร์....................................................................................................... 9 

2.1 การจัดประเภทงานวิจัย .................................................................................................................... 9 

2.2 หลักเกณฑ์การจัดประเภทงานวิจัย .................................................................................................. 13 

3. กระบวนการวิจัยด้านสังคมศาสตร์ .................................................................................................... 14 

3.1 การออกแบบการวิจัย ...................................................................................................................... 14 

3.2 การวิจัยเชิงปริมาณและการวิจัยเชิงคุณภาพ ................................................................................... 16 

3.3 การวิจัยเชิงผสมผสาน ..................................................................................................................... 18 

สรุป ....................................................................................................................................................... 19 

บทที่ 2 การวิจัยเชิงปริมาณ ........................................................................................................... 21 



น | ก า ร ใ ช้ โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร์ ท า ง ส ถิ ติ ใ น ด้ า น สั ง ค ม ศ า ส ต ร์  

เนื้อหา ................................................................................................................................................... 22 

1. ความรู้เบื้องต้นเกี่ยวกับการวิจัยเชิงปริมาณ....................................................................................... 22 

1.1 ความเป็นมาของการวิจัยเชิงปริมาณด้านสังคมศาสตร์.....................................................................22 

1.2 ประเภทของการวิจัยเชิงปริมาณ .....................................................................................................23 

2. ทฤษฎี ............................................................................................................................................... 24 

2.1 ทฤษฎี คือ อะไร ..............................................................................................................................24 

2.2 ประเภทของทฤษฎี ..........................................................................................................................26 

2.3 การเลือกใช้ทฤษฎีในการวิจัย ..........................................................................................................26 

3. สมมติฐาน ......................................................................................................................................... 28 

3.1 สมมติฐาน คือ อะไร ........................................................................................................................28 

3.2 ประเภทของสมมติฐาน ....................................................................................................................29 

4. ตัวแปร .............................................................................................................................................. 30 

4.1 ตัวแปร คือ อะไร .............................................................................................................................30 

4.2 ประเภทตัวแปร ...............................................................................................................................31 

4.3 ระดับการวัดของตัวแปร ..................................................................................................................36 

5. ความสัมพันธ์ระหว่างสมมติฐานและตัวแปร ...................................................................................... 40 

สรุป ....................................................................................................................................................... 42 

แบบฝึกหัดท้ายบท................................................................................................................................. 42 

บทที่ 3 สถิติส าหรับการวิจัย ........................................................................................................... 43 

เนื้อหา ................................................................................................................................................... 44 

1. สถิติ .................................................................................................................................................. 44 

1.1 ความหมายของสถิติ ........................................................................................................................44 

1.2 ประเภทของสถิติ .............................................................................................................................45 

2. ความสัมพันธ์ระหว่างขอ้มูลกับสถิติ ................................................................................................... 48 



ส า ร บั ญ | บ 

2.1 ข้อมูลกับสถิติเชิงพรรณนา .............................................................................................................. 48 

2.2 ข้อมูลกับสถิติเชิงอ้างอิง .................................................................................................................. 49 

3. การทดสอบสมมติฐาน....................................................................................................................... 51 

3.1 ประเภทการทดสอบสมมติฐาน ........................................................................................................ 53 

3.2 กฎเชิงประจักษ์ ............................................................................................................................... 54 

3.3 การยอมรับและปฏิเสธสมมติฐาน .................................................................................................... 55 

4. ความคลาดเคลื่อนของผลการวิจัย ..................................................................................................... 58 

4.1 ประเภทของความคลาดเคลื่อนของผลการวิจัย ............................................................................... 58 

4.2 ปัจจัยที่มีผลต่อความคลาดเคลื่อนของผลการวิจัย ........................................................................... 58 

สรุป ....................................................................................................................................................... 60 

แบบฝึกหัดท้ายบท ................................................................................................................................ 60 

ส่วนที่ 2 ความรู้เบื้องต้นเกี่ยวกับการใช้โปรแกรมทางสถิต ิ

บทที่ 4 แบบสอบถามและข้อมูล ..................................................................................................... 63 

เนื้อหา ................................................................................................................................................... 64 

1. ความสัมพันธ์ระหว่างแบบสอบถามกับแฟ้มข้อมูล ............................................................................. 64 

1.1 ค าถามแบบเลือกตอบ ..................................................................................................................... 67 

1.2 ค าถามแบบปลายเปิด ..................................................................................................................... 67 

1.3 ค าถามแบบประเมินค่า .................................................................................................................... 68 

1.4 ค าถามแบบหลายค าตอบ ................................................................................................................ 69 

1.5 ค าถามแบบจัดอันดับ ...................................................................................................................... 69 

1.6 ค าถามแบบเปรียบเทียบ ................................................................................................................. 70 

1.7 ค าถามแบบถูกผิด ........................................................................................................................... 71 

2. การสร้างตัวแปร ................................................................................................................................ 71 

สรุป ....................................................................................................................................................... 79 

บทที่ 5 ความรู้เบื้องต้นเกี่ยวกับโปรแกรมทางสถิติ ......................................................................... 81 



ป | ก า ร ใ ช้ โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร์ ท า ง ส ถิ ติ ใ น ด้ า น สั ง ค ม ศ า ส ต ร์  

1. โปรแกรมส าเร็จรูปทางสถิติ ............................................................................................................... 82 

2. การติดตั้งโปรแกรมทางสถิติ .............................................................................................................. 83 

3. การใช้โปรแกรมทางสถิตเิบื้องต้น ...................................................................................................... 88 

4. ส่วนประกอบของโปรแกรม PSPP ..................................................................................................... 91 

4.1 ระบบจัดการข้อมูล ..........................................................................................................................91 

4.2 ระบบแสดงผลลัพธ์ ..........................................................................................................................92 

4.3 ระบบค าสั่งแบบข้อความ .................................................................................................................93 

4.4 การใช้ผลลัพธ์ ..................................................................................................................................93 

5. เมนูการใช้โปรแกรม PSPP ................................................................................................................ 95 

5.1 หน้าต่างระบบ DATA EDITOR ...........................................................................................................95 

5.2 หน้าต่างระบบ SYNTAX EDITOR ..................................................................................................... 100 

5.3 หน้าต่างระบบ OUTPUT VIEWER ................................................................................................... 102 

สรุป .................................................................................................................................................... 103 

แบบฝึกหัดท้ายบท.............................................................................................................................. 103 

บทที่ 6 การน าข้อมูลเข้าโปรแกรม ............................................................................................... 105 

เนื้อหา ................................................................................................................................................ 106 

1. การน าข้อมูลเข้าจากแบบสอบถาม ................................................................................................. 106 

1.1 การสร้างแฟ้มข้อมูล ..................................................................................................................... 106 

1.2 การน าข้อมูลเข้าโปรแกรมแบบกรอกข้อมูล .................................................................................. 112 

2. การน าเข้าข้อมูลจากแฟ้มข้อมูล ..................................................................................................... 113 

2.1 การน าข้อมูลเข้าจากโปรแกรมตารางค านวณ ............................................................................... 114 

2.2 การน าข้อมูลเข้าจากแบบสอบถามออนไลน์ ................................................................................. 119 

สรุป .................................................................................................................................................... 123 

แบบฝึกหัดท้ายบท.............................................................................................................................. 123 



ส า ร บั ญ | ผ 

บทที่ 7 การจัดการข้อมูล .............................................................................................................. 125 

เนื้อหา .................................................................................................................................................126 

1. การปรับข้อมูล ................................................................................................................................127 

1.1 การจัดเรียงตัวอย่าง ..................................................................................................................... 127 

1.2 การไขว้ตัวแปรและตัวอย่าง ......................................................................................................... 128 

1.3 การรวมกลุ่มตัวอย่าง .................................................................................................................... 129 

1.4 การแบ่งกลุ่มตัวอย่าง.................................................................................................................... 131 

1.5 การเลือกตัวอย่าง ......................................................................................................................... 132 

1.6 การก าหนดน้ าหนักตัวอย่าง .......................................................................................................... 133 

2. การแปลงข้อมูล ..............................................................................................................................135 

2.1 การสร้างตัวแปรแบบค่าต่อเนื่อง .................................................................................................. 135 

2.2 การนับจ านวนข้อมูล .................................................................................................................... 136 

2.3 การจัดล าดับตัวอย่าง ................................................................................................................... 137 

2.4 การสร้างตัวแปรแบบอัตโนมัติ ...................................................................................................... 139 

2.5 การเปลี่ยนค่าตัวแปรในตัวแปรเดิม .............................................................................................. 140 

2.6 การสร้างตัวแปรแบบค่าจัดกลุ่ม ................................................................................................... 141 

2.7 การสั่งประมวลผลต่อ ................................................................................................................... 143 

สรุป .....................................................................................................................................................143 

แบบฝึกหัดท้ายบท ..............................................................................................................................144 

ส่วนที่ 3 การวิเคราะห์เครื่องมือการวิจัย และตรวจสอบข้อมูล 

บทที่ 8 การวิเคราะห์เครื่องมือการวิจัย......................................................................................... 147 

เนื้อหา .................................................................................................................................................148 

1. การวิเคราะห์ความเที่ยงตรง ............................................................................................................148 

1.1 การวิเคราะห์ความสอดคล้องระหว่างข้อค าถาม-วัตถุประสงค์ของการวิจัย ................................... 149 



ฝ | ก า ร ใ ช้ โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร์ ท า ง ส ถิ ติ ใ น ด้ า น สั ง ค ม ศ า ส ต ร์  

1.2 การวิเคราะห์ความเห็นสอดคล้องกัน ............................................................................................ 154 

สรุป .................................................................................................................................................... 162 

แบบฝึกหัดท้ายบท.............................................................................................................................. 162 

บทที่ 9 การวิเคราะห์ข้อมูลเชงิส ารวจ ............................................................................................. 163 

เนื้อหา ................................................................................................................................................ 164 

1. การตรวจสอบความถูกต้องและความสมบูรณ์ของข้อมูล ................................................................. 164 

1.1 การตรวจสอบการออกแบบข้อมูล ................................................................................................ 164 

1.2 การตรวจสอบความถูกต้องของข้อมูล .......................................................................................... 167 

1.3 การตรวจสอบค่าสูญหาย ............................................................................................................. 173 

1.4 การตรวจสอบค่าผิดปกติและค่าต่างสุด ........................................................................................ 178 

2. การตรวจสอบข้อมูลตามข้อตกลงเบื้องต้น ...................................................................................... 181 

2.1 การแจกแจงแบบปกติ .................................................................................................................. 181 

2.2 ความเท่ากันของความแปรปรวน ................................................................................................. 186 

2.3 ความเป็นเส้นตรง ......................................................................................................................... 188 

สรุป .................................................................................................................................................... 192 

แบบฝึกหัดท้ายบท.............................................................................................................................. 192 

ส่วนที่ 4 การวิเคราะห์ข้อมูลด้วยสถิติเชิงพรรณนา 

บทที่ 10 การวิเคราะห์ข้อมูลเชิงพรรณนา 1 ตัวแปร ................................................................... 195 

เนื้อหา ................................................................................................................................................ 196 

1. การวิเคราะหข์้อมูลแบบค่าจัดประเภท ........................................................................................... 196 

1.1 การวิเคราะห์ข้อมูลด้วยค่าร้อยละ ................................................................................................ 196 

1.2 การวิเคราะห์ข้อมูลด้วยค่าฐานนิยม .............................................................................................. 199 

2.1 การวิเคราะห์ข้อมูลค่าเฉลี่ย (รายตัวแปร) ..................................................................................... 201 

2.2 การวิเคราะห์ข้อมูลด้วยค่าเฉลี่ย (ตัวแปรดัชนี) .............................................................................. 205 

สรุป .................................................................................................................................................... 208 



ส า ร บั ญ | พ 

แบบฝึกหัดท้ายบท ..............................................................................................................................208 

บทที่ 11 การวิเคราะห์ข้อมูลเชิงพรรณนา 2 ตัวแปร .................................................................... 211 

เนื้อหา .................................................................................................................................................212 

1. การวิเคราะห์ข้อมูลระหว่างตัวแปรแบบค่าจัดประเภท ....................................................................212 

1.1 การวิเคราะห์แบบตารางไขว้ 2 ตัวแปร ......................................................................................... 212 

1.2 การวิเคราะห์แบบตารางไขว้ 2 ตัวแปร โดยมีตัวแปรคุม ............................................................... 217 

2. การวิเคราะห์ข้อมูลระหว่างตัวแปรแบบค่าแบ่งประเภทกับตัวแปรแบบค่าต่อเนื่อง .........................223 

2.1 การเปรียบเทียบค่าเฉลี่ย 2 กลุ่ม ................................................................................................... 223 

2.2 การเปรียบเทียบค่าเฉลี่ยมากกว่า 2 กลุ่ม ...................................................................................... 227 

2.3 การเปรียบเทียบค่าเฉลี่ยโดยมีตัวแปรคุม ...................................................................................... 231 

สรุป .....................................................................................................................................................234 

แบบฝึกหัดท้ายบท ..............................................................................................................................234 

ส่วนที่ 5 การวิเคราะห์ข้อมูลด้วยสถิติเชิงอ้างอิง 

บทที่ 12 การทดสอบข้อมูลแบบอิงค่าพารามิเตอร์ ....................................................................... 237 

เนื้อหา .................................................................................................................................................238 

1. การทดสอบค่าเฉลี่ยของกลุ่มตัวอย่าง 1 กลุ่ม ..................................................................................238 

2. การทดสอบค่าเฉลี่ยของกลุ่มตัวอย่างท่ีไม่เป็นอิสระจากกัน 2 กลุ่ม .................................................242 

3. การทดสอบค่าเฉลี่ยของกลุ่มตัวอย่างท่ีเป็นอิสระจากกัน 2 กลุ่ม .....................................................247 

4. การทดสอบค่าเฉลี่ยของกลุ่มตัวอย่างท่ีเป็นอิสระจากกันมากกว่า 2 กลุ่ม ........................................252 

5. การทดสอบความสัมพันธ์รายคู่แบบเพียร์สัน ...................................................................................264 

5.1 การทดสอบความสัมพันธ์แบบง่าย................................................................................................ 266 

5.2 การทดสอบความสัมพันธ์แบบหพุ ................................................................................................ 269 

สรุป .....................................................................................................................................................273 



ฟ | ก า ร ใ ช้ โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร์ ท า ง ส ถิ ติ ใ น ด้ า น สั ง ค ม ศ า ส ต ร์  

แบบฝึกหัดท้ายบท.............................................................................................................................. 274 

บทที่ 13 การทดสอบข้อมูลแบบไม่อิงค่าพารามิเตอร์ (1 ตัวแปร) ................................................ 275 

เนื้อหา ................................................................................................................................................ 276 

1. การทดสอบการแจกแจงของข้อมูล ................................................................................................. 277 

1.1 การทดสอบการแจกแจงของข้อมูลแบบรันส์ ................................................................................ 277 

1.2 การทดสอบการแจกแจงของข้อมูลแบบคอลมอโกรอฟ-สเมอร์นอฟ ............................................. 280 

2. การทดสอบสัดส่วนของกลุ่มตัวอย่าง .............................................................................................. 284 

2.1 การทดสอบความแนบสนิทแบบไคสแควร์ .................................................................................... 284 

2.2 การทดสอบสัดส่วนของกลุ่มตัวอย่างแบบทวินาม ......................................................................... 288 

สรุป .................................................................................................................................................... 291 

แบบฝึกหัดท้ายบท.............................................................................................................................. 291 

บทที่ 14 การทดสอบข้อมูลแบบไม่อิงค่าพารามิเตอร์ (2 ตัวแปร) ....................................................... 293 

เนื้อหา ................................................................................................................................................ 294 

1. การทดสอบความเป็นอิสระของกลุ่มตัวอย่าง .................................................................................. 294 

2. การทดสอบค่ากลางของกลุ่มตัวอย่างที่เป็นอิสระจากกัน 2 กลุ่ม .................................................... 303 

3. การทดสอบค่ากลางของกลุ่มตัวอย่างท่ีเป็นอิสระจากกันมากกว่า 2 กลุ่ม ....................................... 307 

4. การทดสอบค่ากลางของกลุ่มตัวอย่างที่มีความสัมพันธ์กัน 2 กลุ่ม .................................................. 311 

5. การทดสอบค่ากลางของกลุ่มตัวอย่างท่ีมีความสัมพันธ์กันมากกว่า 2 กลุ่ม ..................................... 315 

6. การทดสอบความสัมพันธ์รายคู่แบบสเปียร์แมน ............................................................................. 320 

6.1 การทดสอบความสัมพันธ์อันดับที่แบบง่าย ................................................................................... 322 

6.2 การทดสอบความสัมพันธ์อันดับที่แบบพหุ .................................................................................... 326 

สรุป .................................................................................................................................................... 331 

แบบฝึกหัดท้ายบท.............................................................................................................................. 332 



ส า ร บั ญ | ภ 

บรรณานุกรม................................................................................................................................ 333 

ภาษาไทย .................................................................................................................................... 333 

ภาษาอังกฤษ ............................................................................................................................... 333 

ดัชนี ............................................................................................................................................. 338 

 

  



ม | ก า ร ใ ช้ โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร์ ท า ง ส ถิ ติ ใ น ด้ า น สั ง ค ม ศ า ส ต ร์  

สารบัญตาราง 
ตารางที่ 1.1 เปรียบเทียบขั้นตอนการวิจัยเชิงปริมาณและเชิงคุณภาพ ................................................... 16 

ตารางที่ 2.1 ประเภทตัวแปรแบบตัวอักษรและตัวแปรแบบตัวเลข ........................................................ 39 

ตารางที่ 3.1 ความสัมพันธ์ระหว่างประเภทข้อมูลกับสถิติเชิงพรรณนา .................................................. 48 

ตารางที่ 3.2 เปรียบเทียบข้อตกลงเบื้องต้นของการทดสอบแบบอิงค่าพารามิเตอร์และไม่อิง

ค่าพารามิเตอร์ .............................................................................................................................. 50 

ตารางที่ 3.3 เปรียบเทียบการทดสอบแบบอิงค่าพารามิเตอร์และไม่อิงค่าพารามิเตอร์ ........................... 51 

ตารางที่ 3.4 ขั้นตอนการทดสอบสมมติฐาน ........................................................................................... 53 

ตารางที่ 3.5 การสรุปสมมติฐาน............................................................................................................. 59 

ตารางที่ 4.1 การสร้างตัวแปรจากแบบสอบถาม .................................................................................... 66 

ตารางที่ 4.2 ค าอธิบายประเภทข้อมูล .................................................................................................... 73 

ตารางที่ 4.3 ค่าเริ่มต้นค่าตัวแปรของตัวแปรแต่ละประเภท ................................................................... 73 

ตารางที่ 4.4 การสร้างค าอธิบายตัวแปร ................................................................................................. 74 

ตารางที่ 4.5 การสร้างค าอธิบายค่าตัวแปร............................................................................................. 75 

ตารางที่ 4.6 ประเภทของค่าตัวแปร ....................................................................................................... 75 

ตารางที่ 4.7 ประเภทตัวแปรและระดับการวัด ....................................................................................... 78 

ตารางที่ 4.8 ความหมายของบทบาทของตัวแปร ................................................................................... 78 

ตารางที่ 12.1 การแปลค่าสัมประสิทธิ์สหสัมพันธ์แบบเพียร์สัน ............................................................265 

ตารางที่ 14.1 การแปลค่าสัมประสิทธิ์สหสัมพันธ์แบบสเปียร์แมน .......................................................321 

 

  



ส า ร บั ญ | ย 

สารบัญภาพ 
รูปที่ 1.1 กระบวนการวิจัย ..................................................................................................................... 15 
รูปที่ 2.1 ความเกี่ยวข้องระหว่างตัวแปรเหตุ ตัวแปรผล และตัวแปรบริบท ............................................ 36 
รูปที่ 3.1 ข้อมูลภายใต้ระฆังคว่ า ............................................................................................................ 54 
รูปที่ 3.2 เขตวิกฤต ................................................................................................................................ 55 
รูปที่ 3.3 ค่าวิกฤติการทดสอบแบบหางเดียวทางขวา ............................................................................. 56 
รูปที่ 3.4 ค่าวิกฤติการทดสอบแบบหางเดียวทางซ้าย ............................................................................. 56 
รูปที่ 3.5 ค่าวิกฤติการทดสอบแบบ 2 หาง ............................................................................................. 57 
รูปที่ 4.1 กระบวนการประมวลผลของคอมพิวเตอร์ ............................................................................... 64 

รูปที่ 4.2 ส่วนประกอบของชุดข้อมูล ...................................................................................................... 65 

รูปที่ 4.3 การเปลี่ยนรูปแบบสอบถามเป็นแฟ้มข้อมูล ............................................................................. 65 

รูปที่ 4.4 ข้อมูลในแฟ้มข้อมูลนามสกุล CSV ........................................................................................... 66 

รูปที่ 9.1 ค่าผิดปกติและค่าต่างสุด ....................................................................................................... 178 

รูปที่ 9. 2 ความเบ้และความโด่ง .......................................................................................................... 182 

รูปที่ 9.3 ความแปรปรวน .................................................................................................................... 186 

รูปที่ 9.4 ความสัมพันธ์เชิงเส้นตรงและเส้นโค้ง .................................................................................... 188 

รูปที่ 13.1 การแจกแจงความถี่ ............................................................................................................ 280 
 

 

 

 





 

 

ส่วนที่ 1 

ความรู้เบื้องต้นเกี่ยวกับการวิจัยเชิงปริมาณ

ด้านสังคมศาสตร ์

  





 

 

บทที่ 1 

การวิจัยด้านสังคมศาสตร์ 

ความมุ่งหมายของบทเรียน 
เพ่ือให้ผู้เรียนเข้าใจเกี่ยวกับการหาความรู้ด้านสังคมศาสตร์ รวมถึงสาขาวิชาสังคมวิทยา 

เนื้อหา 

1. การหาความรู้ด้านสังคมศาสตร์ 
2. ประเภทการวิจัยด้านสังคมศาสตร์ 
3. ขั้นตอนการวิจัยด้านสังคมศาสตร์ 

วิธีการสอนและกิจกรรมการเรียนการสอน 
บรรยาย อธิบาย แสดงตัวอย่าง และท าแบบฝึกหัดท้ายบท 

สื่อและอุปกรณ์การสอน 
เอกสารค าสอน ภาพเลื่อน คอมพิวเตอร์ โปรแกรมสอนออนไลน์ (สอนแบบออนไลน์) และเครื่อง

ฉาย (สอนในชั้นเรียน) 

งานที่มอบหมาย 

 ท าแบบฝึกหัดท้ายบท 

การวัดผลและประเมินผล 

การเข้าชั้นเรียน สังเกตความสนใจจากการเรียน สอบถามความเข้าใจจากการบรรยาย และการท า

แบบฝึกหัดท้ายบท 
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เนื้อหา 
การตอบค าถามที่เกิดจากข้อสงสัยของมนุษย์มีการพัฒนาการควบคู่ไปกับวิวัฒนาการของสังคม

มนุษย์อย่างต่อเนื่อง  กล่าวคือ เริ่มจากการตอบข้อสงสัยด้วยความเชื่อ/ความศรัทธา  (fictitious stage) 

ต่อมามีการพัฒนามาเป็นการตอบข้อสงสัยด้วยหลักเหตุผล (metaphysical stage) และที่ได้รับการ

ยอมรับอย่างแพร่หลายในปัจจุบันก็คือ การตอบปัญหาหรือข้อสงสัยต่าง ๆ ด้วยหลักวิทยาศาสตร์ 

(positive stage) มีการตั้งสมมุติฐาน (hypothesis) เก็บรวบรวมข้อมูลมาท าวิเคราะห์ว่าจะยอมรับ 

(accept) หรือปฏิเสธ (reject) ข้อสมมุติฐาน 

1. การหาความรู้ด้านสงัคมศาสตร ์

การค้นหาความรู้ที่ไม่ใช้วิธีการที่เป็นกระบวนการทางวิทยาศาสตร์ (nonscientific method) 

เช่น การพยากรณ์โดยเทพ (oracles) การเข้าฌาน (mysticism) การบอกเล่าโดยผู้วิเศษ (magic) การ

ท านายด้วยโหราศาสตร์ (astrology) ค าผีบอก (spirit) มิใช่ไม่มีอยู่ แต่เป็นวิธีการหาความรู้ที่อยู่นอก

ขอบเขตการหาความรู้ที่เรียกว่า “ศาสตร์” และได้รับการยอมรับจากคนในสังคมสมัยใหม่น้อยมาก 

(Neuman, 2014, p. 8) 

1.1 ศาสตร์ คือ อะไร 

ค าว่า “science” หรือ “ศาสตร์” หมายถึง แบบแผนทางสังคม (social institution) และ

กระบวนการหาความรู้ (produce knowledge) ประเภทหนึ่ง  อันเป็นประดิษฐ์กรรม (invention)  ที่

เกิดมาจากการเปลี่ยนแปลงทางความคิดของมนุษย์ ในยุคเหตุผล (age of reason) หรือยุคแสงสว่างทาง

ปัญญา (enlightenment period) ของประวัติศาสตร์ยุโรปตะวันตกในช่วงปลาย ค.ศ. 1600 ถึงก่อน

ปลาย ค.ศ. 1800 ที่ ให้ความส าคัญกับการคิดหาเหตุผลเชิงตรรกศาสตร์  ( logical reasoning) 

ประสบการณ์ (experience) ในโลกของวัตถุ (material world) ความเชื่อ (belief) ในความก้าวหน้าของ

มนุษย์ (human progress) และการท้าทายด้วยการตั้งค าถามเกี่ยวกับอ านาจของศาสนาที่มีมาแต่โบราณ 

(Neuman, 2014, p. 7-8) การหาความรู้ที่เป็นศาสตร์ มีจุดเน้นที่ส าคัญ 2 ส่วน ดังนี้ (Punch, 1998, p. 

8) 
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1. ด้านข้อมูล ให้ความส าคัญกับความคิดที่สามารถน าไปทดสอบได้กับข้อมูลจากโลกความจริง 

(real-world data) หรือข้อมูลเชิงประจักษ์ (empirical data) 

2. ด้านทฤษฎี ที่ถือได้ว่าเป็นหัวใจของศาสตร์ จึงต้องเน้นการอธิบาย (explain) ด้วยข้อมูล ไม่ใช่

รวบรวมข้อมูลแล้วไม่ใช้ข้อมูลในการอธิบาย 

ดังนั้น “ศาสตร์” จึงเป็นการรวบรวมข้อมูลที่เกี่ยวกับโลก สร้างทฤษฎีโดยใช้ข้อมูลในการอธิบาย 

และทดสอบทฤษฎีด้วยข้อมูล 

คนส่วนใหญ่เมื่อได้ยินค าว่า “science” มักจะนึกถึงภาพและเข้าใจว่าเป็นเรื่องของการทดลอง

ในห้องปฏิบัติการคอมพิวเตอร์  การส่งกระสวยอวกาศไปในจักรวาล และคนที่ใส่เสื้อคลุมสีขาวท างานอยู่

ในห้องทดลอง ซึ่งในความเป็นจริงแล้วก็ไม่ใช่เรื่องที่ผิด เพียงแต่ว่า ภาพและความเข้าใจดังกล่าวนั้นเป็น

เพียงส่วนหนึ่งของการค้นหาความรู้ที่มีพ้ืนฐานมาจากวิทยาศาสตร์ธรรมชาติเท่านั้นเอง (Neuman, 

2014, p. 7)  

ปัจจุบันวิธีการหาความรู้หรือที่เรียกว่า ศาสตร์ (science) แบ่งออกได้เป็น 2 ศาสตร์ใหญ่ๆ คือ 

วิทยาศาสตร์ธรรมชาติ (natural sciences) และสังคมศาสตร์ (science: social) ความจริงแล้วทั้ง 2 

ศาสตร์เป็นทั้งเพ่ือนรักและคู่แข่งกันมาอย่างต่อเนื่อง มีทั้งค้นหาความรู้ที่คาบเกี่ยวกัน หยิบยืมวิธีการหา

ความรู้ (methodology) มาใช้งานร่วมกัน และโต้แย้ง/คัดค้าน/ปฏิเสธความรู้ระหว่างกันอยู่เสมอ 

1.2 ความรู้เบื้องต้นเกี่ยวกับสังคมศาสตร์ 

สังคมศาสตร์ สามารถมองได้หลายมิติ กล่าวคือ เป็นสาขาวิชาที่มีขอบข่ายกว้าง เนื่องจากเป็น

การศึกษาเกี่ยวกับสังคมของมนุษย์ (human society) ครอบคลุมตั้งแต่การศึกษาปัจเจกบุคคล 

( individual) เช่น จิตวิทยาสังคม (social psychology) จนถึงการศึกษาธรรมชาติ (nature) เช่น 

ชีววิทยาเชิงสังคม (social biology) และภูมิศาสตร์ทางสังคม (social geography) มีระเบียบวิธีการที่ใช้

ในการศึกษา (methodologically) หาความรู้ทั้งแบบการวิเคราะห์จากมุมมองที่ควรจะเป็น (normative 

approaches) เช่น กฎหมาย ( law) ปรัชญาสังคมศาสตร์  (social philosophy) ทฤษฎีการเมือง 

(political theory) และการศึกษาด้วยหลักฐานทางประวัติศาสตร์ (historical approaches) เช่น 

ประวัติศาสตร์ทางสังคม (social history) และประวัติศาสตร์ทางเศรษฐกิจ (economic history)  และก็

มีบ่อยครั้งที่ สังคมศาสตร์ หมายถึง สังคมวิทยา (sociology) หรือ การวิเคราะห์ทฤษฎีสังคม (synthetic 
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social theory) เ ท่ า นั้ น  ( Kuper and Kuper, 2003) ซึ่ ง ก็ ส อ ด ค ล้ อ ง กั บ พ จ น า นุ ก ร ม ฉ บั บ

ราชบัณฑิตยสถาน พ.ศ.  2525 (ราชบัณฑิตยสถาน,  2539, น . 817) ที่ ได้ ให้ความหมายของ 

“สังคมศาสตร์” ว่า เป็นศาสตร์ว่าด้วยความรู้เกี่ยวกับสังคม มีหมวดใหญ่ๆ เช่น ประวัติศาสตร์ (เกี่ยวกับ

สังคม) มานุษยวิทยา สังคมวิทยา เศรษฐศาสตร์ รัฐศาสตร์ จิตวิทยาสังคม 

การศึกษาด้านสังคมศาสตร์มีมาตั้งแต่โบราณ แต่แนวคิดการศึกษาทางด้านสังคมศาสตร์สมัยใหม่ 

(modern social sciences) ที่ใช้วิธีการที่เป็นวิทยาศาสตร์ (scientific method) ได้เริ่มขึ้นในยุครุ่งเรือง

ทางความคิด (enlightenment) ในศตวรรษท่ี 18 โดยเริ่มต้นในสาขาวิชาเศรษฐศาสตร์ ต่อมาในศตวรรษ

ที่ 19 ได้แยกแนวคิดออกไปพัฒนาในสาขาวิชามานุษยวิทยา รัฐศาสตร์ จิตวิทยา และสังคมวิทยา ใน

ลักษณะของทฤษฎีระดับกว้าง (wide-ranging theories) เช่นงานของ ออกุสต์ กองต์  (Auguste 

Comte)  คาร์ล มาร์กซ์ (Karl Marx) และเฮอร์เบิร์ต สเปนเซอร์ (Herbert Spencer) และในศตวรรษที่ 

20 ได้มีการพัฒนาไปสู่การน าเอาวิธี เชิงปริมาณ (quantitative method) และเทคนิคเชิ งสถิติ  

(statistical techniques) และรวมถึงวิธีเชิงประจักษ์ (empirical method)1 มาใช้มากขึ้น 

โดยทั่วไปแล้ว ค าว่า “สังคมศาสตร์ (social science)” หมายถึง การศึกษาพฤติกรรมของมนุษย์

ด้วยกระบวนการทางวิทยาศาสตร์ ที่เกิดมาจากค าว่า สังคม (social) คือ ประชาชนและพฤติกรรมของ

ประชาชนที่เกิดจากบริบททางสังคม (social context) กับค าว่า ศาสตร์ (science) คือ วิธีการใน

การศึกษาประชาชนและพฤติกรรมของประชาชน เมื่อเป้าหมายของศาสตร์ คือ การสร้างทฤษฎีที่อธิบาย

เกี่ยวกับประชาชนและพฤติกรรมของประชาชน ดังนั้น ทฤษฎีด้านสังคมศาสตร์จึงวางอยู่บนฐานของ

พฤติกรรมของมนุษย์ และการทดสอบด้วยข้อมูลจากโลกความจริง (Punch, 1998, p. 9) 

สังคมวิทยา (sociology) คือ วิชาที่ว่าด้วยการศึกษาสังคมมนุษย์และการกระท าระหว่างกันทาง

สังคม (social interaction) อย่างเป็นระบบ (systematic) และเป็นการศึกษาที่มีลักษณะเป็นวัตถุวิสัย 

(objective) แบบวิทยาศาสตร์ (David Popenoe 1993 , p. 2) สาขาวิชาสังคมวิทยานอกจาเป็นวิชาที่มี

                                                           
1  ปัจจุบันนักสังคมศาสตรส์่วนใหญ่มักจะใช้วิธีเชิงประจักษ์ 2 ประเภทด้วยกันในการศึกษาหาความรู้ นั่นก็คือ 

1. การบรรยาย (descriptive studies) ขั้นแรกของการค้นหาความรู้ ก็คือ การค้นหาว่าเหตุการณ์ที่เกิดขึ้นนั้นเป็น
อย่างไร เกิดกับใคร ที่ไหน และเมื่อใด 

2. การอธิบาย (explanatory studies) เมื่อได้ท าการบรรยายเหตุการณ์ที่เกิดขึ้นแล้ว นักสังคมวิทยาก็จะอธิบายว่า
เหตุการณ์นั้นเกิดขึ้นได้อย่างไร และเกิดขึ้นเพราะอะไร 



ก า ร วิ จั ย ด้ า น สั ง ค ม ศ า ส ต ร์  | 7 

ความใกล้เคียงและสัมพันธ์กับวิทยาศาสตร์ธรรมชาติตลอดจนวิธีการที่ใช้ในการศึกษาแล้ว สาขาวิชาสังคม

วิทยายังมีความสัมพันธ์กับสังคมศาสตร์สาขาอ่ืน ๆ อีกด้วย โดยในการศึกษาทางสังคมวิทยาจะมองว่า

พฤติกรรมของมนุษย์ คือรูปแบบของพฤติกรรมที่ถูกก าหนดโดยสังคม และสภาพแวดล้อมทางสังคม 

(social circumstance) นักสังคมวิทยาส่วนใหญ่จะอธิบายว่า สิ่งที่มนุษย์กระท าขึ้นในสังคมนั้นจะมี

ผลกระทบต่อบุคคลต่าง ๆ ด้วย ดังนั้นปรากฏการณ์ต่าง ๆ ที่เกิดขึ้นในสังคมย่อมจะมีผลกระทบซึ่งกัน

และกันและมีผลกระทบต่อกันอย่างสลับซับซ้อนด้วยกระบวนการกระท าระหว่างกันทางสังคม (เรวัต แสง

สุริยงค์, 2541)  

มีการกล่าวว่า กลุ่มวิชาทางสังคมศาสตร์ใช้ระเบียบวิธีทางวิทยาศาสตร์เพ่ือศึกษาโลกในเรื่องที่

เกี่ยวข้องกับมนุษย์ วิชาในสังคมศาสตร์แตกต่างจากวิชาในกลุ่มมนุษยศาสตร์ เนื่องจากหลายๆ สาขาวิชา

ในสังคมศาสตร์เน้นการหาความรู้ด้วยกระบวนการทางวิทยาศาสตร์ อย่างไรก็ตามหลายๆ สาขาก็อาจจะ

เน้นระเบียบวิธีเชิงคุณภาพมากกว่าก็ได้ นั่นอาจเพราะมีสาเหตุมาจากที่ทั้งสังคมศาสตร์และวิทยาศาสตร์

ธรรมชาติต่างก็มีฐานะเป็นส่วนหนึ่งของปรัชญาวิทยาศาสตร์ (philosophy of science) ที่แยกตัวออกมา

จากปรัชญาความรู้ (epistemology)2 แต่ด้วยเหตุที่ความก้าวหน้าของวิทยาศาสตร์ธรรมชาติที่มีบทบาท

และครอบง าแนวคิดและวิธีการศึกษาทางวิทยาศาสตร์อย่างมากและรวมถึงวิธีการศึกษาทางสังคมศาสตร์

ด้วย จึงท าให้นักคิดทางสังคมศาสตร์มีการต่อต้านวิธีการของวิทยาศาสตร์ธรรมชาติและพัฒนาวิธี

การศึกษาทางสังคมศาสตร์มาใช้ศึกษาปรากฏการณ์ทางสังคม คือ การวิเคราะห์ในเชิงตีควา ม 

(interpretive analysis) อันเป็นแนวการศึกษาปรากฏการณ์ทางสังคมที่มาจากปรัชญาการตีความ 

(hermeneutics or interpretative philosophy) (อนุสรณ์ ลิ่มมณี, 2542, น. 4-57) 

1.3 วิธีการหาความรู้ 

แม้ว่าการหาความรู้จะมีการสร้างและพัฒนาวิธีการการศึกษาที่แตกต่างกันไปตามธรรมชาติแต่

ละสาขาวิชา แต่วิธีการหาความรู้ทั้งหลายตกอยู่ภายใต้ 2 แนวทางด้วยกัน ดังนี้ 

                                                           
2 เป็นปรัชญาสาขาหนึ่งที่เน้นศึกษาเกี่ยวกับลักษณะของความรู้และข้ออ้างด้านหลักการตลอดจนแนวคิดเกี่ยวกับความรู้ในแง่มุมต่าง ๆ 
โดยทั่วไป อาทิ ที่มา ฐานคติ สภาพ ขอบเขต และความถูกต้อง (อนุสรณ์ ลิ่มมณี, 2542, p. 5) 

http://th.wikipedia.org/w/index.php?title=%E0%B8%A1%E0%B8%99%E0%B8%B8%E0%B8%A9%E0%B8%A2%E0%B8%A8%E0%B8%B2%E0%B8%AA%E0%B8%95%E0%B8%A3%E0%B9%8C&action=edit
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1. การใช้วิธี เชิงประจักษ์ (Empirical method) ซึ่ งเป็นวิธีที่นักวิทยาศาสตร์  รวมทั้งนัก

สังคมศาสตร์นิยมใช้กันเป็นส่วนมาก การหาความรู้ด้วยวิธีเชิงประจักษ์ เป็นการใช้การรับรู้ของมนุษย์ เช่น 

การได้เห็น และการได้ยิน หรือที่เราเรียกกันว่า การสังเกต (observation) 

2. การใช้วิธีไม่ใช่เชิงประจักษ์ (Non-empirical method) มี 2 วิธี ดังนี้ 

      2.1 การใช้หลักเหตุผล (Logic) เป็นการหาความรู้ด้วยวิธีการใช้เหตุผลเพ่ือให้ได้มาซึ่งค าตอบ

นั้น มี 4 วิธี คือ 

2.1.1 หลักนิรนัย/อนุมาน (Deductive) คือ การหาความรู้โดยใช้ข้อสรุปทั่วไปหรือทฤษฎี

อธิบายเรื่องเฉพาะเรื่องใดเรื่องหนึ่ง (ผล) อธิบายปรากฏการณ์ที่เกิดขึ้น (เหตุ) โดยผลที่เกิดขึ้นนั้นมาจาก

เหตุเดียวเท่านั้น 

2.1.2 หลักอุปนัย (Inductive) คือ การหาความรู้โดยใช้ปรากฏการณ์ที่เกิดขึ้น (เหตุ) 

อธิบายหรือสร้างข้อสรุปทั่วไปหรือทฤษฎี (ผล) แต่ผลที่เกิดขึ้นนั้นไม่จ าเป็นต้องเกิดมาจากเหตุเดียว อาจ

เกิดมาจากหลายเหตุด้วยกันก็ได้ 

2.1.3 หลักจารนัย (Abductive) คือ การหาความรู้โดยใช้หลัก การอ้างถึงปรากฏการณ์ที่

เกิดขึ้น (เหตุ) ที่เป็นสิ่งที่ใช้อธิบายข้อสรุปทั่วไปหรือทฤษฎี (ผล) เป็นการใช้เหตุผลในทิศทางตรงข้ามกับ

หลักนิรนัย 

2.1.4 หลักกลนัย (Retroductive) คือ การหาความรู้โดยใช้หลักเหตุผลเหมือนกับการ

อุปนัย แต่การอธิบาย/ท านายข้อสรุปทั่วไปหรือทฤษฎี (ผล) มีความเกี่ยวข้องกับหลายกฎ (rules) หรือ

หลายสิ่งที่ได้จากการสังเกต (observations) หรืออาจกล่าวได้ว่า ตัวอธิบาย/ท านายมีหลายกฎ  

      2.2 การใช้ญาณหรือการหยั่งรู้ (Intuition) คือ การหาความรู้ที่ได้จากประสาทสัมผัส เช่น 

การเห็น การได้ยิน ความรู้สึกจากสิ่งต่าง ๆ 

อาจกล่าวได้ว่าการหาความรู้ของมนุษย์ที่กล่าวมาวางอยู่บนฐานของ 2 ขั้วระหว่างการสังเกต 

(observation) กับการใช้เหตุผล (reason) หรือที่บางครั้งเราอาจได้ยินและได้เห็นในรูปของค าพูดที่ว่า 

ความรู้เชิงประจักษ์ (empirical knowledge) คือ ความรู้ที่ได้มาจากการสังเกตและได้ฟังเกี่ยวกับสิ่ง

ต่างๆ และความรู้เชิงเหตุผล (logical/rational knowledge) คือ ความรู้ที่ได้มาจากการให้เหตุผลโดย

ไม่ได้เห็นหรือไม่ได้ยินมา  
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การหาความรู้อาจขาดความน่าเชื่อถือและไม่ได้รับการยอมรับ หากเป็นการหาความรู้ที่ไม่ได้มา

จากการวิจัย (research) ด้วยการค้นคว้าเพ่ือหาข้อมูลอย่างถี่ถ้วนตามหลักวิชา หรือเป็นกระบวนการ

ค้นหาความรู้อย่างเป็นระบบ (systematic process) จากเหตุการณ์ (events) พฤติกรรม (behaviors) 

ทฤษฎี (theories) และกฎ (laws) ต่าง ๆ เพื่อการค้นพบ (discovering) การตีความ (interpreting) และ

แก้ไขข้อเท็จจริง (revising facts) ดังนั้น นักสังคมศาสตร์ จึงต้องใช้วิธีการหาความรู้ด้วยการวิจัย เพ่ือ

ตอบค าถามหรือข้อสงสัยเกี่ยวกับสังคมมนุษย์ 

2. ประเภทการวิจัยด้านสังคมศาสตร์ 

สังคมศาสตร์มีขอบเขตของการหาความรู้ที่กว้างและมีบริบทที่เกี่ยวข้องที่ซับซ้อน คือ มี

การศึกษาทั้งเรื่องในอดีต ปัจจุบัน อนาคต ธรรมชาติของมนุษย์ สิ่งที่สร้างโดยมนุษย์ และสภาพแวดล้อม

ของมนุษย์ ดังนั้นนักสังคมศาสตร์ (social scientist) จึงต้องใช้หลากหลายวิธีการในการอธิบาย 

(describe) ค้นหา (explore) และท าความเข้าใจ (understand) ความเป็นอยู่ของคนในสังคม (social 

life) และเหตุการณ์ต่างๆ ที่เกิดขึ้นในสังคมตามความเหมาะสม จึงท าให้งานวิจัยทางสังคมศาสตร์ถูกสร้าง

และพัฒนาขึ้นมาเป็นจ านวนมาก แต่หากพิจารณาให้ดีจะพบว่างานวิจัยเหล่านั้นมีคุณลักษณะบาง

ประการร่วมกันอยู่ เช่น วิธีการใช้เหตุผลในการหาความรู้ การใช้องค์ความรู้ในการวิจัย ลักษณะของข้อมูล

ที่เก็บรวบรวม วิธีการออกแบบการวิจัย เป็นต้น  

2.1 การจัดประเภทงานวิจัย 

นักวิชาการน าเอาคุณลักษณะของงานวิจัยมาแบ่งประเภทของงานวิจัยให้เป็นหมวดหมู่ แต่ก็ไม่ได้

หมายความว่านักวิชาการแต่ละคนจะมีมุมมองที่เหมือนกัน จึงเป็นสาเหตุที่ท าให้เราเห็นการจ าแนก

หมวดหมู่ของงานวิจัยที่แตกต่างกันหลายรูปแบบดังต่อไปนี้ (Babbie, 2007, p. 25-26; Neuman, 

2014, p. 24; Keith, 1998, p. 39-41) 

1. การจ าแนกตามประโยชน์ของการวิจัย (Use of research) มี 2 ประเภท ดังนี้ 

   1.1 การวิจัยพื้นฐาน (Basic research) เป็นการวิจัยเพื่อพัฒนากรอบแนวคิด ทฤษฎี และองค์

ความรู้ทางสังคมศาสตร์เอง เน้นการทดสอบทฤษฎีเพ่ือสนับสนุนหรือปฏิเสธทฤษฎี การวิจัยประเภทนี้

อาจเรียกได้ว่าเป็นการวิจัยเชิงยืนยัน (confirmatory research) หรือนักวิชาการบางท่านอาจเรียกว่า 
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การวิจัยบริสุทธ์ (pure research) คือ การวิจัยที่ใช้องค์ความรู้ที่มีอยู่ท าให้เกิดองค์ความรู้ใหม่ตามมา 

(knowledge for knowledge’s sake) 

   1.2 การวิจัยประยุกต์ (Applied research) เป็นการวิจัยเพ่ือตอบปัญหาและแก้ไขปัญหาทาง

สังคม เน้นการค้นหาความสัมพันธ์ระหว่างเหตุและผลของปรากฎการณ์ทางสังคมหรือเหตุการณ์ต่างๆ ที่

เกิดขึ้นในสังคม การวิจัยประเภทนี้อาจเรียกได้ว่าเป็นการวิจัยเชิงส ารวจ (exploratory research) เช่น 

การวิจัยเพื่อประเมินผลโครงการและการใช้นโยบายของรัฐและเอกชน การทดลองใช้โครงการต่าง ๆ ของ

สังคมก่อนที่จะน าไปใช้จริง การคาดคะเนสถานการณ์ทางสังคม การส ารวจความต้องการของผู้บริโภค

เพ่ือประชาสัมพันธ์และโฆษณาขายสินค้าต่าง ๆ งานวิจัยประเภทนี้มีหลายลักษณะ แต่ในที่นี้จะจ าแนก

เพ่ือเป็นตัวอย่างดังนี้ 

1.2.1 การวิจัยประเมินผล (Evaluation research) เป็นการวิจัยเกี่ยวกับประสิทธิภาพ

และประสิทธิผลในการด าเนินโครงการ นโยบาย และการรณรงค์ต่างๆ 

 1.2.2 การวิจัยปฏิบัติการ (Action research) เป็นการวิจัยที่ให้ความส าคัญกับการมีส่วน

ร่วมของหน่วยวิเคราะห์ เพราะเชื่อว่าการพัฒนาความรู้ต้องมาจากประสบการณ์ของสามัญชนและ

ประชาชนทั่วไป และสามารถน าไปใช้ปรับปรุงและแก้ไขปัญหาสถานการณ์ได้เป็นอย่างดี 

 1.2.3 การวิจัยประเมินผลกระทบทางสังคม (Social impact assessment research) 

เป็นการวิจัยที่ต้องการคาดการณ์ผลที่อาจเกิดจากการเปลี่ยนแปลงในการด าเนินโครงการ และการเลือก

ด าเนินนโยบายใดนโยบายหนึ่ง 

2. การจ าแนกตามลักษณะการรวบรวมข้อมูลและเทคนิคการวิเคราะห์ (Data collection and 

analysis techniques) สามารถแบ่งย่อยได้เป็น 2 ประเภทกว้างๆ ดังนี้ 

      2.1 การวิจัยเชิงปริมาณ (Quantitative method) เป็นวิธีการวิจัยที่พยายามจ าแนกประเภท

ปรากฏการณ์ทางสังคม แล้วท าการรวบรวมและวิ เคราะห์  (analyze) ด้วยข้อมูลที่ เป็นตัวเลข 

(numerical data) โดยมุ่งเน้นการหาความเชื่อมโยงที่เกิดขึ้นจ านวนเล็ก ๆ น้อยๆ (a smaller number) 

ในบรรดาคุณลักษณะ (attribute) ของสิ่งที่ท าการศึกษาจากหลายๆ กรณี (many cases) ดังนั้น สิ่งต่างๆ 

ที่ท าการศึกษาจึงต้องสามารถวัดหรือนับได้เป็นตัวเลข มีการออกแบบการวิจัยในรูปแบบต่างๆ ดังนี้ 

 2.1.1 การวิจัยแบบมีการปฏิสัมพันธ์กับหน่วยวิเคราะห์ (Reactive research) เป็น

วิธีการวิจัยที่มีการติดต่อกันระหว่างนักวิจัยและหน่วยวิเคราะห์ในรูปแบบใดรูปแบบหนึ่ง มี 2 ประเภท 

ดังนี้ 
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2.1.1.1 การวิจัยเชิงทดลอง (Experimental research) เป็นการออกแบบการวิจัย

ด้วยการจ าลองหรือสร้างสอดแทรก (Intervention) หรือเลือกหน่วยวิเคราะห์ในห้องปฏิบัติการหรือชีวิต

จริงที่มีสภาพแวดล้อมท่ีแตกต่างกันมาท าการศึกษาเปรียบเทียบความแตกต่างที่เกิดขึ้นระหว่างกลุ่มต่างๆ 

  2.1.1.2 การวิจัยเชิงส ารวจ (Survey research) เป็นการออกแบบการวิจัยโดยใช้

แบบสอบถาม (questionnaires) หรือการสัมภาษณ์ ( interviews) ในการค้นหาค าตอบจากหน่วย

วิเคราะห์จ านวนมากๆ ด้วยวิธีการสุ่มตัวอย่าง (sampling) 

2.1.2 การวิจัยแบบไม่มีการปฏิสัมพันธ์กับหน่วยวิเคราะห์ (Nonreactive research) เป็น

วิธีการวิจัยที่มีการน าเอาข้อมูลของผู้ที่มีส่วนร่วมหรือหน่วยวิเคราะห์มาใช้โดยที่เขาไม่รู้ว่าข้อมูลถูกน าไปใน

การวิจัย มี 2 ประเภท ดังนี้ 

    2.1.2.1 การวิเคราะห์เนื้อหา (Content analysis) เป็นการใช้วิธีการวิเคราะห์ข้อมูล

จากเนื้อหาหรือสารสนเทศที่มีการจัดเก็บไว้แล้ว เช่น หนังสือ บทเพลง วรรณกรรม ภาพยนตร์ ภาพถ่าย 

โฆษณา 

    2.1.2.2 การใช้สถิติที่มีอยู่แล้ว (Existing statistics) เป็นการใช้ข้อมูลที่มีการเก็บ

รวบรวมไว้แล้ว ทั้งจากงานวิจัยที่ท าไว้แล้วหรือข้อมูลจากหน่วยงานภาครัฐและเอกชน  เช่น รายได้ อายุ 

การศึกษา 

     2.2 การวิจัยเชิงคุณภาพ (Qualitative method) เป็นวิธีวิจัยที่ให้ความส าคัญกับประสบการณ์

ของบุ คคล  (personal experiences) และการตี ค ว าม  ( interpretation) เ พ่ื อท า คว าม เข้ า ใ จ 

(understanding) ความหมาย (meaning) ของปรากฏการณ์ทางสังคม มากกว่าการจ าแนกประเภท 

และมุ่งเน้นไปที่การหาความเชื่อมโยงที่เกิดขึ้นเป็นส่วนใหญ่ (a larger number) ในบรรดาคุณลักษณะ 

(attribute) ของสิ่งที่ท าการศึกษาจาก 2-3 กรณี (few case) ที่มีความเกี่ยวข้องกัน โดยใช้การพรรณนา 

(descriptive) หรือการอธิบาย (explanatory) ด้วยค าพูดหรือภาษาบรรยายเป็นหลัก มีการออกแบบ

การวิจัยในรูปแบบต่างๆ ดังนี้ 

          2.2.1 การวิจัยภาคสนาม (Field research) เป็นการวิจัยที่นักวิจัยท าการเก็บรวบรวม

ข้อมูลโดยการเข้าไปสังเกตด้วยตนเองและจดบันทึกเก่ียวกับหน่วยวิเคราะห์และบริบทด้านต่างๆ ที่เกิดขึ้น

ตามความเป็นจริง โดยใช้ระยะเวลาที่ยาวนานจนกว่าจะได้ข้อมูลครบถ้วนและสมบูรณ์ 
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          2.2.2 การวิจัยเชิงประวัติศาสตร์เปรียบเทียบ (Historical-comparative research) เป็น

การวิจัยที่นักวิจัยท าการเก็บรวบรวมข้อมูลเกี่ยวกับเหตุการณ์ต่างๆ ในเชิงประวัติศาสตร์ที่เกิดขึ้นในอดีต

หรือเปรียบเทียบความแตกต่างในเชิงวัฒนธรรมระหว่างสังคม 

3. การจ าแนกตามเป้าหมายของการวิจัย (Purpose of research) มี 2 ประเภท ดังนี้ 

     3.1 การวิจัยเชิงส ารวจเบื้องต้น (Exploratory research) เป็นการวิจัยที่มีเป้าหมายหลักอยู่ที่

การตรวจสอบหรือค้นหาค าตอบส าหรับท าความเข้าใจประเด็นปัญหาหรือปรากฏการณ์เล็กๆ จากค าถาม

ว่า อะไร (what) เพ่ือพัฒนาความคิดและค าถามการวิจัยในระดับต่อไป 

     3.2 การวิจัยเชิงพรรณนา (Descriptive research) เป็นการวิจัยที่มีเป้าหมายหลักอยู่ที่การ

บรรยายให้เห็นภาพสิ่งที่ศึกษาด้วยตัวเลขและตัวอักษร ตอบค าถามตามเค้าโครงที่ก าหนดไว้ว่าใคร (who) 

เมื่อไหร่ (when) ที่ไหน (where) อย่างไร (how) และน าเสนอการวิจัยในรูปของรายละเอียดและการ

จ าแนกประเภท    

     3.3 การวิจัยเชิงอธิบาย (Explanatory research) เป็นการวิจัยที่มีเป้าหมายหลักอยู่ที่การ

อธิบายเหตุการณ์ต่างๆ ว่าเกิดขึ้นได้อย่างไร (why) รวมถึงการสร้าง ต่อเติม พัฒนา ขยาย และทดสอบ

ทฤษฎี 

  4. การจ าแนกตามประเภทกรณีศึกษา (Within or across cases) 

     4.1 การวิจัยแบบศึกษาเป็นรายกรณี (Case-study research) เป็นการศึกษาเชิงลึก ( in-

depth) อย่างละเอียดจากหน่วย (unites) หรือสิ่งที่ศึกษา (cases) ประมาณ 2-3 กรณี ในช่วงเวลาหนึ่ง

หรือเปรียบเทียบหลายๆช่วงเวลา   

     4.2 การวิจัยแบบศึกษาเปรียบเทียบกรณี (Across-case research) ส่วนใหญ่เป็นการศึกษา

เชิงปริมาณ จากสิ่งที่ศึกษาที่มีจ านวนมาก (30-3,000 กรณี) เพ่ือเปรียบเทียบข้อมูลระหว่างกรณีศึกษา

ประมาณ 2-3 คุณลักษณะหรือตัวแปร มากกว่าที่จะสังเกตในรายละเอียดแต่ละกรณี  

  5. การจ าแนกตามมิติของเวลาในการวิจัย (Time dimension in research) มี 3 ประเภท ดังนี้ 

     5.1 การวิจัยแบบตัดขวาง (Cross-sectional research) เป็นการวิจัยที่ต้องการค้นหาค าตอบ

โดยการรวบรวมข้อมูลมาจากหน่วยวิเคราะห์ในช่วงเวลาใดเวลาหนึ่ง (at one time) แต่การวิจัยแบบนี้มี

ข้อดีที่ประหยัดเวลาและงบประมาณ แต่ไม่สามารถแสดงให้เห็นถึงกระบวนการหรือการเปลี่ยนแปลงทาง

สังคมได้ 
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     5.2 การวิจัยแบบระยะยาว (Longitudinal research) เป็นการวิจัยที่ต้องการค้นหาค าตอบ

เชิงความสัมพันธ์โดยการรวบรวมข้อมูลจากหน่วยวิเคราะห์ที่อยู่ในช่วงเวลาที่แตกต่างกัน มี 3 รูปแบบ คือ 

          5.2.1 แบบช่วงเวลาต่อเนื่องกัน (Time-series) เป็นการรวบรวมข้อมูลจากหน่วยวิเคราะห์

ที่มีคุณลักษณะแตกต่างกันกลุ่มหนึ่งหรือหลายกลุ่มในช่วงเวลาหนึ่งแบบติดต่อเป็นล าดับ 

          5.2.2 แบบช่วงเวลาที่ต่างกัน (Panel study) เป็นการเก็บรวบรวมข้อมูลจากหน่วย

วิเคราะห์ที่มีคุณลักษณะเหมือนกันตั้งแต่ 2 ช่วงเวลาขึ้นไป 

          5.2.3 แบบติดตามไปข้างหน้า (Cohort) ท าการเก็บรวบรวมข้อมูลจากหน่วยวิเคราะห์ที่มี

คุณลักษณะหรือประสบการณ์เหมือนกัน ตั้งแต่ 2 ช่วงเวลาขึ้นไป ทั้งแบบใช้ข้อมูลย้อนหลังและไม่

ย้อนหลัง 

     5.3 แบบรายกรณี (Case study) เป็นการวิจัยที่ต้องการค้นหาข้อมูลเชิงลึก (in-depth) จาก

หน่วยวิเคราะห์จ านวนไม่มาก หรือหนึ่งกรณีในช่วงเวลาหนึ่งหรือเปรียบเทียบในหลายช่วงเวลา   

6. การจ าแนกตามประเภทของค าถามการวิจัย (Research question) มี 2 ประเภท ดังนี้  

   6.1 แบบไม่มีสมมติฐาน (without hypotheses) เป็นการวิจัยที่ออกแบบและวางแผนการ

วิจัยโดยเน้นการรวบรวมข้อมูลและวิเคราะห์ข้อมูลเพื่อน าไปใช้ตอบค าถามการวิจัยเท่านั้น 

   6.2 แบบมีสมมติฐาน (with hypotheses) เป็นการวิจัยที่ออกแบบและวางแผนที่เน้นการ

รวบรวมข้อมูลและวิเคราะห์ข้อมูลเพ่ือน าไปตอบถามการวิจัยด้วยวิธีการทดสอบสมมติฐานที่ได้มาจาก

ทฤษฎี 

2.2 หลักเกณฑ์การจัดประเภทงานวิจัย 

ภายใต้ความแตกต่างของการจ าแนกประเภทงานวิจัยมีรูปแบบของการนิยามประเภทการวิจัยที่

แตกต่างกันพอสรุปได้ ดังนี้ 

  1. นิยามการแบ่งประเภทและแบ่งประเภทงานวิจัยเหมือนกัน เช่น จ าแนกตามวิธีการรวบรวม

ข้อมูล แบ่งเป็น การวิจัยเชิงปริมาณ และการวิจัยเชิงคุณภาพ 

2. นิยามการแบ่งประเภทเหมือนกันแต่มีประเภทงานวิจั ยไม่เหมือนกัน เช่น จ าแนกตาม

จุดมุ่งหมาย แบ่งเป็นการวิจัยพื้นฐาน การวิจัยเชิงทฤษฎี การวิจัยประยุกต์ การวิจัยแบบมีสมมติฐาน และ

การวิจัยแบบไม่มีสมมติฐาน 



14 | ก า ร ใ ช้ โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร์ ท า ง ส ถิ ติ ใ น ด้ า น สั ง ค ม ศ า ส ต ร์  

3. นิยามการแบ่งประเภทไม่เหมือนกันแต่แบ่งประเภทงานวิจัยเหมือนกันหรือคาบเกี่ยวกัน เช่น 

จ าแนกตามวิธีการวิจัย แบ่งเป็นการวิจัยเชิงส ารวจ การวิจัยเชิงพรรณนา การวิจัยเชิงอธิบาย การวิจัยเชิง

ท านาย 

4. นิยามไม่เหมือนกันและมีประเภทงานวิจัยที่ไม่เหมือนกัน เช่น จ าแนกตามสาขาการวิจัย 

แบ่งเป็น การวิจัยทางสังคมวิทยา การวิจัยทางรัฐศาสตร์ การวิจัยทางการศึกษา 

กล่าวโดยสรุป มีวิธีการแบ่งประเภทงานวิจัยที่หลากหลาย แต่ที่พบอย่างแพร่หลายและนิยมมาก

ที่สุด คือ แบ่งเป็นการวิจัยเชิงปริมาณ และการวิจัยเชิงคุณภาพ โดยมีนิยามการแบ่งประเภทที่แตกต่างกัน 

เช่น แบ่งตามลักษณะข้อมูล แบ่งตามวิธีการวิเคราะห์ข้อมูล แบ่งตามระเบียบวิธี แบ่งตามการตอบค าถาม

การวิจัย เป็นต้น  

3. กระบวนการวิจัยด้านสังคมศาสตร ์

การวิจัยทุกสาขาวิชาและทุกประเภทมีขั้นตอนการท าวิจัยที่ไม่แตกต่างกันมากนัก แต่โดยทั่วไป

อาจแบ่งออกเป็นขั้นตอนหลักๆ ได้ดังนี้ (Scanlon cited in Wilkinson, 2000, p. 9) 

1. ขั้นคัดเลือกความสนใจ (Choosing a focus) คือ การเลือกและก าหนดปัญหาที่จะท าการวิจัย 

2. ขั้นออกแบบการวิจัย (Research design) คือ การเตรียมและตัดสินใจเกี่ยวกับการใช้วิธีการ

รวบรวมข้อมูลและการวิเคราะห์ข้อมูล 

3. ขั้นรวบรวมข้อมูล (Data collection) คือ การเก็บข้อมูลด้วยการสัมภาษณ์ด้วยตนเองหรือส่ง

แบบสอบถามไปให้กลุ่มเป้าหมายตอบเอง  

4. ขั้นวิเคราะห์ข้อมูล (Data analysis) คือ การวิเคราะห์และตีความข้อมูลที่ได้มาจากการเก็บ

รวบรวมข้อมูล 

5. ขั้นเขียนผลการวิจัย (Writing up the results) คือ การน าเสนอผลการวิจัยด้วยพรรณนาและ

อธิบายจากผลการวิเคราะห์ข้อมูล 

3.1 การออกแบบการวิจัย 

การค้นหาความรู้ด้วยการวิจัยมีกระบวนการที่เป็นระบบ (systematic) การเริ่มท าการวิจัยจึง

ต้องมีการออกแบบการวิจัย (research design) อย่างเป็นขั้นตอน (step-by-step) ตามระเบียบวิธีของ
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การท าวิจัย การออกแบบการวิจัยตามกระบวนการวิจัยทางสังคมศาสตร์สามารถแสดงให้เห็นเป็นแผนผัง

ดังรูปด้านล่าง 

 
รูปที่ 1.1 กระบวนการวิจัย (ปรับปรุงมาจาก Babbie, 2007, p. 108) 
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 การเริ่มด าเนินโครงการวิจัยอาจมีจุดเริ่มต้นมาจากความสนใจ หรือความคิด หรือทฤษฎี  เป็นไป

ได้ทั้งสิ้น หรืออาจเริ่มมาจากความสนใจที่ท าให้เกิดความคิดซึ่งเหมาะกับทฤษฎีหนึ่ง หรือทฤษฎีอาจท าให้

เกิดความคิดใหม่ๆ และสร้างความสนใจใหม่ๆ ตามมาก็เป็นไปได้เช่นกัน (Babbie, 2007, p. 109) 

3.2 การวิจัยเชิงปริมาณและการวิจัยเชิงคุณภาพ 

การท าวิจัยของนักสังคมศาสตร์ต้องปฏิบัติการวิจัยตามล าดับขั้นของกระบวนการวิจัยให้ถูกต้อง 

แต่เนื่องจากการวิจัยทางสังคมศาสตร์ 2 ประเภทใหญ่ คือ การวิจัยเชิงปริมาณและการวิจัยเชิงคุณภาพ 

ต่างมีปรัชญาและแนวคิดในการค้นหาความรู้ที่แตกต่างกัน ดังนั้นการวิจัยทั้งสองประเภทจึงมีล าดับและ

ขั้นตอนของการท าวิจัยที่แตกต่างกันอยู่บ้าง ดังตารางด้านล่าง (Neuman, 2014, p. 14-15) 

ตารางที่ 1.1 เปรียบเทียบขั้นตอนการวิจัยเชิงปริมาณและเชิงคุณภาพ 

ขั้นที่ การวิจัยเชิงปริมาณ การวิจัยเชิงคุณภาพ 

1 เลือกหัวข้อ (Select topic) ท าความเข้าใจสังคม (Acknowledge social self) 

2 ตั้งค าถามให้ชัดเจน (Focus question) เกิดมุมมองและความเข้าใจ (Adopt perspective) 

3 ออกแบบการศึกษา (Design study) ออกแบบการศึกษา (Design study) 

4 รวบรวมข้อมูล (Collect data) รวบรวมข้อมูล (Collect data) 

5 วิเคราะห์ข้อมูล (Analyze data) วิเคราะห์ข้อมูล (Analyze data) 

6 ตีความข้อมูล (Interpret data) ตีความข้อมูล (Interpret data) 

7 น าเสนอการวิจัย (Inform others) น าเสนอการวิจัย (Inform others) 

นักวิจัยที่เน้นวิธีการวิจัยเชิงคุณภาพ เริ่มต้นการวิจัยด้วยการใช้ตัวนักวิจัยเองท าการประเมินและ

ไตร่ตรอง (self-assessment and reflections) สถานการณ์จากบริบทของสังคมเชิงประวัติศาสตร์ 

(sociohistorical context) เพ่ือรับรู้ในเรื่องตัวตน (self-aware) ของสังคมหรือการวางตัวของนักวิจัยใน

สังคม ไม่มุ่งเน้นที่การตั้งค าถามเฉพาะเรื่องเหมือนกับการวิจัยเชิงปริมาณ แต่ให้ความส าคัญกับกระบวน

ทัศน์ทางทฤษฎีและปรัชญา ( theoretical-philosophical paradigm) ของการอยากรู้อยากเห็น 

(inquisitive) และมุ่งเน้นการสร้างค าถามที่ต้องการค าตอบที่เปิดกว้าง (open-ended) อันจะน าไปสู่การ

เกิดมุมมองและความเข้าใจ ส าหรับขั้นการออกแบบการศึกษา การรวบรวมข้อมูล การวิเคราะห์ข้อมูล 

และการตีความข้อมูล  
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การวิจัยเชิงปริมาณและการวิจัยเชิงคุณภาพมีขั้นตอนที่เหมือนกัน แต่มีความแตกต่างกันใน

รายละเอียดของแต่ละขั้นตอน กล่าวคือ นักวิจัยเชิงคุณภาพจะเน้นการกระบวนการวิจัยระหว่างขั้นตอน

การรวบรวมข้อมูล การวิเคราะห์ข้อมูล และการตีความข้อมูลไปที่การสร้างทฤษฎีใหม่และสรุปผลตาม

ทฤษฎีที่มีอยู่แล้ว ขณะที่นักวิจัยเชิงปริมาณส่วนใหญ่จะเน้นขั้นตอนการตีความไปที่การทดสอบสมมติฐาน 

(test hypothesis) ที่สร้างไว้อยู่ก่อนแล้ว ส่วนนักวิจัยเชิงคุณภาพจะเน้นขั้นตอนการตีความไปที่การ

ตีความเพ่ือการสร้างแนวคิดใหม่และการสร้างทฤษฎี (constructing theoretical) ส าหรับขั้นตอน

สุดท้าย คือ การน าเสนอการวิจัย การวิจัยทั้งสองประเภทมีการน าเสนอการวิจัยเหมือนกัน แต่อาจ

แตกต่างกันในรูปแบบของรายงานตามแนวทางของการวิจัยแต่ละประเภท (Neuman, 2006, p. 14-15)  

การวิจัยแต่ละวิธีมีทั้งจุดอ่อนและจุดแข็ง บางสถานการณ์อาจต้องเลือกใช้การวิจัยเชิงผสมผสาน 

(mixed methods research) ทั้งการวิจัยเชิงปริมาณและการวิจัยเชิงคุณภาพ ดังนี้ 

1. ต้องการความเข้าใจที่สมบูรณ์ (More complete understanding) เพราะการใช้เครื่องมือ

วัดแนวคิดด้วยวิธีการเชิงปริมาณ ค่าคะแนนที่ได้จากการวัดอาจไม่สามารถบอกเรื่องราวต่างๆได้อย่าง

สมบูรณ์ ดังนั้นจึงต้องสอบถามหรือสนทนากับประชาชนที่เกี่ยวข้องจ านวนหนึ่งอาจท าให้เกิดความเข้าใจ

ได้ดีขึ้น 

2. ต้องการตรวจสอบบริบทตามความแตกต่างของเครื่องมือ (Context specific instruments) 

การสร้างเครื่องมือเพ่ือศึกษาแนวคิด น าไปใช้กับกลุ่มตัวอย่าง/ประชากรที่แตกต่างกัน การท าความเข้าใจ

กลุ่มตัวอย่าง/ประชากรก่อนการพัฒนาเครื่องมือ ท าให้การพัฒนาเครื่องมือเป็นไปด้วยดีและเหมาะสม

มากกว่า 

3. ต้องการอธิบายผล (Explain results) การใช้เครื่องมือรวบรวมข้อมูลเกี่ยวกับตัวแปรปัจจัย

เพ่ือการท านายแนวคิดนั้น เป็นการให้ความส าคัญกับตัวท านาย สามารถอธิบายว่าอะไร (what) และ

ท าไม (why) เป็นผลท าให้เกิดปรากฏการณ์ แต่การวิจัยแบบผสมผสม สามารถบอกได้ว่า ปรากฏการณ์ที่

ท าการศึกษามีกลไกในการเกิดอย่างไร (how) 

4. ต้องการตรวจสอบการก าหนดปัจจัยแทรก (Determine if an intervention will work) 

การค้นหาปัจจัยแทรกที่นักวิจัยผู้อ่ืนพัฒนาไว้ แต่ไม่สามารถค้นหาค าตอบได้จากตัวอย่างที่ท าการศึกษา 

ดังนั้นจึงต้องใช้วิธีการแบบผสมผสานในการตรวจสอบก่อนที่จะก าหนดตัวแปรแทรก 
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5. ต้องการเชื่อมโยงขั้นตอนต่างๆ ในกระบวนการประเมินผล (Tie together several steps in 

an evaluation process) เช่น การประเมินประสิทธิภาพขององค์กร เพ่ือท าความเข้าใจผลลัพธ์ของ

องค์กร การใช้เครื่องมือวัดประสิทธิภาพให้ค าตอบเฉพาะผลลัพธ์ แต่การวิจัยแบบผสมผสาน จะช่วย

อธิบายว่า ท าไม (why) ผลลัพธ์จึงเกิดขึ้น  

3.3 การวิจัยเชิงผสมผสาน 

การวิจัยเชิงผสมผสาน (mixed method research) เป็นทั้งวิธีการ (method) และระเบียบวิธี 

(methodology) เพ่ือด าเนินการวิจัย (conducting research) เกี่ยวกับการรวบรวม (collecting) การ

วิเคราะห์ (analyzing) และการบูรณาการ ( integrating) ด้วยวิธีการวิจัยเชิงปริมาณ (quantitative 

research) และการวิจัยเชิงคุณภาพ (qualitative research) ในการค้นหาค าตอบ (inquiry) อาจเป็น

การศึกษาเรื่องเดียว (single study) หรือ โครงการต่อเนื่องระยะยาว (longitudinal) โดยมีจุดมุ่งหมาย 

คือ ท าให้เกิดความเข้าใจ (understanding) ปัญหาหรือประเด็นการวิจัยที่ดีกว่าการใช้วิธีการใดวิธีการ

หนึ่งขึ้นเพียงวิธีการเดียว แบ่งได้เป็น 3 ประเภท ดังนี้ 

1. วิธีการเปรียบเทียบ (Triangulation mixed methods design) น าข้อมูลและผลการวิจัยที่

ได้จากวิธีการวิจัยเชิงปริมาณและเชิงคุณภาพมาท าการเปรียบเทียบและตีความ (interpretation) 

Quantitative Research 

(data and results) 
-> Interpretation <- 

Qualitative Research 

(data and results) 

2. วิธีการอธิบาย (Explanatory mixed methods design) เริ่มท าการวิจัยด้วยวิธีการเชิง

ปริมาณ และท าการติดตามหรือตรวจสอบ (follow up) เพ่ืออธิบายด้วยวิธีการเชิงคุณภาพ 

Quantitative Research 

(data and results) 

-> 

Follow Up 

Qualitative Research 

(data and results) 
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3. วิธีการส ารวจเบื้องต้น (Exploratory mixed methods design) ใช้วิธีการเชิงคุณภาพส ารวจ

ข้อมูลเบื้องต้นก่อนก่อร่างหรือสร้าง (building) การวิจัยด้วยวิธีการเชิงปริมาณ 

Qualitative Research 

 (data and results) 

-> 

Building 

Quantitative Research  

(data and results) 

สรุป 

การวิจัยทางสังคมศาสตร์ เป็นวิธีการหนึ่งในการหาความรู้ของมนุษย์ที่ได้รับอิทธิพลมาจาก

วิทยาศาสตร์ธรรมชาติและตามแนวทางที่พัฒนาขึ้นมาเองจากนักคิดด้านสังคมศาสตร์ โดยมีการออกแบบ

อย่างเป็นขั้นตอนและเป็นระบบตามหลักวิชาการ (methodology) ใช้วิธีเชิงประจักษ์ทั้งทางตรงและ

ทางอ้อมในการเก็บข้อมูลและสารสนเทศ ( information) ทั้งเชิงปริมาณ และ/หรือเชิงคุณภาพ น าไป

วิเคราะห์ อธิบาย ท านาย สร้างข้อสรุป และสนับสนุนทฤษฎี รวมถึงตอบค าถามที่เกิดจากข้อสงสัย

เกี่ยวกับสังคมมนุษย์ในทุกด้าน (social phenomena) และน าไปประยุกต์ใช้ในการแก้ไขปัญหาที่เกี่ยว

ของในสังคม  

แบบฝึกหัดท้ายบท 
ให้ผู้เรียนค้นหางานวิจัยด้านสังคมศาสตร์จากฐานข้อมูลของห้องสมุดที่สนใจแล้วตอบค าถาม 

ดังนี้ 

1. งานวิจัยที่ค้นได้ เป็นงานวิจัยเชิงปริมาณ เชิงคุณภาพ หรือเชิงผสมผสาน  
2. งานวิจัยดังกล่าว มีขั้นตอนการวิจัยกี่ข้ันและอะไรบ้าง 
3. งานวิจัยดังกล่าว มีและไม่มีขั้นตอนการวิจัยตามที่บรรยายไว้หรือไม่ 

  





 

 

 บทที่ 2 
การวิจัยเชิงปริมาณ 

ความมุ่งหมายของบทเรียน 
เพ่ือให้ผู้เรียนเข้าใจวิธีการวิจัยเชิงปริมาณที่เกิดจากความสัมพันธ์ระหว่างทฤษฎี สมมติฐาน และ

ตัวแปร  

เนื้อหา 

1. ความรู้เบื้องต้นเกี่ยวกับการวิจัยเชิงปริมาณ 
2. ทฤษฎี 
3. สมมุติฐาน 
4. ตัวแปร 
5. ความสัมพันธ์ระหว่างสมมติฐานและตัวแปร 

วิธีการสอนและกิจกรรมการเรียนการสอน 
บรรยาย แสดงตัวอย่าง สืบค้นข้อมูลจากฐานข้อมูลห้องสมุด และท าแบบฝึกหัดท้ายบท 

สื่อและอุปกรณ์การสอน 
เอกสารค าสอน ภาพเลื่อน คอมพิวเตอร์ โปรแกรมสอนออนไลน์ (สอนแบบออนไลน์) และเครื่อง

ฉาย (สอนในชั้นเรียน) 

งานที่มอบหมาย 

 ท าแบบฝึกหัดท้ายบท 

การวัดผลและประเมินผล 

การเข้าชั้นเรียน สังเกตความสนใจจากการเรียน สอบถามความเข้าใจจากการบรรยาย และการ

ท าแบบฝึกหัดท้ายบท 
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เนื้อหา 

การท าวิจัยแต่ละวิธีการ (approach) มีกระบวนการที่แตกต่างกัน การท าวิจัยด้วยวิธีการนิรนัย 

(deductive) มีการตั้งสมมติฐานจากทฤษฎีและเก็บรวบรวมข้อมูล3มาทดสอบสมมติฐาน ส่วนการท าวิจัย

ด้วยวิธีการอุปนัย (inductive) ใช้การรวบรวมข้อมูลเพ่ือค้นหากฎเกณฑ์หรือรูปแบบ (pattern) แล้วจึง

สร้างเป็นข้อเสนอเชิงทฤษฎีชั่วคราว (tentative conclusion or proposition) ส าหรับการค้นหาข้อมูล

มาสนับสนุน 

1. ความรู้เบื้องต้นเกี่ยวกับการวิจัยเชิงปริมาณ 

การวิจัยด้านสังคมศาสตร์รวมถึงสาขาสังคมวิทยาจ าแนกแบบกว้างๆ หรือตามวิธี การ 

(techniques) การรวบรวมข้อมูล (data collection) และการวิเคราะห์ข้อมูล (data analysis) ได้เป็น 

2 ประเภทใหญ่ คือ การวิจัยเชิงปริมาณ (quantitative research) และการวิจัยเชิงคุณภาพ (qualitative 

research) การวิจัยทั้งสองประเภทต่างมีความเชื่อเกี่ยวกับความจริงที่เรียกว่า ภาววิทยา (ontology) 

และวิธีการค้นหาความรู้หรือการเข้าถึงความจริงที่เรียกว่า ญาณวิทยา (epistemology) จึงท าให้เกิด

มุมมองที่แตกต่างกันในวิธีการรวบรวบข้อมูลและการวิเคราะห์ข้อมูล  (Blaikie, 2010, p. 204) แต่การ

วิจัยทั้ง 2 วิธี มีเป้าหมายที่เหมือนกัน คือ การได้ความรู้หรือข้อสรุปผลการวิจัยที่มีความถูกต้องและมี

ความน่าเชื่อถือ 

1.1 ความเป็นมาของการวิจัยเชิงปริมาณด้านสังคมศาสตร์ 

การวิจัยเชิงปริมาณเป็นกลยุทธ์หนึ่ง (a strategy) ในการหาความรู้ (inquiry) เกี่ยวกับโลกและ

ธรรมชาติด้วยวิธีการที่เป็นวิทยาศาสตร์ (scientific method) ของกลุ่มนักวิจัยที่เชื่อ (belief) ในความ

เป็นจริ ง  ( true) หรือที่ เ รี ยกกันว่ า  นักปฏิฐานนิยม (positivist)4 และนักปฏิฐานนิยมยุคหลั ง 

(postpositivist)5 การท้าทายแนวคิดนักปฏิฐานนิยมของนักปฏิฐานนิยมยุคหลังที่เป็นนักสังคมวิทยายุค

                                                           
3 ส่วนใหญ่ใช้ข้อมูลเชิงปริมาณ แต่ก็สามารถใช้ข้อมูลเชิงคุณภาพได้ในกรณีท่ีการทดสอบสมมุติฐานน้ันต้องการให้ข้อคิดเห็นหรือให้เหตุผลที่ได้มา
จากหลักฐาน  
4 แนวคิดเก่าที่เน้นการหาความรู้ที่เป็นความจริงแท้ (absolute truth) คือ เป็นจรงิตลอดเวลาและทุกสถานที่ และเป็นจริงเสมอไม่ว่าสถานการณ์
จะเป็นอย่างไร 
5
 แนวคิดใหม่ที่ไม่เช่ือว่า ความจรงิแทม้ีอยู่จรงิ  
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บุกเบิก เช่น ออกุสต์ กองต์ (Auguste Comte) อีมีล เดอร์ไคม์ (Emile Durkheim) ในศตวรรษที่ 19 ที่

เห็นว่า แนวคิดเกี่ยวกับความจริงแท้ไม่สามารถน ามาใช้ในการศึกษาพฤติกรรม  (behavior) และการ

กระท า (actions) ของมนุษย์ได้ ท าให้มีการน าเอาวิธีการหาความรู้เชิงเหตุและผลบนฐานความคิดของ

นักปฏิฐานนิยมไปพัฒนาใหม่โดยใช้วิธีการก าหนดความสัมพันธ์เชิงสาเหตุ (deterministic) เพ่ือพิสูจน์ 

(identify) สาเหตุ (causes) ที่มีอิทธิพล (influence) ท าให้เกิดผลลัพธ์ (outcomes) เช่น วิธีการทดลอง 

หรือใช้วิธีการลดทอน (reductionistic) โดยการน าเอาสิ่งที่เป็นความคิด (ideas) เช่น ทฤษฎี สมมติฐาน 

และค าถามการวิจัย มาลดทอนให้มีขนาดเล็กเป็นชุดความคิดหรือตัวแปรที่สามารถน าไปทดสอบได้ แต่

ยังคงรักษาวิธีการเข้ าถึงความรู้ที่ เป็นจริงเชิ งวัตถุวิสัย (objective reality) ด้วยวิธีการสัง เกตุ  

(observation) และการวัด (measurement) จากความจริงที่มีอยู่ภายนอก (out there) ที่ด ารงอยู่ 

หลังจากนั้นเป็นต้นมาท าให้เกิดการพัฒนาการวัดเชิงตัวเลข (numeric measurement) ด้วยวิธีการ

สังเกตและศึกษาพฤติกรรมของปัจเจกบุคคลอย่างแพร่หลายในบรรดานักปฏิฐานนิยมยุคหลัง รวมถึง

น ามาใช้ทดสอบ (tested) และตรวจสอบ (verified) กฎหรือทฤษฎีให้เกิดความเข้าใจเกี่ยวกับโลกให้ดีขึ้น 

ท าให้วิธีการวิจัยที่เริ่มจากทฤษฎีใดทฤษฎีหนึ่ง แล้วท ารวบรวมข้อมูลมาเพ่ือสนับสนุน (supports) หรือ

ปฏิเสธ (refutes) ตามวิธีการของนักปฏิฐานนิยมยุคหลังได้รับการยอมรับว่าเป็นวิธีการที่เป็นวิทยาศาสตร์ 

(Creswell, 2009, p. 6-7) 

ตั้งแต่ช่วงปลายศตวรรษที่ 19 เป็นต้นมา การวิจัยเชิงทดลองด้านจิตวิทยาเริ่มน าเอาวิธีการวิจัย

เชิงปริมาณที่วางอยู่บนฐานความคิดแบบปฏิฐานนิยมมาใช้เป็นเครื่องมือค้นหาความรู้กันอย่างแพร่หลาย 

(Creswell, 2014, p. 12) ข้อมูลในการวิจัยเชิงปริมาณด้านสังคมส่วนใหญ่เมื่อเก็บรวบรวมมาแล้วนิยมท า

ให้เป็นรหัส (coding) ในรูปแบบของตัวเลข (numerical) ส าหรับน าไปใช้กับโปรแกรมคอมพิวเตอร์เพ่ือ

วิเคราะห์ด้วยวิธีการทางสถิติ (statistical analysis) ด้วยการพรรณนา (describing) และการอธิบาย 

(explaining) ก่อนน าไปน าเสนอตามจุดมุ่งหมาย (Babbie, 2013, p. 413-414) 

1.2 ประเภทของการวิจัยเชิงปริมาณ 

การวิจัยเชิงปริมาณอาจแบ่งได้เป็นหลายประเภท แต่หากแบ่งตามวัตถุประสงค์ของการวิจัย

สามารถแบ่งได้เป็น 2 วิธีการ (approaches) ดังนี้ 
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1. การวิจัยพ้ืนฐาน (Basic research) คือ การวิจัยที่เน้นการทดสอบทฤษฎีเพ่ือสนับสนุนหรือ

ปฏิเสธทฤษฎี การวิจัยประเภทนี้อาจเรียกได้ว่าเป็นการวิจัยเชิงยืนยัน (confirmatory research) 

2. การวิจัยเชิงประยุกต์ (Applied research) คือ การวิจัยที่เน้นการค้นหาความสัมพันธ์ระหว่าง

เหตุและผลของปรากฎการณ์ทางสังคมหรือเหตุการณ์ต่างๆที่เกิดขึ้นในสังคม การวิจัยประเภทนี้อาจเรียก

ได้ว่าเป็นการวิจัยเชิงส ารวจ (exploratory research) 

การวิจัยเชิงปริมาณแม้ว่าจะมีวัตถุประสงค์ที่แตกต่างกัน แต่เป้าหมายที่ส าคัญ คือ การทดสอบ

ทฤษฎี  ( theories) ที่ เ ป็ นข้ อสรุ ปที่ เ ป็ นนามธรรมจากความ เป็ นจริ งมาท า ให้ เป็ นรู ปธรรม 

(operationalization) ด้วยการสร้างเป็นสมมติฐาน (hypothesis) ท าการนิยาม (identification) หรือ

พรรณนา (description) ตัวแปร (variable) ส าหรับสร้างเป็นเครื่องมือ (instrument) วัดหรือรวบรวม

ข้อมูลที่เป็นตัวเลข (numbered data) จากกลุ่มตัวอย่าง (sample) หรือประชากร (population) ที่มี

จ านวนมากหรือขนาดใหญ่ และน าไปวิเคราะห์ด้วยวิธีการทางสถิติ (statistical procedures) เพ่ือการ

ทดสอบหานัยส าคัญเชิงสถิติ (statistical significance) ของข้อมูล (Creswell, 2009, p. 4; Wagner & 

Okeke cited by Garner, M., Wagner, C., & Kawulich, B., 2009, p. 62; Williams, 2016, p. 88) 

2. ทฤษฎ ี

ค าว่า ทฤษฎี (theory) มาจากภาษากรีก คือ “theoria” ซึ่งหมายถึง “looking at” เป็นค า

กว้างๆ และเป็นประโยคเชิงข้อความ คล้ายกับสมมติฐาน แต่ทฤษฎีมีลักษณะที่แตกต่างกันมาก บาง

ทฤษฎีอาจอยู่ในรูปของทฤษฎีชาวบ้าน ( folk theory) ซึ่งไม่ต่างไปจากความเชื่อในชีวิตประจ าวัน 

(everyday beliefs) บางทฤษฎีอาจเป็นทฤษฎีระดับกว้าง (grand theory) อธิบายเค้าโครงหรือภาพรวม 

(explanatory schema) ของปรากฎการณ์ทางสังคม (social phenomena) และบางทฤษฎีอาจเป็น

ทฤษฎีระดับกลาง (middle range theory) ที่เป็นประโยคหรือข้อความ (statement) ที่สามารถทดสอบ

ได้ (testable) และมีขอบเขตการอธิบายเฉพาะปรากฎการณ์ทางสังคมภายใต้บริบท (context) เฉพาะ

ของสังคม-ประวัติ/วัฒนธรรม (socio-historical/cultural) (Williams, 2016, p. 218-224) 

2.1 ทฤษฎี คือ อะไร 

ทฤษฎี (theory) เป็นความคิด (notion) หรือค ากล่าว (statement) ที่สรุป (abstract) ให้เห็น

ถึงทิศทางของความสัมพันธ์ระหว่างแนวคิด (concept) เช่น เหตุการณ์หนึ่งเกิดจากอะไร มีกระบวนการ
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อย่างไร อะไรเกิดขึ้นก่อน อะไรเกิดขึ้นหลัง อะไรเป็นสาเหตุที่ท าให้เกิดและไม่ท าให้เกิด บางทฤษฎีได้รับ

การยอมรับอย่างเป็นทางการ (formal) แต่บางทฤษฎีอาจยังไม่ได้รับการยอมรับอย่างเป็นทางการ 

(informal) บางทฤษฎีมีความละเอียด (elaborate) และความซับซ้อน (complex) แต่ลักษณะทฤษฎีที่ดี

ต้องมีความเรียบง่าย (simplicity) และความชัดเจน (clarity)  (Bouma and Ling, 2004, p. 19) 

ทฤษฎีอาจเป็นแนวคิด  (a concept) ชื่อของปรากฎการณ์  (a naming of phenomena) 

ประเภทของความคิด (an ideal type) การพรรณนารายละเอียดของการกระท า (a thick description 

of an action) การบรรยายในลักษณะของตัวแบบ (a narrative as well as a model) ทฤษฎีมีลักษณะ

การอธิบายข้อเท็จจริงหรือจารนัย (abductive) กระบวนการ (process) มากกว่าการชี้แนะ (suggested) 

และมีความส าคัญมากในการท าวิจัย เพราะเป็นเครื่องมือหรือเลนส์ ( lens) ที่ช่วยให้นักวิจัยมอง

ปรากฎการณ์ (phenomena) แม้ว่าจะไม่ให้ภาพที่สมบูรณ์แต่ช่วยให้นักวิจัยตัดสินใจว่าจะมองที่อะไร 

รวมถึงสร้างค าถามการวิจัย ออกแบบการวิจัย สร้างกรอบแนวคิด การวิจัยแบบนิรนัย (deduction 

approach) ทฤษฎีจะถูกใช้เป็นแนวทางในการสร้างกรอบแนวคิด (conceptual framework) ของการ

วิจัย เพ่ือน าไปสู่การสร้างสมมติฐาน (hypothesis) และการทดสอบ (tested) นอกจากนั้นทฤษฎียังช่วย

เป็นกรอบของการอ้างอิงในการวิเคราะห์ ช่วยให้นักวิจัยเข้าใจว่าเกิดอะไรขึ้น (what happened) และ

เกิดผลที่ตามมาจากสิ่งที่เกิดขึ้น (consequences for what happened) อธิบายว่าอะไรคือสาเหตุของ

สิ่งที่เกิดขึ้น กรอบแนวคิดเชิงทฤษฎี (theoretical frameworks) เป็นสะพานเชื่อมระหว่างความเชื่อ

เกี่ยวกับญาณวิทยา (epistemology) และภาวะวิทยา (ontology) และการวิเคราะห์ (analysis) และ

การตีความของข้อมูล (interpretation of data) (Hammond and Wellington, 2013, p.141-144)  

ทฤษฎีเป็นการรวมความคิดหลายๆความคิดเข้าด้วยกัน (a collection of ideas) หรือค า

บรรยายสรุปความเป็นจริง (reality) ที่ได้มาจากการสังเกตจากโลกเชิงประจักษ์ (empirical world) หรือ

เป็นการอธิบายอย่างเป็นระบบ (systematic explanation) เกี่ยวกับกฎเกณฑ์ (regularities) ส าหรับ

น าไปใช้ในการสังเกต (observation) (Bryman, 2012, p. 21; Aneshensel, 2013, p. 20, 32 Babbie, 

2013, p. 8) 

ทฤษฎีเป็นข้อเสนอหรือประพจน์ (propositions) หรือสมมติฐาน (hypotheses) ที่เป็นชุดความ

เกี่ยวพันระหว่างกัน ( interrelated) ของมโนทัศน์หรือสิ่งที่เป็นนามธรรม (constructs) หรือตัวแปร 

(variables) แสดงถึงความสัมพันธ์ระหว่างตัวแปรในรูปของขนาด (magnitude) หรือทิศทาง (direction) 



26 | ก า ร ใ ช้ โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร์ ท า ง ส ถิ ติ ใ น ด้ า น สั ง ค ม ศ า ส ต ร์  

หรืออาจปรากฏอยู่งานวิจัยในรูปของข้อโต้แย้ง (argument) การอภิปราย (discussion) เหตุผล 

(rationale) ที่ใช้ในการอธิบาย (explain) หรือท านาย (prediction) ปรากฎการณ์ที่ เกิดขึ้นในโลก 

(Creswell, 2009, p. 51) 

2.2 ประเภทของทฤษฎ ี

นักปรัชญาและนักวิชาการมีการสร้างทฤษฎีส าหรับใช้ในการอธิบายและศึกษาสังคมไว้จ านวน

มาก การน าเอาทฤษฎีมาใช้ในการค้นหาความรู้หรือท าวิจัยวิจัยขึ้นอยู่กับความสนใจของนักวิจัยและ

ปรากฎการณ์ทางสังคมที่ศึกษา บางเรื่องอาจที่มีขอบเขตกว้างและมีขนาดใหญ่ระดับสังคม  เช่น การต่อสู้

ระหว่างชนชั้นของสังคม ความสัมพันธ์ระหว่างประเทศ ความสัมพันธ์ระหว่างสถาบันหลักทางสังคม 

(รัฐบาล ศาสนา ครอบครัว)  บางเรื่องเป็นวิถีชีวิตของคนหรือกลุ่มคนในสังคม  เช่น พฤติกรรมการหาคู่ 

การพิจารณาคดีของผู้พิพากษา ความสัมพันธ์เพ่ือนร่วมงาน แต่บางเรื่องอาจเป็นทั้งระดับมหภาคและ

จุลภาค เช่น ความขัดแย้ง (conflict) โดยทั่วไปมีการจ าแนกทฤษฎีที่ใช้ในการศึกษาสังคมออกเป็น 3 

ระดับ ดังนี้ (Babbie, 2013, p. 33) 

1. ทฤษฎีระดับมหภาค (Macro theory) เป็นทฤษฎีที่ใช้อธิบายลักษณะโดยรวมของสังคม 

(aggregate entities of society) หรือทั้งสังคม (whole societies) เช่น ทฤษฎีโครงสร้าง -หน้าที่  

(structural-functional) ทฤษฎีเครือข่ายทางสังคม (social network) 

2. ทฤษฎีระดับกลาง (Meso theory) มีนักวิจัยบางกลุ่มนิยมเอาทฤษฎีระดับมหภาคมา

ประยุกต์ใช้ระหว่างระดับมหภาคกับระดับจุลภาค เพ่ือใช้ศึกษาองค์การ (organization) ชุมชน 

(community) และประเภทของสังคม (social category) 

3. ทฤษฎีระดับจุลภาค (Micro theory) เป็นทฤษฎีที่ใช้อธิบายวิถีชีวิตของคนในสังคม (social 

life) ที่มีความใกล้ชิดและมีปฏิสัมพันธ์กันในระดับบุคคล (individual) หรือกลุ่มขนาดเล็ก (small group) 

เช่น ทฤษฎีการกระท าระหว่างกันเชิงสัญลักษณ์ (symbolic interactionism) 

2.3 การเลือกใช้ทฤษฎีในการวิจัย 

การเลือกใช้ทฤษฎีในการอธิบายปรากฎการณ์ทางสังคมในแต่ละสาขาวิชามีความเชื่อแตกต่างกัน 

นักสังคมวิทยาส่วนใหญ่เชื่อว่า การศึกษาพฤติกรรม (behaviors) และการตัดสินใจ (decisions) ของ

บุคคล (individuals) ไม่สามารถน าไปใช้อธิบายปรากฎการณ์ทางสังคมที่มีความซับซ้อนได้อย่างสมบูรณ์ 
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เพราะปรากฎการณ์ทางสังคม (social phenomena) เกิดมาจากปฏิสัมพันธ์ของประชาชน (social 

interaction) ในองค์การ (organizations) สถาบัน (institutions) และสังคม (societies) ซึ่งตรงข้ามกับ

นักจิตวิทยาและนักเศรษฐศาสตร์ส่วนใหญ่ที่มีแนวโน้มจะยอมรับว่าปรากฎการณ์ทางสังคมนั้นสามารถ

ลดทอน (reducible) ไปสู่การอธิบายการกระท า (actions) ของบุคคล เพราะบุคคลมีทางเลือกที่เป็น

อิสระ (independent choices) ดังนั้นจึงสามารถเอามารวมกันเพ่ืออธิบายกระบวนการทางสังคม 

(social processes) ที่ซับซ้อนได ้(Sawyer, 2005)  

การน าเอาทฤษฎีไปใช้เป็นกรอบในการมองหรืออธิบายปรากฎการณ์ทางสังคมต้องเลือกใช้

ทฤษฎีให้เหมาะกับประเด็นที่ต้องการศึกษา บางเรื่องอาจใช้ทฤษฎีระดับใดระดับหนึ่งเท่านั้น แต่บางเรื่อง

อาจน าเอาทฤษฎีในระดับท่ีแตกต่างกันมาอธิบายร่วมกัน (link) เพ่ือให้เห็นความเก่ียวข้องระหว่างกัน 

แม้ว่าแนวคิดการศึกษาและอธิบายปรากฎการณ์ทางสังคมด้วยการเชื่อมโยงระหว่างแนวคิดที่มี

ระดับแตกต่างกันของอีมีล เดอร์ไคม์ (Emile Durkheim) มีนักสังคมศาสตร์จ านวนไม่น้อยที่ไม่เห็นด้วย 

แต่ก็มีนักวิชาการจ านวนไม่น้อยที่น าเอาข้อเสนอของเดอร์ไคม์ไปใช้ในการอธิบายข้อเท็จจริงทางสังคม 

(social facts) อีกท้ังยังเป็นตัวอย่างหนึ่งที่สามารถน ามาอธิบายเพื่อให้เข้าใจวิธีใช้ทฤษฎีที่มีระดับแตกต่าง

กันเชื่อมโยงความสัมพันธ์ระหว่างกลไกระดับจุลภาค (microlevel mechanism) กับกลไกระดับมหภาค 

(macrolevel mechanism) โดยเดอร์ไคม์ได้เสนอไว้ว่า ความแตกต่างของอัตราการฆ่าตัวตาย (suicide) 

ของคนในสังคมเกิดมาจากระดับความเป็นปึกแผ่นทางสังคม (social solidarity) ในระดับท่ีสูงกว่า พร้อม

กับยกตัวอย่างให้เห็นว่า ประเทศท่ีประชาชนส่วนใหญ่เป็นคาทอลิกมีอัตราการฆ่าตัวตายน้อยกว่าประเทศ

ที่ประชาชนส่วนใหญ่เป็นโปรเตสแตนต์ เพราะสังคมคาทอลิกมีความเป็นปึกแผ่นทางสั งคมสูงจึงช่วย

ป้องกันไม่ให้ประชาชนฆ่าตัวตายและท าให้มีอัตราการฆ่าตัวน้อยกว่า (Babones, 2014, p. 7-8) 

ปรากฏการณ์ทางสังคมในโลกเสมือนจริง (virtual world) ที่อุบัติ/ผุดบังเกิด (emergence) อย่าง

หลากหลายและรวดเร็ว อาจต้องเชื่อมโยงทั้งทฤษฎี/แนวคิดในระดับจุลภาคกับมหภาค (micro-macro 

link) เช่น การปฏิสัมพันธ์ทางสังคม กลุ่มสังคม เครือข่ายสังคม สื่อสังคมออนไลน์ ในการท าความเข้าใจ

และอธิบายสิ่งที่เกิดขึ้น 

ทฤษฎีและสมมติฐานมีความสัมพันธ์กันอย่างมาก เราสามารถน าเอาทฤษฎีที่เป็นนามธรรมและ

เป็นค ากล่าวกว้างๆ ไปทดสอบได้ (testable) โดยการลดทอน (deductive) ให้มีลักษณะเฉพาะหรือแคบ

ลงให้เป็นประโยคในเชิงสมมติฐาน (Williams, 2016, p. 88) 
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3. สมมติฐาน 

มีการกล่าวกันว่า สมมติฐาน ไม่มีความจ าเป็นหรือไม่เหมาะกับการท าวิจัยด้วยวิธีการอุปนัย 

(inductive) ที่เน้นการสังเกตและท าความเข้าใจปรากฏการณ์ทางสังคมแล้วสร้างเป็นทฤษฎี การวิจัย

แบบจารนัย (abductive) อาจใช้สมมติฐานเป็นแนวทางในการสร้างทฤษฎี (generating theory) แต่

แตกต่างจากวิธีการนิรนัย (deductive) คือ เป็นการสร้างสมมติฐานที่เกิดขึ้นในระหว่างท าการวิจัยและ

ถูกน ามาใช้เป็นขั้นตอนย่อย (subsequent stage) ของการวิจัย ส่วนการวิจัยแบบกลนัย (retroductive) 

ไม่มีการสร้างสมมุติฐาน หน้าที่ของนักวิจัยคือ การออกแบบ (postulate) โครงสร้าง (structure) หรือ

กลไก (mechanism) ที่มีอยู่ และด าเนินการในรูปของการเสนอแนะ  (Blaikie, 2010, p. 10,147) 

สมมติฐานโดยทั่วไปสร้างมาจากทฤษฎีเพ่ือน าไปใช้ในการรวบรวมข้อมูลและตรวจสอบ (verify) 

หรืออาจสร้างมาจากผลการวิจัยในอดีต การทบทวนวรรณกรรมที่เกี่ยวข้อง และรวมถึงอาจได้มาจากการ

คิดข้ึนเอง (thin air) (Flynn, Sakakibara, Schroeder, Bates & Fynn, 1990, p. p. 253) 

สมมติฐานที่ได้มาจากทฤษฎีหรือแนวคิดต้องน ามาประยุกต์ใช้ให้เหมาะสมกับสถานการณ์ อาจใช้

เป็นค าตอบ (answer) ที่เป็นไปได้ในการตอบค าถาม (question) ท าไม (why) และอย่างไร (how)6 และ

อาจไม่จ าเป็นต้องมีความสัมพันธ์เชิงเหตุและผล (causal) แต่ต้องมีความชัดเจน มีความเข้าใจง่าย ไม่มี

ความคลุมเครือ และสามารถท าไปทดสอบได้อย่างเป็นขั้นเป็นตอน (Black, 1999, p. 45, 53; Babbie, 

2008, p. 48) 

3.1 สมมติฐาน คือ อะไร 

สมมติฐาน (Hypothesis) คือ ประโยคหรือข้อความที่เป็นค าตอบล่วงหน้าของปัญหาวิจัยที่ระบุ

ถึงความสัมพันธ์ระหว่างตัวแปรตั้งแต่สองตัวแปรขึ้นไปที่ได้มาจากทฤษฎี การคาดคะเนจากความรู้ และ

ประสบการณ์ของนักวิจัย เมื่อก าหนดเป็นสมมติฐานเชิงวิจัยแล้ว ในการทดสอบสมมติฐานด้วยสถิติจะมี

การแปลงสมมติฐานเชิงวิจัยไปเป็นสมมติฐานเชิงสถิติก่อน 

สมมติฐานไม่เพียงแต่จะเป็นตัวก าหนดตัวแปร แต่มีบทบาทส าคัญในการน าไปสู่ความเกี่ยวข้อง

กันของสิ่งที่ท าการศึกษา แม้ว่าตัวแปรนั้นไม่ได้อยู่ในความสนใจที่ต้องก าหนดและนิยามความหมาย 

                                                           
6 ค าถามการวิจัยประเภท อะไร (what) ไม่ต้องตั้งสมมติฐาน 
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เพราะบางประโยคแสดงให้เห็นหรือหมายถึงความสัมพันธ์เชิงเหตุและผลอย่างมีเหตุผลพร้อมกับล าดับ

เวลาของเหตุการณ์ และสะท้อนถึงความเป็นไปได้ของปรากฏการณ์ที่เกิดขึ้นอันเป็นผลมาจากหลาย

สาเหตุ หรือมีความต่อเนื่องของสาเหตุของการเกิดเหตุการณ์ (Black, 1999, p. 34-35) 

สมมติฐานจะเขียนในลักษณะประโยคบอกเล่าทั่วไป (basic statement) เพ่ืออธิบายข้อเท็จจริง

ที่ยังคลุมเครือและก าหนดทิศทางในการท าวิจัยให้เกิดความชัดเจน (Fisher, 1949, p. p. 13 cited by 

Cohen, 1977, p. 1) โดยแสดงการคาดคะเนของผลลัพธ์ (outcome) ที่เกิดจากความสัมพันธ์ระหว่างตัว

แปร 2 ตัวแปรหรือมากกว่า (Babbie, 2008, p. 48) หรือเป็นความสัมพันธ์ระหว่างสองแนวคิด 

(concept) ประโยคหนึ่งเป็นเหตุ (cause) และอีกประโยคหนึ่งเป็นผล (outcome) ทั้งเหตุและผล คือ 

ตัวแปร ที่ใช้เป็นแนวทางในการรวบรวมข้อมูลของนักวิจัยและน าไปใช้ในการทดสอบสมมติฐาน (Blaikie, 

2010, p. 10; Field, 2013, p. 7) 

3.2 ประเภทของสมมตฐิาน 

สมมติฐานมีลักษณะเหมือนกับทฤษฎีมาก แต่ถูกน ามาใช้ในการวิจัยด้านสังคมใน 2 แนว คือ เป็น

ประโยคเชิงข้อความ (propositional statement) อาจเป็นประโยคบอกเล่าหรือประโยคปฏิเสธที่เป็น

จริงหรือเป็นเท็จอย่างใดอย่างหนึ่ง และเป็นประโยคเชิงตรรกะ (logical form) เพ่ือใช้ในการทดสอบนัย

ยะส าคัญเชิงสถิติ (statistical significance) ของข้อมูล (Williams, 2016, p. 88) ดังนั้นจึงมีการเขียน

สมมติฐานในงานวิจัยแต่ละเรื่องหรือสาขาวิชาให้เห็นใน 2 รูปแบบ ดังนี้ 

1. สมมติฐานเชิงวิจัย (Research hypothesis) คือ ค าตอบที่ผู้วิจัยเขียนไว้ในตอนแรกเริ่มการ

วิจัย เป็นการคาดเดาผลไว้ล่วงหน้าว่าจะเป็นไปตามนั้น เป็นลักษณะของการใช้ค าบรรยายหรือพรรณนา

ลักษณะความสัมพันธ์ของตัวแปร มักอยู่ในลักษณะการคาดคะเนผลว่าไม่แตกต่างกัน แตกต่างกัน 

มากกว่า หรือน้อยกว่า เช่น ชาวต่างชาติที่ท างานอยู่ในนิคมอุตสาหกรรมแหลมฉบังและนิคมอุตสาหกรรม

มาบตาพุดมีการด าเนินชีวิตประจ าวันไม่แตกต่างกัน ประชาชนในเขตชนบทมีระดับการศึกษาแตกต่างกับ

ประชาชนในเขตเมือง ประชาชนในเขตชนบทมีรายได้น้อยกว่าประชาชนในเขตเมือง ครัวเรือนในเขต

ชนบทมีจ านวนสมาชิกมากกว่าครัวเรือนในเขตเมือง  

2. สมมติฐานเชิงสถิติ (Statistical hypothesis) คือ สมมติฐานทางวิจัยที่ถูกแทนที่ด้วยการใช้

สัญลักษณ์ในทางคณิตศาสตร์ หรือสถิติที่บ่งบอกความสัมพันธ์ของตัวแปร ในรูปของเครื่องหมายแทน
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คุณลักษณะของตัวแปรนั้นๆ เป็นสมมติฐานที่ใช้ในการวิเคราะห์ข้อมูลเพ่ือการทดสอบสมมติฐานการวิจัย 

เช่น  = 0  หรือ  ≠ 0 หรือ  > 0 หรือ  < 0 

ในการวิจัยเชิงปริมาณท่ีมีการทดสอบสมมติฐาน สมมติฐานทางวิจัยจะถูกแปลงให้เป็นสมมติฐาน

ทางสถิติใน 2 ลักษณะ ดังนี้ 

1. สมมติฐานศูนย์หรือสมมติฐานหลักหรือสมมติฐานที่เป็นกลางหรือสมมติฐานไร้นัยส าคัญ (Null 

hypothesis:  Ho หรือ H0) หมายถึง สมมติฐานที่มิได้บ่งชี้ความแตกต่างหรือความสัมพันธ์ของตัวแปร 

หรือเป็นประโยคที่กล่าวถึง ความไม่แตกต่างของประชากร (no difference in the population) เช่น 

ชาวต่างชาติที่ท างานอยู่ในนิคมอุตสาหกรรมแหลมฉบังและนิคมอุตสาหกรรมมาบตาพุดมีการด าเนิน

ชีวิตประจ าวันไม่แตกต่างกัน 

2. สมมติฐานทางเลือกหรือสมมติฐานรอง หรือสมมติฐานที่เหลือ (Alternative hypothesis:  

Ha หรือ H1) หมายถึง สมมติฐานที่ระบุความสัมพันธ์ของตัวแปร ทั้งในลักษณะก าหนดทิศทางบวก หรือ

ลบ และไม่ก าหนดทิศทาง หรือเป็นประโยคที่กล่าวถึง ความแตกต่างของประชากร (difference) เช่น 

ชาวต่างชาติที่ท างานอยู่ในนิคมอุตสาหกรรมแหลมฉบังและนิคมอุตสาหกรรมมาบตาพุดมีการด าเนิน

ชีวิตประจ าวันแตกต่างกัน 

4. ตัวแปร 

ตัวแปร (variables) เป็นแนวคิดที่ เป็นนามธรรมสามารถสังเกต (observable) และวัด 

(measurable) ได้ด้วยการท าให้แนวคิดสามารถวัดได้ด้วยตัวแปร (Bouma and Ling, 2004, p. 41) 

ตัวแปรได้มาจากหลายแหล่งทั้งแนวคิด ทฤษฎี ปัญหาการวิจัย สมมติฐ าน การทบทวน

วรรณกรรม งานวิจัยที่เกี่ยวข้อง หน่วยวิเคราะห์ (ใคร/อะไร) และการสร้างของนักวิจัย (นิยามตัวแปร/

การวิเคราะห์) มีต าราทั้งด้านการวิจัยและการวิเคราะห์ข้อมูลให้ค านิยามหรือความหมายเกี่ยวกับตัวแปร

ไว้หลากหลาย จึงน าเอามาน าเสนอเป็นตัวอย่างพอสังเขปดังต่อไปนี้  

4.1 ตัวแปร คือ อะไร 

 ตัวแปร คือ คุณลักษณะ (a characteristic) ของสิ่งต่างๆ (objects) ในการวัด (measurement) 

คุณลักษณะของสิ่งต่างๆนั้นสามารถที่จะสมมติ (assume) ให้เป็นสิ่งใดก็ได้ (any one) ตามที่ก าหนดให้
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เป็นผลลัพธ์ (outcomes) ไว้ตั้งแต่ต้น เช่น เพศ ส่วนสูง น้ าหนัก เชื้อชาติ สัญชาติ และรายได้ของบุคคล 

ผลลัพธ์ที่ได้จากการวัดคุณลักษณะจากสิ่งประเภทเดียวกันหรือคนกลุ่มเดียวกันจะมีค่าที่แตกต่างกันในแต่

ละสิ่งหรือแต่ละคน (Traub, 1994, p. 5)  

 ตัวแปร คือ แนวคิดประเภทหนึ่ง (a type of concept) ซึ่งมีความแตกต่างกัน (vary) ในเรื่อง

ของจ านวน (amount) หรือคุณภาพ (quality) ซึ่งอาจมากหรือน้อย หรืออาจมีความแตกต่างกันเป็น

ประเภท (categories) ตัวแปรที่สนใจไม่ใช่เรื่องของความแตกต่างของจ านวนหรือประเภท แต่เป็นเรื่อง

ของความสามารถในการวัดได้ (measurable) (Bouma and Ling, 2004, p. 19) 

ตัวแปร คือ ทุกสิ่งที่สามารถท าการวัดได้ (measured) และมีลักษณะหรือคุณสมบัติที่แตกต่าง

กัน (across entities) หรืออาจเป็นสิ่งเดียวกันแต่อยู่ในช่วงเวลาที่แตกต่างกัน (across time) (Field, 

2013) 

อาจกล่าวได้ว่า ตัวแปร คือ สัญลักษณ์ (symbol) ที่นักวิจัยสร้างมาจากแนวคิดหรือทฤษฎีเพ่ือ

แทนสรรพสิ่งที่ต้องการศึกษา (objects) และสามารถน าไปนับ ค านวณ และสรุปเป็นปริมาณด้วยตัวเลข 

กราฟ แผนภูมิ แผนภาพ และค าอธิบาย 

การวัดอาจท าได้โดยตรงจากประสาทสัมผัสของนักวิจัย เช่น ตา หู จมูก หรือใช้สิ่งประดิษฐ์เป็น

เครื่องมือช่วยวัดจากสิ่งที่อยู่นอกความสามารถการเข้าถึงด้วยประสาทสัมผัสของมนุษย์ เช่น ดาวเทียม 

กล้องจุลทรรศ์ ยานส ารวจ และอาจต้องสร้างตัวแปรเทียมโดยอาศัยวัดหลายๆดัชนีที่สามารถสังเกตได้ 

เช่น โครงสร้างของสังคม สถาบันทางสังคม ความศรัทธา ความเชื่อ   

4.2 ประเภทตวัแปร 

ตัวแปรไม่เพียงแต่จ าแนกสรรพสิ่ งที่วัดให้มีแตกต่างกันเท่านั้น ในการทดสอบหรือหา

ความสัมพันธ์ระหว่างเหตุ (cause) และผล (outcome) ผู้วิจัยยังต้องก าหนดให้ตัวแปรมีหน้าที่  

(functions) แตกต่างกันไปตามตรรกะและความสัมพันธ์ตามทฤษฎีและสมมติฐาน บางต าราแบ่งเป็น 3 

ประเภท เช่น ตัวแปรอิสระ ตัวแปรตาม และตัวแปรคุม แต่บางต าราแบ่งเป็น 6 ประเภท เช่น  ตัวแปร

อิสระ ตัวแปรตาม ตัวแปรคุม ตัวแปรแทรกแซง ตัวแปรก ากับ และตัวแปรเกินหรือตัวแปรแทรกซ้อน 
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ส าหรับในที่นี้ได้รวบรวมชื่อตัวแปรที่ปรากฏในต าราต่างๆ มาแบ่งตามลักษณะของการท าหน้าที่ 

ความสัมพันธ์กับตัวแปรอ่ืนๆ และการสร้างตัวแปร โดยมีรายละเอียดดังต่อไปนี้ 

1. กลุ่มตัวแปรสาเหตุ  (Cause Variables) คือ ตัวแปรที่ผู้วิจัยก าหนดให้เป็นต้นเหตุของ

ปรากฎการณ์ ซึ่งมีหลายชื่อ แต่ชื่อที่นิยมใช้มากที่สุด คือ ตัวแปรอิสระ โดยมีรายละเอียดดังต่อไปนี้ 

1.1 ตัวแปรอิสระ (Independent variable) คือ ตัวแปรที่เป็นสาเหตุ (cause) ที่มีผลกระทบ 

(impact) หรือท าให้เกิดการเปลี่ยนแปลงต่อตัวแปรอ่ืน ตัวแปรอิสระนอกจากจะมีชื่อเรียกว่า ตัวแปรต้น 

เพราะเป็นต้นเหตุท าให้ตัวแปรอื่นมีเกิดการเปลี่ยนแปลง 

1.2 ตัวแปรอธิบาย (Explanatory/Explaining variable) หรืออาจรู้จักในชื่อว่า ตัวแปรตัว

ท านาย (predictor variable) คือ ตัวแปรอิสระหรือตัวแปรเหตุประเภทหนึ่งที่ใช้อธิบายการเปลี่ยนแปลง

ในตัวแปรตอบสนอง (respond variables) มักใช้ในการศึกษาเชิงความสัมพันธ์ (correlational studies) 

การวิเคราะห์เชิงทดถอย (regression) และการศึกษาแบบไม่ทดลอง (non-experimental study) เช่น 

ระดับการศึกษาเป็นตัวแปรอธิบายรายได้ที่แตกต่างกัน 

1.3 ตัวแปรทดลอง (Treatment variable) เพราะผู้วิจัยสามารถก าหนดค่าให้กลุ่มตัวอย่างมี

ลักษณะที่แตกต่างกันเพ่ือทดลองเปรียบเทียบผลลัพธ์ที่เกิดขึ้น เช่น การทดสอบความเร็วในการให้บริการ

ด้วยระบบอัตโนมัติกับระบบเจ้าหน้าที่  

1.4 ตัวแปรถูกจัดการ (Manipulated variable) หากผู้วิจัยจัดการหรือก าหนดให้มีค่าเพ่ิมขึ้น

หรือลดลง หรือควบคุมให้มีค่าคงที่ (constant) เพ่ือทดลองการเกิดผลลัพธ์ในกระบวนการวิเคราะห์หรือ

ทดลอง 

 2. กลุ่มตัวแปรผล (Result Variables) คือ ตัวแปรที่ผู้วิจัยก าหนดให้แสดงผลของปรากฎการณ์ 

มีหลายชื่อเช่นกัน แต่ชื่อที่นิยมใช้มากที่สุด คือ ตัวแปรตาม โดยมีรายละเอียดดังต่อไปนี้ 

2.1 ตัวแปรตาม (Dependent variable) คือ ตัวแปรที่มีค่าหรือผลลัพธ์เปลี่ยนแปลงไปตามตัว

แปรอิสระหรือตัวแปรอืน่ๆ อาจมีชื่อเรียกอ่ืน เช่น ตัวแปรที่ถูกอธิบาย (explained variables) ตัวแปรถูก

ท านาย (predicted variables) รวมถึงมีชื่อเรียกท่ีแตกต่างกันไปอีกหลายชื่อดังต่อไปนี้ 

2.2 ตัวแปรผลลัพธ์ (Outcome variable คือ ตัวแปรที่แสดงค่าที่เป็นผล (results) หรือ

ผลลัพธ์ (outcome) ที่ไดมาจากการศึกษา ส่วนใหญ่ใช้ในการศึกษาแบบไม่ทดลอง (non-experimental 

study) 
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2.3 ตัวแปรเกณฑ์ (Criterion variable) ส่วนใหญ่นิยมเรียกในการวิเคราะห์ตัวแบบเชิงสถิติ 

(statistical modeling) เช่น การวิเคราะห์ถดถอย (regression analysis) การวิเคราะห์ความแปรปรวน 

(analysis of variance) การวิ เคราะห์จ าแนกกลุ่ ม  (discriminant analysis) และการวิ เคราะห์

สหสัมพันธ์คาโนนิคอล (canonical correlation) ที่ก าหนดให้ตัวแปรตามเป็นตัวแปรที่ถูกพยากรณ์ 

(being predicted) ผลลัพธ์ที่ได้ (outcome) จะข้ึนอยู่กับ (depend on) หลายสาเหตุ 

2.4 ตัวแปรตอบสนอง (Response variable) เป็นชื่อที่นิยมเรียกกันในการวิจัยสาขาวิชา

จิตวิทยาที่เป็นการทดลองเก่ียวกับการแสดงออกของพฤติกรรมเม่ือได้รับการกระตุ้นโดยสิ่งเร้า 

2.5 ตัวแปรภายใน (Endogenous variable) คือ ตัวแปรเชิงสาเหตุที่ก าหนดขึ้นในระบบหรือ

ตัวแบบเชิงสาเหตุ (a causal model) ที่ท าการศึกษา เช่น การวิเคราะห์การถดถอยเชิงเส้นตรง (linear 

regression) และมีค่าที่ถูกก าหนดโดยตัวแปรอ่ืนๆ จึงมีความผันแปรไปตามสาเหตุจากตัวแปรที่เป็น

ต้นเหตุของการเกิดตัวแปร (คล้ายกับตัวแปรตาม แต่ไม่เหมือนกันทั้งหมด) 

 3. กลุ่มตัวแปรบริบท (Context Variables) คือ ตัวแปรที่ผู้วิจัยก าหนดให้มีหรือไม่มีอิทธิพล 

(influence) ต่อความสัมพันธ์ระหว่างตัวแปรเหตุกับตัวแปรผล มีหลายชื่อเรียก โดยมีรายละเอียด

ดังต่อไปนี้ 

3.1 ตัวแปรคุม (Control variable) คือ ตัวแปรที่ผู้วิจัยไม่ต้องการให้อยู่หรือต้องก าจัดออกไป

ในการทดสอบความสัมพันธ์ระหว่างตัวแปรอิสระและตัวแปรตาม เพ่ือแสดงให้เห็นว่าความสัมพันธ์

ระหว่างตัวแปรอิสระและตัวแปรตามไม่ได้เกิดจากตัวแปรอ่ืนหรือตัวแปรที่น ามาใช้เป็นตัวแปรคุม  ดังนั้น

ตัวแปรคุมจึงมีชื่อเรียกในชื่อ อ่ืน เช่น ตัวแปรเกินหรือตัวแปรแทรกซ้อนหรือตัวแปรภายนอก 

(extraneous variable) หรือตัวแปรร่วม (covariate variable) 

3.2 ตัวแปรแทรกแซง (Intervening variable) คือ ตัวแปรที่ไม่สามารถสังเกตได้โดยตรง (not 

direct observable) แต่มีความเก่ียวโยง (link) กับตัวแปรอิสระและตัวแปรตาม อาจมีการใช้ชื่อเรียกอ่ืน 

เช่น  ตัวแปรส่งผ่าน (mediating variable) หรือตัวแปรคั่นกลาง ( intermediary variable) เช่น มี

ความสัมพันธ์ทางสถิติเชิงลบระหว่างความเป็นเมืองกับขนาดครอบครัว ความเป็นเมืองไม่ใช่ปัจจัยที่มีอิทธิ

พต่อขนาดครอบครัวเพียงอย่างเดียว แต่ความเป็นเมืองมีแนวโน้มท าให้คนมีการศึกษาและความรู้ในการ

วางแผนครอบครัวที่ดี ท าใหมีบุตรจ านวนที่เหมาะสมกับสภาพเศรษฐกิจ ตัวแปรด้านการศึกษาและ

เศรษฐกิจ คือ ตัวแปรแทรกที่คั่นกลางความสัมพันธ์ระหว่างความเป็นเมืองกับขนาดครอบครัว หรือ

สถานภาพทางสังคมของพ่อแม่มีผลต่อทางตรงต่อสถานภาพทางสังคมของลูก แต่สถานภาพทางสังคมตัว
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แปรที่มีผลทางอ้อมต่อสถานภาพทางสังคมของลูก คือ การศึกษาของลูก (Parent’s status -> child’s 

education -> child’s status) 

3.3 ตัวแปรคั่นกลาง (Mediator variable) คือ ตัวแปรที่มีอิทธิพล (influences) หรือคั่นกลาง

ความสัมพันธ์ (relation) ระหว่าง 2 ตัวแปร และท าให้เกิดกระทบระหว่างกัน (interaction effect)  

3.4 ตัวแปรก ากับ (Moderator variable) หรืออาจมีชื่อเรียกเป็นอย่างอ่ืน เช่น ตัวแปรปรับ 

ตัวแปรขยาย ตัวแปรกลาง คือ ตัวแปรที่มีปฏิสัมพันธ์ ( interaction) กับตัวแปรอิสระ และมีผลท าให้เกิด

การเปลี่ยนทิศทางของความสัมพันธ์ระหว่างตัวแปรอิสระกับตัวแปรตาม เช่น ทฤษฎีบูรณาการการ

ยอมรับและใช้เทคโนโลยี (The Unified Theory of Acceptance and Use of Technology: UTAUT) 

เพศ อายุ และประสบการณ์ เป็นตัวแปรคั่นกลางและมีอิทธิพลระหว่างตัวแปรอิทธิพลทางสังคม (social 

influence) และความคาดหวัง (effort expectation) กับพฤติกรรมความตั้งใจ (behavioral intention) 

ตัวแปรก ากับอาจเป็นตัวแปรแบบค่าแบ่งกลุ่มหรือตัวแปรแบบค่าต่อเนื่องก็ได้ เช่น สถานะภาพทาง

เศรษฐกิจและสังคมมีความสัมพันธ์กับความพร้อมด้านเทคโนโลยีดิจิทัล ตัวแปรก ากับที่เป็นตัวแปรแบบ

ค่าแบ่งกลุ่ม คือ ระดับการศึกษา หรือตัวแปรก ากับที่เป็นตัวแปรแบบค่าต่อเนื่อง คือ รายได้ 

3.5 ตัวแปรเกินหรือตัวแปรแทรกซ้อน (Extraneous variable)  คือ ตัวแปรที่ อยู่ ใน

สภาพแวดล้อม (environment) ของการวิจัยแต่ไม่ได้ท าการควบคุม หรืออาจกล่าวได้ว่า ตัวแปรทั้งหมด

ที่ไม่ใช่ตัวแปรอิสระ และเป็นตัวแปรไม่ได้ตั้งใจน ามาศึกษาหรือวิเคราะห์ แต่อาจส่งผลหรือไม่มีผลต่อตัว

แปรตามหรือผลลัพธ์ ตัวแปรอิสระกับตัวแปรตามอาจไม่ได้มีความสัมพันธ์เชิงสาเหตุระหว่างกัน แต่

ความสัมพันธ์เกิดจากตัวแปรเกิน เช่น ศึกษาความสัมพันธ์ระหว่างสถานะภาพทางเศรษฐกิจและสังคมกับ

ความพร้อมด้านเทคโนโลยีดิจิทัล แต่ไม่ได้น าเอาประเภทของสังคมมาศึกษาด้วย 

3.6 ตัวแปรพัวพัน/รบกวน (Confounding variable) คือ ตัวแปรภายนอกในแบบจ าลองทาง

สถิติ ที่ไม่ใช่ตัวแปรหลักท่ีศึกษา (ตัวแปรอิสระและตัวแปรตาม) และมีอิทธิพลต่อตัวแปรอิสระและตัวแปร

ตาม ท าให้ความสัมพันธ์ระหว่างตัวแปรหลักไม่ชัดเจน (อาจสูงกว่าความเป็นจริง) หรือเป็นความสัมพันธ์

ปลอม เช่น คนในชนบทมีและใช้เทคโนโลยีดิจิทัลน้อยกว่าคนในเมือง ปัจจัยภายนอกที่มีซ่อนอยู่และมี

อิทธิพลต่อการมีและการใช้เทคโนโลยีดิจิทัลของคนในเมืองและชนบท คือ ความพร้อมด้านโครงสร้าง

พ้ืนฐานด้านเทคโนโลยีดิจิทัล 

3.7 ตัวแปรภายนอก (Exogenous variable) คือ ตัวแปรปัจจัย (factor variables) ในระบบ

หรือตัวแบบเชิงสาเหตุ (a causal model) ที่ท าการศึกษา ค่าของตัวแปรเป็นอิสระจากตัวแปรที่อยู่
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ภายในระบบหรือตัวแบบ แต่ถูกก าหนด (determined) จากปัจจัยหรือตัวแปรภายนอกระบบหรือตัว

แบบที่ท าการศึกษา และเป็นปัจจัยที่ไม่น าเอามาศึกษา ในเชิงสถิติคือตัวแปรที่ก าหนดไม่ให้มีความสัมพันธ์

กัน (non-correlation) ระหว่างตัวแปรภายนอกกับตัวแปรอิสระที่อยู่ภายในระบบหรือตัวแบบ  เช่น 

สถานภาพทางเศรษฐกิจและสังคมมีหลายสาเหตุเป็นตัวก าหนดสถานภาพทางเศรษฐกิจและสังคมแต่ไม่

น าเอามาเป็นปัจจัยในการอธิบายด้วย เช่น ระดับความเป็นเมือง ชาติตระกูล มรดก 

4. กลุ่มตัวแปรจ าลอง (Pseudo Variables) คือ ตัวแปรที่ผู้วิจัยสร้างหรือก าหนดให้มีค่าจากดัชนี

ต่างๆ เพื่อท าหน้าที่เป็นตัวแปรเหตุ ตัวแปรผล หรือตัวแปรบริบท โดยมีรายละเอียดดังต่อไปนี้ 

4.1 ตัวแปรเสริม (Auxiliary variable) คือ ตัวแปรที่ช่วยให้ตัวแปรที่มีข้อมูลที่ไม่สมบูรณ์

สามารถวิเคราะห์ได้ เช่น การวิเคราะห์ตัวแปรที่มีข้อมูลสูญหายต้องใช้วิธีการรวมตัวแปรเสริมเข้าช่วย 

หรืออาจสร้างตัวแปรพิเศษ (extra variables) เพ่ือใส่ค่าเพ่ิมท าให้การวิเคราะห์มีความแม่นย าและ

ถูกต้องมากขึ้น 

4.2 ตัวแปรเชิงโครงสร้าง (Construct variable) คือ ตัวแปรที่สร้างจากแนวคิดหรือทฤษฎี มี

ลักษณะเป็นตัวแปรนามธรรม (abstract variables) และไม่สามารถสังเกตได้โดยตรง  (latent 

variables) 

4.3 ตัวแปรหุ่น (Dummy variable) คือ ตัวแปรที่สร้างจากการแปลงค่า (recoding) ตัวแปร

แบบค่าแบ่งกลุ่ม (categorial variables) ที่มีค่าแบ่งกลุ่มมากกว่า 2 กลุ่ม ให้มี 2 ค่า (binary data) เพ่ือ

ใช้ในการวิเคราะห์การถดถอย (regression analysis) เช่น ตัวแปรที่อยู่ (residence) มีค่าตัวแปร 1 = 

เมือง (urban) 2 = ชานเมือง (suburb)  และ 3 = ชนบท (rural) สร้างเป็นตัวแปรหุ่นชื่อใหม่ คือ เขต

บ้านพักอาศัย (home_area) มีค่าตัวแปร 2 ค่า คือ 1 = เมือง (urban) 0 = ไม่ใช่เมือง (non-urban) 

หรือ 1 = ชนบท (rural) 0 = ไม่ใช่ชนบท (non-rural) เพ่ือใช้ในการวิเคราะหการถดถอย (regression 

analysis) 

4.4 ตัวแปรสังเกตได้ (Manifest variable) คือ ตัวแปร (variable) หรือปัจจัย (factor) ที่

สามารถวัด (measured) หรือสังเกตได้ (observed) โดยตรง และเป็นตัวแปรดัชนี (indicator variable) 

ส าหรับสร้างตัวแปรแฝง (latent variable) เพ่ือให้สามารถทดสอบหรือวัดได้ว่ามีอยู่หรือไม่ เช่น สถาบัน

ครอบครัวไม่สามารถวัดหรือสังเกตุได้โดยตรงต้องวัดหรือสังเกตจากการแต่งงาน อ านาจการตัดสินใจของ

สมาชิกในครอบครัว ขนาดครอบครัว ประเภทครอบครัว สายเลือด 
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4.5 ตัวแปรแฝง (Latent variable) คือ ตัวแปร (variable) หรือปัจจัย (factor) ที่ไม่สามารถ

วัดหรือสังเกตได้โดยตรง ต้องสร้างหรืออ้างอิงจากตัวแปรหรือปัจจัยที่สามารถสังเกตได้ เช่น ความศรัทธา

ในศาสนาต้องสร้างหรือวัดจากตัวแปรที่สามารถสังเกตได้ เช่น การถือศีล การฟังธรรม การท าบุญ 

ความหลากหลายของประเภทตัวแปรที่จ าแนกตามการท าหน้าที่ของตัวแปรที่กล่าวมาเป็นผลมา

จากการแบบการวิจัยและการวิเคราะห์ข้อมูล หากน าตัวแปรดังกล่าวมาจัดกลุ่มใหม่สามารถแสดงให้เห็น

ได้ดังรูปด้านล่าง 

 

 

 

 

 

 

 รูปที่ 2.1 ความเกี่ยวข้องระหว่างตัวแปรเหตุ ตัวแปรผล และตัวแปรบริบท 

การวิเคราะห์ความสัมพันธ์ระหว่างตัวแปรเหตุและตัวแปรผล เป็นความพยายามค้นหาต้นเหตุที่

แท้จริง หากทราบพฤติกรรมหรือผลกระทบของตัวแปรบริบทแต่ละตัวแปร จะท าให้ก าจัดปัจจัยที่ไม่

เกี่ยวข้องออกได้ถูกต้อง และได้ค าตอบที่เป็นจริง 

4.3 ระดับการวัดของตัวแปร 

ตัวแปรมีความแตกต่างกันอย่ างซับซ้อนทั้ งด้ านรูปแบบ ( forms) และระดับ  (levels) 

ความสัมพันธ์ระหว่างการวัดและจ านวนที่แสดงได้จากการวัดถูกเรียกว่า ระดับการวัด ( level of 

measurement) หรือมาตรการวัด (scale of measurement) 

ระดับการวัดตัวแปรมีความเกี่ยวข้องกับเลือกใช้ประเภทของสถิติเพ่ือการพรรณนา (describe) 

หรือการอ้างอิง (inference) ไปสู่ประชากร โดยทั่วไปนักวิจัยจะใช้ตัวอักษร (string) หรือเลข (numeric) 

กลุ่มตัวแปรเหตุ 

กลุ่มตัวแปรจ ำลอง (เชิงสำเหตุ) 

กลุ่มตัวแปรผล 

กลุ่มตัวแปรจ ำลอง (เชิงผลลัพธ์) 

กลุ่มตัวแปรบริบท 

ตวัแปรคมุ 

ตวัแปรแทรกแซง 

ตวัแปรก ากบั 

ตวัแปรกวน 
ตวัแปรเกิน/แทรกซอ้น 

ความสัมพันธ์ 
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เป็นค่าในการจัดกลุ่มหรือจัดประเภท (classify or categorize) จัดต าแหน่งหรืออันดับ (rank or order) 

หรือก าหนดให้เป็นคะแนนหรืออัตรา (score or rating)  

ใน ปี ค.ศ. 1932 ผลของการประชุมของคณะกรรมการของสมาคมความก้าวหน้าทาง

วิทยาศาสตร์แห่ง สหราชอาณาจักร (The British Association for the Advancement of Science) 

ที่ประกอบไปด้วยนักคณิตศาสตร์ นักฟิสิกส์ และนักจิตวิทยา ได้เกิดประเด็นค าถามว่า “มันเป็นไปได้

หรือไม่ที่จะวัดความรู้สึกของมนุษย์?” ท าให้ต้องมีการประชุมเพ่ือถกเถียงกันอย่างต่อเนื่องยาวนานถึง 7 

ปี จึงได้ข้อสรุปในปี ค.ศ. 1940 ว่า การวัดสามารถแบ่งได้เป็น 2 ประเภท คือ การวัดด้วยวิธีการเชิง

ประจักษ์ (empirical operations) และการวัดที่เป็นมาตราตามหลักคณิตศาสตร์ (mathematical) 

ต่อมาในปี ค.ศ. 1946 สแตนลี่ย์ สมิทธิ์ สตีเว่นส์ (Stanley Smith Stevens) จึงเสนอแนวคิดในการ

แบ่งกลุ่มมาตราการวัดเป็น 4 ประเภท โดยมาตราส่วนการวัดแต่ละประเภทจะมีคุณลักษณะและประเภท

ที่แตกต่างกันไปตามการนิยามจากข้อมูลเชิงประจักษ์ ดังนี้ (Stevens, 1946; Osborn, 2008, p. 50-51) 

1. มาตราส่วนแบบจัดกลุ่ม (Nominal scale) คือ ตัวแปรที่ก าหนดให้สิ่งที่ศึกษา (objects) มี

ลักษณะเป็นฉลากหรือชื่อ (label) ที่เป็นค าที่สามารถนับจ านวนได้ (numeral) เช่น เพศ อาชีพ ศาสนา 

ภูมิล าเนา เขตท่ีอยู่อาศัย 

2. มาตราส่วนแบบจัดอันดับ (Ordinal scale) คือ ตัวแปรที่ก าหนดให้สิ่งที่ศึกษา (objects) มี

ลักษณะเป็นอันดับต าแหน่ง (rank order) ที่เป็นค าที่สามารถนับจ านวนได้ (numeral) เช่น ระดับ

การศึกษา (ประถม มัธยมศึกษา และอุดมศึกษา) ระดับรายได้ (น้อย ปานกลาง และมาก) ชนชั้น (ต่ า 

กลาง และสูง)  

3. มาตราส่วนแบบช่วง (Interval scale) คือ ตัวแปรที่ได้จากการวัดวัตถุให้มีขนาดจ านวนที่

เท่ากัน (same amount) และก าหนดเป็นตัวเลข (numerical) ที่แตกต่างกัน เพ่ือแสดงให้เห็นสิ่งที่ศึกษา

มีปริมาณที่แตกต่างกัน เช่น ขั้นเงินได้ในการเสียภาษี 0-150,000 (0%), เกิน 150,000-300,000 (5%), 

เกิน 300,000-500,000 (10%), เกิน 500,000-750,000 (15%), เกิน 7500,000-1,000,000 (20%), เกิน 

1,000,000-2,000,000 (25%), เกิน 2,000,000-5,000,000 (30%) และเกิน 5,000,000 บาท ขึ้นไป 

(35%) 

4. มาตราส่วนแบบอัตราส่วน (Ratio scale) คือ ตัวแปรที่มีการวัดเหมือนกับช่วงมาตรา แต่มี

มาตราวัดที่เป็นศูนย์แท้ (absolute zero) เช่น อายุ เงินเดือน น้ าหนัก ส่วนสูง คะแนนสอบ 
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ปัจจุบันมาตราส่วนการวัดของ สตีเว่นส์ ถูกน ามาใช้อย่างแพร่หลายทั้งการวิจัยด้านวิทยาศาสตร์

และสังคมศาสตร์ แต่ในการวิจัยของแต่ละสาขามีธรรมชาติของการวัดและการใช้มาตราส่วนการวัดที่

แตกต่างกัน เช่น การสังเกตของนักวิทยาศาสตร์กายภาพส่วนใหญ่ข้อมูลเป็นมาตราส่วนแบบอัตราส่วน 

(น้ าหนัก ส่วนสูง ความเร็ว) ส่วนการสังเกตของนักสังคมศาสตร์ส่วนใหญ่ข้อมูลเป็นมาตราส่วนแบบจัด

อันดับ (ทัศนคติ ความฉลาด สมรรถนะ) นอกจากที่กล่าวมาในเอกสาร ต ารา และงานวิจัยต่างๆ มีการ

แบ่งมาตราส่วนการวัดของตัวแปรในมิติต่างๆ ดังนี้ 

1. ตัวแปรแบบค่าจัดประเภท (Categorical variable) เป็นตัวแปรที่มีค่าที่แบ่งออกจากกันอย่าง

เด็ดขาดหรือแบ่งเป็นกลุ่มประเภทอย่างชัดเจน ได้แก่ ตัวแปรแบบจัดกลุ่ม (nominal variable) และตัว

แปรแบบจัดอันดับ (ordinal variable) 

2 ตัวแปรแบบค่าต่อเนื่อง (Continuous variable) เป็นตัวแปรที่มีค่าที่มีความต่อเนื่องกัน 

(continuous) ได้แก่ ตัวแปรแบบช่วง (interval variable) และตัวแปรแบบอัตราส่วน (ratio variable)  

3. ตัวแปรแบบค่าไม่ต่อเนื่อง (Discontinuous variable) เป็นตัวแปรที่มีการแบ่งค่าเป็นกลุ่ม 

ได้แก่ ตัวแปรแบบจัดกลุ่ม ตัวแปรแบบจัดอันดับ ตัวแปรแบบทวิลักษณะ (binary variables) และตัว

แปรแบบค่าวิมุต (discrete variable) 

4. ตัวแปรแบบค่าสองประเภท (Dichotomous variable) เป็นตัวแปรที่มีค่าแบ่งกลุ่ม 2 กลุ่ม 

ได้แก่ ตัวแปรแบบสองประเภท/ทวิลักษณะ (binary variables) และตัวแปรแบบค่าวิมุต/ไม่ต่อเนื่อง 

(discrete variable) รวมถึงตัวแปรแบบจัดกลุ่มที่มีค่าแบ่งกลุ่ม 2 กลุ่ม  

5. ตัวแปรแบบค่าทวิลักษณะ (Binary variable) มีลักษณะเป็นทั้งตัวแปรแบบจัดกลุ่ม ตัวแปร

แบบจัดอันดับ และตัวแปรแบบค่าไม่ต่อเนื่อง ค่าของตัวแปรมีลักษณะเป็นค าหรือข้อความ (string) ที่มี

ลักษณะตรงข้ามหรือเป็นสิ่งที่อยู่คู่กัน เช่น ชาย/หญิง เมือง/ชนบท ไม่ใช่/ใช่ ผิด/ถูก ไม่ส าเร็จ/ส าเร็จ 

หรือเป็นเลขท่ีมีค่าไม่ต่อเนื่องกันแต่สามารถนับได้ (counting) เช่น 0 กับ 1 

6. ตัวแปรแบบค่าวิมุต (Discrete variable) มีลักษณะเป็นทั้งตัวแปรแบบค่าต่อเนื่องและตัวแปร

แบบทวิลักษณะ ค่าของตัวแปรมีลักษณะเป็นตัวเลข (numeric) แบบจ านวนเต็ม (integer) ที่สามารถ

ค านวณได้ (calculated) เช่น 0 กับ/ถึง 1 หรือเป็นตัวแปรสองประเภทที่แปลงค่ามาเป็นคะแนน 0 กับ 1 

เช่น 0 ไม่ใช่ชาย กับ 1 = ชาย หรือ 0 = ไม่ใช่เมือง กับ 1 = เมือง 
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7. ตัวแปรแบบค่าหลายประเภท (Polychotomous variable) เป็นตัวแปรแบบจัดประเภท 

(categorical variable) ที่มีค่าของตัวแปรมากกว่า 2 ค่า จึงเป็นประเภทตัวแปรที่มีคุณลักษณะ

ครอบคลุมตัวแปรแบบแบ่งกลุ่มเกือบทุกประเภท ยกเว้นตัวแปรแบบทวิลักษณะ (binary variables) 

การแบ่งประเภทตัวแปรตามระดับการวัดหรือมาตราการวัดตามที่กล่าวมา ขึ้นอยู่กับ

วัตถุประสงค์หรือวิธีการของการจ าแนก จึงท าให้เห็นลักษณะของตัวแปรในหลายมิติ แต่ในกระบวนการ

ในการวิเคราะห์ข้อมูลด้วยโปรแกรมคอมพิวเตอร์ต้องบอกให้โปรแกรมหรือคอมพิวเตอร์รู้ว่า แต่ละตัวแปร

เป็นตัวแปรแบบตัวอักษร (string variables) หรือตัวแปรแบบตัวเลข (numeric variables) เพราะตัว

แปรแต่ละประเภทต้องใช้วิธีการประมวลผลในการค านวณที่เหมาะสมตามหลักสถิติ คือ ตัวแปรแบบ

ตัวอักษรต้องใช้การนับ (counting) ไม่สามารถน าไปค านวณหาค่าเฉลี่ย (mean) ส่วนตัวแปรแบบตัวเลข

อาจใช้การนับหรือการหาค่าเฉลี่ยก็ได้ ดังนั้นจึงควรท าความเข้าใจและจัดตัวแปรในทุกระดับการวัดให้เป็น 

2 กลุ่มตัวแปร ดังตารางด้านล่าง 

ตารางที่ 2.1 ประเภทตัวแปรแบบตัวอักษรและตัวแปรแบบตัวเลข 

ตัวแปรแบบตัวอักษร (String Variables) ตัวแปรแบบตัวเลข (Numeric Variables) 

ตัวแปรเชิงคุณภาพ/คุณลักษณะ 
(qualitative variables) 

ตัวแปรเชิงปริมาณ 
(quantitative variables) 

ตัวแปรแบบค่าจัดประเภท 
(categorical variables) 

ตัวแปรค่าต่อเนื่อง 
(continuous variables) 

ตัวแปรมาตราแบบจัดกลุ่มและจัดอันดับ 
(nominal scale and ordinal scale variables) 

ตัวแปรมาตราแบบช่วงและอัตราส่วน 
(interval scale and ratio scale variables) 

ตัวแปรแบบค่าวิมุต 
(discrete variables) 

ตัวแปรแบบค่าวิมุต  
(discrete variables) 

ตัวแปรแบบค่าสองประเภทและตัวแปรแบบค่าทวิลักษณะ 
(dichotomous and binary variables) 

 

ตัวแปรแบบค่าหลายประเภท  
(polychotomous variables) 

 

 

การแบ่งประเภทการวัดของตัวแปรตามที่กล่าวมามีความเกี่ยวข้องกับการตัดสินใจเบื้องต้นใน

การเลือกใช้สถิติแต่ละประเภทในการวิเคราะห์ข้อมูล การเข้าใจและสามารถแบ่งประเภทการวัดของตัว
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แปรได้ถูกต้องจะท าให้การเลือกใช้สถิติถูกต้องก่อนท าตรวจสอบลักษณะของข้อมูลตามข้อตกลงเบื้องต้น

ของสถิติแต่ละประเภทในข้ันต่อไป 

5. ความสัมพันธ์ระหว่างสมมติฐานและตัวแปร 

 ทฤษฎีมีความเป็นนามธรรมมาและกล่าวถึงความสัมพันธ์ระหว่างปรากฎการณ์แบบกว้างๆ การ

ลดทอนทฤษฎีมาสร้างเป็นสมมติฐานในรูปแบบของความสัมพันธ์ระหว่างตัวแปรสามารถแบ่งรูปแบบของ

ความสัมพันธ์ได้ดังต่อไปนี้ 

1. ความสัมพันธ์เชิงสาเหตุ (Causal relationship) เป็นความสัมพันธ์ที่ตัวแปรเหตุและตัวแปร

ผลมีการเปลี่ยนแปลงไปในทิศทางเดียวกัน เมื่อตัวแปรเหตุมีค่าเพ่ิมข้ึน ตัวแปรผลจะเปลี่ยนค่าเพ่ิมข้ึนตาม

ไปด้วย 

 
ความยากจนเป็นสาเหตุของความเหลื่อมล้ าด้านดิจิทัล 

H0 = ความยากจนไม่ใช่สาเหตุของความเหลื่อมล้ าด้านดิจิทัล 

H1 = ความยากจนเป็นสาเหตุของความเหลื่อมล้ าด้านดิจิทัล 

 

 

 

 

ความยากจน 
ความ 

เหลื่อมล้ าด้าน

ดิจิทัล 
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2. ความสัมพันธ์เชิงผกผัน (Inverse causal relationship) เป็นความสัมพันธ์ในรูปของตัวแปร

เหตุมีค่าเพ่ิมข้ึนหรือลดลง ตัวแปรตามจะค่าเปลี่ยนไปในทางตรงข้าม คือ ตัวแปรเหตุมีค่าเพ่ิมข้ึน ตัวแปร

ผลจะเปลี่ยนค่าลดลง แต่ถ้าตัวแปรเหตุมีค่าลดลง ตัวแปรผลจะเปลี่ยนค่าเพ่ิมข้ึน 

 

ระดับการศึกษาเป็นสาเหตุของความเหลื่อมล้ าด้านดิจิทัล 

H0 = ระดับการศึกษาไม่ใช่สาเหตุของความเหลื่อมล้ าด้านดิจิทัล 

H1 = ระดับการศึกษาเป็นสาเหตุของความเหลื่อมล้ าด้านดิจิทัล 

3. ความสัมพันธ์เชิงหลายสาเหตุ (Multiple-cause relationship) เป็นความสัมพันธ์ของตัว

แปรผลที่เกิดมาจากหลายสาเหตุและอาจมีทิศทางที่ไม่เหมือนกัน 

 

มีหลายสาเหตุร่วมกันที่ท าให้เกิดความเหลื่อมล้ าด้านดิจิทัล 

H0 = ความยากจน การศึกษา และอายุ ไม่ใช่สาเหตุร่วมกันของการเกิดความเหลื่อมล้ าด้านดิจิทัล 

H1 = ความยากจน การศึกษา และอายุ เป็นสาเหตุร่วมกันของการเกิดความเหลื่อมล้ าด้านดิจิทัล 

ความ 

เหลื่อมล้ าด้าน

ดิจิทัล 

 

ระดับการศึกษา 

ระดับ

การศึกษา 

อาย ุ

ความ 

เหลื่อมล้ า

ด้านดิจิทัล 

ความ

ยากจน 
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สรุป 
 การวิจัยเชิงปริมาณเป็นวิธีการหาความรู้ที่เน้นการวัดและการวิเคราะห์ข้อมูลที่เก็บรวบรวม

มาแล้วนิยมท าให้เป็นรหัสในรูปแบบของตัวเลขส าหรับน าไปวิเคราะห์ด้วยวิธีการทางสถิติ  โดยการน าเอา

ทฤษฎีมาลดทอนเป็นสมมติฐานหรือชุดตัวแปรขนาดเล็กที่สามารถท าการทดสอบได้ด้วยข้อมูลเชิง

ประจักษ์ ใช้ตัวแปรเป็นเครื่องมือวัดและรวบรวมข้อมูลที่เป็นตัวเลขจากประชากรหรือกลุ่มตัวอย่าง และ

ท าการสรุปข้อมูลด้วยสถิติ เพ่ือพรรณนา อธิบาย หาความสัมพันธ์ และท านายปรากฏการณ์ระหว่างตัว

แปร 

แบบฝึกหัดท้ายบท 

ให้ผู้เรียนค้นหางานวิจัยเชิงปริมาณด้านสังคมศาสตร์จากฐานข้อมูลของห้องสมุดที่สนใจ แล้ว

ตอบค าถาม ดังนี้ 

1. งานวิจัยที่ค้นได้ มีทฤษฎีอะไรบ้าง 
2. งานวิจัยที่ค้นได้ สมมติฐานประเภทใด 
3. งานวิจัยที่ค้นได้ เขียนสมมติฐานแต่ละประเภทไว้ว่าอย่างไร 
4. ทดลองเขียนสมมติฐานเชิงสถิติทั้งสมมติฐานหลักและสมมติฐานรองจากงานวิจัยที่ค้นได้ 
5. ทดลองเขียนสมมติฐานเพ่ือทดสอบแบบหางเดียวและสองหางจากงานวิจัยที่ค้นได้ 
6. งานวิจัยที่ค้นได้ มีตัวแปรอะไรบ้าง และแต่ละตัวแปรมีระดับการวัดแบบใด 

  



 

 

บทที่ 3 
สถิติส าหรับการวิจัย 

ความมุ่งหมายของบทเรียน 
ผู้เรียนเข้าใจและเลือกใช้สถิติแต่ละประเภทในการวิเคราะห์และทดสอบข้อมูลได้ถูกต้องและ

เหมาะสม 

เนื้อหา 
1. สถิติ 

2. ความสัมพันธ์ระหว่างข้อมูลกับสถิติ 

3. การทดสอบสมมติฐาน 

4. ความคลาดเคลื่อนของผลการวิจัย 

วิธีการสอนและกิจกรรมการเรียนการสอน 
บรรยาย แสดงตัวอย่าง สืบค้นข้อมูลจากฐานข้อมูลห้องสมุด และท าแบบฝึกหัดท้ายบท 

สื่อและอุปกรณ์การสอน 
เอกสารค าสอน ภาพเลื่อน คอมพิวเตอร์ โปรแกรมสอนออนไลน์ (สอนแบบออนไลน์) และเครื่อง

ฉาย (สอนในชั้นเรียน) 

งานที่มอบหมาย 

 ท าแบบฝึกหัดท้ายบท 

การวัดผลและประเมินผล 

การเข้าชั้นเรียน สังเกตความสนใจจากการเรียน สอบถามความเข้าใจจากการบรรยาย และการ

ท าแบบฝึกหัดท้ายบท 
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เนื้อหา 

ช่วงปลายคริสต์ศตวรรษที่ 17 เริ่มมีการใช้ค าว่า ความน่าจะเป็น (probability) จนถึงต้น

คริสต์ศตวรรษที่ 19 ค าว่า โอกาส (chance) น่าจะเริ่มครอบง าโลก นักวิทยาศาสตร์สมัยใหม่ยุคแรกๆไม่มี

การใช้สถิติและก่อนทศษวรรษที่ 1840 ก็ไม่มีสิ่งที่บงบอกให้เห็นถึงเรื่องการวัด (measurement) จนถึง

ประมาณกลางศตวรรษที่ 19 เป็นต้นมา สถิติ (statistics) ถูกน ามาใช้โดยรัฐ (state) และเริ่มเข้ามามี

บทบาทในวิทยาศาสตร์ธรรมชาติ (natural science) รวมถึงสังคมศาสตร์สมัยใหม่ (Williams, 2016, p. 

210-211) 

1. สถิต ิ

สถิติเป็นเรื่องเกี่ยวกับการรวบรวม (collection) การวิเคราะห์ (analysis) และแปลความหมาย 

(interpretation) ข้อมูลที่เป็นตัวเลข รวมถึงเป็นเครื่องมือเชิงประจักษ์ (empirical tool) และเครื่องมือ

เชิงญาณวิทยา (epistemology tool) เพราะท าให้เราสามารถใช้อธิบาย (explain) และท านาย 

(predict) สิ่งต่างๆในโลกนี้ได้ หากเราไม่มีสถิติเราก็ไม่สามารถท่ีจะอธิบายหรือท านายได้ 

1.1 ความหมายของสถติ ิ

สถิติ (statistics) คือ การรวมกลุ่มของข้อมูลเชิงตัวเลข (numerical data) ที่ได้มาจากการ

ส ารวจทางสังคม (social survey) หรือการส ามะโน (census) (Jary and Jary, 1995, p. 654)  

สถิติ คือ วิธีการหนึ่งทางคณิตศาสตร์ (a set of mathematical techniques) ที่ใช้ในการ

จัดการ (organize) และเปลี่ยนแปลง (manipulate) ข้อมูลเพ่ือน าไปใช้ตอบค าถามและทดสอบทฤษฎี 

(Healey, 1999, p. 1) 

สถิติเป็นค าที่มีสองความหมาย ความหมายแรก คือ การอธิบาย (describing) ข้อมูลของ

ปรากฏการณ์ใดปรากฎการณ์หนึ่ง และความหมายที่สอง คือ การรวบรวม (collecting) และการ

วิเคราะห์ (analyzing) ข้อมูล (Greenfield and Greener, 2016, p. 289)  
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นิยามในเชิงการวิจัย ส่วนใหญ่อธิบายว่า สถิติ คือ ค่าสรุปรวมที่ค านวณมาจากลักษณะหรือตัว

แปรของตัวอย่าง เพ่ือน าไปใช้บรรยาย (describe) คุณลักษณะ (characteristic) ของตัวอย่าง (sample) 

และอ้างอิง (inference) ไปยังประชากร (population) 

1.2 ประเภทของสถิต ิ

โดยทั่วไปและต าราหลายเล่มแบ่งประเภทสถิติตามเทคนิคทางสถิติเป็น 3 ประเภท คือ สถิติเชิง

พรรณนา สถิติเชิงอ้างอิง และสถิติเชิงความสัมพันธ์และท านาย (Healey, 1999, p. 259-260; Field, 

2009, p. 540; Yang, 2010, p. 7; Evans, 2014, p. 2-5) ดังนี้ 

1. สถิติเชิงพรรณนา (Descriptive statistic) คือ สถิติสาขาหนึ่งที่มีวัตถุประสงค์ในการใช้

บรรยาย (describes) ลักษณะของข้อมูลพ้ืนฐานของสิ่งที่ใช้ในการศึกษา โดยใช้วิธีสรุป (summary 

indictors) หรือลดจ านวนข้อมูลขนาดใหญ่จากกลุ่มตัวอย่างหรือการวัดให้อยู่ในรูปของดัชนีหรือค่าสรุป

ขนาดเล็กที่มีความกระชับหรือสามารถเข้าใจได้ ไม่สามารถน าผลไปอ้างอิงหรือพยากรณ์ค่าของกลุ่มอ่ืน ๆ 

เช่น จากการศึกษารายจ่ายต่อเดือนของประชาชนในชุมชนแห่งหนึ่ง พบว่า จากประชาชนที่สุ่มมาทั้งหมด 

100 คน มีรายจ่ายรายเดือนเฉลี่ยคนละ 3,500 บาท โดยทั่วไปมีการแบ่งเป็น 5 ประเภท ดังนี้ 

    1.1 การวัดการแจกแจงความถี่ (Frequency distribution) ได้แก่ ค่าความถี่ (frequency) 

ค่าจ านวนนับ (count) และค่าร้อยละ (percentage) 

    1.2 การวัดแนวโน้มสู่ส่วนกลาง (Central tendency) ได้แก่ ค่าฐานนิยม (mode) ค่ามัธย

ฐาน (median) และค่าเฉลี่ย (mean) 

    1.3 การวัดการกระจายหรือความผันแปร (Dispersion/Variation) ได้แก่ ค่าพิสัย (range) 

ค่าส่วนเบี่ยงเบนมาตรฐาน (standard deviation) ค่าความแปรปรวน (variance) ค่าสัมประสิทธิ์ความ

แปรปรวน (coefficient of variation) ค่าส่วนเบี่ยงเบนควอไทล์ (quartile deviation) ค่าส่วนเบี่ยงเบน

เฉลี่ย (mean or average deviation) และค่าพิสัยระหว่างควอไทล์ (interquartile range) 

    1.4 การวัดต าแหน่ง (Position/Location) ได้แก่ ค่าควอไทล์ (quartiles) ค่าเดไซล์ (decile) 

ค่าเปอร์เซ็นไทล์ (percentiles) ค่า N-ไทล์ (N-tiles) และคะแนนมาตรฐาน (standardized scores: z-

scores) 

    1.5 การวัดรูปร่าง (Shape) ได้แก่ ค่าความเบ้ (skewness) และค่าความโด่ง (kurtosis)  
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2. สถิติเชิงอ้างอิง (Inferential statistic) คือ สถิติกลุ่มตัวแบบเชิงเส้นทั่วไป (general linear 

models) ที่ค านวณข้อมูลจากกลุ่มตัวอย่างหนึ่งกลุ่มตัวอย่าง หรือมากกว่าหนึ่งกลุ่มตัวอย่าง แล้วให้

ค่าสถิติ (เช่น ค่าเฉลี่ยของประชากรทั้งหมด) ที่สามารถใช้อ้างอิงหรือท านายลักษณะของประชากร  เพ่ือ

ตัดสินใจเชิงความน่าจะเป็น (probability) เช่น จากประชาชนที่สุ่มมาทั้งหมด 100 คน มีรายจ่ายราย

เดือนเฉลี่ยคนละ 3,500 บาท และโดยอาศัยทฤษฎีความน่าจะเป็น ท าการประมาณรายจ่ายโดยเฉลี่ยราย

เดือนของประชาชนทั้งหมดในชุมชนได้เป็นระหว่าง 3,300 และ 3,700 บาท โดยทั่วไปมีการแบ่งเป็น 2 

ประเภท ดังนี้ 

   2.1 การทดสอบแบบอิงค่าพารามิเตอร์  (Parametric test) คือ สถิติที่มีค่าตัวเลขทาง

ประชากรที่ใช้ในการอ้างอิงไปสู่คุณลักษณะ (characteristics) ของประชากร ข้อตกลงเบื้องต้นข้อมูลที่ใช้

ในการวิเคราะห์มีระดับการวัดเป็นแบบค่าต่อเนื่อง ได้แก่ ช่วงมาตรา ( interval) และสัดส่วนมาตรา 

(ratio) และข้อมูลมีการแจกแจงปกติ (normal distribution) เช่น การทดสอบค่าเฉลี่ยของกลุ่มตัวอย่าง 

1 กลุ่ม (One-sample t-test) การทดสอบค่าเฉลี่ยของกลุ่มตัวอย่างที่ อิสระจากกัน 2 กลุ่ม (Two-

independent samples t-test) การทดสอบค่าเฉลี่ยของกลุ่มตัวอย่างที่เป็นอิสระจากกันมากกว่า 2 

กลุ่ม (การทดสอบความแปรปรวนแบบทางเดียว: One-way ANOWA) การทดสอบค่าเฉลี่ยของกลุ่ม

ตัวอย่างที่ไม่อิสระจากกัน 2 กลุ่ม (Two-dependent sample t-test) การทดสอบค่าเฉลี่ยของกลุ่ม

ตัวอย่างที่ไม่อิสระจากกันมากกว่า 2 กลุ่ม หรือที่เรียกว่า การทดสอบความแปรปรวนแบบวัดซ้ า 

(Repeated Measures ANOVA) การทดสอบความแปรปรวนแบบสองทาง (Two-way ANOVA) การ

ทดสอบความสัมพันธ์รายคู่แบบเพียร์สันหรือการทดสอบสหสัมพันธ์แบบเพียร์สัน (Pearson 

Correlation) การทดสอบการถดถอยเชิงเส้นตรง (Linear Regression) การวิเคราะห์องค์ประกอบ 

(Factor Analysis) และการวิเคราะห์ตัวแปรพหุ (Multivariate Analysis)7 

   2.2 การทดสอบแบบไม่อิงค่าพารามิเตอร์ (Non-parametric test) คือ สถิติที่ไม่มีค่าตัวเลข

ทางประชากรที่ใช้ในการอ้างอิงไปสู่คุณลักษณะ (characteristics) ของประชากร จึงท าให้บางต าราจัด

รวมอยู่ในกลุ่มของสถิติเชิงพรรณนา ข้อมูลที่ใช้ในการวิเคราะห์มีระดับการวัดเป็นแบบข้อมูลแบ่งกลุ่ม 

ได้แก่ มาตราแบบจัดกลุ่ม (nominal scale) และจัดอันดับ (ordinal/rank-order scale) บางต าราอาจ

                                                           
7 การวิเคราะห์ที่มีเง่ือนไขต้องใช้ตัวอย่างขนาดใหญ่และขอ้มูลมีการแจกแจงแบบปกติ เช่น ตัวแบบสมการโครงสร้างแบบใช้ค่าความ
แปรปรวนร่วม (Covariance Based Structural Equation Modeling: CB-SEM) ที่เน้นการวิเคราะห์เชิงยืนยัน (Awang, Afthanorhan, 
& Asri 2015) 
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เรียกสถิติประเภทนี้ว่า การทดสอบที่มีการแจกแจงแบบอิสระ (distribution-free test)8 หรือ การ

ทดสอบที่เป็นอิสระจากข้อตกลง (assumption-free test) เพราะสถิติที่ใช้ทดสอบข้อมูลอาจมีข้อตกลง

เพียงเล็กน้อยหรือไม่มีข้อตกลงเลยเกี่ยวกับลักษณะการแจกแจงของข้อมูล (data distributions) เช่น 

การทดสอบความสอดคล้องของข้อมูลด้วยไคสแควร์ (X2 goodness of fit) การทดสอบความเป็นอิสระ

ของข้อมูลด้วยไคสแควร์ (X2 Test for Independence) การทดสอบค่ากลางของข้อมูล 1 กลุ่มตัวอย่าง 

(One-sample Test) การทดสอบค่ากลางของกลุ่มตัวอย่างที่มีความสัมพันธ์กัน (2 Related Samples 

Test) การทดสอบค่ากลางของกลุ่มตัวอย่างที่เป็นอิสระจากกัน ( Independence Sample Test) การ

ทดสอบสหสัมพันธ์แบบสเปียร์แมน (Spearman Correlation Test) การวิเคราะห์การถดถอยแบบไม่อิง

ค่าพารามิเตอร์ (Non-parametric Regression Analysis) และการวิเคราะห์พหุแบบไม่อิงค่าพารามิเตอร์ 

(Non-parametric Multivariate Analysis)9 

3. สถิติเชิงความสัมพันธ์และการท านาย (Correlational and predictive statistic) คือ สถิติที่

ใช้ในการบอก/พรรณนา (describing) ความสัมพันธ์ระหว่างเหตุการณ์ต่างๆ หรือท านายจากเหตุการณ์

หนึ่งไปสู่อีกเหตุการณ์หนึ่ง โดยมีรายละเอียด ดังนี้ 

   3.1 สถิติเชิงความสัมพันธ์ เป็นเครื่องมือที่ใช้ในการวัดความเข้มข้น (strength) และทิศทาง 

(direction) ของความสัมพันธ์ (relationships) โดยรวมระหว่าง 2 ชุดหรือกลุ่มข้อมูลที่ได้จากการสังเกต 

เช่น ความสัมพันธ์ระหว่างความยากจนกับอาชญากรรม และน าไปใช้ในเชิงการอ้างอิงจากกลุ่มตัวอย่าง

ไปสู่กลุ่มประชากร ได้แก่ การวิเคราะห์สหสัมพันธ์แบบเพียร์สัน (Pearson Correlation) และการ

วิเคราะห์สหสัมพันธ์แบบสเปียร์แมน (Spearman Correlation) 

   3.2 สถิติเชิงการท านาย เป็นเครื่องมือที่ใช้ในการท านาย (prediction) ผลลัพธ์ของเหตุการณ์

หนึ่งจากอีกเหตุการณ์หนึ่ง เช่น การท านายความพร้อมด้านเทคโนโลยีสารสนเทศและการสื่อสารจาก

สถานะภาพทางเศรษฐกิจและสังคม การท านายจะมีความถูกต้องมากน้อยเพียงใดขึ้นกับว่าข้อมูลที่ได้มา

จากการสังเกตมีความสัมพันธ์กันมากน้อยเพียงใด ได้แก่ การวิเคราะห์การถดถอยเชิงเส้นตรง  (linear 

regression) และการวิเคราะห์การถดถอยเชิงโลจิสติก (logistic regression) 

                                                           
8 เป็นการทดสอบที่ขอ้มูลมีลักษณะการแจกแจงแบบใดก็ได้ หรืออาจเรียกว่า การทดสอบที่ไม่มีข้อตกลงหรือการทดสอบที่เป็นอิสระจาก
ข้อตกลง  (free assumption) 
9 การวิเคราะห์ที่สามารถใช้ตัวอยา่งขนาดเล็กและข้อมูลมีการแจกแจงแบบอิสระ เช่น การวิเคราะห์ตัวแบบสมการโครงสร้างแบบใช้ค่าความ
แปรปรวน (Variance Based Structural Equation Modeling: VB-SEM) ที่เน้นการวิเคราะห์เชิงส ารวจ (exploratory analysis) 
(Awang, Afthanorhan and Asri 2015)  
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จากที่กล่าวมาแสดงให้เห็นว่า สถิติที่ใช้ในการวิเคราะห์ข้อมูลแต่ละประเภทมีความคาบเกี่ยวกัน 

การจ าแนกประเภทต้องบอกหลักเกณฑ์ให้ชัดเจน เพราะสถิติเชิงความสัมพันธ์และเชิงการท านายยัง

สามารถจ าแนกได้เป็น 2 ประเภท คือ สถิติแบบอิงค่าพารามิเตอร์และสถิติแบบไม่อิงค่าพารามิเตอร์ หรือ

สถิติเชิงพรรณาสามารถจัดเป็นสถิติแบบไม่อิงค่าพารามิเตอร์ได้เช่นกัน เนื่องจากเป็นสถิติที่ใช้พรรณนา

เฉพาะกลุ่มตัวอย่างหรือประชากรเท่านั้น โดยไม่อ้างอิงจากกลุ่มตัวอย่างไปสู่ประชากร 

2. ความสมัพันธ์ระหวา่งข้อมูลกับสถติ ิ

ข้อมูลที่ใช้ในการวิจัยมีหลายระดับการวัด หากเป็นข้อมูลแบบเมตริก (metric data) เป็นค่า

ต่อเนื่อง (continuous data) เช่น อายุ เงินเดือน น้ าหนัก ส่วนสูง สามารถน าไปค านวณหาค่าเฉลี่ยได้ 

แต่การวิจัยด้านสังคมศาสตร์ส่วนใหญ่ข้อมูลเป็นแบบไม่ใช่เมตริก (nonmetric data) โดยเฉพาะข้อมูล

แบบค่าจัดประเภท (categorical data) เช่น เพศ วัย เขตที่อยู่อาศัย ไม่สามารถน าไปค านวณหาค่าเฉลี่ย

ได้เหมือนกับข้อมูลแบบเมตริก ต้องใช้ค่าความถ่ีหรือค่าร้อยละ  

สถิติแต่ละประเภทมีข้อตกลงเบื้องต้น (basic assumptions) ในการวิเคราะห์ข้อมูลแต่ละ

ประเภท หากฝืนข้อตกลง (violate assumptions) มีความเสี่ยงท าให้เกิดความคลาดเคลื่อนของผลการ

วิเคราะห์และน าไปสู่การตีความผิดตามมา 

2.1 ข้อมูลกบัสถิติเชิงพรรณนา  

การบรรยายลักษณะทางประชากรของกลุ่มตัวอย่างมีข้อตกลงเกี่ยวกับข้อมูลเช่นกัน การเลือกใช้

สถิติวัดแนวโน้มเข้าสู่ส่วนกลางและการกระจายมีแนวทางในการเลือกใช้สถิติให้ตรงกับข้อตกลงดังตาราง

ด้านล่าง (Verma, & Abdel-Salam, 2019, p. 3-4) 

ตารางที่ 3.1 ความสัมพันธ์ระหว่างประเภทข้อมูลกับสถิติเชิงพรรณนา 

ประเภทของข้อมูล ลักษณะของข้อมูล แนวโน้มสู่ส่วนกลาง การกระจาย 

ไม่ใช่เมตริก  

(จัดประเภท) 

จัดกลุ่ม ค่าฐานนิยม ค่าความถ่ี/ค่าร้อยละ 

จัดอันดับ ค่ามัธยฐาน ค่าพิสัย 

เมตริก  ช่วง/อัตราส่วน  ค่าเฉลี่ย 
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ประเภทของข้อมูล ลักษณะของข้อมูล แนวโน้มสู่ส่วนกลาง การกระจาย 

(ต่อเนื่อง) (ถ้ามีการแจกแจงแบบปกติหรือ

ใกล้เคียง) ค่าเบี่ยงเบน

มาตรฐาน ช่วง/อัตราส่วน  

(ถ้ามีการแจกแจงแบบเบ้) 
ค่ามัธยฐาน 

2.2 ข้อมูลกบัสถิติเชิงอ้างอิง  

ข้อมูลที่ได้มาจากประชากรหรือตัวอย่างการวิจัยมีหลากหลายลักษณะหรือระดับการวัด หาก

ข้อมูลเป็นแบบเมตริก (metric data) หรือเป็นข้อมูลแบบค่าต่อเนื่อง (continuous data) เช่น อายุ 

เงินเดือน น้ าหนัก ส่วนสูง หรือเป็นมาตราแบบช่วง (interval scale) หรือมาตราแบบอัตราส่วน (ratio 

scale) สามารถเลือกใช้สถิติแบบอิงค่าพารามิเตอร์ (parametric statistical) ในการวิเคราะห์ข้อมูลที่

รวบรวมมาได้ แต่ในการวิจัยด้านสังคมศาสตร์ส่วนใหญ่ข้อมูลเป็นแบบไม่ใช่เมตริก (nonmetric data) 

หรือเป็นข้อมูลแบบค่าจัดประเภท (categorical data) เช่น ทัศนคติ ความฉลาด สมรรถนะ หรือเป็น

มาตราแบบจัดกลุ่ม (nominal scale) หรือมาตราส่วนแบบจัดอันดับ (ordinal scale) ไม่เหมาะกับการ

วิเคราะห์ข้อมูลด้วยสถิติแบบอิงค่าพารามิเตอร์ หากนักวิจัยฝืนใช้สถิติแบบอิงค่าพารามิเตอร์ เช่น ใช้ 

ANOVA วิเคราะห์หาอิทธิพลรวมด้วยข้อมูลมาตราแบบจัดอันดับจะได้ผลการวิเคราะห์ที่เป็นปฏิสัมพันธ์

ลวง (spurious interactions) และได้ค่าการประมาณการของขนาดผลกระทบต่ ากว่าที่ควรจะเป็น 

(underestimation of effect sizes) (Osborn, 2008, p. 50-51) 

การเลือกใช้สถิติอ้างอิงหรือสถิติเชิงอนุมานทุกประเภท มีข้อตกลงเบื้องต้นร่วมกัน คือ ตัวอย่าง

ได้มาจากประชากรด้วยวิธีการสุมแบบสุ่ม (random sample) และแต่ละประเภทมีข้อตกลงเกี่ยวกับ

ระดับการวัดและลักษณะของข้อมูลดังนี้ (Allison, 2002, p. V; Hair & Others, 2006, p. 49-50; Field, 

2009; Garson, 2012; Halter, 2017, p. 10-11; Verma, & Abdel-Salam, 2019, p. 65-188) 

1. การทดสอบแบบอิงค่าพารามิเตอร์ (Parametric test) ข้อมูลต้องเป็นข้อมูลตัวเลขหรือเป็น

ค่าต่อเนื่องหรือมีการวัดตั้งแต่ระดับช่วงมาตรา ( interval scale) ขึ้นไป ข้อมูลมีการแจกแจงปกติ 

(normal distribution) มีความเป็นแบบเดียวกันของความแปรปรวน (homogeneity of variance) 
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ความเป็นอิสระของข้อมูล (independence) และ/หรือข้อมูลมีความเป็นเส้นตรงในการวิเคราะห์การ

ถดถอยเชิงเส้นตรง (linear regression analysis) 

2. การทดสอบแบบไม่อิงค่าพารามิเตอร์ (Non-parametric test) เป็นสถิติที่มีข้อตกลงเพียง

เล็กน้อยหรือเป็นการทดสอบที่เป็นอิสระจากข้อตกลง (assumption-free test) ข้อมูลมีการวัดระดับใดก็

ได้ ข้อมูลไม่จ าเป็นต้องมีการแจกแจงปกติ ข้อมูลแต่ละกลุ่มไม่จ าเป็นต้องมีการกระจายเท่ากัน และ/

หรือไม่มีความเป็นเส้นตรงในการวิเคราะห์การถดถอยไม่ใช่เชิงเส้นตรง (nonlinear regression 

analysis) 

ตารางที่ 3.2 เปรียบเทียบข้อตกลงเบื้องต้นของการทดสอบแบบอิงค่าพารามิเตอร์และไม่อิง
ค่าพารามิเตอร์ 

ข้อมูล อิงค่าพารามิเตอร์ ไม่อิงค่าพารามิเตอร์ 

ความเป็นสุ่ม (randomness) / / 

ความเป็นอิสระ (independence) / / 

ระดับการวัด (level of measurement)   

- ค่าต่อเนื่อง (อัตราส่วน/ช่วง) / X 

- ค่าจัดประเภท (จัดอันดับ/จัดกลุ่ม) / / 

การแจกแจงแบบปกต ิ(normality) / X 

ความเท่ากันของความแปรปรวน (homogeneity) / X 

ความสัมพันธ์เชิงเส้นตรง (linearity) / X 

การทดสอบสมมติฐานด้วยสถิติเชิงอ้างอิงแบบเดิม (traditional test) คือ การทดสอบแบบอิง

ค่าพารามิเตอร์  (parameter test) โดยอิงอยู่กับการแจกแจงแบบความน่าจะเป็น (probability 

distribution) เช่น การแจกแจกปกติ (normal distribution) และนักวิจัยส่วนใหญ่ยอมรับกันอย่าง

แพร่หลายว่าเป็นสถิติที่มีอ านาจจ าแนก (statistical power) ท าผลการทดสอบหรือข้อสรุปมีความ

ถูกต้องมาก อย่างไรก็ตามหากข้อมูลที่ใช้ในการทดสอบไม่ตรงกับข้อตกลงเบื้องต้นของสถิติเชิงอ้างอิงแบบ

อิงค่าพารามิเตอร์ สามารถใช้การทดสอบแบบไม่อิงค่าพารามิเตอร์ (non-parametric test) ทดแทนได้

แม้ว่าจะมีประสิทธิภาพไม่เท่ากับการทดสอบแบบอิงค่าพารามิเตอร์ เพราะจะช่วยลดความคลาดเคลื่อน

ของผลการวิเคราะห์ได้ 
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ก่อนการวิเคราะห์ข้อมูลด้วยสถิติแบบอิงค่าพารามิเตอร์จึงต้องท าการตรวจสอบคุณลักษณะของ

ข้อมูล (exploratory data analysis) ให้ตรงกับข้อตกลง หากตรวจสอบแล้วพบว่าไม่ตรงกับข้อตกลงให้

เลือกใช้สถิติแบบไม่อิงค่าพารามิเตอร์แทนดังนี้ 

ตารางที่ 3.3 เปรียบเทียบการทดสอบแบบอิงค่าพารามิเตอร์และไม่อิงค่าพารามิเตอร์ 

ประเภทการทดสอบ อิงค่าพารามิเตอร์ ไม่อิงค่าพารามิเตอร์ 

กลุ่มตัวอย่าง 1 กลุ่ม 1-sample t test Sign test, Wilcoxon signed rank test 

กลุ่มตัวอย่าง 2 กลุ่ม 2-sample t test Mann-Whitney test 

กลุ่มตัวอย่างมากกว่า 2 กลุ่ม One-Way ANOVA Kruskal-Wallis test 

ทดสอบซ้ า 2 เหตุการณ์ Paired sample t-test Wilcoxon Test 

ทดสอบซ้ ามากกว่า 2 เหตุการณ ์
One-Way repeated-

measures ANOWA 
Friedman test 

ความสัมพันธ์รายคู่ Pearson’ s correlation Spearman’ s correlation 

3. การทดสอบสมมติฐาน 

มีตัวอย่างของทฤษฎีจ านวนมากที่ได้รับการยอมรับมาอย่างยาวนาน แต่ต่อมาขาดความ

น่าเชื่อถือ เพราะความจริง (truths) ที่อยู่บนฐานของความเป็นจริงถูกปฎิเสธ ถ้าเราไม่มั่นใจว่า ทฤษฎี 

(theory) นั้น ถูกต้อง (true) วิธีที่ดี คือ เราต้องตัดสินด้วยความน่าจะเป็น (probability) ว่า ทฤษฎี นั้น 

ถูกต้องหรือไม ่

การทดสอบสมมติฐาน คือ วิธีการหนึ่งในกระบวนการสรุป (generates) การกระท า (actions) 

ของประชากรที่ได้รับอิทธิพลมาจากตัวแปรบางตัว อีกทั้งเป็นกระบวนการที่เป็นวิทยาศาสตร์ในการ

ทดสอบว่า สมมติฐานนั้นเป็นไปได้หรือน่าเชื่อถือหรือไม่ 

การทดสอบสมมติฐานที่ใช้วิธีการอ้างอิงเชิงสถิติ (statistical inference) มี 2 ส านักความคิด 

และมีฐานความเชื่อที่แตกต่างกัน ดังนี้ (Orloff & Bloom, 2014) 

1. ส านักความคิดแบบเบย์  (Bayesian) มีความเชื่อว่า ความน่าจะเป็น (probability) ที่

สมมติฐานจะมีความเป็นจริงก่อน (priori) มีข้อมูลมาสนับสนุน ความน่าจะเป็นที่สมมติฐานจะมีความเป็น
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จริงหลัง (posterior) มีข้อมูลมาสนับสนุนแล้ว และการพิสูจน์สมมติฐานต้องอยู่ภายใต้เงื่อนความควรจะ

เป็น (likelihood) ที่ ได้จากข้อมูล และความน่าจะเป็นรวม ( total probability) ของข้อมูลท าให้

สมมติฐานมีความเป็นไปได้ทั้งหมด (all possible) 

2. ส านักความคิดแบบฟรีเควนทิสต์ (Frequentist) มีความเชื่อว่า ความน่าจะเป็นของสมมติฐาน

ไม่มีความเป็นจริงทั้งก่อนและหลัง แต่ความน่าจะเป็นของสมมติฐานขึ้นอยู่กับความควรจะเป็น 

(likelihood) ของข้อมูลที่ได้มาจากทั้งการสังเกตและไม่ได้ท าการสังเกต (observed and unobserved 

data) ภายใต้เงื่อนไขเฉพาะแต่ละสมมติฐาน สมมติฐานที่เป็นจริงต้องได้ข้อมูลมาจากการสุ่มตัวอย่างที่มี

ลักษณะของการกระจายหรือแจกแจก (distributions)   

การทดสอบสมมติฐานแบบเบย์มีอิทธิพลต่อการวิเคราะห์ข้อมูลในช่วงก่อนศตวรรษที่ 20 แม้ว่า

จะมีประโยชน์ในการค้นหาความรู้ใหม่ในหลายเรื่องท่ีไม่รู้ความน่าจะเป็นของสมติฐาน แต่การมุ่งมั่นอยู่กับ

การค้นหาความรู้ก่อนมีข้อมูลที่ได้จากการสังเกตแบบกระจาย (priori distributions) มาสนับสนุน เป็น

ความรู้ที่ให้ความส าคัญกับความคิดเห็นส่วนตัวหรือความรู้ก่อนประสบการณ์เชิงจิตพิสัย (subjective 

priori) ที่เรียกสั้นๆ ว่า ความเชื่อ (belief) การทดสอบสมมติฐานด้วยความไม่แน่นอนของความน่าจะเป็น

จากกระจายของข้อมูล และการอ้างอิงจากสิ่งหนึ่งด้วยระดับความเชื่อมั่นจากสิ่งหนึ่งที่มีอยู่ก่อน ท าให้

ในช่วงศตวรรษที่ 20 การทดสอบแบบฟรีเควนทิสต์เข้ามามีอิทธิพลแทน เนื่องจากไม่ใช้ความรู้ก่อน

ประสบการณ์เชิงจิตพิสัย (subjective priori) ที่มีความไม่แน่นอนขึ้นอยู่กับแต่ละบุคคล แต่ใช้หลักความรู้

จากประสบการณ์เชิงวัตถุ (objective posterior) ทดสอบความน่าจะเป็นของสมมติฐานจากข้อมูลที่

ได้มาจากการส ารวจตรวจสอบเชิงวิทยาศาสตร์ (scientific investigations) ก าหนดระดับนัยส าคัญทาง

สถิติ (significance level) และวิเคราะห์หาค่าความน่าจะเป็น (probability value: p-value) เพ่ือใช้

ตัดสินใจที่จะปฏิเสธ (reject) สมมติฐานหลัก (null hypothesis) ผลการทดสอบอาจมีความแตกต่างกัน

จากการก าหนดระดับนัยส าคัญทางสถิติที่แตกต่างกัน และรวมถึงการเกิดความคลาดเคลื่อนแบบที่ 1 หรือ 

2 (Orloff & Bloom, 2014) 

การวิจัยเชิงปริมาณที่มีการตั้งสมมติฐาน นักวิจัยจะใช้ผลทดสอบสมมติฐานในกระบวนการการ

ตัดสินใจ (determine) ประเมินข้อมูลเชิงประจักษ์ (empirical value) ในการทดสอบ/ยืนยันทฤษฎี 

(theory)  
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การทดสอบสมมติฐาน พัฒนามาจากวิธีการตรวจสอบ (proof) ความขัดแย้งทางสถิติ  

(statistical contradiction) จากหลักฐาน (evidence) ที่รวบรวมมาจากข้อสนับสนุนทางทฤษฎี 

(theory) โดยการอธิบายว่า (demonstrating) ข้อมูล (data) มีความแตกต่าง (unlikely) จากการสังเกต 

(observed) ถ้าตัวแบบทางทฤษฎีที่สร้างมาจากสมมติฐานเป็นเท็จ (false) โดยมีขั้นตอนดังต่อไปนี้ 

ตารางที่ 3.4 ขั้นตอนการทดสอบสมมติฐาน 

ขั้นที่ 1 สร้างสมมติฐาน H0 และ H1 สมมติฐานแบบหางเดียวหรือสองหาง 

ขั้นที่ 2 ก าหนดระดับนัยส าคัญทางสถิติ  0.05 หรือ 0.025 หรือ 0.00 

ขั้นที่ 3 รวบรวมข้อมูล ข้อมูลแบบค่าแบ่งกลุ่มหรือค่าต่อเนื่อง 

ขั้นที่ 4 วิเคราะห์ข้อมูล อิงค่าพารามิเตอร์หรือไม่อิงค่าพารามิเตอร์ 

ขั้นที่ 5 ทดสอบสมมติฐาน ปฏิเสธหรือยอมรับสมมติฐาน H0 หรือ H1 

ขั้นที่ 6 สรุปและตีความ ตัดสินใจถูกต้องหรือเกิดความคาดเคลื่อนแบบที่ 1 หรือ 2 

3.1 ประเภทการทดสอบสมมติฐาน 

การตัดสินใจเกี่ยวกับสมมติฐานโดยอาศัยเกณฑ์บางอย่างเข้าช่วย โดยทั่วไปจะใช้วิธีการทางสถิติ

กับข้อมูลที่ได้มาจากตัวอย่าง แล้วพิจารณาความน่าจะเป็นของเหตุการณ์ท่ีเกิดขึ้น 2 แบบ ดังนี้ 

1. การทดสอบแบบ 2 หาง (Two tailed Test) คือ การทดสอบว่าค่าพารามิเตอร์มีค่าเท่ากับ

ค่าที่ก าหนดหรือไม่ (สังเกตจากใน H1 หรือ Ha จะมีเครื่องหมาย =) เขียนเป็นสัญลักษณ์ทางคณิตศาสตร์

ดังนี้ 

H0   = 0 (ประชาชนในเขตชนบทมีระดับการศึกษาไม่แตกต่าง (เท่ากับ) กับประชาชนในเขตเมือง) 

H1   ≠ 0 (ประชาชนในเขตชนบทมีระดับการศึกษาแตกต่าง (ไม่เท่ากับ) กับประชาชนในเขตเมือง) 

2. การทดสอบแบบหางเดียว (One tailed Test) คือ การทดสอบว่าค่าพารามิเตอร์มีค่ามากกว่า

หรือน้อยกว่าค่าที่ก าหนด (สังเกตได้จากใน H1 หรือ Ha จะมีเครื่องหมาย > หรือ <) มี 2 แบบ คือ  

    2.1 ทดสอบแบบหางเดียวด้านขวา (right tailed) เขียนเป็นสัญลักษณ์ทางคณิตศาสตร์ดังนี้ 

       H0:  = 0 (ครัวเรือนในเขตชนบทมีจ านวนสมาชิกเท่ากับครัวเรือนในเขตเมือง) 

       H1:  > 0 (ครัวเรือนในเขตชนบทมีจ านวนสมาชิกมากกว่าครัวเรือนในเขตเมือง) 
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     2.2 ทดสอบแบบหางเดียวด้านซ้าย (left tailed) เขียนเป็นสัญลักษณ์ทางคณิตศาสตร์ดังนี้  

H0  = 0 (ประชาชนในเขตชนบทมีรายได้เท่ากับประชาชนในเขตเมือง) 

H1  < 0 (ประชาชนในเขตชนบทมีรายได้น้อยกว่าประชาชนในเขตเมือง) 

3.2 กฎเชิงประจักษ์  

 การวิจัยเชิงปริมาณด้านสังคมศาสตร์และสาขาสังคมวิทยาวางอยู่บนฐานของปรัชญา

วิทยาศาสตร์ธรรมชาติส านักประจักษ์นิยม (empiricism) ที่ยอมรับเฉพาะความรู้เชิงประสบการณ์ที่มี

หลักฐานเชิงประจักษ์สนับสนุน จึงสร้างกฎเชิงประจักษ์ (empirical rule) ส าหรับใช้ทดสอบสมมติฐาน

หลัก (null hypothesis) ด้วยข้อมูลที่สร้างมาจากตัวแปรเชิงสุ่ม (random variable) บนฐานความเชื่อ

ที่ว่า ปรากฎการณ์ที่เกิดขึ้นตามธรรมชาติมีลักษณะสุ่ม 

ข้อมูลจากตัวแปรเชิงสุ่มตามกฎเชิงประจักษ์มีลักษณะการกระจายหรือแจกแจงแบบปกติ 

(normal distribution) โดยก าหนดให้ข้อมูลทั้งหมดที่อยู่ภายใต้โค้งปกติ (normal curve) เท่ากับ 

100% หรือ 1 แบ่งข้อมูลด้วยกฎสามซิกม่า (three sigma rule) เป็น 3 ส่วนจากจุดกลางที่เป็นค่าเฉลี่ย

ด้วยค่าเบี่ยงเบนมาตรฐาน (three standard deviations of the mean) หรือเป็นกฎ 68-95-99.7 (68-

95-99.7 rule) ข้อมูลภายใต้ระฆังคว่ า (bell curve) ถูกแบ่งข้อมูลออกเป็น 3 ส่วน ดังต่อไปนี้ 

 
รูปที่ 3.1 ข้อมูลภายใต้ระฆังคว่ า 

68% ตกอยู่ภายในพ้ืนที่ที่ 1 ของความเบี่ยงเบนมาตรฐาน (+/-1σ) ของค่าเฉลี่ย  

95% ตกอยู่ภายในพ้ืนที่ที่ 2 ของความเบี่ยงเบนมาตรฐาน (+/-2σ) ของค่าเฉลี่ย 

99.7% ตกอยู่ภายในพ้ืนที่ที่ 3 ของความเบี่ยงเบนมาตรฐาน (+/-3σ) ของค่าเฉลี่ย 
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 การน าเอากฎเชิงประจักษ์มาประยุกต์ใช้ทดสอบความน่าจะเป็นของสมมติฐานหลักโดยใช้ข้อมูล

ที่ได้มาจากประสบการณ์หรือการส ารวจ หากข้อมูลตกอยู่ในพ้ืนที่ที่ 1 ถึง 3 หรือช่วงร้อยละ 68 ถึง 99.7 

แสดงว่า ข้อมูลมีลักษณะของการกระจายหรือแจกแจงใกล้เคียงกับกับปรากฎการณ์หรือข้อมูลที่เกิดขึ้น

ตามธรรมชาติ จึงยอมรับสมมติฐานหลัก  

การอ้างอิงข้อมูลจากตัวอย่างในการทดสอบความน่าจะเป็นของสมมติฐานในแต่ละศาสตร์มี

ข้อตกลงหรือการยอมรับแตกต่างกัน ด้านวิทยาศาสตร์ข้อมูลส่วนใหญ่ได้มาจากห้องปฏิบัติการที่มีการ

ควบคุมและจัดสภาพแวดล้อมของตัวแปรให้มีความใกล้เคียงกับธรรมชาติได้มากที่สุด จึงใช้ค่าร้อยละ 

99.7 หรือก าหนดค่านัยส าคัญทางสถิติ (significance level) = 0.01 ในการทดสอบสมมติฐานหลัก ส่วน

ด้านสังคมศาสตร์ข้อมูลส่วนใหญ่ได้มาจากสังคมที่มีความไม่แน่นอนอีกทั้งไม่สามารถควบคุมบริบทให้

ปราศจากการรบกวนจากปัจจัยต่างๆได้ จึงใช้ค่าร้อยละ 95 หรือก าหนดค่านัยส าคัญทางสถิติ  

(significance level) = 0.05 ในการทดสอบสมมติฐานหลัก 

3.3 การยอมรับและปฏิเสธสมมติฐาน  

 การตัดสินใจที่จะปฏิเสธหรือยอมรับสมมติฐานหลัก (H0) ขึ้นอยู่กับค่าสถิติที่เราค านวณได้จาก

ข้อมูลที่สังเกตุได้จากตัวอย่าง (เช่น ค่าของ X2, Z, t) โดยน าค่าสถิติที่ค านวณได้ไปเทียบกับ ค่าวิกฤต 

(critical value)10 เพ่ือดูว่าค่าสถิตินั้นตกอยู่ในเขตวิกฤต (critical region) หรือไม่ (ค่าวิกฤตมักหาโดย

การเปิดตารางสถิติ แต่ปัจจุบันผลที่ได้จากการวิเคราะห์ข้อมูลด้วยโปรแกรมคอมพิวเตอร์จะให้ค่าสถิติ

ส าหรับใช้ตัดสินใจปฏิเสธหรือยอมรับได้เลย)  

 

 

 

รูปที่ 3.2 เขตวิกฤต 

                                                           
10

 ค่าวิกฤต คือ ค่าที่แบ่งพื้นท่ีใต้โค้งความน่าจะเป็นออกเป็น 2 ส่วน คือ ส่วนแรกเรียกว่า เขตวิกฤต (critical/rejection region) และส่วนที่

สองเรียกว่า เขตการยอมรับ (acceptance region) ซึ่งเป็นบริเวณที่ท าให้ยอมรับ H0 ถ้าค่าสถิติที่ค านวณจากข้อมูลของตัวอย่างมีค่าตกอยู่ใน
เขตวิกฤต (critical region) เราจะปฏิเสธ H0 และยอมรับ H1 แต่ถ้ามีค่าตกอยู่ในเขตการยอมรับ (acceptance region) เราจะยอมรับ H0 

Critical Value 

Critical/Rejection Region Critical/Rejection Region 

Acceptance Region 

Critical Value 
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ค่าสถิติที่ค านวณและน าไปเปรียบเทียบกับค่าวิกฤตว่าตกอยู่ในเขตวิกฤติหรือไม่ คือ ค่าความ

น่าจะเป็น (probability value: p-value) ของข้อมูลที่อยู่นอกพ้ืนที่ของข้อมูลที่ ได้จากการสังเกต 

(observed) หรือ Acceptance Region ตามที่คาดคะเนไว้ว่าจะยอมรับสมมติฐานหลัก (H0) โดยค่า

ความน่าจะเป็นมีค่าอยู่ระหว่าง 0 ถึง 1 ก่อนการทดสอบสมมติฐานผู้วิจัยต้องก าหนดค่าวิกฤติหรือค่า

นัยส าคัญทางสถิติ (significance: Sig.)11 หรือค่า  ที่จะปฏิเสธสมมติฐานหลักก่อน เช่น  = 0.01 

(1%) หรือ  = 0.05 (5%) ถ้าค านวณได้ค่าความน่าจะเป็นอยู่นอกเขตวิกฤติหรือมากกว่าค่า  เราจะ

ยอมรับสมมติฐานหลัก (H0) แต่ถ้าค านวณได้ค่าความน่าจะเป็นตกอยู่ในเขตวิกฤติหรือได้ค่าความน่าจะ

เป็นเท่ากับหรือน้อยกว่าค่า  เราจะปฏิเสธสมมติฐานหลัก (H0) และยอมรับสมมติฐานทางเลือก (H1) 

ดังนี้ 

 1. การทดสอบแบบหางเดียวทางขวา -> ยอมรับ (H0 เพราะ P-value > ) 

 
รูปที่ 3.3 ค่าวิกฤติการทดสอบแบบหางเดียวทางขวา 

2. การทดสอบแบบหางเดียวทางซ้าย -> ยอมรับH0 เพราะ P-value >   

 
รูปที่ 3.4 ค่าวิกฤติการทดสอบแบบหางเดียวทางซ้าย 

                                                           
11

 นกัสงัคมศาสตรส์่วนใหญ่ยอมรบัหรือนิยมใช้ค่านัยส าคัญทางสถิติที่ระดับ 0.05 (Halter, 2017, p. 14) 

p-value = 0.1314 

 = 0.05 1- = 0.95 

 = 0.05 

p-value = 0.1314 

1- = 0.95 
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3. การทดสอบแบบ 2 หาง -> ยอมรับ H0 เพราะ P-value >   

 

รูปที่ 3.5 ค่าวิกฤติการทดสอบแบบ 2 หาง 

การใช้โปรแกรมคอมพิวเตอร์ทดสอบสมมติฐานด้วยสถิติ ผลการวิเคราะห์ส าหรับใช้ตัดสินใจ

ยอมรับหรือปฏิเสธสมมติฐานหลักมีการแสดงผลลัพธ์หลายรูปแบบ เช่น แสดงด้วยค าว่า p-value หรือ

บางโปรแกรมแสดงด้วยค าว่า Sig. เพ่ือให้นักวิจัยน าไปเทียบกับค่านัยส าคัญทางสถิติ (α) ที่ก าหนด 

(0.05, 0.25, 0.00) เพ่ือเป็นจุดแบ่งระหว่างพ้ืนที่ยอมรับ (acceptance region) กับพ้ืนที่วิกฤติ/ปฏิเสธ 

(critical/rejection region) ที่เขียนเป็นเกณฑ์ไว้ก่อนการวิเคราะห์ข้อมูล 2 รูปแบบดังต่อไปนี้   

เกณฑ์ในการทดสอบสมมุติฐาน คือ หากการทดสอบสัดส่วนของข้อมูลด้วยวิธี………………ได้ค่า

ความน่าจะเป็น (p-value) มากกว่าค่านัยส าคัญทางสถิติ (α = 0.05) จะยอมรับสมมติฐานหลัก (H0) แต่

หากได้ค่าความน่าจะเป็น (p-value) น้อยกว่าหรือเท่ากับค่านัยส าคัญทางสถิติ (α = 0.05) จะปฏิเสธ

สมมติฐานหลัก (H0) และยอมรับสมมติฐานทางเลือก (H1) 

เกณฑ์ในการทดสอบสมมุติฐาน คือ หากการทดสอบสัดส่วนของข้อมูลด้วยวิธี………………ได้ค่า

ความน่าจะเป็น (p-value > 0.05) ตกอยู่ในพ้ืนที่การยอมรับ จะยอมรับสมมติฐานหลัก (H0) แต่หากได้

ค่าความน่าจะเป็น (p-value =< 0.05) ตกอยู่ในพ้ืนที่การปฏิเสธ จะปฏิเสธสมมติฐานหลัก (H0) และ

ยอมรับสมมติฐานทางเลือก (H1) 

การแปลความหมายค่าความน่าจะเป็น (p-value) ต้องระมัดระวังการตีความผิดพลาด ระดับ

นัยส าคัญทางสถิติ (significance level) = 0.05 หรือ 0.01 หมายถึง ความน่าจะเป็นที่จะเกิดความ

คลาดเคลื่อนแบบที่ 1 (type I error) ร้อยละ 5 หรือร้อยละ 1 หรือตีความได้ว่า ถ้ายอมรับสมมติฐาน

p-value/2 = 0.0655 p-value/2 = 0.0655 

/2 = 0.025 /2 = 0.025 
1- = 0.95 



58 | ก า ร ใ ช้ โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร์ ท า ง ส ถิ ติ ใ น ด้ า น สั ง ค ม ศ า ส ต ร์  

หลักหรือสมมติฐานหลักเป็นจริง มีโอกาสแบบสุ่ม (randomness) ที่จะเกิดการปฏิเสธสมมติฐานหลัก 5 

หรือ 1 ครั้ง (Orloff & Bloom, 2014) 

4. ความคลาดเคลือ่นของผลการวิจัย 

ผู้วิจัยที่เลือกใช้วิธีการวิจัยเชิงปริมาณนอกจากมีความรู้ในระเบียบวิธีการวิจัยและการสร้าง

เครื่องมือในการรวบรวมข้อมูลเป็นอย่างดีแล้ว ยังต้องมีความรู้และความเข้าใจในการใช้สถิติเป็นอย่างดี 

รวมถึงต้องน าเอาข้อมูลมาใช้ให้ถูกต้องตามข้อตกลงเบื้องต้น (basic assumptions) ของแต่ละสถิติด้วย 

เพ่ือป้องกันไม่ให้เกิดความคลาดเคลื่อนในการอ้างอิง ( inferential errors) ไปสู่แนวคิดหรือทฤษฎีที่

ต้องการพิสูจน์หรือตรวจสอบ 

4.1 ประเภทของความคลาดเคลื่อนของผลการวิจัย 

ความคลาดเคลื่อนในการวิจัยเชิงปริมาณเป็นห่วงโซ่ต่อเนื่องกันและเกิดมาจากหลายสาเหตุแต่

แบ่งได้เป็น 2 กลุ่ม ดังนี้ (Lash, Fox, & Fink, 2009: 13) 

1. ความคลาดเคลื่อนเชิงสถิติ (Statistical error) หรือทีเ่รียกว่า ความคลาดเคลื่อนจากการเลือก

ตัวอย่าง (sampling error) มีสาเหตุเกิดมาจากตัวอย่างที่ได้มาจากประชากรทั้งด้านขนาดตัวอย่าง 

(sample size) และการเลือกตัวอย่าง (sampling) 

2. ความคลาดเคลื่อนเชิงระบบ (Systematic error) หรือที่เรียกว่า ความคลาดเคลื่อนจาก

เครื่องมือ ( instrument error) มีสาเหตุเกิดมาจากคุณภาพของเครื่องมือวัดทั้งด้านความเที่ยงตรง 

(validity) และความน่าเชื่อถือ (reliability) 

4.2 ปัจจัยที่มีผลต่อความคลาดเคลื่อนของผลการวิจัย 

ความคลาดเคลื่อนที่เกิดขึ้นอาจไม่สามารถก าจัดออกไปได้จากการวิจัย แต่สามารถลดความเสี่ยง

ของการเกิดความคลาดเคลื่อนได้โดยการเพ่ิมอ านาจของสถิติ (statistical power) หรือที่เรียกว่า อ านาจ

ในการทดสอบสมมติฐาน (power of a hypothesis test) ที่เป็นความน่าจะเป็น (probability) ของ

ความถูกต้องที่จะปฏิเสธสมมติฐานหลักที่เป็นเท็จ (H0=false) หรือปฏิเสธสมมติฐานหลักเมื่อสมมติฐาน

ทางเลือกเป็นจริง (H1=true) หรือเป็นดัชนีความน่าจะเป็นที่จะไม่เกิดความความคลาดเคลื่อนแบบที่ 2 
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หากอ านาจของสถิติเพ่ิมข้ึนหรือเข้าใกล้ 1 โอกาสที่จะเกิดความคลาดเคลื่อนแบบที่ 2 จะลดลง ซึ่งอ านาจ

ของสถิติมีความเก่ียวข้องกับ 3 ปัจจัย ดังนี้ 

1. ระดับนัยส าคัญทางสถิติ (Statistical significance) คือ ค่าความน่าจะเป็น (p-value) ที่ใช้

ก าหนดเกณฑ์ในการปฏิเสธสมมติฐานหลัก (H0) เช่น 0.05 หรือ 0.01 หรือ 0.001 

2. ขนาดของอิทธิพล (Effect size) คือ ขนาด (magnitude) ของค่าทางสถิติที่ได้จากทดสอบ

เปรียบเทียบหรือทดสอบความสัมพันธ์ (relationship) ระหว่าง 2 ตัวแปร เช่น ค่าเฉลี่ย ค่าสัมประสิทธิ์

สหสัมพันธ์ ค่าสัมประสิทธิ์การถดถอย  หากขนาดอิทธิพลมีมากแสดงว่าปรากฎการณ์ที่ ศึกษามี

ความสัมพันธ์กันมากกว่าขนาดอิทธิพบที่น้อยกว่า หรืออาจกล่าวได้ว่า มีโอกาสมากที่จะไม่เกิดทับกัน 

(nonoverlap) ของคะแนนระหว่างกลุ่มที่ทดสอบ 

3. ขนาดตัวอย่าง (Sample size) การเลือกตัวอย่างมีวัตถุประสงค์เ พ่ือใช้ในการอ้างอิง 

( inference) จากตัวอย่างไปสู่ประชากรที่ทราบจ านวน ( finite population) ด้วยวิธีการประมาณ 

(estimate) จากค่าพารามิเตอร์ของประชากร (population parameters) เช่น จ านวนรวม (total) 

ค่าเฉลี่ย (mean) และสัดส่วน (proportion) ขนาดตัวอย่างจึงเป็นองค์ประกอบที่ส าคัญในการออกแบบ

การวิจัย จึงต้องมีจ านวนที่เพียงพอและมีผลท าให้เกิดผลกระทบ (effect) ต่ออ านาจของสถิตหรือระดับ

ของนัยส าคัญทางสถิติ 

ความคลาดเคลื่อนในการสรุปผลการทดสอบสมมติฐานหรือผลการวิจัยมีความเป็นไปได้สอง

ผลลัพธ์ (two possible outcomes) คือ สมมติฐานหลักอาจได้รับการยอมรับหรือปฏิเสธ ดังนี้  

1. ความคลาดเคลื่อนแบบที่ 1 (Type I error) คือ ปฏิเสธสมมติฐานหลักท่ีเป็นจริง (H0 = true)  

2. ความคลาดเคลื่อนแบบที่ 2 (Type II error) คือ ยอมรับสมมติฐานหลักที่เป็นเท็จ (H0 = 

false) 

ตารางที่ 3.5 การสรุปสมมติฐาน 

 ยอมรับ (Accept) H0 ปฏิเสธ (Reject) H0 

H0 = จริง (True) สรุปถูกต้อง ความคลาดเคลื่อนแบบที่ 1 (Type II Error) 

H0 = เท็จ (False) ความคลาดเคลื่อนแบบที่ 2 (Type II Error) สรุปถูกต้อง 
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สรุป 

 สถิติที่ใช้ในการวิเคราะห์ข้อมูลการวิจัยประกอบด้วยสถิติเชิงพรรณนาและสถิติเชิงอ้างอิง 

ข้อตกลงเบื้องต้นที่ส าคัญของการเลือกใช้สถิติแต่ละประเภท คือ ประเภทของข้อมูล แม้ว่าสถิติ เชิง

พรรณนาจะไม่สามารถน าผลไปอ้างอิงหรือพยากรณ์ค่าของกลุ่มอ่ืน ๆ แต่หากเลือกใช้ไม่ตรงกับประเภท

ของข้อมูลก็ท าให้ได้ผลการวิเคราะห์ที่ผิดได้ ส่วนการทดสอบแบบอิงค่าพารามิเตอร์แม้ว่าจะมีอ านาจ

จ าแนกเชิงสถิติ (statistical power) ที่ท าให้มั่นใจได้ว่า ผลการทดสอบหรือข้อสรุปมีความถูกต้องมาก 

แต่ถ้าฝืนใช้การทดสอบแบบอิงค่าพารามิเตอร์โดยละเมิดข้อตกลง (violate assumptions) จะมีผลท าให้

การค้นพบหรือข้อสรุปที่ได้มีความไม่ถูกต้อง หากข้อมูลไม่ตรงกับข้อตกลงของการทดสอบแบบอิง

ค่าพารามิเตอร์ควรเลือกใช้การทดสอบแบบไม่อิงค่าพารามิเตอร์แทน 

แบบฝึกหัดท้ายบท 

ให้ผู้เรียนค้นหางานวิจัยเชิงปริมาณด้านสังคมศาสตร์จากฐานข้อมูลของห้องสมุดที่สนใจ แล้ว

ตอบค าถาม ดังนี้ 

1. งานวิจัยที่ค้นได้วิเคราะห์ข้อมูลด้วยสถิติอะไรบ้าง  
2. สถิติแต่ละตัวในงานวิจัยที่ค้นได้จัดเป็นสถิติประเภทใด 

  



 

 

ส่วนที่ 2 

ความรู้เบื้องต้นเกี่ยวกับการใช้โปรแกรมทาง

สถิติ 

  





 

 

บทที่ 4 
แบบสอบถามและข้อมูล 

ความมุ่งหมายของบทเรียน 
ผู้เรียนสามารถแปลงข้อมูลจากแบบสอบถามไปเป็นแฟ้มข้อมูลได้  

เนื้อหา 
1. ความสัมพันธ์ระหว่างแบบสอบถามกับแฟ้มข้อมูล 

2. การสร้างตัวแปร 

วิธีสอนและกิจกรรมการเรียนการสอน 
บรรยาย แสดงตัวอย่าง แนะน าการแปลงแบบสอบถามให้เป็นข้อมูลที่คอมพิวเตอร์สามารถอ่าน

ได้ และท าแบบฝึกหัดท้ายบท 

สื่อและอุปกรณ์การสอน 
เอกสารค าสอน ภาพเลื่อน คอมพิวเตอร์ โปรแกรมสอนออนไลน์ (สอนแบบออนไลน์) และเครื่อง

ฉาย (สอนในชั้นเรียน) 

งานที่มอบหมาย 

 ท าแบบฝึกหัดท้ายบท 

การวัดผลและประเมินผล 

การเข้าชั้นเรียน สังเกตความสนใจจากการเรียน สอบถามความเข้าใจจากการบรรยาย และการ

ท าแบบฝึกหัดท้ายบท  
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เนื้อหา 

การน าข้อมูลที่เก็บรวบรวมด้วยแบบสอบถามหรือแบบฟอร์มมาประมวลผลด้วยคอมพิวเตอร์ 

ต้องแปลงรูปข้อมูลที่เก็บรวบรวมมาให้อยู่ในรูปข้อมูลที่คอมพิวเตอร์สามารถอ่านได้ (machine-

readable data)  ข้อมูลที่สามารถใช้ในกระบวนการประมวลผลด้วยโปรแกรมคอมพิวเตอร์ ต้องเป็น

ข้อมูลดิจิทัลหรือข้อมูลเชิงเลข (digital)  ดังนั้นการน าข้อมูลที่ได้จากแบบสอบถามไปประมวลผลหรือ

วิเคราะห์ข้อมูล ต้องท าการเปลี่ยนรูปข้อมูลในแบบสอบถามให้เป็นข้อมูลในรูปแบบที่โปรแกรมสามารถ

น าไปประมวลผลได้ 

1. ความสมัพันธ์ระหวา่งแบบสอบถามกับแฟ้มข้อมลู 

คอมพิวเตอร์มีกระบวนการประมวลผล คือ น าข้อมูลเข้า (input) จากแฟ้มข้อมูล -> ประมวลผล 

(processing) ตามเงื่อนไข -> แสดงผล (display) ตามค าสั่ง ดังนี้ 

 

 

 

รูปที่ 4.1 กระบวนการประมวลผลของคอมพิวเตอร์ 

การวิเคราะห์ข้อมูลจากแบบสอบถาม (questionnaire) ต้องแปลงข้อมูลจากแบบสอบถามไป

เก็บไว้ในรูปของแฟ้มข้อมูล (file) ที่เครื่องจักร (คอมพิวเตอร์) สามารถอ่าน (machine readable) และ

น าไปประมวลผลได้ โดยแฟ้มข้อมูลต้องมีส่วนประกอบที่ส าคัญ คือ กรณีศึกษา/ตัวอย่าง (case) ตัวแปร 

(variable) และค่าตัวแปร (value)  

 

น ำข้อมูลเข้ำ

• ข้อมูล
• ตัวเลข
• ตัวอักษร

ประมวลผล

• ค าสั่งทางสถิติ
• สถิติเชิงพรรณนา
• สถิติเชิงอ้าอิง

แสดงผล

• สารสนเทศ
• ตาราง
• กราฟ
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รูปที่ 4.2 ส่วนประกอบของชุดข้อมูล (data set)  

 ก่อนออกแบบแฟ้มข้อมูลต้องท าความเข้าใจความสัมพันธ์ระหว่างส่วนประกอบของ

แบบสอบถามกับส่วนประกอบของแฟ้มข้อมูล ดังนี้ 

1. ข้อมูลของแบบสอบถามแต่ละชุด คือ กรณีศึกษา/ตัวอย่าง (case)  

2. ข้อค าถามแต่ละค าถาม คือ ตัวแปร (variable)  

3. ค าตอบของแต่ละข้อค าถาม คือ ค่าตัวแปร (value) 

เพ่ือให้เห็นภาพการเปลี่ยนรูปจากแบบสอบถามไปเป็นแฟ้มข้อมูล ในรูปของตาราง (table) โดย

มีแถว (row) เป็นชุดข้อมูลของแบบสอบถามแต่ละฉบับ มีหัวของแต่ละสดมภ์ (column) เป็นชื่อตัวแปร 

และมีช่อง (cell) เป็นข้อมูลของแต่ละตัวแปร จึงเขียนเป็นภาพไดด้ังนี้ 

 

รูปที่ 4.3 การเปลี่ยนรูปแบบสอบถามเป็นแฟ้มข้อมูล 

แฟ้มข้อมูลที่คอมพิวเตอร์สามารถอ่านและน าเข้าโปรแกรมอาจไม่อยู่ในรูปของตารางก็ได้ เพราะ

งานวิจัยบางเรื่องได้ข้อมูลจากฐานข้อมูล (database) หรือรวบรวมด้วยเครื่องจักร (machine) แต่ต้อง

id gender age ICT1 ICT2 ICT3 

1 2 20 1 0 0 

2 1 25 1 1 0 

3 2 22 1 1 1 

4 1 18 0 1 1 

 

กรณีศกึษา/ตวัอยา่ง 

ตัวแปร 

คา่ตวัแปร 
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จัดเก็บข้อมูลเป็นแถวๆ และมีตัวคั่น (delimiter) เช่น , (comma) ; (semicolon) " " (quotation 

marks)  (tab) เพ่ือแบ่งข้อมูลออกเป็นส่วนๆ เช่น แฟ้มข้อมูล *.csv (comma-separated value) หรือ 

*.txt (text) ดังนั้นจึงต้องเปิดดูรูปแบบของข้อมูลก่อนด้วยโปรแกรมแก้ไขข้อความ (Text Editor) เช่น 

Notepad ดังตัวอย่างในภาพ 

 

รูปที่ 4.4 ข้อมูลในแฟ้มข้อมูลนามสกุล CSV แบบมีตัวคั่นด้วยเครื่องหมายจุลภาค 

การรวบรวมข้อมูลในการวิจัยเชิงส ารวจส่วนใหญ่นิยมออกแบบข้อค าถามเป็นแบบปลายปิด 

(close end) มากกว่าค าถามแบบปลายเปิด (open end) เพราะค าถามแบบปลายปิดแปลงข้อมูลไป

วิเคราะห์ง่ายกว่าค าถามแบบปลายเปิด เพราะมีค าตอบหรือค่าตัวแปร (value) ที่ก าหนดไว้แล้ว แต่

เนื่องจากค าถามมีหลายรูปแบบ ดังนั้นการสร้างตัวแปรจากแบบสอบถามจึงมีวิธีการที่ไม่เหมือนกัน ดังนี้ 

ตารางที่ 4.1 การสร้างตัวแปรจากแบบสอบถาม 

เครื่องมือรวบรวมข้อมูล  โปรแกรมวิเคราะห์ข้อมูล/แฟ้มข้อมูล 

แบบสอบถามแบบปลายปิด (ค าตอบเดียว) 

แบบสอบถาม -> กรณีศึกษา/ตัวอย่าง (case) 

ข้อค าถาม -> ชื่อตัวแปร (variable name) และค าอธิบายตัวแปร (variable label) 

ค าตอบ -> ค่าตัวแปร (value) 

แบบสอบถามแบบปลายปิด (หลายค าตอบ) 

แบบสอบถาม -> กรณีศึกษา/ตัวอย่าง (case) 

ข้อค าถาม -> - 

ค าตอบ -> ชื่อตัวแปร (variable name) หรือ ค่าตัวแปร (value) 

แบบสอบถามแบบปลายเปิด 

แบบสอบถาม -> กรณีศึกษา/ตัวอย่าง (case) 

ข้อค าถาม -> - 

ค าตอบ -> ชื่อตัวแปร (variable name) หรือ ค่าตัวแปร (value) 
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   การบันทึกข้อมูลลงในแฟ้มข้อมูล ถ้าเป็นข้อค าถามท่ีมีค าตอบเดียว ก็น าเอาค าตอบมาสร้างเป็น

ตัวแปรได้เลย แต่หากเป็นข้อค าถามที่มีหลายค าตอบ ต้องใช้ค าตอบมาสร้างเป็นตัวแปร ดังนี้ 

1. ค าถามแบบค าตอบเดียว  

ตัวอย่าง เพศ สร้างเป็นตัวแปรได้ 1 ตัวแปร คือ gender  

    ตัวอย่าง อายุ….ปี สร้างเป็นตัวแปรได้ 1 ตัว คือ age 

2. ค าถามแบบหลายค าตอบ  

ตัวอย่าง เทคโนโลยีที่มีใช้ [1] คอมพิวเตอร์ [2] โทรศัพท์ [3] อินเทอร์เน็ต ต้องสร้างเป็นตัว 

           แปรหลายตัวแปร คือ ICT1 ICT2 และ ICT3  

ตัวอย่าง เชื่อชาติ …..สัญชาติ…… สร้างเป็นตัวแปรได้ 2 ตัว คือ Nation และ Race 

แม้ว่าแบบสอบถามจะมีข้อค าถามแบบปลายปิดและปลายเปิด มีค าตอบเดียวและหลายค าตอบ 

ตามที่กล่าวมาแล้ว แต่แบบสอบถามยังมีข้อค าถามที่หลากหลายรูปแบบ จึงรวบรวมข้อค าถามที่นิยมใช้

กันมาออกแบบเป็นแฟ้มข้อมูลตัวอย่าง ดังต่อไปนี้ 

1.1 ค าถามแบบเลือกตอบ 
ค าถาม ชื่อตัวแปร ค าอธิบายตัวแปร ค่าตัวแปรและค าอธิบาย 

1. เพศ 

[1] ชาย    [2] หญิง 

Gender 

 

Gender 1 = Male 

2 = Female 

2. ที่อยู่ 

[1] เมือง               [2] ชานเมือง   [3] ชนบท 

Residence Residence 1 = Urban 

2 = Suburb 

3 = Rural 

ตัวอย่างแฟ้มข้อมูลค าถามแบบเลือกตอบ 

ID Gender Residence 
1 1 2 
2 2 1 
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1.2 ค าถามแบบปลายเปดิ 

ค าถาม 
ชื่อ 

ตัวแปร 

ค าอธิบาย 

ตัวแปร 

ค่าตัวแปร 

และค าอธิบาย 

1. สัญชาติ ……และเช้ือชาติ………ของท่าน (โปรดระบุ) 

 

2. ระยะเวลาที่อาศัยอยู่ในประเทศไทย….…ปี…....เดือน  

Nation 

Race 

Time 

Nation of Responder 

Race of Responder 

Stay in Thai (month) 

- 

- 

1-999 

ตัวอย่างแฟ้มข้อมูลค าถามแบบปลายเปิด 

Nation Race Time 

British Chinese 6 

Japan Japan 10 

Indian Hindo 36 

1.3 ค าถามแบบประเมินค่า 

ค าถาม 
ชื่อ 

ตัวแปร 

ค าอธิบาย 

ตัวแปร 

ค่าตัวแปร 

และค าอธิบาย 

ความพึงพอใจท่ีมีต่อการใช้บริการผ่านเว็บไซต์ 

ข้อ การใช้บริการ 
ระดับคะแนน 

5 4 3 2 1 0 

1 มีบริการผ่านเว็บไซตต์รงกับท่ี

คาดหวังไว ้
      

2 มีความสะดวกเข้าไปใช้งานใน

ส่วนต่าง ๆ ของเว็บไซต ์

      

3 มีความไว้วางใจเมื่อท าธุรกรรม

ผ่านเว็บไซต ์

      

 

eService1 

 

eService2 

 

eService3 

 

Expect of 

Services 

Convenience 

of Services 

Trust of 

Services 

0 = No 

1 = Least 

2 = Little 

3 = Nature 

4 = More 

5 = Most 

ตัวอย่างแฟ้มข้อมูลค าถามแบบประเมินค่า 

eService1 eService2 eService3 

5 2 4 
2 1 3 
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1.4 ค าถามแบบหลายค าตอบ 

ค าถาม 
ชื่อ 

ตัวแปร 

ค าอธิบาย 

ตัวแปร 

ค่าตัวแปร 

และค าอธิบาย 

เทคโนโลยีสารสนเทศและการสื่อสารที่ท่านมีใช้ในบ้าน (ตอบไดม้ากกว่า 1 ข้อ) 

ข้อ ค าถาม มี ไม่ม ี

1 คอมพิวเตอร์แบบเคลื่อนที ่   

2 คอมพิวเตอร์แบบแท็บเล็ต   

3 คอมพิวเตอร์แบบสวมใส ่   

4 โทรศัพทแ์บบอัจฉริยะ   
 

 

 

ICT1 

ICT2 

ICT3 

ICT4 

 

 

Laptop PC 

Tablet PC 

Wearable PC 

Smartphone 

 

 

 

0 = No 

1 = Yes 

ตัวอย่างแฟ้มข้อมูลค าถามแบบหลายค าตอบ 

ICT1 ICT2 ICT3 ICT4 ICT5 

0 1 1 0 1 

1 1 1 1 1 

1.5 ค าถามแบบจัดอันดับ 

ค าถาม 
ชื่อ 

ตัวแปร 

ค าอธิบาย 

ตัวแปร 

ค่าตัวแปร 

และค าอธิบาย 

 ท่านใช้อินเทอร์เน็ตที่ใดมากที่สุด 3 อันดับ  

ข้อ ค าถาม 
อันดับ 

มากที่สุด น้อย น้อยที่สุด 

1 บ้านตนเอง    

2 บ้านญาต/ิเพื่อน    

3 ที่ท างาน    

4 โรงเรียน/มหาวิทยาลยั    
 

Place1 

Place2 

Place3 

Place4 

Home 

Relation 

Office 

School 

1 = Least 

2 = More 

3 = Most 

หรือ 

Use1 

Use2 

Use3 

Last Use 

More Use 

Most Use 

1 = Home 

2 = Relation 

3 = Office 

4 = School 

ตัวอย่างแฟ้มข้อมูลค าถามแบบจัดอันดับ 

Place1 Place 2 Place 3 Place 4  USE1 USE2 USE3 

3  2 1  2 3 1 

2  3  หรือ 2 1 3 

0 1  3  3 1 4 
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1.6 ค าถามแบบเปรียบเทยีบ 

ข้อค าถาม 
ชื่อ 

ตัวแปร 
ค าอธิบาย 
ตัวแปร 

ค่าตัวแปร
และค าอธิบาย 

ส านักงาน 

ค าถาม 

ออนไลน ์

 ระดับคะแนน ระดับคะแนน 

5 4 3 2 1 0 5 4 3 2 1 0 

      1. ความง่ายในการ

ด าเนนิการ 

      

      2. ความประหยัด

ในการใช้บริการ 

      

 

  

0 = No 

1 = Least 

2 = Little 

3 = Nature 

4 = More 

5 = Most 

ServOff1 

ServOn1 

Ease of Office 

Ease of Web 

ServOff2 

ServOn2 

Saving to Office 

Saving to Web 

ตัวอย่างแฟ้มข้อมูลค าถามแบบเปรียบเทียบ 

ServOff1 ServOn1 ServOff2 ServOn2 
3 5 2 4 

2 3 3 5 
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1.7 ค าถามแบบถูกผิด 

ข้อค าถาม 
ชื่อ 

ตัวแปร 

ค าอธิบาย 

ตัวแปร 

ค่าตัวแปร 

และค าอธิบาย 

1. ความรู้เกี่ยวกับกฎและระเบียบที่เกีย่วกับการใช้เทคโนโลยีสารสนเทศ 

ข้อ ค าถาม ถูก ไม่แน่ใจ ผิด 

1 ข้อมูลอิเล็กทรอนิกส์ไม่สามารถใช้

เป็นพยานหลกัฐานในการพจิารณา

คดีทางกฎหมายได้ 

   

2 การยอมรับในความเป็นเจ้าของ

ข้อมูลอิเล็กทรอนิกส์ต้องมีลายมือ

ชื่ออิเล็กทรอนิกส์ด้วย 

   

3 หน่วยงานของรัฐสามารถปฏิเสธ

ความรับผิดชอบทางกฎหมายจาก

ข้อความในข้อมูลอิเล็กทรอนิกส์ได้ 

   

 

 

 

Know1 

 

 

Know2 

 

 

Know3 

 

 

Evident in Law 

 

 

eSignature of 

Owner 

 

Disclaimer of 

Government 

 

 

 

 

0 = 0 คะแนน 

1 = 1 คะแนน 

ตัวอย่างแฟ้มข้อมูลค าถามแบบถูกผิด 

Know1 Know2 Know3 

1 1 0 

0 0 0 

1 1 1 

เฉลยค าตอบ 

ข้อ 1 ถูก = 1 ไม่แน่ใจ = 0 และผดิ = 0 

ข้อ 2 ถูก = 1 ไม่แน่ใจ = 0 และผดิ = 0 

ข้อ 3 ถูก = 0 ไม่แน่ใจ = 0 และผดิ = 1 
 

แบบสอบถาม 1 ชุด อาจมีข้อค าถามเป็นแบบค าตอบเดียว หรือเป็นแบบสอบถามที่มีทั้งข้อ

ค าถามแบบค าตอบเดียวและหลายค าตอบรวมกัน การออกแบบแบบสอบถามต้องค านึงถึงการน าเอาข้อ

ค าถามและค าตอบไปใช้ในการสร้างตัวแปรและค่าตัวแปรในแต่ละแฟ้มข้อมูล รวมถึงระดับการวัดตัวของ

ตัวแปร (variable scale) ส าหรับใช้สถิติในการวิเคราะห์ด้วย  
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จากตัวอย่างแบบสอบถาม ข้อค าถามแบบประเมินค่า (rating scale) ส่วนใหญ่ก าหนดการประเมินค่า
เป็น มากที่สุด มาก ปานกลาง น้อย น้อยที่สุด แม้ว่าจะมีการก าหนดตัวเลขควบคู่ไปกับระดับการประเมิน 
เช่น 5 4 3 2 1 ด้วย และในการวิเคราะห์ข้อมูลก็มีการอนุโลมให้ค าตอบที่ได้จากการประเมินค่าแบบนี้
เป็นระดับการวัดแบบมาตราวัด (scale measurement) หรือเป็นค่าต่อเนื่อง (continuous data) เพ่ือ
ไม่ให้ละเมิดข้อตกลง (violate assumptions) และสามารถวิเคราะห์ด้วยสถิติสหสัมพันธ์ (correlation) 
ได้ แต่หากการออกแบบค าตอบให้เป็นคะแนน (score) ตั้งแต่ 0-5 น่าจะท าให้ระดับการวัดของตัวแปร
เป็นไปตามข้อตกลง (meet assumptions) จะดีกว่าการอนุโลมเพื่อให้เป็นไปตามเง่ือนไขทางสถิติ 

2. การสร้างตัวแปร 

การสร้างตัวแปร  (variable definition) คือ ก าหนดคุณลักษณะของตัวแปร (variable 

attribute) ให้คอมพิวเตอร์รู้รายละเอียดเกี่ยวกับตัวแปรและสามารถน าข้อมูลไปใช้วิเคราะห์ได้ด้วย

โปรแกรมคอมพิวเตอร์ โดยมีรายละเอียดและเงื่อนไขดังต่อไปนี้ 

1. ชื่อตัวแปร (Variable Name) คือ สัญลักษณ์ (symbol) ทีก่ าหนดขึ้นเพ่ืออธิบายข้อมูล (data) 

ให้โปรแกรมคอมพิวเตอร์รู้จักและน าไปใช้ในฟังก์ชั่น (function) ในกระบวนการประมวลผล โดยทั่วไปมี

เงื่อนไขหรือกฎที่คล้ายกัน ดังนี้ 

   1.1 ชื่อตัวแปรต้องเริ่มต้นด้วยตัวอักษรเท่านั้น (โดยทั่วไปใช้ภาษาอังกฤษ)  หลังจากนั้นอาจ

เป็นตัวอักษร (letter) ตัวเลข (number) อักขระพิเศษ (special character) เช่น @, #, _ หรือ $ ก็ได้ 

   1.2 ชื่อตัวแปรห้ามปิดท้ายด้วย จุด หรือ เส้นใต้อักขระ (underscore) 

   1.3 ชื่อตัวแปรห้ามเว้นวรรค (blank) และห้ามใช้อักษรพิเศษ เช่น !, ?, ‘ และ * 

   1.4 ชื่อตัวแปรในแฟ้มข้อมูลเดียวกันต้องไม่เหมือนกันหรือซ้ ากัน 

   1.5 ชื่อตัวแปรโดยทั่วไปควรมีความยาวไม่เกิน 64 ตัวอักษร หรือ ไบต์ (bye) ภาษาที่ใช้ไบต์

เดียว เช่น อังกฤษ เยอรมัน ฝรั่งเศส และสเปน เป็นต้น บางโปรแกรมสามารถก าหนดชื่อตัวแปรได้ยาว

มากกว่า 64 ตัวอักษร  

   1.6 ชื่อตัวแปรห้ามใช้ค าสงวน (reserved keyword) เช่น ALL, AND, BY, EQ, GE, GT, LE, 

LT, NE, NOT, OR, TO และ WITH) 

   1.7 ชื่อตัวแปรอาจเป็นอักษรใหญ่เล็กหรือตัวเล็ก (upper or lower case) เช่น GENDER 

หรือ Gender หรือ gender ก็ได้ แต่การใช้อักษรตัวเลขจะสะดวกในการน าไปใช้กับโปรแกรมอ่ืนๆ 
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   1.8 ชื่อตัวแปรที่มีความยาวมาก จะมีผลกระทบต่อการแสดงผล เช่น แสดงผลไม่ครบ หรือ

แสดงผลหลายบรรทัด ดังนั้นไม่ควรก าหนดชื่อตัวแปรยาวมากเกิน ควรใช้ค าสั้นๆ ที่มีความหมายในตัว

หรือใช้ค าย่อที่นิยมใช้กันอย่างแพร่หลายและเข้าใจได้ง่ายแทนข้อค าถามจากแบบสอบถามที่ เป็นประโยค

ยาวๆ เช่น เทคโนโลยีสารสนเทศและการสื่อสารที่ท่านมีใช้ในบ้าน ใช้ชื่อตัวแปรว่า ICT หากเป็นเรื่อง

เดียวกันและมีความเก่ียวข้องกัน อาจใช้ตัวเลขต่อท้ายตามล าดับ เช่น ICT1 ICT2 ก็ได้  

2. ประเภทตัวแปร (Variable Type) คือ ประเภทของข้อมูลหรือค่าตัวแปร (value) ที่ใช้ในการ

ประมวลผล เนื่องจากข้อมูลที่ได้จากกระบวนการรวบรวมข้อมูล (data collection) มีหลายรูปแบบ แต่

ในกระบวนการประมวลผล ข้อมูลที่เป็นตัวอักษร (character/text/string/alphanumeric) ต้องท าการ

นับ (count) เป็นตัวเลข (numeric) แล้วจึงน าไปประมวลผลด้วยตัวด าเนินการทางคณิตศาสตร์ 

(arithmetic operator) เช่น + - x ÷ ส่วนข้อมูลที่เป็นตัวเลข (numeric) สามารถค านวณ (calculate) 

ด้วยตัวด าเนินการทางคณิตศาสตร์ได้เลย อีกทั้งบางโปรแกรมมีระบบแบ่งประเภทตัวแปรตามประเภท

ของข้อมูลที่ก าหนดไว้ตั้งแต่ขั้นตอนน าข้อมูลเข้า (data input) ให้เลือกใช้ให้ตรงกับข้อตกลงเกี่ยวกับ

ประเภทของข้อมูลของแต่ละค าสั่งทางสถิติอีกด้วย ดังนั้นในที่นี้จึงต้องท าความเข้าใจเกี่ยวกับข้อมูลของ

ตัวแปร 2 ประเภทดังต่อไปนี้ 

ตารางที่ 4.2 ค าอธิบายประเภทข้อมูล 

ประเภทข้อมูล ค าอธิบาย 

Numeric ข้อมลูที่เป็นตัวเลข มีค่าเป็นตัวเลข มีค่าเป็น + หรือ – ก็ได้  

String ข้อมูลที่ไม่ใช่ตัวเลข เป็นได้ท้ัง ตัวอักษร ข้อความ และตัวอักษรเลข เป็นตัวแปร

ที่มีค่าเป็นตัวอักษรหรือตัวเลขหรือเครื่องหมายต่างๆ แม้ว่าค่าตัวแปรจะเป็น

ตัวเลข ก็ไม่สามารถน าไปค านวณได้ เพราะเป็นตัวอักษรเลข (alphanumeric) 

3. จ านวนค่าตัวแปรและทศนิยม (Width and Decimals) ตัวแปรแต่ละตัวจากแบบสอบถามมี

ค่าตัวแปรมาจากค าตอบที่แตกต่างกัน แต่โปรแกรมก าหนดค่าเริ่มต้น (default) ไว้ให้แล้ว ดังต่อไปนี้ 

ตารางที่ 4.3 ค่าเริ่มต้นค่าตัวแปรของตัวแปรแต่ละประเภท 

ประเภทตัวแปร จ านวนค่าตัวแปร ทศนิยม 

Numeric 8 2 
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ประเภทตัวแปร จ านวนค่าตัวแปร ทศนิยม 

Comma 8 2 

Dot 8 2 

Scientific notation 8 2 

Date 11 0 

Dollar 8 2 

Custom currency 8 2 

String 8 0 

4. ค าอธิบายตัวแปร (Variable Label) คือ ค าอธิบายหรือข้อความขยายชื่อตัวแปร เพ่ือให้เข้าใจ

ความหมายของชื่อตัวแปร เพราะโดยทั่วไปมักสร้างชื่อตัวแปรด้วยค าย่อหรือค าที่มีความหมายสั้นๆ แต่ชื่อ

ตัวแปรบางตัวอาจไม่ต้องให้ความหมายก็ได้ เพราะชื่อตัวแปรสามารถสื่อความหมายหรือเข้าใจได้ใน

ตัวเองว่า ตัวแปรนั้นหมายถึงอะไร เช่น age แต่ชื่อตัวแปรที่สร้างขึ้นเองบางครั้งอาจไม่สื่อความหมายจึง

ต้องให้ค าอธิบายตัวแปรไว้ เพ่ือให้ผู้ใช้แฟ้มข้อมูลที่ไม่ได้เป็นผู้สร้างแฟ้มข้อมูลหรือการอ่านผลลัพธ์ 

(output) สามารถเข้าใจได้ว่า ตัวแปรนั้นหมายถึงอะไร ดังตัวอย่างต่อไปนี้ 

ตารางที่ 4.4 การสร้างค าอธิบายตัวแปร 

ชื่อตัวแปร (Variable Name) ค าอธิบายตัวแปร (Variable Label) 

Id Questionnaire Identification 

Gender ก าหนดหรือไม่ก าหนดก็ได้ 

ICT1 Have the Desktop PC in Home 

ICT2 Have the Laptop PC in Home 

Place Place for Surf Internet 

Cost Amount spent on communication per month 

5. ค าอธิบายค่าตัวแปร (Value Label) การบันทึกข้อมูลลงในแฟ้มข้อมูลที่ง่ายและสะดวกที่สุด 

คือ การใช้ตัวเลขหรือตัวอักษรเป็นรหัสแทนค าตอบจากแบบสอบถาม แต่การใช้รหัสที่เป็นตัวเลขเป็นสิ่งที่

นิยมมากกว่าการใช้ตัวอักษร เพราะขณะท าการบันทึกข้อมูลแป้นพิมพ์ตัวเลขที่อยู่กันเป็นกลุ่มบริเวณ

เดียวกันสามารถท าการบันทึกข้อมูลได้ง่ายกว่าการใช้แป้นพิมพ์ตัวอักษร เช่น Gender หรือ เพศ 
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ก าหนดให้เลข 1 เป็นรหัสแทน Male หรือ เพศชาย และ 2 เป็นรหัสแทน Female หรือ เพศหญิง ดังนั้น

รหัสที่เป็นตัวเลขหรือตัวอักษรจึงต้องให้ค าอธิบาย เพ่ือความเข้าใจการในการแปลผลลัพธ์  

การให้ค านิยมค่าตัวแปร ไม่จ าเป็นต้องให้ค าอธิบายทุกค่าตัวแปร ค่าตัวแปรที่ควรให้นิยาม คือ 

ค่าของตัวแปรแบบค่าแบ่งประเภท (ระดับการวัดแบบจัดกลุ่มและจัดอันดับ) ส่วนค่าตัวแปรแบบค่า

ต่อเนื่อง (ระดับการวัดแบบช่วงและสัดส่วน) เป็นค่าตัวแปรที่มีความหมายอยู่ในตัวอยู่แล้ว ไม่จ าเป็นต้อง

ให้ค าอธิบาย เช่น ค่าใช้จ่าย มีค่าตัวแปรที่บันทึกไว้เป็น 10,000 เป็นต้น การให้ค าอธิบายค่าตัวแปร

สามารถแสดงให้เห็นได้เป็นตัวอย่าง ดังต่อไปนี้   

ตารางที่ 4.5 การสร้างค าอธิบายค่าตัวแปร 

ชื่อตัวแปร (Variable Name) ค าอธิบายค่าตัวแปร (Value Label) 

Id ไม่ต้องให้ความหมายเพราะล าดับที่แบบสอบถามมีความหมายอยู่แล้ว 

Gender 1 = Male, 2 = Female 

ICT1 0 = No, 1 = Yes 

ICT2 0 = No, 1 = Yes 

Place 1 = Home, 2 = Relation, 3 = Office, 4 = School 

5 = Telecenter, 6 = Internet Café 

Cost ไม่ต้องให้ความหมายเพราะจ านวนค่าใช้จ่ายมีความหมายอยู่ในตัวแล้ว 

ค่าตัวแปรที่ได้จากค าตอบเรื่องเดียวกัน อาจมีค่าตัวแปรที่แตกต่างกัน ขึ้นอยู่กับวัตถุประสงค์ใน

การเก็บข้อมูล เช่น อายุ ค่าใช้จ่าย สามารถเก็บข้อมูลได้ 2 แบบ ดังนี้ 

ตารางที่ 4.6 ประเภทของค่าตัวแปร 

ชื่อตัวแปร 
ค่าตัวแปร 

ค่าแบ่งกลุ่ม ค่าต่อเนื่อง 

อายุ (1) ต่ ากว่า 15 ปี 

(2) 15 – 60 ปี 

(3) มากกว่า 60 ปี 

……………..ป ี
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ชื่อตัวแปร 
ค่าตัวแปร 

ค่าแบ่งกลุ่ม ค่าต่อเนื่อง 

ค่าใช้จ่ายด้านการสื่อสารราย

เดือน 

(1) น้อยกว่า 1,000 บาท 

(2) 1,001 – 5,000 บาท 

(3) มากกว่า 5,000 บาท 

……………..บาท 

ค่าตัวแปรอายุและค่าใช้จ่าย เป็นค่าแบ่งกลุ่มต้องให้ค าอธิบาย ส่วนค่าตัวแปรที่เป็นค่าต่อเนื่อง 

ไม่จ าเป็นต้องให้ค าอธิบาย เพราะมีความหมายอยู่ในตัวเองแล้ว  

6. ค่าขาดหาย (Missing Value) หรือ ค่าว่าง หรือ ค่าสูญหาย อาจอยู่ในรูปของไม่ค่าตัวแปรใน

ช่องใส่ค่าตัวแปร (cell) หรือ มีค่าตัวแปรแต่มีการก าหนดให้ไม่น ามาใช้ในการค านวณ  

ค่าขาดหาย เกิดข้ึนได้ในทุกๆ งานวิจัย แม้ว่ามีการวางแผนการออกแบบแบบสอบถามให้รองรับ

ค าตอบที่จะท าให้เกิดค่าขาดหายไว้แล้วก็ตาม เช่น ไม่ทราบ ไม่ตอบ ไม่มีความคิดเห็น เป็นต้น ค าตอบ

เหล่านี้ส่วนใหญ่จะไม่น าเข้าไปรวมอยู่ในการประมวลผลข้อมูล เพราะมีผลท าให้ผลลัพธ์ที่ได้จากการ

ค านวณผิดไป การสร้างค่าขาดหายในแฟ้มข้อมูลสามารถท าได้ 2 แบบ คือ  

  6.1 ไม่ใส่ค่าใดๆ ลงไปในช่องใส่ค่าตัวแปร (blank) แต่โปรแกรมจะให้ค่าเป็นจุด (.) วิธีนี้

โปรแกรมจะก าหนดให้เป็นค่าขาดหายของระบบ (system missing value) และไม่น าเอาเข้ามารวมใน

การค านวณโดยอัตโนมัติ 

  6.2 ใส่รหัสที่ก าหนดให้เป็นค่าขาดหาย (user missing value) รหัสตัวเลขที่นิยมน ามาใช้เป็น

ค่าขาดหาย คือ เลข 9 วิธีการนี้ผู้ใช้โปรแกรมจะต้องก าหนดให้โปรแกรมรู้ว่าเลข 9 คือ ค่าขาดหาย ไม่

ต้องน ามารวมในการค านวณ 

การก าหนดรหัสค่าขาดหายต้องสัมพันธ์กับประเภทของข้อมูล หากประเภทข้อมูลเป็นตัวเลข 

รหัสค่าขาดหายก็ต้องเป็นตัวเลขเช่นกัน     

7. ความกว้างของช่องค่าตัวแปรหรือสดมภ์ (Columns) ค่าเริ่มต้น (default) ความกว้างของ

สดมภ์ที่โปรแกรมก าหนดไว้ คือ 8 ต าแหน่ง หากชื่อตัวแปรมีความยาวไม่เกินที่โปรแกรมก าหนดไว้ การ

แสดงผลตัวแปรในหน้าต่างแสดงข้อมูล (data view) จะแสดงผลอยู่ในบรรทัดเดียว แต่หากชื่อตัวแปรมี

ความยาวมาก โปรแกรมจะแสดงผลในบรรทัดใหม่ในลักษณะซ้อนต่อกัน ดังนั้นผู้ใช้งานสามารถก าหนดให้

การแสดงผลตัวแปรอยู่ในบรรทัดเดียวกันได้โดยก าหนดความกว้างของสดมภ์ให้มากขึ้น แต่การสร้างชื่อ
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ตัวแปรยาวๆ เป็นสิ่งที่ควรหลีกเลี่ยง เพราะไม่เพียงแต่จะท าให้การแสดงผลไม่สวยงามแล้ว การเพ่ิมความ

กว้างของสดมภ์ จะมีผลท าให้การแสดงผลตัวแปรในหน้าต่างท าได้น้อย การดูตัวแปรและค่าตัวแปลใน

แนวนอนท าได้ไม่สะดวก เพราะต้องใช้แถบเลื่อนหน้าจอ (scroll bar) เลื่อนดูข้อมูลไปมา 

8. การจัดต าแหน่งค่าตัวแปร (Align) โปรแกรมมีการออกแบบการแสดงค่าตัวแปรให้เห็นถึง

ความแตกต่างของประเภทตัวแปรที่สร้างไว้เป็นค่าปริยาย ดังต่อไปนี้ 

   8.1 ตัวแปรที่มีค่าเป็นตัวเลข การแสดงผลค่าตัวแปรในหน้าต่างแสดงข้อมูล ค่าตัวแปรจะ

แสดงผลชิดด้านซ้ายในช่องใส่ค่าตัวแปร  

   8.2 ตัวแปรที่มีค่าเป็นตัวอักษร ค่าตัวแปรจะแสดงผลชิดด้านขวาในช่องใส่ค่าตัวแปร  

การเปลี่ยนแปลงการแสดงผลต าแหน่งค่าตัวแปรใหม่ สามารถท าได้ 3 แบบ จากรายการเมนู คือ 

แสดงผลชิดด้านซ้าย (left) แสดงผลชิดด้านขวา (right) และแสดงผลกึ่งกลาง (center) ตามที่ต้องการ 

แต่การคงค่าปริยายไว้น่าจะช่วยให้การจ าแนกประเภทตัวแปรท าได้ง่ายกว่าการจัดต าแหน่งใหม่ 

9. ระดับการวัด (Measure) โดยทั่วไปตัวแปรในการวิจัยแบ่งระดับการวัดเป็น 4 ระดับ คือ 

มาตราแบบจัดกลุ่ม มาตราแบบจัดอันดับ มาตราแบบช่วง และมาตราแบบสัดส่วน น าเอาทั้ง 4 ระดับมา

จ าแนกเป็นตัวแปรเชิงคุณภาพและเชิงปริมาณ หรือตัวแปรแบ่งกลุ่มและตัวแปรต่อเนื่อง เป็นต้น แต่การ

ใช้โปรแกรม PSPP สร้างตัวแปร แบ่งระดับการวัดตัวแปรเป็น 3 แบบ ดังต่อไปนี้ 

  9.1 ระดับการวัดแบบสเกล (Scale) 

  9.2 ระดับการวัดแบบจัดกลุ่ม (Nominal) 

  9.3 ระดับการวัดแบบจัดอันดับ (Ordinal) 

การสร้างตัวแปรที่มีค่าเป็นตัวเลขและตัวอักษรตามที่กล่าวมาแล้วเป็นการก าหนดประเภทตัว

แปรตามคุณลักษณะของตัวแปร แต่ไม่สามารถจ าแนกได้ว่า ตัวแปรใดมีระดับการวัดที่เหมาะสมกับการ

น าเอาไปวิเคราะห์ด้วยสถิติใด และโปรแกรมได้ก าหนดค่าปริยายระดับการวัดของตัวแปรแต่ละประเภท

ไว้ดังต่อไปนี้ 
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ตารางที่ 4.7 ประเภทตัวแปรและระดับการวัด 

ประเภทตัวแปร ระดับการวัด 

Numeric Scale 

Comma Scale 

Dot Scale 

Scientific notation Scale 

Date Scale 

Dollar Scale 

Custom currency Scale 

String Nominal 

 การก าหนดระดับการวัดตัวแปรไม่เพียงแต่จะช่วยให้โปรแกรมท าการคัดกรองตัวแปรแต่ละตัว

เข้าไปในกระบวนการเลือกค าสั่งประมวลผลที่เหมาะสมเท่านั้น แต่ยังช่วยแสดงสัญลักษณ์ระดับการวัดให้

ผู้วิเคราะห์ตัดสินใจเลือกใช้ตัวแปรในการเลือกใช้ค าสั่งในการค านวณได้อย่างเหมาะสมอีกด้วย 

 10. บทบาทของตัวแปร (Role) คือ การก าหนดคุณสมบัติของตัวแปรที่เตรียมไว้ใช้กับบางค าสั่งที่

ต้องมีการเตรียมข้อมูล (data preparation) การแทนค่าแบบพหุ (multiple imputation) และการ

วิเคราะห์แบบจ าลอง (model techniques) เพ่ือน าไปใช้ในระบบสนทนา (dialog box) ในการติดต่อกับ

ระบบผู้ใช้งานแบบกราฟิก (graphical user interfaces) ในการวิเคราะห์ข้อมูล ดังนี้  

ตารางที่ 4.8 ความหมายของบทบาทของตัวแปร 

บทบาทของตัวแปร ความหมาย 

Input ตัวแปรข้อมูลเข้าหรือตัวแปรอิสระ 

Output ตัวแปรผลลัพธ์หรือตัวแปรตาม 

None ไม่ก าหนดบทบาท (เป็นค่าเริ่มต้น) 

Partition ตัวแปรที่มีการแบ่งข้อมูลเป็นกลุ่มๆ ส าหรับการสอน (training) หรอื การ

ทดสอบ (testing) หรือการตรวจสอบ (validation) 

Split ตัวแปรที่เตรียมไว้ส าหรับโปรแกรมอ่ืนๆ หรือ third party software 
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สรุป 

ข้อมูลที่เก็บรวบรวมด้วยแบบสอบถามและต้องการน ามาประมวลผลด้วยโปรแกรมคอมพิวเตอร์

ทางด้านสถิติ ต้องแปลงรูปให้เป็นข้อมูลที่คอมพิวเตอร์สามารถอ่านได้ในรูปของแฟ้มข้อมูลที่มี

ส่วนประกอบที่ส าคัญ คือ กรณีศึกษาหรือตัวอย่าง ตัวแปร และค่าตัวแปร 

 โดยทั่วไปแฟ้มข้อมูลที่น าข้อมูลเข้าโปรแกรมอาจจัดเก็บข้อมูลเป็นตารางที่ประกอบด้วยแถวที่

เป็นชุดข้อมูลของแบบสอบถามแต่ละฉบับ มีหัวแบ่งเป็นสดมภ์เพ่ือใช้เป็นชื่อตัวแปร และมีช่องให้ใส่ข้อมูล

หรือค่าของแต่ละตัวแปร นอกจากแฟ้มข้อมูลแบบตารางแล้วยังมีแฟ้มข้อมูลอีกประเภทหนึ่ งที่

คอมพิวเตอร์สามารถน าไปประมวลผลได้ คือ แฟ้มข้อมูลแบบตัวอักษรที่เก็บข้อมูลเป็นเป็นแถวๆ และมี

ตัวคั่นเป็นเครื่องหมายลูกน้ า (,) เครื่องหมายอัญประกาศ (" ") เว้นระยะ (tab) เช่น แฟ้มข้อมูล *.csv 

หรือ *.txt  

แบบฝึกหัดท้ายบท 

 ให้ผู้เรียนฝึกแปลงแบบสอบถามเป็นตัวแปรและข้อมูลดังต่อไปนี้ 

1. ให้ผู้เรียนสร้างแบบสอบถามมีทั้งข้อค าถามเลือกตอบแบบจัดกลุ่มและจัดอันดับ และข้อ

ค าถามแบบกรอกข้อมูลเป็นตัวเลขและตัวอักษร 

2. ให้ผู้เรียนแปลงแบบสอบถามให้เป็นตัวแปรและค่าตัวแปร 

  





 

 

บทที่ 5 
ความรู้เบื้องต้นเกี่ยวกับโปรแกรมทางสถิติ 

ความมุ่งหมายของบทเรียน 
ผู้เรียนรู้จักโปรแกรมคอมพิวเตอร์ด้านสถิติส าหรับวิเคราะห์ข้อมูล สามารถติดตั้งและเริ่มใช้งาน

เบื้องต้นได้  

เนื้อหา 
1. โปรแกรมส าเร็จรูปทางสถิติ 

2. การติดตั้งโปรแกรม PSPP 

3. การใช้โปรแกรม PSPP เบื้องต้น 

4. ส่วนประกอบของโปรแกรม PSPP 

5. เมนูการใช้โปรแกรม PSPP 

วิธีสอนและกิจกรรมการเรียนการสอน 
บรรยาย แนะน าการติดตั้งและใช้โปรแกรม และท าแบบฝึกหัดท้ายบท 

สื่อและอุปกรณ์การสอน 
เอกสารค าสอน ภาพเลื่อน คอมพิวเตอร์ โปรแกรม PSPP โปรแกรมสอนออนไลน์ (สอนแบบ

ออนไลน์) และเครื่องฉายภาพโปรเจคเตอร์ (สอนในชั้นเรียน) 

งานที่มอบหมาย 

 ติดตั้งโปรแกรมวิเคราะห์ข้อมูลให้เสร็จสมบูรณ์ และท าแบบฝึกหัดท้ายบท 

การวัดผลและประเมินผล 

การเข้าชั้นเรียน สังเกตความสนใจจากการเรียน สอบถามความเข้าใจจากการบรรยาย ประเมิน

จากการติดตั้งโปรแกรม การใช้โปรแกรม และการท าแบบฝึกหัดท้ายบท 
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เนื้อหา 

การวิจัยเชิงปริมาณ ส่วนใหญ่มีการเก็บรวบรวมข้อมูลจ านวนมากระดับหนึ่งตามขนาดของ

ประชากร ข้อมูลที่เก็บรวบรวมมาแล้ว หากไม่สามารถค านวณและวิเคราะห์อย่างรวดเร็ว ข้อมูลที่เก็บมา

อาจล้าสมัยและไม่มีประโยชน์ต่อการวิจัย เพราะค าตอบและผลการทดสอบสมมติฐานการวิจัยไม่ใกล้เคียง

สถานการณ์จริงที่เปลี่ยนไปตามการเปลี่ยนแปลงของสังคม ดังนั้นนักวิจัยจึงต้องมีเครื่องมือที่สามารถ

ประมวลผลได้รวดเร็วและวิเคราะห์ข้อมูลได้อย่างซับซ้อน นั่นก็คือ โปรแกรมคอมพิวเตอร์ส าหรับการ

ค านวณและวิเคราะห์ข้อมูล 

1. โปรแกรมส าเร็จรูปทางสถิต ิ

ปัจจุบันโปรแกรมส าเร็จรูปส าหรับใช้วิเคราะห์ข้อมูลมีให้เลือกใช้จ านวนมาก มีทั้งโปรแกรมแบบ

ให้ใช้ฟรีและมีค่าใช้จ่าย และมีการจัดกลุ่มเป็นโปรแกรมรหัสเปิดหรือโอเพนซอร์ซ (open source) 

โปรแกรมสาธารณะ (public domain) โปรแกรมแจกฟรี  (freeware) และโปรแกรมมีลิขสิทธิ์  

(proprietary) (Wikipedia, 2020) ส าหรับในที่นี้แบ่งเป็น 2 กลุ่ม และมีตัวอย่างโปรแกรมที่นิยมใช้งาน

กันอย่างแพร่หลาย ดังต่อไปนี้ 

1. โปรแกรมเชิงพาณิชย์ (Commercial Application) เช่น IBM SPSS (Statistical Package 

for the Social Sciences) หรือ PASW (Predictive Analytics SoftWare), SAS (Statistical Analysis 

System) 

2. โปรแกรมแบบสาธารณะทั่วไป (Non-commercial Application หรือ GNU (General 

Public License: GNU-GPL)12 เช่น PSPP, R, JASP, JAMOVI 

โปรแกรมส าเร็จรูปทางสถิติมีการพัฒนาและออกแบบผ่านมาหลายยุค ในอดีตโปรแกรมส่วนใหญ่

ที่ติดตั้งอยู่บนเครื่องคอมพิวเตอร์ขนาดใหญ่ (main frame) และคอมพิวเตอร์เครื่องแม่ข่าย (server 

computer) ผู้ใช้งานต้องส่งข้อมูลและค าสั่งไปท าการประมวลผลผ่านเครื่องคอมพิวเตอร์ลูกข่าย (client 

computer) แบบข้อความ (command line) จนถึงในระยะแรกของยุคคอมพิวเตอร์ส่วนบุคคล (PCs 

                                                           
12

 ไม่มีลิขสิทธิ์ (copyleft) เปิดเผยและแพร่รายละเอียดของโปรแกรม (open-source) ที่เรียกวา่ รหัสต้นฉบบั (source code) เพื่ออนุญาต

ให้บุคคลทั่วไปสามารถไปท าซ้ า เผยแพร่ และดัดแปลงซอฟต์แวร์นั้นได้อยา่งถูกต้องตามกฎหมาย และโดยเสรี 
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Era) ต่อมาได้มีการพัฒนาระบบติดต่อกับผู้ใช้งานแบบกราฟิก (graphic user interface: GUI) มีไอคอน 

(icon) และเมนู (menu) ท าให้สามารถใช้งานได้ง่าย (user friendly) และในยุคหลังคอมพิวเตอร์ส่วน

บุคคล (Post-PCs Era) มีหลายโปรแกรมที่สามารถใช้งานจากระบบประมวลผลแบบกลุ่มเมฆ (cloud 

computing) ด้วยโปรแกรมเรียกดูข้อมูลบนอินเทอร์เน็ต (browser) แบบออนไลน์ (online)  

ส าหรับเอกสารค าสอนนี้จะแนะน าการใช้เฉพาะโปรแกรม PSPP ที่ติดตั้งบนคอมพิวเตอร์ส่วน

บุคคลในระบบปฏิบัติการ Windows เท่านั้น เพ่ือให้เรียนรู้และฝึกใช้งานเบื้องต้น โดยมีรายละเอียด

ดังต่อไปนี้ 

2. การติดตั้งโปรแกรมทางสถิต ิ

 โปรแกรม PSPP เป็น 1 ในโปรแกรมทางสถิติแบบรหัสเปิด (Open Source Statistical 

Software: OSSS) ภายใต้สัญญาอนุญาตให้ใช้ซอฟต์แวร์แบบสาธารณะทั่วไปที่เรียกกว่า GNU General 

Public License (GNU-GPL) มี ให้ เลื อกใช้ ง านบนเครื่ องคอมพิว เตอร์ ส่ วนบุคคล ( PC) หลาย

ระบบปฏิบัติการ (OS)13 โดยพัฒนาขึ้นมาเพ่ือเลียนแบบ (clone) ให้เป็นตัวเลือกใช้งานแทนโปรแกรม 

SPSS มีทั้งระบบการติดต่อกับผู้ใช้งานแบบกราฟิก (GUI) และระบบค าสั่งแบบข้อความ (command 

line) ที่คล้ายกัน แต่มีค าสั่งและสถิติให้เลือกใช้วิเคราะห์ข้อมูลน้อยกว่า บางค าสั่งไม่มีเมนูค าสั่งแบบ

กราฟิกต้องใช้ระบบค าสั่งแบบข้อความแทน เช่น การทดสอบกลุ่มตัวอย่างมากกว่า 2 กลุ่มที่เป็นอิสระ

จากกัน (K Independent Samples Tests) 

ผู้ใช้งานสามารถค้นหาโปรแกรม PSPP จากอินเทอร์เน็ต14 และท าการติดตั้งโปรแกรมก่อนการ

ใช้งานตามขั้นตอนดังต่อไปนี้  

ขั้นที่ 1 การค้นหาและดาวน์โหลดโปรแกรม 

1. เปิดโปรแกรมค้นหาข้อมูลบนอินเทอร์เน็ต (browser) เช่น Google Chrome, Microsoft 

Edge  

2. พิมพ์ค าว่า pspp download 

                                                           
13 วินโดว์ (Windows) แมคโอเอสเท็น (Max OS X) และยูนิกซ์/ลินุกซ์ (Unix/Linux)  
14 ควรดาวน์โหลด (download) จากเว็บไซต์ GNU Project หรือ SOURCEFORGE เพราะเป็นแหล่งเผยแพร่โปรแกรมที่มีความปลอดภัย
มากกว่าแหล่งอื่น และไม่มีการดัดแปลงเพื่อติดตั้งโปรแกรมเสริมให้ติดตั้งโปรแกรมอื่นเพิ่มเติมลงในเครื่องของผู้ใช้งานซ่ึงอาจเป็นท าให้
คอมพิวเตอร์เสียหายหรือสร้างความร าคาญระหว่างการใช้งาน 
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3. เพ่ือความง่ายและลดขั้นตอนการเข้าถึงไฟล์ติดตั้งให้เลือกลิงค์ pspp4windows download 

| SourceForge.net (https://sourceforge.net/projects/pspp4windows/)15 

4. คลิกเมาส์ที่ Download 

 

4. Save เก็บไว้ใน Drive หรือ Folder ในเครื่องคอมพิวเตอร์ที่ต้องการติดตั้งโปรแกรม 

 

ขั้นที่ 2 วิธีการติดตั้งโปรแกรม 

ก่อนการติดตั้งโปรแกรม ควรปิดหรือหยุดการท างานของโปรแกรมป้องกันไวรัส  การติดตั้ง

โปรแกรมสามารถเลือกท าได้ 2 วิธี ดังนี้ 

 

                                                           
15 ระบบให้บริการดาว์โหลดจะพาไปที่เว็บไซต์ SOURCEFORGE และเลือกไฟล์ติดตั้งเวอร์ล่าสุดและระบบปฏิบัติการ (OS) ที่ก าลังใช้งานให้

อัตโนมัติ 

การติดตั้งโปรแกรม
(Installation)

การติดตั้งแบบทั่วไป
(Defualt)

การติดตั้งแบบปรับแต่งโดยผู้ใช้งาน
(Customization)
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1. การติดตั้งแบบทั่วไป (default) เป็นวิธีการให้โปรแกรมก าหนดคุณสมบัติของโปรแกรมให้

เหมาะกับระบบปฏิบัติการเอง มีข้ันตอนดังต่อไปนี้  

๏ ดับเบิลคลิกเมาส์ที่ไฟล์ติดตั้ง                                                   (ชื่อไฟล์จะแตกต่าง
ไปตามเวอร์ชั่นล่าสุด) 

๏ หากโปรแกรม Windows แสดงหน้าต่าง User Account Control -> กดปุ่ม Yes 

 

2. การติดตั้งแบบปรับแต่งโดยผู้ใช้งาน (customization) เป็นวิธีที่ผู้ใช้งานสามารถก าหนด

คุณสมบัติในการติดตั้งโปรแกรมให้เหมาะสมกับระบบปฏิบัติการที่ใช้งาน โดยมีขั้นตอนดังนี้ 

๏ คลิกขวาที่ไฟล์ติดตั้ง (ชื่อไฟล์จะแตกต่างไปตามเวอร์ชั่นล่าสุดที่ปรับปรุง) -> เลือกเมนู
ค าสั่ง Properties  

๏ เลือกแถบ Compatibility ในหน้าต่าง Properties  
๏ เลือกคลิก / ที่ค่าที่ต้องการก าหนดค่า 
๏ กดปุ่ม Apply และกดปุ่ม OK 
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๏ ดับเบิลคลิกเมาส์ที่ไฟล์ติดตั้ง                                                             
๏ หากโปรแกรม Windows แสดงหน้าต่าง User Account Control -> กดปุ่ม Yes 

 

3. โปรแกรมแสดงหน้าต่าง Readme -> กดปุ่ม Next 

 

4. โปรแกรมแสดงหน้าต่างให้เลือกพ้ืนที่ในการติดตั้ง 

๏ หากต้องการติดตั้งในพ้ืนที่ที่โปรแกรมก าหนด -> กดปุ่ม Install 
๏ หากไม่ต้องการติดตั้งในพ้ืนที่ที่โปรแกรมก าหนด -> กดปุ่ม Browse เลือกพ้ืนที่ติดตั้งใหม่ 
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 5. ระหว่างการติดตั้ง โปรแกรมจะแสดงข้อความว่า Installing 

 

 6. เมื่อติดตั้งเสร็จเรียบร้อยแล้ว โปรแกรมจะแสดงข้อความว่า Installation Complete หรือ 

 

 7. เมื่อติดตั้งโปรแกรมเสร็จเรียบร้อยแล้ว บนพ้ืนจอของคอมพิวเตอร์ (desktop) จะแสดง

ไอคอนหรือสัญรูป (icon) 2 ไอคอน คือ แฟ้มข้อมูลคู่มือการใช้งาน (PSPP Manual) และปุ่มเปิด

โปรแกรม (PSPP) 

  

หากต้องการจัดเก็บไอคอนไว้ให้เป็นระเบียบ ไม่ปนกับไอคอนอ่ืนๆ ท าให้หาง่ายเมื่อต้องการใช้

งาน ให้สร้างโฟลเดอร์บนพ้ืนจอของคอมพิวเตอร์แล้วย้าย 2 ไอคอน ไปเก็บไว้ในโฟลเดอร์ดังกล่าว โดย

คลิกขวาบนพ้ืนจอคอมพิวเตอร์ -> New -> Folder -> พิมพ์ชื่อ PSPP -> ใช้เมาส์ลากไอคอนไปใส่ไว้ใน

โฟลเดอร์ 
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3. การใช้โปรแกรมทางสถิติเบื้องต้น 

 การใช้โปรแกรมเบื้องต้น เป็นการแนะน าวิธีการเปิดและปิดโปรแกรม และให้รู้จักส่วนประกอบที่

ส าคัญๆของโปรแกรม เช่น เมนู ค าสั่ง ระบบน าเข้าข้อมูล และระบบแสดงผล 

3.1 การเปิดโปรแกรม มี 3 วิธี ดังนี้ 

 

๏ Start (เมนู)         -> PSPP (กลุ่มโปรแกรม) -> PSPP (โปรแกรม) 

 

๏ คลิกท่ีเครื่องมือค้นหา (search) ด้านล่างซ้ายของจอภาพ         -> พิมพ์
ค าว่า pspp 
 

การเปิดโปรแกรม
(Open)

เมนู
(Menu)

ค้นหา
(Search)

ไอคอนหรือสัญรูป 
(Icon) 
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๏ คลิกท่ีค าว่า Open 

 

๏ คลิกท่ีไอคอนหรือสัญรูป (icon) PSPP บนพื้นจอของคอมพิวเตอร์ (desktop) 

 

3.2 การเปิดแฟ้มข้อมูล (ทดลองเปิดแฟ้มข้อมูลตัวอย่าง hotel.sav)  

๏ File -> New -> Data (ไปที่ C:\Program Files\PSPP\share\pspp\examples) 
๏ เลือกไฟล์ hotel.sav  
๏ กดปุ่ม Open 
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3.3 การปิดโปรแกรม มี 3 วิธี ดังนี้ 

 

๏ เมนู File -> Quit (Ctrl+Q) หรือ  
๏ กดปุ่ม Ctrl+Q บนแป้นพิมพ์ 
๏ คลิกเครื่องหมาย X มุมบนด้านซ้ายของโปรแกรม 

 

๏ กดปุ่ม Close without saving (ปิดโดยไม่ท าการบันทึกแฟ้มข้อมูล) 

  

การปิดโปรแกรม
(Quit)

เมนูค าสั่ง
(Menu Bar)

แป้นพิมพ์
(Keyboard)

ปุ่มปิด
(Icon)
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4. ส่วนประกอบของโปรแกรม PSPP 

โปรแกรม PSPP มี 3 ระบบที่ส าคัญ คือ ระบบจัดการข้อมูล (Data Editor) ระบบแสดงผลลัพธ์ 

(Output Viewer) และระบบค าสั่งแบบข้อความ (Syntax Editor) โดยมีรายละเอียดดังต่อไปนี้ 

4.1 ระบบจัดการข้อมูล  

ระบบจัดการข้อมูลประกอบด้วยระบบแสดงรายการตัวแปร (Variable View) และระบบแสดง

รายการข้อมูล (Data View) โดยมีรายละเอียดตามภาพด้านล่าง 

 

ระบบแสดงรายการตัวแปร (Variable View) 

 
ระบบแสดงรายการข้อมูล (Data View) 

Menu Bar (แถบเมนูชุดค าสั่ง) 

Toolbar (แถบปุ่มค าสั่ง) 

Variable View (แถบเปลี่ยนการแสดงรายการตัวแปร) 

Data View (แถบเปลี่ยนการแสดงรายการข้อมูล) 

Title Bar (แถบชื่อแฟ้มขอ้มูลและระบบโปรแกรม)
ต่าง) 

Variable Attributes (สดมภ์หรือคอลัมน์แสดงคุณลักษณะของตัวแปร) 

Variables (รายการตวัแปร) 

Case (ชุดข้อมูล) 

Cell Editor (ช่องแสดงค่าตัวแปร) 

Cell (ช่องใส่ค่าตัวแปร) 

Variable Name (ชื่อตัวแปร) 

Status Bar (แถบสถานภาพการท างานของโปรแกรม) 
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4.2 ระบบแสดงผลลัพธ์  

ระบบแสดงผลลัพธ์จะปรากฎให้เห็นเมื่อมีการใช้ค าสั่งใดค าสั่งหนึ่งในกระบวนการวิเคราะห์

ข้อมูล  

๏ ทดลองวิเคราะห์ข้อมูลจากแฟ้มข้อมูล hotel.sav 
๏ เลือกเมนู Analyze -> Descriptive Statistics -> Frequencies…  

o Variables(s): เลือกตัวแปรทั้งหมด (v1 v2 v3 v4 v5) ใส่ในช่อง Variables 
(ดับเบิลคลิกเมาส์เมาส์ที่ชื่อตัวแปรหรือใช้เมาส์ชี้ที่ชื่อตัวแปรและกดปุ่ม 

o กดปุ่ม OK 

 

 

Title Bar (แถบชื่อแฟ้มผลลัพธ์และระบบโปรแกรม) 
Menu Bar (แถบเมนูชุดค าสั่ง) 

Tree Diagram of Result (เมนูรายการผลลัพธ์) 

Syntax Output (ผลลัพธ์ของค าสั่งแบบข้อความ) 

Table Output (ตารางผลลัพธ์) 
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4.3 ระบบค าสั่งแบบข้อความ  

๏ เปิดจากเมนูค าสั่ง File -> New -> Syntax ในระบบจัดการข้อมูล  
๏ ทดลองพิมพ์ค าสั่งแบบข้อความใน Syntax Editor ตามตัวอย่างด้านล่าง 

frequencie 

/variable = v1 v2 v3 v4 v5 

/format = avalue table. 

 
๏ เลือกเมนู Run -> All 

4.4 การใช้ผลลัพธ์ 

 ผลลัพธ์ที่ได้จากการประมวลผลโปรแกรมจะเปิดเป็นหน้าต่างระบบแสดงผลลัพธ์ (Output 

Viewer) การใช้ผลลัพธ์มี 3 วิธี ดังนี้ 

 

๏ การดูผลลัพธ์จากหน้าจอภาพ  
o น าผลลัพธ์ไปกรอกใส่ตารางที่เตรียมไว้ ผลลัพธ์จากหน้าจอภาพไม่สามารถ Copy ไปใส่ใน

เอกสารอื่นได้  
๏ การพิมพ์ออกเครื่องพิมพ์ 

o เมนู File -> Print  
o เลือกเครื่องพิมพ์ 

ผลลัพธ์
(Ouput)

จอภาพ
(Screen)

เครื่องพิมพ์
(Printer)

แฟ้มข้อมูล
(Files)

Title Bar (แถบชื่อระบบโปรแกรม) 
Menu Bar (แถบเมนูชุดค าสั่ง) 

Syntax (ค าสั่งแบบ

ขอ้ความ) 
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๏ ก า ร ส่ ง อ อ ก  ( export) เ ป็ น แ ฟ้ ม ข้ อ มู ล น า ม ส กุ ล  PDF (*.pdf) HTML (*.html) 
OpenDocument (*.odt) Text (*.txt) และ Text [plain] (*.txt) PostScript (*.ps) และ 
Comma-Separated Value (*.csv) 
o เมนู File -> Export  
o พิมพ์ชื่อไฟล์ ในช่อง Name ด้านบนของหน้าต่าง Export Output  
o เลือกประเภทไฟล์จาก Infer file type from extension 
o เลือก Drive และ Folder ที่ต้องการเก็บข้อมูล 
o กดปุ่ม Save 
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5. เมนูการใช้โปรแกรม PSPP 

 โปรแกรม PSPP ออกแบบเมนูส าหรับให้ใช้งานเป็น 2 ส่วน คือ เมนูแบบรายการค าสั่ง (menu 

bar) และเมนูแบบปุ่มภาพ (toolbar) โดยมีรายละเอียดดังต่อไปนี้ 

5.1 หน้าต่างระบบ Data Editor 

 Data Editor เป็นระบบที่ใช้งานมากที่สุดระบบหนึ่งในการใช้โปรแกรมแบบกราฟิก (GUI) มีเมนู 

2 แบบดังต่อไปนี้  

5.1.1 เมนูแบบรายการค าสั่ง (Menu Bar) 

 เมนูแบบรายการค าสั่งเป็นเมนูแบบผังหรือต้นไม้ (tree menu) แบ่งเป็นกลุ่มค าสั่ง เมื่อใช้คลิก

เมาส์ชี้และคลิกขวาจะมีรายการค าสั่งย่อยให้เลือกใช้ดังต่อไปนี้ 

5.1.1.1 เมนู File 

 เมนู File เป็นเมนูรวมค าสั่งที่เกี่ยวกับการจัดการแฟ้มข้อมูล (file management) ได้แก่ New 

(สร้างแฟ้มข้อมูลใหม่) Open (เปิดแฟ้มข้อมูลที่มีอยู่แล้ว) Import Data (น าข้อมูลเข้าจากแฟ้มข้อมูล

โปรแกรมอ่ืน) Save (จัดเก็บข้อมูล) Save As (จัดเก็บข้อมูลเป็นแฟ้มข้อมูลชื่อใหม่) Rename Dataset 

(เปลี่ยนชื่อชุดข้อมูล) Display Data File Information (แสดงรายละเอียดของข้อมูลในแฟ้มข้อมูล) 

Recently Used Data และ Recently Used Files (เลือกใช้แฟ้มข้อมูลที่เปิดใช้งาน) และ Quit (ปิด

หรือออกจากโปรแกรม PSPP) 
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5.1.1.2 เมนู Edit 

 เมนู Edit เป็นเมนูรวมค าสั่งเกี่ยวกับจัดการตัวแปร (variable management) เพ่ือเพ่ิมหรือ

แก้ไขตัวแปร ได้แก่ Insert Variable (เพ่ิมตัวแปร) Go To Variable (เลื่อนหรือวิ่งไปยังตัวแปรที่เลือก) 

Cut (ตัดข้อมูล) Copy (ส าเนาข้อมูล) Paste (วางหรือแปะข้อมูลที่ได้จากการตัดหรือส าเนาข้อมูล) Clear 

Variables (ลบตัวแปร) และ Options (ก าหนดรูปแบบการแสดงผลรายการตัวแปร) 

 

5.1.1.3 เมนู View 

เมนู View เป็นเมนูรวมค าสั่งเกี่ยวกับการจัดการการแสดงผล (display management) เพ่ือให้

แสดงผลหรือหรือไม่แสดงผล และเปลี่ยนแปลงการแสดงผล ได้แก่ Status Bar (ปิด/เปิดแถบสถานภาพ

การท างานของโปรแกรม) Font (เปลี่ยนประเภทและขนาดตัวอักษร) Grid Line (แสดง/ไม่แสดงเส้นแบ่ง

ในตารางข้อมูล) Value Labels (แสดง/ไม่แสดงค าอธิบายค่าตัวแปร)  Data (แสดงข้อมูล) และ 

Variables (แสดงรายการตัวแปร) 
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5.1.1.4 เมนู Data 

 เมนู Data เป็นเมนูรวมค าสั่งเกี่ยวกับปรับข้อมูล (data manipulation) ได้แก่ Sort Cases (การ

จัดเรียงข้อมูล) Transpose (การไขว้ตัวแปร) Aggregate (การรวมข้อมูล) Split File (การแบ่งข้อมูล)  

Select Cases (การเลือกข้อมูล) และ Weight Cases (การก าหนดน้ าหนักข้อมูล) 

 

5.1.1.5 เมนู Transform 

เมนู Transform เป็นเมนูรวมค าสั่งเก่ียวกับการแปลงรูปแบบข้อมูล (variable 

transformation) ได้แก่ Compute (การสร้างตัวแปรแบบค่าต่อเนื่อง) Count (การนับจ านวนข้อมูล) 

(Rank Cases (การจัดล าดับตัวอย่าง) Automatic Recode (การสร้างตัวแปรแบบอัตโนมัติ) Recode 

into Same Variables (การเปลี่ยนค่าตัวแปรในตัวแปรเดิม) Recode into Different Variables (การ

สร้างตัวแปรแบบค่าแบ่งกลุ่ม) และ Run Pending Transforms (การสั่งประมวลผลต่อ) 

 

5.1.1.6 เมนู Analyze 

 เมนู Analyze เป็นเมนูรวมค าสั่งเกี่ยวกับการวิเคราะห์ข้อมูล (data analysis) ด้วยสถิติประเภท

ต่างๆ ได้แก่ Descriptive Statistics (การวิเคราะห์ด้วยสถิติ เชิงพรรณนา) Compare Means (การ
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วิเคราะห์เปรียบเทียบค่าเฉลี่ย) Univariate Analysis (การวิเคราะห์ตัวแปรเดี่ยว) Bivariate Correlation 

(การวิเคราะห์ความสัมพันธ์รายคู่) Factor Analysis (การวิเคราะห์องค์ประกอบ) Reliability (การ

วิเคราะห์ความน่าเชื่อถือ) Linear Regression (การวิเคราะห์ถดถอยเชิงเส้นตรง) Non-Parametric 

Statistics (การวิเคราะห์ด้วยสถิติไม่อิงค่าพารามิเตอร์) และ ROC Curve (การวิเคราะห์พื้นที่ใต้โค้ง)   

 

5.1.17 เมนู Graphs 

เมนู Graphs เป็นเมนูรวมค าสั่งเกี่ยวกับการวิเคราะห์ข้อมูลด้วยวิทัศน์หรือกราฟ ได้แก่ 

Scatterplot (กราฟการกระจาย) Histogram (กราฟแจกแจงความถี่) และ Barchart (กราฟแท่ง) 

 

5.1.1.8 เมนู Utilities 

เมนู Utilities เป็นเมนูรวมค าสั่งเกี่ยวกับการจัดการตัวแปรและแฟ้มข้อมูล ได้แก่ Variables 

(แสดงรายละเอียดหรือข้อมูลเกี่ยวกับตัวแปร เลื่อนหรือวิ่งไปยังตัวแปร และแปะข้อมูลเกี่ยวกับตัวแปร ) 

และ Data File Comments (บันทึกหรือเขียนค าแนะน าเก่ียวกับแฟ้มข้อมูล) 
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5.1.1.9 เมนู Windows 

เมนู Windows เป็นเมนูรวมค าสั่งเกี่ยวกับการจัดการหน้าต่างที่ก าลังใช้งาน (windows 

management) ได้แก่ Minimize all Windows (ยุบ/ปิดหน้าต่างทั้งหมด) Split (แบ่งตารางรายการตัว

แปรหรือข้อมูลเป็น 4 ส่วน) และ DataSet (เลือกชุดข้อมูลที่ก าลังเปิดใช้งาน) 

 

5.1.1.10 เมนู Help 

 เมนู Help เป็นเมนูรวมค าสั่งเกี่ยวกับความช่วยเหลือ ได้แก่ Reference Manual (คู่มืออ้างอิง/

การใช้งาน) และ About (ข้อมูลโดยย่อเก่ียวกับโปรแกรม) 

 

5.1.2 เมนูแบบปุ่มภาพ (Toolbar) 

 เมนูแบบปุ่มภาพเป็นเมนูค าสั่งประเภทหนึ่งที่ทีมพัฒนาเลือกค าสั่งที่ใช้งานกันบ่อยมาออกแบบ

เป็นปุ่มกดและมีภาพสัญลักษณ์ประกอบ ๆ เพ่ือให้ใช้งานได้สะดวกและรวดเร็วตามแนวคิด GUI  โดยมี

ค าสั่งดังต่อไปนี้ 

 

 

 

 

 

เปิดแฟ้มขอ้มูล 

บันทึกแฟ้มข้อมลู 

ไปยังตัวแปรที่เลอืก 

สร้างตัวแปรใหม ่

แบ่งกลุ่มตวัอย่าง 

ก าหนดน้ าหนกั 

แสดง/ซ่อนค าอธิบายค่าของตัว
แปร 
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5.2 หน้าต่างระบบ Syntax Editor 

 การใช้โปรแกรม PSPP แบบ GUI บางครั้งอาจต้องใช้ค าสั่งแบบข้อความ (command line) โดย

เปิดระบบ Syntax Editor จากเมนู File -> New -> Syntax และเม่ือหน้าต่างระบบ Syntax Editor 

ปรากฎขึ้นจะมีเมนูให้ใช้งานดังต่อไปนี้ 

5.2.1 เมนู File 

 เมนู File เป็นเมนูรวมค าสั่งที่เกี่ยวกับการจัดการแฟ้มข้อมูล (file management) เหมือนกับ

ระบบ Data Editor ได้แก่ New (สร้างแฟ้มข้อมูลใหม่) Open (เปิดแฟ้มข้อมูลที่มีอยู่แล้ว) Save (จัดเก็บ

ข้อมูล) Save As (จัดเก็บข้อมูลเป็นแฟ้มข้อมูลในชื่อใหม่) Print (พิมพ์ Syntax ออกเครื่องพิมพ์) และ 

Quit (ปิดระบบ Syntax Editor) 

 

5.2.2 เมนู Edit 

เมนู Edit เป็นเมนูรวมค าสั่งที่เกี่ยวกับการจัดการค าสั่งหรือข้อความใน Syntax ได้แก่ Cut (ตัด) 

Copy (ส าเนา) Paste (แปะ) Delete (ลบ) Undo (ท ากลับ/ยกเลิก) Redo (ท าใหม่) และ Find (ค้นหา) 
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5.2.3 เมนู Run 

เมนู Run เป็นเมนูรวมค าสั่งที่เกี่ยวกับการประมวลผล Syntax ได้แก่ All (ประมวลผลทั้งหมด) 

Selection (ประมวลผลเฉพาะที่เลือก) Current Line (ประมวลผลเฉพาะบรรทัดที่ตัวชี้ต าแหน่งวางอยู่) 

และ To End (ประมวลผลจากต าแหน่งที่ตัวชี้ต าแหน่งวางอยู่จนสุด Syntax) 

 

5.2.4 เมนู Windows 

เมนู Windows เป็นเมนูรวมค าสั่งที่เกี่ยวกับการจัดการหน้าต่างระบบ Syntax Editor ได้แก่ 

Minimize all Windows (ยุบ/ปิดหน้าต่างทั้งหมด) Output (เลือกเปิดหน้าต่างผลลัพธ์) และ Syntax 

Editor (เลือกเปิดหน้าต่าง Syntax Editor) 

 

5.2.5 เมนู Help 

เมนู Help เป็นเมนูรวมค าสั่งเกี่ยวกับความช่วยเหลือ ได้แก่ Reference Manual (คู่มืออ้างอิง/

การใช้งาน) และ About (ข้อมูลโดยย่อเก่ียวกับโปรแกรม) 
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5.3 หน้าต่างระบบ Output Viewer 

 หน้าต่างระบบ Output Viewer จะแสดงผลทุกครั้งที่มีการใช้ค าสั่งของโปรแกรม เช่น เปิด

แฟ้มข้อมูล ประมวลผลข้อมูล แก้ไขข้อมูล ฯลฯ และเม่ือหน้าต่างระบบ Output Viewer ปรากฎขึ้นจะมี

เมนูให้ใช้งานดังต่อไปนี้ 

5.3.1 เมนู File 

เมนู File เป็นเมนูรวมค าสั่งเกี่ยวกับการพิมพ์และส่งออกผลลัพธ์ ได้แก่ Print (พิมพ์ผลลัพธ์ออก

ทางเครื่องพิมพ์) Export (ส่งผลลัพธ์ออกเป็นไฟล์ *.spv, *.pdf, *.html, *.odt, *.txt, *.ps และ *.csv) 

และ Quit (ปิดระบบ  Output Viewer) 

 

5.3.2 เมนู Edit 

เมนู Edit เป็นเมนูรวมค าสั่งเกี่ยวกับการจัดส าเนาผลลัพธ์ ได้แก่ Select All (เลือกผลลัพธ์

ทั้งหมด) Copy (ส าเนาผลลัพธ์ที่เลือก) 

 

5.3.3 เมนู Windows 

เมนู Windows เป็นเมนูรวมค าสั่งที่เกี่ยวกับการจัดการหน้าต่างระบบ Output Viewer ได้แก่ 

Minimize all Windows (ยุบ/ปิดหน้าต่ างทั้ งหมด) Output ( เลือกเปิดหน้าต่ างผลลัพธ์ )  และ 

D:\Data\PSPP\ASPSS_Data.sav [DataSet1] (เลือกเปิดหน้าต่างข้อมูล) 
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5.3.4 เมนู Help 

เมนู Help เป็นเมนูรวมค าสั่งเกี่ยวกับความช่วยเหลือ ได้แก่ Reference Manual (คู่มืออ้างอิง/

การใช้งาน) และ About (ข้อมูลโดยย่อเก่ียวกับโปรแกรม) 

 

สรุป 

 โปรแกรม PSPP เป็นโปรแกรมแบบสาธารณะทั่วไป สามารถดาวน์โหลดจากอินเทอร์เน็ตมา

ติดตั้งและใช้งานได้ฟรี มีระบบติดต่อกับผู้ใช้งานทั้งแบบใช้ค าสั่งที่เป็นข้อความ (command line) และ

แบบกราฟิก (GUI) เหมาะส าหรับผู้เรียนที่เริ่มเรียนรู้การวิเคราะห์ข้อมูลและเริ่มท าวิจัยเบื้องต้น และยัง

เป็นโปรแกรมเริ่มต้นส าหรับเรียนรู้การวิเคราะห์ข้อมูลด้วยสถิติก่อนก้าวไปใช้โปรแกรมอ่ืนต่อไป 

แบบฝึกหัดท้ายบท 

 ให้ผู้เรียนทบทวนการใช้โปรแกรมดังต่อไปนี้ 

1. ให้ผู้เรียนทดลองเปิดโปรแกรมและปิดโปรแกรม  

2. ศึกษาเมนู ค าสั่ง และส่วนประกอบของโปรแกรมว่ามีอะไรบ้าง 

  





 

 

บทที่ 6 
การน าข้อมูลเข้าโปรแกรม 

ความมุ่งหมายของบทเรียน 
ผู้เรียนสามารถน าข้อมูลจากแบบสอบถามกรอกเข้าโปรแกรม และน าข้อมูลที่เก็บอยู่ในรูปของ

แฟ้มข้อมูลเข้าโปรแกรม  

เนื้อหา 
1. การน าข้อมูลเข้าจากแบบสอบถาม 

2. การน าข้อมูลเข้าจากแฟ้มข้อมูล 

วิธีการสอนและกิจกรรมการเรียนการสอน 
บรรยาย แสดงตัวอย่าง แนะน าการกรอกข้อมูลเข้าโปรแกรมและน าข้อมูลเข้าจากแฟ้มข้อมูล 

และท าแบบฝึกหัดท้ายบท 

สื่อและอุปกรณ์การสอน 
เอกสารค าสอน ภาพเลื่อน คอมพิวเตอร์ โปรแกรม PSPP โปรแกรมสอนออนไลน์ (สอนแบบ

ออนไลน์) และเครื่องฉาย (สอนในชั้นเรียน) 

งานที่มอบหมาย 

 ท าแบบฝึกหัดท้ายบท 

การวัดผลและประเมินผล 

การเข้าชั้นเรียน สังเกตความสนใจจากการเรียน สอบถามความเข้าใจจากการบรรยาย และการ

ท าแบบฝึกหัดท้ายบท  
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เนื้อหา 

ข้อมูลที่ใช้ในการวิจัยเชิงปริมาณอาจเป็นข้อมูลปฐมภูมิ (primary data) ที่ได้จากการใช้
แบบสอบถามในการรวบรวมข้อมูล มีทั้งการส ารวจด้วยแบบสอบที่สร้างด้วยกระดาษ (non-digital 
questionnaire) และแบบสอบถามที่สร้างด้วยโปรแกรมคอมพิวเตอร์ (digital questionnaire) และ
ข้อมูลทุติยภูมิ (secondary data) ที่จัดเก็บไว้แล้ว มีทั้งข้อมูลแบบเก่าที่เก็บไว้เป็นเอกสาร (non-digital 
data) เช่น หนังสือ รายงานประจ าปี และข้อมูลแบบใหม่ที่เป็นดิจิทัล (digital data) เช่น แฟ้มข้อมูล
คอมพิวเตอร์ และโปรแกรมฐานข้อมูล  

การน าข้อมูลเข้าไปวิเคราะห์ด้วยโปรแกรมคอมพิวเตอร์จึงต้องมีการเตรียมข้อมูลตามลักษณะ
ของข้อมูลที่ได้มา ซึ่งอาจต้องเริ่มจากการสร้างแฟ้มข้อมูล น าข้อมูลเข้าแบบกรอกข้อมูล หรือดึงเข้าจาก
แฟ้มข้อมูล   

1. การน าข้อมลูเข้าจากแบบสอบถาม 

 แบบสอบถามหรือแบบส ารวจเป็นเครื่องมือวัดที่นิยมใช้ในการรวบรวมข้อมูลอย่างแพร่หลาย 

ปัจจุบันนักวิจัยอาจต้องสร้างแบบสอบถามทั้งแบบเก่าโดยใช้การพิมพ์ด้วยกระดาษหรือที่เรียกว่า 

แบบสอบถามแบบออฟไลน์ และอาจต้องใช้แบบสอบถามออนไลน์ควบคู่กันไป เพราะผู้ตอบแบบสอบถาม

อาจถนัดหรือมีความพร้อมใช้แบบใดแบบหนึ่ง จึงต้องเตรียมสร้างแบบสอบถามทั้งสองแบบไว้ให้

เลือกตอบ ดังนั้นหากมีการเก็บรวบรวมข้อมูลด้วยแบบสอบถามแบบออฟไลน์จึงต้องท าการสร้าง

แฟ้มข้อมูลและกรอกข้อมูลเข้าโปรแกรมโดยมีวิธีการดังต่อไปนี้ 

1.1 การสร้างแฟ้มข้อมูล 

การสร้างแฟ้มข้อมูล คือ การสร้างแบบฟอร์มรับข้อมูจากแบบสอบถาม หรือเป็นการแปลง
แบบสอบถามให้เป็นข้อมูลที่โปรแกรมสามารถน าไปประมวลผลได้ เมื่อเข้าใจถึงความสัมพันธ์ระหว่าง
แบบสอบถามกับแฟ้มข้อมูลแล้ว เราสามารถสร้างแฟ้มข้อมูลจากโปรแกรมได้ดังนี้ 
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 1. เปิดโปรแกรม PSPP โปรแกรมจะแสดงหน้าต่างระบบจัดการข้อมูล (Data Editor) 
 2. คลิกเมาส์ที่แถบ Variable View ด้านล่างซ้ายของหน้าต่าง Data Editor 

 

 3. ตัวอย่างแฟ้มข้อมูล 

 

4. การสร้างตัวแปร 

 การสร้างตัวแปร คือ การแปลงข้อค าถามให้เป็นตัวแปร บางข้อค าถามอาจต้องแปลงจากค าตอบ 
รวมถึงการก าหนดคุณลักษณะของตัวแปร เช่น ชื่อตัวแปร ประเภทตัวแปร ลักษณะของข้อมูล ค าอธิบาย
ชื่อตัวแปร และค าอธิบายค่าตัวแปร   

โดยทั่วไปการเลื่อนตัวชี้ต าแหน่งหรือเคอร์เซอร์ (cursor) ไปยังช่องต่างๆ (cells) ในโปรแกรม 
PSPP สามารถใช้เมาส์ (mouse) หรือ ทัชแพด (touchpad) หรือ แทร็คแพด (trackpad) เลื่อนได้
เหมือนกับโปรแกรมทั่วไป และสามารถใช้คีย์บอร์ด (keyboard) ปุ่มลูกศรซ้ายหรือขวา และปุ่มลูกศรขึ้น
หรือลง เลื่อนตัวชี้ต าแหน่งหรือเคอร์เซอร์ไปยังช่องที่อยู่ใกล้เคียงได้เช่นกัน  

เนื่องจากมีบางคอลัมน์ที่มีระบบเมนูให้เลือกก าหนดค่าซ่อนอยู่ เช่น Type, Width Decimal, 
Value Labels, Missing Values, Align, Measure และ Role ท าให้ไม่สามารถใช้คีย์บอร์ดปุ่มลูกศรซ้าย
หรือขวาเลื่อนไปทางซ้ายหรือขวาได้ ต้องใช้คีย์บอร์ดปุ่มแท็บ (tab) เลื่อนจากซ้ายไปขวา และใช้ปุ่มชิฟท์ 
(shift) + แท็บ (tab) เลื่อนจากขวาไปซ้าย 



108 | ก า ร ใ ช้ โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร์ ท า ง ส ถิ ติ ใ น ด้ า น สั ง ค ม ศ า ส ต ร์  

๏ การก าหนดชื่อตัวแปร (Variable Name)  
o พิมพ์ชื่อตัวแปรในช่องใต้คอลัมน์ Name  

 

๏ การก าหนดประเภทและรูปแบบตัวแปร (Variable Type)  
o คลิกเมาส์ในช่องใต้คอลัมน์ Type โปรแกรมจะแสดงหน้าต่างให้ก าหนดรูปแบบและ

ประเภทของตัวแปร (ถ้าใช้ตัวเลขเป็นข้อมูลของตัวแปรให้เลือก Numeric หรือถ้าใช้
ตัวอักษรเป็นข้อมูลของตัวแปรให้เลือก String) 

o ก าหนดจ านวนค่าตัวแปร ในช่อง Width: โดยพิมพ์ตัวเลขทับตัวเลขค่าเริ่มต้น หรือกด
ปุ่ม - หรือ + 

o ก าหนดจ านวนทศนิยมตัวแปร ในช่อง Decimal Places: โดยพิมพ์ตัวเลขทับตัวเลขค่า
เริ่มต้น หรือกดปุ่ม - หรือ + 

o กดปุ่ม OK 

 

ข้อมูลของตัวแปรด้านสังคมศาสตร์ส่วนใหญ่เป็นตัวเลข (numeric) และตัวอักษร (string) หาก
ข้อมูลเป็นตัวอักษรควรแทนค่าให้เป็นตัวเลข และก าหนดให้เป็นตัวแปรประเภท Numeric เพราะบาง
ค าสั่งไม่แสดงตัวแปรที่เป็นตัวอักษร เช่น Means หากก าหนดค่าตัวแปร ชาย = M และ หญิง = F ตัว
แปรจะไม่ปรากฏในรายการตัวแปรให้เลือกเพ่ือท าการวิเคราะห์เปรียบเทียบ ต้องแปลงค่าของตัวแปรให้
เป็นตัวเลขก่อน) 

๏ การก าหนดจ านวนค่าตัวแปร (Variable Width)  
o พิมพ์ตัวเลขจ านวนค่าตัวแปรใต้คอลัมน์ Width 

หรือกดปุ่ม - หรือ +   

 ค่าเริ่มต้น (default) จ านวนค่าตัวแปรของตัวแปรแบบตัวเลขและตัวอักษรก าหนดไว้เป็น 8 
ต าแหน่ง หากไม่ต้องการบังคับจ านวนค่าตัวแปรที่ให้กรอกข้อมูล ให้ใช้ค่าเริ่มต้น 
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๏ การก าหนดจ านวนทศนิยมของค่าตัวแปร (Variable Decimal)  
o พิมพ์ตัวเลขจ านวนทศนิยมใต้คอลัมน์ Decimal หรือกด

ปุ่ม - หรือ +   

ค่าเริ่มต้น (default) จ านวนทศนิยมของตัวแปรประเภทตัวเลขก าหนดไว้เป็น 2 ต าแหน่ง และ
ตัวแปรประเภทตัวอักษรก าหนดไว้ 0 ต าแหน่ง หากต้องการให้การแสดงข้อมูลในหน้าต่างแสดงข้อมูล 
(data view) เข้าใจง่าย ดูแล้วสามารถจ าแนกประเภทตัวแปรได้ว่าตัวแปรใดเป็นตัวแปรแบบค่าแบ่งกลุ่ม
และตัวแปรแบบค่าต่อเนื่อง ให้ก าหนดจ านวนทศนิยมของตัวแปรแบบค่าแบ่งกลุ่ม คือ Nominal และ 
Ordinal เป็น 0 ต าแหน่ง และก าหนดจ านวนทศนิยมของตัวแปรแบบค่าต่อเนื่อง คือ Scale เป็น 2 
ต าแหน่ง 

๏ การก าหนดค าอธิบายชื่อตัวแปร (Variable Label)  
o พิมพ์ค าอธิบายช่ือตัวแปรใต้คอลัมน์ Label   

หากชื่อตัวแปรสื่อความหมาย อาจไม่ต้องมีค าอธิบายชื่อตัวแปร เช่น Gender หากใช้ชื่อย่อและ
ไม่สื่อความหมาย เช่น V1 หรือ QoS ควรก าหนดชื่อตัวแปรพอให้เข้าใจได้ ไม่ยาวมาก เพราะหากสร้าง
ชื่อตัวแปรยาวมากจะมีผลในตารางการแสดงผลการวิเคราะห์ 

๏ ก าหนดค าอธิบายค่าของตัวแปร (Values)  
o คลิกเมาส์ในช่องว่างใต้คอลัมน์ Value 

Labels (โปรแกรมจะแสดงหน้างต่างให้
ก าหนดคา่และค าอธิบายค่าของตัวแปร) 

o พิมพ์ค่าของตัวแปรในช่อง Value: 
o พิมพ์ความหมายของค่าของตัวแปรในช่อง 

Value Label: 
o กดปุ่ม Add 

 

การแก้ไขค่าและความหมายของค่าของตัวแปร ให้คลิกเมาส์ที่ค่านั้นและท าการแก้ไข เมื่อท าการ
แก้ไขแล้วให้กดปุ่ม Apply เพ่ือเปลี่ยนแปลงค่าและความหมาย และหากต้องการลบความหมายของค่า
ของตัวแปร ให้คลิกเมาส์ที่ค่านั้นและกดปุ่ม Remove 

โปรแกรม PSPP ไม่สามารถ Copy ค่าในช่อง Value Labels ได้ หากตัวแปรมี Value Label 
เหมือนกัน ให้ใช้วิธีการดังนี้ 
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1. สร้างตัวแปรให้ครบ โดยยังไม่ต้องก าหนด Value Labels 
2. เลือกเมน ูFile -> New -> Syntax 

ตัวอย่าง 

ตัวแปร V1 V2 V3 V4 ให้พิมพ์ค าสั่งในหน้าต่าง 
Syntax Editor ดังนี้ 

add value label V1 V2 V3 V4 0 'No' 1 
'Least' 2 'Less' 3 'Nature' 4 'More' 5 'Most'.  

3. เมนู Run -> Current Line หรือกด Cltr+R ที่ท้ายบรรทัดของค าสั่ง 

๏ การก าหนดค่าขาดหาย (Missing 
Values)  
o คลิกเมาส์ในช่องว่างใต้คอลัมน์ 

Missing Values 

o เลือกก าหนดค่าขาดหายแบบค่าไม่
ต่อเนื่อง (discrete) เช่น 0 (ไม่มี
ค าตอบ) 9 (ไม่ตอบ) 8 (ไม่ทราบ) 
หรือ เป็นช่วง (range) เช่น Low: 0 
High: 14 Discrete value: 99 
(วิเคราะห์เฉพาะค่าตั้งแต่ 15 ขึ้นไป 
และไม่รวม 99) 

o กดปุ่ม OK 

 

๏ การก าหนดความกว้างของช่องค่าตัวแปร
หรือสดมภ์ (Columns) 
o พิมพ์ตัวเลขจ านวนความกว้างของ

ช่องค่าตัวแปรใต้คอลัมน์ Columns 
หรือกดปุ่ม - หรือ +  

 

 

ค่าเริ่มต้น (default) ความกว้างของช่องค่าตัวแปรก าหนดไว้เป็น 8 ต าแหน่ง หากมีจ านวนตัว
แปรมากและต้องการลดความกว้างของหน้าจอในการแสดงข้อมูลให้ลดตัวเลขจ านวนความกว้างลง หรือ
ใช้เมาส์ดึงลดขนาดความกว้างในหน้าต่างแสดงข้อมูล (data view) 
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๏ การจัดต าแหน่งค่าตัวแปร (Align) 
o คลิกเมาส์ในช่องใต้คอลัมน์ Align (โปรแกรมจะแสดง

เมนูรายการต าแหน่งค่าตัวแปร)  
o เลือกต าแหน่งค่าตัวแปร  

๏ การก าหนดระดับการวัด (Measure) 
o คลิกเมาส์ในช่องใต้คอลัมน์ Measure (โปรแกรมจะ

แสดงเมนูรายการระดับการวัด) 
o เลือกระดับการวัด  

๏ การก าหนดบทบาทของตัวแปร (Variable Role) 
o คลิกเมาส์ในช่องใต้คอลัมน์ Role (โปรแกรมจะแสดง

เมนูรายการจุดมุ่งหมายของตัวแปร) 
o เลือกประเภทท่ีมาของข้อมูลหรือตัวแปร 

 
 ผู้ใช้โปรแกรมอาจสร้างตัวแปรโดยใช้ค่าเริ่มต้นทั้งหมด แต่ที่ส าคัญในการวิเคราะห์ข้อมูลต้อง
ทราบว่า ตัวแปรใดเป็นตัวแปรแบบค่าแบ่งกลุ่มหรือตัวแปรแบบค่าต่อเนื่อง เพราะในการเลือกวิเคราะห์
ด้วยสถิติแต่ละประเภทต้องเลือกใช้ตัวแปรให้ถูกต้องและตรงกับข้อตกลงเบื้องต้น (basic assumptions) 

 5. การบันทึกแฟ้มข้อมูล (Save) 

 แฟ้มข้อมูล (data files) ที่สร้างด้วยโปรแกรม PSPP ใช้โครงสร้างระบบแฟ้มข้อมูล (system 
file) แบบเดียวกับแฟ้มข้อมูลของโปรแกรม SPSS วิธีการบันทึกแฟ้มข้อมูลมีขั้นตอนดังต่อไปนี้ 

๏ เลือกเมนู File -> Save… (Ctrl + S) 
หรือ Save As… (Shift + Ctrl + S) หรือ 
คลิกเมาส์ที่ไอคอน  
o เลือกพ้ืนที่ (folder) เก็บแฟ้มข้อมูล 
o พิมพ์ชื่อแฟ้มข้อมูลในช่อง Name 

(ทดลองพิมพ์ ASPSS_Data โดยไม่
ต้องใส่นามสกุลของแฟ้มข้อมูล) 

o กดปุ่ม Save  
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รูปแบบ (format) ของแฟ้มข้อมูล หากไม่เลือกรูปแบบใดโปรแกรมจะบันทึกให้เป็น System 
File เป็นแฟ้มข้อมูลแบบเก่าที่ไม่มีการบีบอัดข้อมูล ได้แฟ้มข้อมูลที่มีนามสกุลเป็น sav หากต้องการ
บันทึกเป็นแฟ้มข้อมูลแบบใหม่ที่มีการบีบอัดข้อมูลให้เลือกเป็น Compressed System File จะได้
แฟ้มข้อมูลที่มีนามสกุล zsav และถ้าต้องการบันทึกเป็นแฟ้มข้อมูลแบบใช้ได้หลายระบบ ส าหรับใช้
แลกเปลี่ยนข้อมูล ให้เปิดอ่านได้อย่างเดียว ไม่สามารถแก้ไขได้ ให้เลือก Portable File จะได้แฟ้มข้อมูล
ที่มีนามสกุล por   

1.2 การน าข้อมูลเข้าโปรแกรมแบบกรอกข้อมูล 

ข้อมูลที่น ามาใช้ในการวิจัยมีที่มาจากหลายแหล่งข้อมูลและมีหลายรูปแบบ แต่ข้อมูลทั้งหลาย
ต้องผ่านกระบวนการแปลงข้อมูลให้เป็นข้อมูลดิจิทัล (digital data) และมีโครงสร้างข้อมูล (data 
structure) เป็นตารางข้อมูลที่โปรแกรมสามารถน าไปประมวลผลได้  

การวิจัยที่ใช้การส ารวจข้อมูลด้วยแบบสอบถามแบบเก่าที่เป็นกระดาษ หรือที่ปัจจุบันนิยม
เรียกว่า แบบสอบถามแบบออฟไลน์ (offline questionnaire) ก่อนการกรอกข้อมูลต้องท าการสร้าง
แฟ้มข้อมูลก่อนตามที่วิธีการที่กล่าวมาแล้ว จากนั้นจึงท าการกรอกข้อมูลเข้า (entering data) ดังต่อไปนี้ 

๏ เปิดแฟ้มข้อมูล (แฟ้มข้อมูลที่สร้างไว้และยังไม่มีข้อมูล) 
๏ คลิกเมาส์ที่แถบ Data View ด้านล่างซ้าย 
๏ พิมพ์ค่าตัวแปร (Value) ใต้ช่องชื่อตัวแปร (Variable Name) 
๏ คลิกเมาส์ที่ช่องว่างของตัวแปรถัดไป หรือใช้คีย์บอร์ดปุ่มลูกศรซ้าย เพ่ือเลื่อน Cursor ไป

ยังช่องข้อมูลของตัวแปรถัดไป 

 

 ระหว่างกรอกข้อมูล ควรบันทึกข้อมูลเป็นระยะ โดยไปท่ีเมนู File -> Save… (Ctrl + S) หรือ 
Save As… (Shift + Ctrl + S) หรือคลิกเมาส์ที่ ไอคอน  



ก า ร น า ข้ อ มู ล เ ข้ า โ ป ร แ ก ร ม | 113 

2. การน าเข้าข้อมลูจากแฟ้มข้อมูล  
ข้อมูลที่น ามาใช้ในการวิเคราะห์ด้วยโปรแกรมคอมพิวเตอร์อาจได้มาจากหลายแหล่งข้อมูล เช่น 

การบันทึกข้อมูลด้วยโปรแกรมตารางค านวณ (spreadsheet software) การรวบรวมข้อมูลด้วย
แบบสอบถามแบบออนไลน์ (online questionnaire) ข้อมูลที่ส่งออก (export) ออกมาจากฐานข้อมูล 
(database) และข้อมูลเปิด (open data) ของหน่วยงานต่างๆที่เผยแพร่ไว้ในอินเทอร์เน็ต โดยทั่วไป
ข้อมูลที่เผยแพร่ข้อมูลสู่สาธารณะและการให้บริการแลกเปลี่ยนข้อมูล นิยมท าเป็นแฟ้มข้อมู 2 รูปแบบ 
ดังนี้ 

1. แฟ้มข้อมูลแบบตัวอักษร (Text Files) แฟ้มข้อมูลมีนามสกุลเป็น csv หรือ txt หรือ dat แบ่ง
ข้อมูลด้วยตัวคั่น  (delimiter-separated formats)  เช่น  เครื่ องหมายจุลภาค (comma)  หรือ 
เครื่องหมายค าพูด (quote) เครื่องหมายเว้นระยะ (tab)  

2. แฟ้มข้อมูลจากโปรแกรมตารางค านวณ (Spreadsheet Files) ที่เป็นโปรแกรมเปิดรหัส 
(open-source) เช่น Gnumeric Spreadsheet (*.gnumeric) และ Open Document Spreadsheet 
(*.ods)  

โปรแกรม PSPP เป็นโปรแกรมทางสถิติแบบรหัสเปิดหรือโอเพนซอร์ซ (Open Source 
Statistical Software: OSSS) ที่ออกแบบมาเพ่ือเป็นตัวเลือกใช้งานแทนโปรแกรม SPSS นอกจาก
สามารถเปิดแฟ้มข้อมูลของโปรแกรม SPSS ได้แล้ว ยังสามารถใช้ข้อมูลจากแฟ้มข้อมูลของโปรแกรม
ตารางค านวณได้ด้วย เพราะมีโครงสร้างรูปแบบการเก็บข้อมูลเป็นตาราง (table) มีสดมภ์ (column) 
และแถว (row) เหมือนกัน  

อย่างไรก็ตามหากเป็นแฟ้มข้อมูลที่สร้างด้วยโปรแกรมตารางค านวณแบบรหัสเปิด  เช่น 
Gnumeric, LibreOffice or Openoffice แฟ้มข้อมูลมีนามสกุล *.gnumeric หรือ *.ods สามารถน า
ข้อมูลเข้าโปรแกรม (importing data) ได้ทันทีโดยไม่ต้องแปลงแฟ้มข้อมูล  

ส่วนแฟ้มข้อมูลจากโปรแกรมตารางค านวณเชิงพาณิชย์ที่นิยมใช้อย่างแพร่หลาย เช่น Microsoft 
Excel (*.xls หรือ *.xlsx) และ Google Sheet (*.gsheet) ไม่สามารถน าข้อมูลเข้าโปรแกรมทันที ต้อง
ท าการแปลงแฟ้มข้อมูลที่โปรแกรม PSPP สามารถอ่านเข้าโปรแกรมได้ โดยต้องแปลงให้เป็นแฟ้มข้อมูลที่
มีเฉพาะข้อมูลตัวอักษรเท่านั้น (plain text file) เช่น แฟ้มข้อมูลที่มีตัวคั่นเป็นเครื่องหมายจุลภาค 
(Comma Separated Values) มีนามสกุล CSV (*.csv) หรือแฟ้มข้อมูลที่มีเครื่องหมายเว้นระยะ (Tab 
Separated Values) มีนามสกุล TXT (*.txt) 
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Import Data 
     

Text Files 
*.csv, *.txt และ *.prn 

 
Spreadsheet Files  

(Commercial Software) 
*.xls, *.xlsx และ *.gsheet 

 
Spreadsheet Files 

(Open Source Software) 
*.gnumeric และ *.ods 

2.1 การน าข้อมูลเข้าจากโปรแกรมตารางค านวณ 

โปรแกรมตารางค านวณเชิงพาณิชย์ที่นิยมใช้กันอย่างแพร่หลายมี 2 โปรแกรม คือ Microsoft 
Excel และ Google Sheet การทดลองแปลงแฟ้มข้อมูลทั้ง 2 โปรแกรมเป็นแฟ้มข้อมูลแบบตัวอักษร
นามสกุล CSV และน าข้อมูลเข้าโปรแกรมไม่พบปัญหาใดๆ ส่วนการแปลงแฟ้มข้อมูลนามสกุล xls , xlsx 
และ gsheet เป็นแฟ้มข้อมูลนามสกุล ODS พบปัญหาการเข้ากันไม่ได้ (incompatibility) ของข้อมูลที่ได้
จากแฟ้มข้อมูลนามสกุล xls และ xlsx ดังนั้น เพ่ือให้ผู้เรียนได้ประสบการณ์การน าข้อมูลแบบตาราง
ค านวณเข้าโปรแกรมจึงแบ่งเป็น 2 วิธี  โดยมีขั้นตอนดังนี้ 

ดาวโหลดแฟ้มข้อมูล “รายงานด้านสังคม” จากศูนย์กลางข้อมูลเปิดภาครัฐ (Open 
Government Data) ที่ https://data.go.th มา 1 ปี (ตัวอย่างปี พ.ศ. 2558) และบันทึก (Save) เป็น
แฟ้มข้อมูลชื่อ ASPSS_Data_Excel.xls 

 

๏ เปิดแฟ้มข้อมูล ASPSS_Data_Excel.xls ด้วยโปรแกรม Microsoft Excel  
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คลิกเมาส์ที่ แถบข้อมูล  ชุมชน ตัดข้อมูลแถวที่  1 (จ านวนชุมชนประเภทต่าง ๆ ใน
กรุงเทพมหานคร ณ เดือนมิถุนายน 2558) และข้อมูลแถวที่ 53 (แหล่งข้อมูล : กองการพัฒนาชุมชน 
ส านักพัฒนาสังคม กรุงเทพมหานคร) 

๏ เลือกเมนู File 
๏ โปรแกรมแสดงหน้าต่าง Home 
๏ คลิกเมาส์ที่ค าสั่ง Export -> Change File Type -> Save as Another File Type 

(หรือเลือกใช้ค าสั่ง Save As แทน Export)  
๏ กดปุ่ม Save As  

 

๏ เลือกพ้ืนที่เก็บข้อมูล ->พิมพ์ชื่อแฟ้มข้อมูลในช่อง File name: ->  
๏ เลือกประเภทแฟ้มข้อมูลใน Save as type: เป็น CSV UTF-8 (Comma delimited) 

(*.csv) 
๏ กดปุ่ม Save 
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การเลือกบันทึกแฟ้มข้อมูลเป็นแบบ UTF-8 (Universal Coded Character Set – 8 Bit) หาก
แฟ้มข้อมูลมีหลายภาษา เช่น ตัวเลข ตัวอักษรภาษาอังกฤษ ภาษาไทย และภาษาอ่ืนๆ จะท าให้การ
แสดงผลร่วมกันได้หรือแสดงภาษาผสมกัน ไม่เป็นข้อมูลที่อ่านไม่ออก 

๏ โปรแกรมแสดงข้อความเตือนว่า “ประเภทแฟ้มข้อมูลที่เลือกไม่สนับสนุนสมุดงาน 
(workbooks) ที่มีอยู่ด้วยกันหลายแผ่นงาน (sheets) ” หากต้องการบันทึกเฉพาะแผ่น
งานที่ก าลังเปิดใช้งาน (active) ให้เลือกคลิก OK  

๏ กดปุ่ม OK 

 

๏ ทดลองเปิดแฟ้มข้อมูล ASPSS_Data_Excel.csv ด้วยโปรแกรม Notepad (ดูว่ามีตัว
คั่นหรือแบ่งข้อมูลแบบใดบ้าง เพราะบางแฟ้มข้อมูลอาจมีเครื่องหมายแบ่งข้อมูลมากกว่า 
1 แบบ) 

 
 

๏ เปิดโปรแกรม PSPP 
๏ เลือกเมนู File -> Import Data … 
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๏ เลือกแฟ้มข้อมูล ASPSS_Data_Excel.csv 
๏ เมนูด้านซ้ายแสดงขั้นตอนการน าแฟ้มข้อมูลเข้า 5 ขั้นตอน 
๏ กดปุม่ Next  

 

๏ ก าหนดจ านวนข้อมูลที่ต้องการน าข้อมูลเข้า 
o All cases (ทั้งหมด) 
o Only the first … cases (จ านวน) 
o Only the first … % of file (approximately) (ร้อยละ) 

๏ กดปุ่ม Next 

 

๏ คลิกเมาส์หรือใช้คีย์บอร์ดลูกศรลง -> เลื่อนแถบสีไป Line ที่ 2 
๏ Line above selected line contains variable names (บรรทัดบนที่ เลือกเป็น

บรรทัดของชื่อตัวแปร) เลือก /   
๏ กดปุ่ม Next 
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๏ Separators (ก่อนน าแฟ้มข้อมูลเข้าต้องตรวจดูว่ามีตัวคั่นอ่ืนหรือไม่ หากมีเครื่องหมาย
คั่นแบบอ่ืน ให้เลือกด้วย) คลิกเมาส์ / ที่ Comma (,)  

๏ กดปุ่ม Next    

 

๏ ก าหนดคุณสมบัติตัวแปร (ไม่ก าหนดก็ได้ ไปก าหนดภายหลังใน Data Editor ก็ได้) 
๏ คลิกเมาส์ปุ่มขวาที่ตัวแปรรวมและเลือกค าสั่ง Clear Variables 
๏ กดปุ่ม Apply 

 

๏ โปรแกรมแสดงหน้าต่าง Data Editor พร้อม Output Viewer 
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๏ คลิกเมาส์ที่แถบ Data View ด้านล่างซ้ายของโปรแกรมเพ่ือดูข้อมูลที่น าเข้ามา 

 

บันทึกแฟ้มข้อมูลเป็นแฟ้มข้อมูลนามสกุลเป็น sav เพ่ือความสะดวกเปิดใช้ในครั้งต่อไป 

๏ เลือกเมนู File -> Save As… (Shift + Ctrl + S) 

หากข้อมูลที่เป็นภาษาไทยแสดงผลเป็นภาษาต่างด้าว ให้แก้ไข Regional format ใน Settings 
ของระบบปฏิบัติการ Windows เป็น Thai (Thailand) 

2.2 การน าข้อมูลเข้าจากแบบสอบถามออนไลน ์

ปัจจุบันนักวิ จั ยนิ ยม ใช้  Google Form สร้ า งแบบสอบถามออนไลน์  (online/digital 
questionnaire) มากขึ้น เพราะสามารถส่งแบบสอบถามผ่านอินเทอร์เน็ตไปถึงผู้ตอบได้สะดวดและ
รวดเร็ว ผลลัพธ์ที่ได้จากการส ารวจสามารถดูได้จากระบบ View Response ได้ทันที แต่หากต้องการ
น ามาวิเคราะห์ด้วยโปรแกรม PSPP ต้องบันทึกข้อมูลเข้าโปรแกรม Google Sheet เป็นแฟ้มข้อมูล
นามสกุล *.gsheet และแปลงแฟ้มข้อมูลให้เป็นแฟ้มข้อมูลแบบตัวอักษรหรือเป็นแฟ้มข้อมูลของ
โปรแกรมตารางค านวณแบบรหัสเปิด ส าหรับในที่นี้จะแปลงเป็น *.ods เพ่ือให้ผู้เรียนได้ทดลองน าเข้า
ข้อมูลจากแฟ้มข้อมูลแบบตารางค านวณ  
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เปิดแฟ้มข้อมูล “Example Spreadsheet” ของ Google Sheet จากอินเทอร์ เน็ต ( เปิด 
https://www.google.com และค้นหาค าว่า “example spreadsheet google sheet”) ที่ลิงค์ 
https://docs.google.com/spreadsheets/d/1BxiMVs0XRA5nFMdKvBdBZjgmUUqptlbs74Ogv
E2upms/edit 

 

๏  เลือกเมนู File -> Download -> OpenDocument format (.ods) 

 

๏ บันทึกแฟ้มข้อมูลเป็นชื่อ ASPSS_Data_Google.ods 
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๏ เปิดโปรแกรม PSPP 
๏ เมนู File -> Import Data … 
๏ เลือกแฟ้มข้อมูล ASPSS_Data_Google.ods 
๏ เมนูด้านซ้ายแสดงขั้นตอนการน าแฟ้มข้อมูลเข้า 3 ขั้นตอน 
๏ กดปุม่ Next 

 

๏ ในช่อง Cells: ก าหนดช่วงข้อมูล (ตรวจสอบจากแฟ้มข้อมูลให้ตรงกับที่โปรแกรม
ก าหนด) 

๏ ใน Sheet Index: เลือกตารางข้อมูล (หากมีหลายตารางข้อมูลจะแสดงชื่อให้เลือก) 
๏ Use first row as variable names (ก าหนดให้แถวแรกเป็นชื่อตัวแปร) เลือก / 
๏ กดปุ่ม Next   
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๏ ก าหนดคุณสมบัติตัวแปร (ไม่ก าหนดก็ได้ ไปก าหนดภายหลังใน Data Editor ก็ได้) 
๏ กดปุ่ม Apply 

 

๏ โปรแกรมแสดงหน้าต่าง Data Editor พร้อม Output Viewer 

 

๏ คลิกเมาส์ที่แถบ Data View ด้านล่างซ้ายของโปรแกรมเพ่ือดูข้อมูลที่น าเข้ามา 

 

๏ บันทึกแฟ้มข้อมูลเป็นแฟ้มข้อมูลนามสกุลเป็น sav เพ่ือความสะดวกเปิดใช้ในครั้งต่อไป 
๏ เลือกเมนู File -> Save As… (Shift + Ctrl + S) 
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สรุป 

 การน าข้อมูลเข้าโปรแกรม คือ การเตรียมข้อมูลเพ่ือน าข้อมูลจากแบบสอบถามหรือจากเอกสาร
ที่บันทึกข้อมูลเข้าโปรแกรมวิเคราะห์ข้อมูลและบันทึกไว้เป็นแฟ้มข้อมูล วิธีการน าข้อมูลเข้าโปรแกรมมีทั้ง
วิธีการกรอกข้อมูลด้วยตนเอง และดึงข้อมูลจากแฟ้มข้อมูลที่มีอยู่แล้ว เช่น แฟ้มข้อมูลจากโปรแกรม
ตารางค านวณ และแฟ้มข้อมูลแบบตัวอักษร 

แบบฝึกหัดท้ายบท 

 ให้ผู้เรียนฝึกสร้างแฟ้มข้อมูลจากแบบสอบถาม และน าข้อมูลจากโปรแกรมตารางค านวณเข้า
โปรแกรมดังต่อไปนี้ 

1. ให้ผู้เรียนใช้แบบสอบถามที่สร้างไว้ส ารวจข้อมูลภายในชั้นเรียนคนละ 5 ชุด และกรอกข้อมูล
เข้าโปรแกรม 

2. ให้ผู้เรียนสร้างแบบสอบถามออนไลน์ด้วย Google Form และส ารวจข้อมูลภายในชั้นเรียน
คนละ 5 ชุด 

3. ให้ผู้เรียนแปลงแฟ้มข้อมูลที่ได้จากแบบสอบถามออนไลน์และน าข้อมูลเข้าโปรแกรม 
4. ให้ผู้เรียนค้นหาแฟ้มข้อมูลแบบตารางค านวณ (*.xls และ *.xlsx) และแฟ้มข้อมูลแบบ

ตัวอักษร (*.csv) และทดลองน าข้อมูลเข้าจากแฟ้มข้อมูล 

  





 

 

บทที่ 7 
การจัดการข้อมูล 

ความมุ่งหมายของบทเรียน 
ผู้เรียนสามารถเลือกใช้ข้อมูลและเปลี่ยนรูปแบบข้อมูลให้ตรงกับวัตถุประสงค์ของการวิเคราะห์

ข้อมูล 

เนื้อหา 
1. การปรับข้อมูล 

2. การเปลี่ยนรูปแบบข้อมูล 

วิธีการสอนและกิจกรรมการเรียนการสอน 
บรรยาย อธิบาย แสดงตัวอย่าง และท าแบบฝึกหัดท้ายบท 

สื่อและอุปกรณ์การสอน 
เอกสารค าสอน ภาพเลื่อน คอมพิวเตอร์ โปรแกรม PSPP โปรแกรมสอนออนไลน์ (สอนแบบ

ออนไลน์) และเครื่องฉาย (สอนในชั้นเรียน) 

งานที่มอบหมาย 

 ท าแบบฝึกหัดท้ายบท 

การวัดผลและประเมินผล 

การเข้าชั้นเรียน สังเกตความสนใจจากการเรียน สอบถามความเข้าใจจากการบรรยาย และการ

ท าแบบฝึกหัดท้ายบท  
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เนื้อหา 

 การจัดการข้อมูล (Data Management) คือ การปรับข้อมูล (data manipulation) ที่เป็นตัว

แปรหรือค่าของตัวแปรในแฟ้มข้อมูล เช่น เลือกข้อมูล (selecting data) บางส่วนมาวิเคราะห์ หรือ

เปลี่ยนรูปแบบข้อมูล (data transformation) ให้เป็นตัวแปรใหม่หรือมีค่าของตัวแปรเป็นค่าใหม่  

 ค าสั่งที่ใช้ในการจัดการข้อมูลมี 2 กลุ่มค าสั่ง คือ Data และ Transform ทั้ง 2 ค าสั่งจะมีผลท า

ให้แฟ้มข้อมูลมีการเปลี่ยนแปลงแบบชั่วคราว (temporarily) แต่จะมีผลท าให้แฟ้มข้อมูลมีการ

เปลี่ยนแปลงแบบถาวร (permanently) เมื่อท าการบันทึกแฟ้มข้อมูล (save) บางค าสั่งโปรแกรมจะ

แสดงสถานะของแต่ละค าสั่งเป็น off หรือ by ในแถบสถานะภาพการท างานด้านล่าง โดยมีรายละเอียด

ดังต่อไปนี้ 

Data Transform 

- Sort Cases… (การจัดเรียงตัวอย่าง) 

- Transpose… (การไขว้ตัวแปรและตัวอย่าง) 

- Aggregate… (การรวมค่าของกลุ่มตัวอย่าง) 

- Split File… (การแบ่งกลุ่มตัวอย่าง)* 

- Select Cases… (การเลือกตัวอย่าง)* 

- Weight Cases… (กา รก า หนดน้ า ห นั ก

ตัวอย่าง) * 

- Compute… (การสร้างตัวแปรแบบค่าตัวเลข) 

- Count… (การนับจ านวนตัวอย่าง) 

- Rank Cases… (การจัดล าดับตัวอย่าง) 

- Automatic Recode…(การเปลี่ยนค่าตัวแปรเป็นตัว

แปรใหม่แบบอัตโนมัติ) 

- Recode into Same Variables… (การเปลี่ยนค่าตัว

แปรในตัวแปรเดิม) 

- Recode into Different Variables… (การเปลี่ยน

ค่าตัวแปรเป็นตัวแปรใหม่) 

- Run Pending Transforms (การสั่งประมวลผลต่อ) 

 

*ค าสั่งแบบชั่วคราวจนกว่าจะมีการยกเลิกใช้ค าสั่ง (turn off) หรือก าหนดให้เป็นค่าปกติ (default 

value) 

บทนีจ้ะใช้แฟ้มข้อมูล ASPSS_Data.sav ที่เคยสร้างไว้ในบทที่ 5 การน าข้อมูลเข้าโปรแกรม และ 

hotel.sav ในโฟลเดอร์ examples (C:\Program Files\PSPP\share\pspp\examples) โดยสามารถ

เปิดใช้งานพร้อมกัน และสลับเลือกใช้งานจากเมนู Windows ดังนี้ 
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 การเลือกตัวแปรในรายการตัวแปรด้านซ้ายในหน้าต่างของแต่ละค าสั่ง มี 2 วิธี คือ ใช้เมาส์ชี้ที่ชื่อ

ตัวแปรที่ต้องการเลือกแล้วกดปุ่มแบบดับเบิลคลิกท่ีปุ่มซ้ายของเมาส์ หรือใช้เมาส์ชี้ที่ชื่อตัวแปรที่ต้องการ

เลือก แล้วกดปุ่มลูกศร  

1. การปรับข้อมลู 

การปรับข้อมูล คือ การเปลี่ยนแปลงรูปแบบของข้อมูลทั้งหมด (global changes) ในชุดข้อมูล 

เช่น การจัดเรียงข้อมูล การไขว้ตัวแปร การรวมข้อมูล การแบ่งข้อมูล การเลือกข้อมูล และการก าหนด

น้ าหนักข้อมูล โดยมีรายละเอียดดังต่อไปนี้  

1.1 การจัดเรียงตัวอย่าง  

การจัดเรียงตัวอย่าง (Sort Cases) คือ การเรียงตัวอย่างตามค่าของตัวแปร 1 ตัวแปร หรือหลาย

ตัวแปร และสามารถเลือกเรียงล าดับจากค่าน้อยไปมาก (ascending order: 1-9 or A-Z) หรือจากค่า

มากไปน้อย (ascending order: 9-1 or Z-A) โดยมีวิธีการดังนี้ 

๏ เลือกเมนู Data -> Sort Cases… 

๏ Sort by: เลือกตัวแปรค่าจัดประเภท/ค่าต่อเนื่อง 1 ตัวแปรหรือมากกว่า จากรายการตัวแปร
ด้านซ้าย  

๏ ในกลุ่มค าสั่ง Sort Order เลือกวิธีการจัดเรียง 

o Ascending (เรียงจากค่าน้อยไปมาก เช่น 1->9 หรือ A->Z) 
o Descending (เรียงจากค่ามากไปน้อย เช่น 9->1 หรือ Z->A) 

๏ กดปุ่ม OK 
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ตัวอย่าง: การจัดเรียงตัวอย่างด้วยตัวแปร Gender และ Age จากค่าน้อยไปมาก 

 
 

 

1.2 การไขว้ตัวแปรและตวัอย่าง  

 การไขว้ตัวแปรและตัวอย่าง (Transpose) คือ การสลับตัวแปร (variables) ที่อยู่ในรูปของ

สดมภ์ (columns) ไปเป็นตัวอย่าง (cases) อยู่ในรูปของแถว (rows) และสลับตัวอย่าง (cases) ที่อยู่ใน

รูปของแถว (rows) ไปเป็นตัวแปร (variables) อยู่ในรูปของสดมภ์ (columns)  

ตัวแปรที่ต้องการไขว้ไปเป็นตัวอย่าง ต้องเป็นตัวแปรแบบตัวเลข (numeric variables) และตัว

แปรที่ต้องการไขว้ค่าของตัวแปรไปเป็นตัวแปรใหม่ควรเป็นตัวแปรแบบตัวอักษร (string variables) 

เพราะค่าตัวแปรที่เป็นตัวเลข ตัวเลขแรกจะถูกเป็นตัวอักษร V ทั้งหมด โดยมีวิธีการดังนี้ 

๏ เมนู Data -> Transpose… 

๏ Variables: เลือกตัวแปรค่าต่อเนื่อง 1 ตัวแปรหรือมากกว่า (ตัวแปร -> ตัวอย่าง) จาก
รายการตัวแปรด้านซ้าย 

๏ Name Variables: เลือกตัวแปรค่าจัดกลุ่มในช่องด้านซ้าย 1 ตัวแปร (ตัวอย่าง -> ตัวแปร) 
๏ กดปุ่ม OK 

ตัวอย่าง: การไขว้ตัวแปร Age และ Edu เป็นตัวอย่าง และไขว้ค่าใน Province เป็นตัวแปร 
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1.3 การรวมกลุม่ตัวอย่าง  

 การรวมกลุ่มตัวอย่าง (Aggregate) คือ การรวมกลุ่ม (summarizes groups) ของตัวอย่าง 

(cases) ที่มีค่าเหมือนกันจากหลายตัวแปร (break variables) เช่น รวมรายได้ อายุ และประสบการณ์

ท างานของตัวอย่างที่มีระบบการศึกษาเหมือนกันให้เป็นกลุ่มการศึกษา โดยเลือกสร้างเป็นชุดข้อมูลใหม่ 

(data set) หรือสร้างเป็นแฟ้มข้อมูล (file) ใหม่ก็ได้ โดยมีวิธีการดังนี้ 

๏ เลือกเมนู Data -> Aggregate… 
๏ Break variable(s): เลือกตัวแปรค่าจัดกลุ่ม 1 ตัวแปร จากรายการตัวแปรด้านซ้าย 
๏ ในกลุ่มค าสั่ง Aggregated variables: ก าหนดวิธีการรวมค่าของกลุ่มตัวอย่าง 

o Variable Name: พิมพ์ชื่อตัวแปรที่เป็นค่ารวมกลุ่มข้อมูล  
o Variable Label: พิมพ์ค าอธิบายตัวแปร 
o ในกลุ่มค าสั่ง Functions: เลือกวิธีการรวมกลุ่มข้อมูล 

- Sum of values (ค่ารวม) 

- Mean average (ค่าเฉลี่ย) 

- Median average (ค่าเฉลี่ยมัธยฐาน) 

- Standard deviation (ค่าเบี่ยงเบนมาตรฐาน) 

- Maximum value (ค่าสูงสุด) 

- Minimum value (ค่าต่ าสุด) 

- Percentage greater than (ค่าร้อยละที่มากกว่า) 

- Percentage less than (ค่าร้อยละที่น้อยกว่า) 

- Percentage included in range (ค่าร้อยละที่อยู่ในช่วง) 

- Percentage excluded from range (ค่าร้อยละที่ไม่อยู่ในช่วง) 

- Fraction greater than (เศษส่วนที่มากกว่า) 

- Fraction less than (เศษส่วนที่น้อยกว่า) 

- Fraction included in range (เศษส่วนที่อยู่ในช่วง) 

- Fraction excluded from range (เศษส่วนที่ไม่อยู่ในช่วง) 

- Number of cases (จ านวนของตัวอย่าง) 

- Number of cases (unweighted) (จ านวนของตัวอย่างที่ไม่ถ่วงน้ าหนัก) 
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- Number of missing values (จ านวนของค่าสูญหาย) 

- Number of missing values (unweighted) (จ านวนของค่าสูญหายที่ไม่ถ่วงน้ าหนัก) 

- First non-missing value (ค่าแรกของค่าปกติ) 

- Last non-missing value (ค่าสุดท้ายของค่าปกติ) 

o เลือกตัวแปรที่ต้องการรวมกลุ่มข้อมูล 1 ตัวแปร จากรายการตัวแปรด้านซ้ายใส่ใน
ช่องว่างหลังปุ่มลูกศร 

o Argument 1: และ Argument 2: ก าหนดเงื่อนไขการรวบกลุ่มข้อมูล (บาง Functions 
เช่น Percentage included in range -> Argument1: ค่าเริ่มต้น และ Argument 2: 
ค่าสิ้นสุด)   

๏ กดปุม่ Add เพ่ือใส่ค าสั่งการรวมกลุ่มตัวอย่างเข้าโปรแกรม 
๏ ในกลุ่มค าสั่ง Save ก าหนดวิธีการสร้างผลลัพธ์ 

o Add aggregated variables to the active dataset (เพ่ิมตัวแปรการรวมกลุ่มตัวอย่าง
ลงในชุดข้อมูลที่เปิดใช้งาน) 

o Replace the current dataset with the aggregated variables (สร้ า งตั วแปรการ
รวมกลุ่มตัวอย่างแทนที่ชุดข้อมูลที่เปิดใช้งาน) 

o Write a new data file containing only the aggregated variables (สร้างแฟ้มข้อมูล
ใหม่ มีเฉพาะตัวแปรการรวมกลุ่มตัวอย่าง) 

๏ ในกลุ่มค าสั่ง Options for very large datasets ก าหนดวิธีการจัดเรียงตัวอย่าง (กรณี
เป็นชุดข้อมูลขนาดใหญ่มาก) 
o File is already sorted on break variables(s). (แฟ้มข้อมูลท าการจัดเรียงตัวอย่างแล้ว) 
o Sort file before aggregating. (จัดเรียงตัวอย่างก่อนท าการรวมกลุ่มตัวอย่าง) 

๏ กดปุ่ม OK 

ตัวอย่าง: การรวมค่าของตัวแปร Age เป็นค่าเฉลี่ยในแต่ละกลุ่มของตัวแปร Gender 
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1.4 การแบ่งกลุม่ตัวอย่าง  

 การแบ่งกลุ่มตัวอย่าง (Split File) คือ การแบ่งกลุ่มตัวอย่างในแฟ้มข้อมูลตามค่าของตัวแปรแบบ

จัดประเภท (categorical variables) เพ่ือวิเคราะห์ตัวอย่างเป็นกลุ่มย่อยแบบชั่วคราว (temporary) 

จนกว่าจะยกเลิกการแบ่งกลุ่ม โดยมีวิธีการดังนี้ 

๏ ทดลองวิเคราะห์ค่าเฉลี่ยของอายุ 
o เลือกเมนู Analyze -> Descriptive Statistics -> Descriptives…  
o Variables: เลือกตัวแปร Age ในรายการตัวแปรด้านซ้าย 

๏ เลือกเมนู Data -> Split File… 
๏ ในกลุ่มค าสั่งด้านขวามือ เลือกวิธีการแบ่งกลุ่มตัวอย่าง 

o Analyze all cases. Do not create groups. (ไม่แบ่งกลุ่ม หรือ Split File Off) 
o Compare groups. (เปรียบเทียบค่าเฉลี่ยแต่ละกลุ่ม) 
o Organize output by groups. (แบ่งแสดงผลแต่ละกลุ่ม) 

๏ Groups based on: เลือกตัวแปรค่าจัดกลุ่ม 1 ตัวแปรหรือมากกว่า จากรายการตัวแปร
ด้านซ้าย 

๏ เลือกวิธีการจัดเรียงกลุ่ม 
o Sort the file by grouping variables. (เรียงกลุ่มตามตัวแปร) 
o File is already sorted. (แฟ้มข้อมูลนี้จัดเรียงกลุ่มแล้ว) 

๏ กดปุ่ม OK 
๏ ทดลองวิเคราะห์ค่าเฉลี่ยของอายุอีกครั้งและดูเปรียบเทียบผลลัพธ์ 

 

ตัวอย่าง: ผลการวิเคราะห์ค่าเฉลี่ยของตัวแปร Age ด้วยการแบ่งกลุ่มด้วยตัวแปร Gender 
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1.5 การเลือกตัวอย่าง  

 การเลือกตัวอย่าง (Select Cases) คือ การก าหนดเงื่อนไขเพ่ือเลือกตัวอย่างส าหรับใช้วิเคราะห์ 

ข้อมูลที่ไม่ถูกเลือกตามเงื่อนไขจะถูกลบออกจากชุดข้อมูลที่ใช้วิเคราะห์ (data stream) แบบชั่วคราว 

(temporary) จนกว่าเงื่อนไขที่ก าหนดไว้จะถูกยกเลิก โดยมีวิธีการดังนี้ 

เงื่อนไขที่เป็นค่าปกติ (default) คือ เลือกทั้งหมด (all cases) และมีตัวเลือก คือ เลือกสุ่มเป็น 

จ านวนร้อยละ (random) เลือกเฉพาะช่วงข้อมูล (range) และเลือกเฉพาะตัวอย่างที่ไม่มีค่าขาดหาย 

(use filter variable) ข้อมูลที่ไม่ถูกเลือก โดยมีวิธีการดังนี้ 

๏ เลือกเมนู Data -> Select Cases… 
๏ ในกลุ่มค าสั่ง Select เลือกวิธีการเลือกตัวอย่าง 

o All Cases (เลือกทั้งหมด หรือ Filter off) 
o Random sample of cases (สุ่มขนาดตัวอย่างเป็นจ านวนร้อยละ) 

- ก าหนดจ านวนร้อยละ 

- กดปุ่ม Continue  

o Based on time or case range (เลือกตัวอย่างตามช่วงที่ก าหนด) 
- ก าหนดช่วงตัวอย่าง 

- กดปุ่ม Continue 

o Use filter variable (ใช้ตัวแปรเลือกตัวอย่างท่ีไม่มีค่าเป็น 0 หรือค่าสูญหาย) 
- เลือกตัวแปรจากช่องด้านซ้าย -> ใส่ในช่องว่าง 

- กดปุ่ม Continue 

๏ ในกลุ่มค าสั่ง Unselected Cases Are ก าหนดวิธีการเลือกตัวอย่าง 
o Filtered (กรองออกด้วยการท าสัญลักษณ์เป็นเครื่องหมาย \ ที่หน้าข้อมูลของแต่ละ

ตัวอย่าง) 
o Deleted (ลบออกจากชุดข้อมูล) 

๏ กดปุ่ม OK 
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ตัวอย่าง: การเลือกตัวอย่างด้วยวิธีสุ่มขนาดตัวอย่างเป็นจ านวนร้อยละและเลือกตัวอย่างตามช่วงที่

ก าหนด 

 

 

 

 

 

1.6 การก าหนดน้ าหนักตวัอย่าง  

 การก าหนดน้ าหนักตัวอย่าง (Weight Cases) คือ การก าหนดจ านวนตัวอย่างในการวิเคราะห์ให้

มีจ านวนที่แตกต่างไปจากเดิมแบบชั่วคราว (temporary) ตามสัดส่วนของค่าในตัวแปรดัชนีที่มีอยู่ใน

แฟ้มข้อมูล จนกว่าจะยกเลิกการก าหนดน้ าหนักตัวอย่าง โดยมีวิธีการดังนี้ 

๏ ทดลองวิเคราะห์เปรียบเทียบค่าเฉลี่ยอายุระหว่างกลุ่มเพศ 
๏ เลือกเมนู Analyze -> Compare Means -> Means…  

o Dependent List: เลือกตัวแปร Age จากรายการตัวแปรด้านซ้าย 
o Independent List: เลือกตัวแปร Gender จากรายการตัวแปรด้านซ้าย 
o กดปุ่ม OK 

๏ ใช้ค าสั่ง Aggregate สร้างตัวแปร Gender_freq เพ่ือรวมอายุของกลุ่มตัวอย่าง 
๏ เลือกเมนู Data -> Weight Cases… 
๏ ในกลุ่มค าสั่งด้านขวา เลือกวิธีการก าหนดน้ าหนักตัวอย่าง 

o Do not weight cases (ไม่ก าหนดน้ าหนักตัวอย่าง หรือ Weight Off) 
o Weight cases by (ก าหนดน้ าหนักจากตัวแปรที่เลือก) 

- เลือกตัวแปรความถี่จากรายการตัวแปรในช่องด้านซ้าย -> Frequency Variable 

๏ กดปุ่ม OK 
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๏ ทดลองวิเคราะห์เปรียบเทียบค่าเฉลี่ยอายุระหว่างกลุ่มเพศอีกครั้งและดูเปรียบเทียบผลลัพธ์ 

ตัวอย่าง: ผลการวิเคราะห์ค่าเฉลี่ยตัวแปร Age ก่อนและหลังการก าหนดน้ าหนักตัวอย่างด้วยตัวแปร 

Gender 
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2. การแปลงข้อมูล 

 การแปลงข้อมูล คือ การเปลี่ยนแปลงข้อมูลเฉพาะตัวแปรที่เลือก  เช่น การเปลี่ยนค่าของตัวแปร 

การสร้างตัวแปรใหม่  

2.1 การสร้างตัวแปรแบบค่าต่อเนื่อง  

 การสร้างตัวแปรแบบค่าต่อเนื่อง (Compute) คือ การสร้างหรือเปลี่ยนค่าตัวแปรที่มีค่าเป็น

ตัวเลขแบบต่อเนื่อง (numeric) ให้เป็นตัวแปรใหม่ โดยใช้ฟังก์ชั่น (function) ทางคณิตศาสตร์ เช่น + 

(บวก) – (ลบ) * (คูณ) / (หาร) Sum (ผลรวม) Mean (ค่าเฉลี่ย) SD (ค่าเบี่ยงเบนมาตรฐาน) Median 

(ค่ามัธยฐาน) Mod (ฐานนิยม)  เขียนเป็นนิพจน์เชิงตัวเลข (numerical expression) โดยมีวิธีการดังนี้ 

๏ เลือกเมนู Transform -> Compute… 
๏ Target Variable: พิมพ์ชื่อตัวแปรใหม่ 
๏ กดปุ่ม Type & Label… -> ก าหนดรายละเอียดเกี่ยวกับตัวแปร เช่น ค าอธิบายชื่อตัวแปร 

และประเภทตัวแปร (ไม่ก าหนดก็ได้) 
๏ ในช่อง Numeric Expression สร้างนิพจน์เชิงตัวเลข มี 2 วิธีการดังนี้ 

o สร้างนิพจน์เชิงตัวเลขเอง เช่น Age+5 หรือ V1+V2+V3 หรือ (V1+V2+V3)/3  
o เลือกใช้โปรแกรมฟังก์ชั่นในกลุ่มค าสั่ง Functions: เช่น SUM(V1, V2, V3) หรือ MEAN 

(V1, V2, V3) 

ตัวอย่าง: การสร้างตัวแปร Age_new5 โดยเพิ่มค่า 5 ปี ในตัวแปร Age และการสร้างตัวแปรคะแนน

เฉลี่ยความพึงพอใจ Sat_avg จากตัวแปรคะแนนความพึงพอใจ 5 ตัวแปร (V1, V2, V3, V4, V5) 
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2.2 การนับจ านวนข้อมูล  

 การนับจ านวนข้อมูล (Count) คือ การสร้างตัวแปรใหม่จากการนับค่าตามเงื่อนไข (criterion 

value) ที่เกิดขึ้น (occurrences) ภายในรายการตัวแปร (variable) ของแต่ละตัวอย่าง (cases) โดยมี

วิธีการดังนี้ 

๏ เลือกเมนู Transform -> Count… 
๏ Target Variable: พิมพ์ชื่อตัวแปรใหม่ 
๏ Numeric Variables: เลือกตัวแปรในช่องรายการตัวแปรที่ต้องการนับค่า 
๏ กดปุ่ม Define Values…  
๏ เลือกวิธีการนับค่า 

o Value: (ค่าใดค่าหนึ่งของตัวแปร) 
o System Missing (ค่าสูญหายของระบบ) 
o System or User Missing (ค่าสูญหายของระบบหรือผู้ใช้) 
o Range: (ช่วงค่าของตัวแปร) 
o Rang, LOWEST thru value (ช่วงค่าของตัวแปรที่ก าหนดถึงค่าต่ าสุด) 

o Rang, value thru HIGHEST (ช่วงค่าของตัวแปรที่ก าหนดถึงค่าสูงสุด) 
๏ ในกลุ่มค าสั่ง Values to Count: กดปุ่ม Add 
๏ กดปุ่ม Continue 
๏ กดปุ่ม OK 
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ตัวอย่าง: การนับจ านวนค่า 2 และ 3 ในตัวแปร Gender และ Edu และสร้างเป็นตัวแปร 

GE_Count_23 

 

 

 

 

 

 

2.3 การจัดล าดับตัวอย่าง  

 การจัดล าดับตัวอย่าง (Rank Cases) คือ การสร้างตัวแปรใหม่จากการจัดล าดับกลุ่มตัวอย่างด้วย

การจัดเรียงค่า (order) ของตัวแปรประเภทตัวเลข (numeric variables) ตามค าสั่ งที่ก าหนด 

(mandatory) เช่น ค่าที่เท่ากัน (tied) ค่าล าดับที่ (rank) ค่าเปอร์เซ็นต์ไทล์ (percentile) ค่าสัดส่วน 

(proportion) ฯลฯ โดยมีวิธีการดังนี้ 

๏ เลือกเมนู Transform -> Rank Cases… 
๏ Variable(s): เลือกตัวแปรแบบค่าต่อเนื่อง 1 ตัวแปรหรือมากกว่า จากรายการตัวแปร

ด้านซ้าย 
๏ By: เลือกหรือไม่เลือกตัวแปรก็ได้ 
๏ ในกลุ่มค าสั่ง Assign rank 1 to: เลือกวิธีจัดล าดับ 

o Smallest Value (ค่าน้อยสุด) 
o Largest Value (ค่ามากสุด) 

๏ กดปุ่ม Rank Types เพ่ือเลือกประเภทการจัดล าดับ 
o Rank (จัดล าดับ) 
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o Fractional rank as % (ค่าร้อยละของล าดับค่าเศษส่วน) 
o Savage score (คะแนนดิบ) 
o Sum of case weights (ค่ารวมของการก าหนดน้ าหนักของตัวอย่าง) 
o Fractional rank (ล าดับของค่าเศษส่วน) 
o Ntiles (ค่าเปอร์เซ็นไทล์) 
o Proportion Estimates (ประมาณการของค่าสัดส่วน) 
o Normal Scores (คะแนนมาตรฐาน) 
o ในกลุ่มค าสั่ง Proportion Estimation Formula เลือกสูตรการประมาณการค่าสัดส่วน 

- Blom (บลอม) 

- Tukey (ทูกีย์) 

- Rankit (รันชิต) 

- Van der Waerden (แวน เดอ แวร์เดน) 

๏ กดปุ่ม Continues 
๏ กดปุ่ม Ties… เพ่ือก าหนดวิธีจัดอันดับหากมีค่าเท่ากัน 

o Mean (ค่าเฉลี่ย) 
o Low (ค่าน้อย) 
o Hight (ค่ามาก) 
o Sequential ranks to unique value (เรียงอันดับต่อไปจนถึงค่าที่ไม่เท่ากัน) 

๏ กดปุ่ม Continuous 
๏ กดปุ่ม OK 

ตัวอย่าง: การจัดล าดับตัวอย่างด้วยตัวแปร Age โดยใช้ Rank และ Ntiles 
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2.4 การสร้างตัวแปรแบบอัตโนมัติ  

 การสร้างตัวแปรแบบอัตโนมัติ (Automatic Recode) คือ การสร้างตัวแปรใหม่โดยให้โปรแกรม

เปลี่ยนค่าตัวแปรที่เป็นตัวอักษร (string) ให้เป็นตัวเลข (numeric) แบบอัตโนมัติ ค่าใหม่ที่เป็นตัวเลขเกิด

จากการใช้ตัวอักษรไปเทียบค่ากับรหัสอักขระ (character code) แล้วแปลงเป็นตัวเลขตามล าดับ เช่น 

ค่าท่ีเป็นตัวอักษรในตัวแปรเพศที่มีค่าเป็น “ชาย” ถูกเปลี่ยนเป็น 1 และ “หญิง” ถูกเปลี่ยนเป็น 2 แต่ถ้า

เป็น “male” ถูกเปลี่ยนเป็น 2 และ “female” ถูกเปลี่ยนเป็น 1 

๏ เลือกเมนู Transform -> Automatic Recode… 
๏ Old: เลือกตัวแปรแบบตัวอักษรในช่องรายการตัวแปร 1 ตัวแปรหรือมากกว่า  
๏ New Name: คลิกเมาส์ที่ชื่อตัวแปรเก่า -> พิมพ์ชื่อตัวแปรใหม่ 
๏ กดปุ่ม Add New Name (ใส่ชื่อตัวแปรใหม่ในช่อง New) 
๏ เลือกวิธีการสร้างตัวแปรแบบอัตโนมัติ 

o Recode starting form (สร้างค่าตัวแปรจาก) 
- Lowest value (ค่าน้อยสุด) 

- Highest value (ค่ามากสุด) 

o Use the same recode scheme for all variables (ใช้วิธีการแปลงค่าเหมือนกันทุกตัว
แปร) 

o Treat blank string values as missing (ตัวแปรที่มีค่าว่างให้ท าเป็นค่าสูญหาย) 
๏ กดปุ่ม OK 

ตัวอย่าง: การสร้างรหัสหรือค่าตัวแปรใหม่แบบอัตโนมัติจากตัวแปรที่มีค่าเป็นตัวอักษร 
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2.5 การเปลี่ยนค่าตัวแปรในตัวแปรเดิม  

 การเปลี่ยนค่าตัวแปรในตัวแปรเดิม (Recode into Same Variables) คือ การแทนค่าหรือ

เปลี่ยนค่าเก่าให้เป็นค่าใหม่ในตัวแปรเดิม การเปลี่ยนค่าตัวแปรแบบนี้ต้องมั่นใจว่าจะไม่ใช้ค่าเดิมแล้ว โดย

มีวิธีการดังนี้ 

๏ เลือกเมนู Transform -> Recode into Same Variables… 
๏ Variables: เลือกตัวแปรแบบตัวเลข/ตัวอักษร 1 ตัวแปรหรือมากกว่า จากรายการตัวแปร

ด้านซ้าย -> คลิกเมาส์ที่ชื่อตัวแปรในช่อง Variables  
๏ กดปุ่ม Old and New Values… 

o ในกลุ่มค าสั่งด้านซ้าย ก าหนดค่าเก่าของตัวแปร 
- Value: (ค่าใดค่าหนึ่งของตัวแปร) 

- System Missing (ค่าสูญหายของระบบ) 

- System or User Missing (ค่าสูญหายของระบบหรือผู้ใช้) 

- Rang:  through (ช่วงจากค่า…ถึงค่า…) 

- Range, LOWEST thru value (ช่วงจากค่าต่ าสุดถึงค่า…) 

- Range, value thru HIGHEST (ช่วงจากค่าสูงสุดถึงค่า…) 

- All other values (ค่าอ่ืนๆทั้งหมด) 

o ในกลุ่มค าสั่ง New Value ก าหนดค่าใหม่ 
- Value (ค่าใหม่) 

- System Missing (ก าหนดให้เป็นค่าสูญหายของระบบ) 

- กดปุ่ม Add (เพ่ิมค่า) หรือ Edit (แก้ไข) หรือ Remove (ลบทิ้ง) 

o กดปุ่ม Continue 
๏ กดปุ่ม OK 
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ตัวอย่าง: การแปลงตัวแปร Gender ให้เป็นตัวแปรหุ่น (dummy variables) โดยการแทนค่าเดิม 1 = 

Male และ 2 = Female ให้เป็นค่าใหม่ 1 = Female และ 0 = Non-femle 

 

 

 

 

2.6 การสร้างตัวแปรแบบค่าจัดกลุ่ม  

 การสร้างตัวแปรแบบค่าจัดกลุ่ม (Recode into Different Variables) คือ การสร้างตัวแปรจาก

ค่าเก่าที่เป็นค่าต่อเนื่องหรือค่าจัดกลุ่มให้เป็นตัวแปรใหม่มีค่าเป็นค่าจัดกลุ่ม โดยยังคงเก็บชื่อตัวแปรและ

ค่าของตัวแปรไว้ตามเดิม โดยมีวิธีการดังนี้ 

๏ เลือกเมนู Transform -> Recode into Different Variables… 
๏ Variables: เลือกตัวแปรแบบตัวเลข/ตัวอักษรในช่องรายการตัวแปร 1 ตัวแปรหรือมากกว่า 
๏ ใต้ค าว่า Old ในช่อง Variables: คลิกเมาส์ที่ชื่อตัวแปรเก่า 
๏ ในกลุ่มค าสั่ง Output Variable ช่อง Name:  พิมพ์ชื่อตัวแปรใหม่ และช่อง Label: 

ค าอธิบายของตัวแปรใหม่ -> กดปุ่ม Change (หากมีหลายตัวแปรให้ท าวิธีเดียวกัน) 
๏ กดปุ่ม Old and New Values… 

o ในกลุ่มค าสั่งด้านซ้าย ก าหนดค่าเก่าของตัวแปร 
- Value: (ค่า) 

- System Missing (ค่าสูญหายของระบบ) 

- System or User Missing (ค่าสูญหายของระบบหรือผู้ใช้) 

- Rang:  through (ช่วงจากค่า…ถึงค่า…) 

- Range, LOWEST thru value (ช่วงจากค่าต่ าสุดถึงค่า…) 

- Range, value thru HIGHEST (ช่วงจากค่าสูงสุดถึงค่า…) 
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- All other values (ค่าอ่ืนๆทั้งหมด) 

o ก าหนดค่าใหม่ในกลุ่มค าสั่ง New Value 
- Value (ค่าใหม่) 

- System Missing (ก าหนดให้เป็นค่าสูญหายของระบบ) 

- Copy old values (ส าเนาหรือใช้ค่าเก่า) 

- กดปุ่ม Add (เพ่ิมค่า) หรือ Edit (แก้ไข) หรือ Remove (ลบทิ้ง) 

o ก าหนดคุณลักษณะของตัวแปรดังนี้ (หากต้องการแปลงตัวแปรให้เป็นตัวแปรแบบ
ตัวอักษรหรือตัวแปรแบบตัวเลข) 

- Output variables are stringsWidth: (ก าหนดเป็นตัวแปรแบบตัวอักษร) 

- Covert numeric strings to numbers (‘5’ -> 5) (เปลี่ยนตัวเลขแบบตัวอักษรเป็นค่า

แบบจ านวน) 

o กดปุ่ม Continue 
๏ กดปุ่ม OK 

ตัวอย่าง: การจัดกลุ่มตัวอย่างจากตัวแปร Age ที่เป็นค่าต่อเนื่องให้เป็นตัวแปรมีค่าเป็นกลุ่มอายุ (1 = 

ต่ ากว่า 15 ปี 2 = 15 ถึง 59 ปี และ 3 = 60 ขึ้นไป)  
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2.7 การสั่งประมวลผลตอ่  

 การสั่งประมวลผลต่อ (Run Pending Transforms) คือ การสั่งให้โปรแกรมท างานต่อระหว่าง

โปรแกรมหยุดการประมวลผลเพ่ือเตือนให้ตรวจสอบและแก้ไข (ในแถบสถานการณ์ท างานด้านล่างจะ

แสดงขอ้ความว่า Transformation Pending) เมื่อตรวจสอบหรือแก้ไขแล้วจึงสั่งให้ประมวลผลต่อ โดยมี

วิธีการดังนี้ 

๏ เลือกเมนู Transform -> Run Pending Transforms (เมื่อโปรแกรมเตือนให้ตรวจสอบ
หรือแก้ไข ข้อความ Run Pending Transforms จะเปลี่ยนเป็นสีเข้ม) 

 

สรุป 

 การจัดการข้อมูล คือ การปรับข้อมูลหรือค่าของตัวแปรในแฟ้มข้อมูลเพ่ือเลือกข้อมูลบางส่วนมา

วิเคราะห์ หรือเปลี่ยนข้อมูลให้เป็นตัวแปรใหม่หรือมีค่าของตัวแปรเป็นค่าใหม่ 

 ค าสั่งที่ใช้ในการจัดการข้อมูลมีทั้งค าสั่งแบบชั่วคราวที่มีผลต่อค าสั่งต่อไปที่ใช้เท่านั้น  และค าสั่ง

แบบถาวรที่มีผลต่อการเปลี่ยนแปลงของชุดข้อมูลตลอดไป ค าสั่งที่ใช้ในการจัดการข้อมูลแบ่งได้เป็น 2 

กลุ่ม ดังนี้ 
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1. ค าสั่งส าหรับการปรับข้อมูล เป็นค าสั่งที่ใช้ในการเปลี่ยนแปลงรูปแบบของข้อมูลทั้งหมดในชุด

ข้อมูล เช่น การจัดเรียงข้อมูล การไขว้ตัวแปร การรวมข้อมูล การแบ่งข้อมูล การเลือกข้อมูล และการ

ก าหนดน้ าหนักข้อมูล 

2. ค าสั่งส าหรับการแปลงข้อมูล เป็นค าสั่งที่ใช้ในการเปลี่ยนแปลงข้อมูลเฉพาะตัวแปรที่เลือก 

เช่น การเปลี่ยนค่าของตัวแปร การสร้างตัวแปรใหม่ 

แบบฝึกหัดท้ายบท 

 ให้ผู้เรียนฝึกจัดการข้อมูลและแปลงข้อมูลดังต่อไปนี้ 

1. เปิดแฟ้มข้อมลู ASPSS_Data.sav และจัดการข้อมูลด้วยค าสั่งดังต่อไปนี้ 

    - Transpose -> ไขว้ ข้ อมู ล ใ นแ ฟ้มข้ อมู ล ที่ บั นทึ ก เ ก็ บ ไ ว้ ใ ห้ เ หมื อนกั บ ข้ อ มู ล ใ น 

ASPSS_Data.sav  

    - Aggregate -> การรวมค่าของตัวแปร Age เป็นค่าเฉลี่ยในแต่ละกลุ่มของตัวแปร Edu  

    - Split File -> วิเคราะห์ค่าเฉลี่ยของตัวแปร Age ด้วยการแบ่งกลุ่มด้วยตัวแปร Edu  

    - Select Cases -> เลือกตัวอย่างด้วยวิธีสุ่มขนาดตัวอย่างเป็นจ านวนร้อยละ 75 

    - Count -> นับค่า 0 ในตัวแปร Gender  

    - Recode into Same Variables -> เปลี่ยนค่าของตัวแปร Gender ให้เป็นตามเดิม  

       - Recode into Difference Variables -> สร้างตัวแปร Edu_level มี 2 กลุ่ม คือ ระดับต่ า

กว่าอุดมศึกษา และระดับอุดมศึกษา 

2. เปิดแฟ้มข้อมูล hotel.sav และจัดการข้อมูลด้วยค าสั่งดังต่อไปนี้ 

    - Compute -> สร้างตัวแปรใหม่ชื่อ Sat_sum รวมคะแนนความพึงพอใจจากตัวแปร V1 ถึง 

V5 



 

 

ส่วนที่ 3 

การวิเคราะห์เครื่องมือการวิจัย 

และตรวจสอบข้อมูล 

  





 

 

บทที่ 8 
การวิเคราะห์เครื่องมือการวิจัย 

ความมุ่งหมายของบทเรียน 
ผู้เรียนสามารถวิเคราะห์คุณภาพของเครื่องมือการวิจัยได้  

เนื้อหา 
1. การวิเคราะห์ความถูกต้อง 

2. การวิเคราะห์ความน่าเชื่อถือ 

วิธีการสอนและกิจกรรมการเรียนการสอน 
บรรยาย อธิบาย แสดงตัวอย่าง และท าแบบฝึกหัดท้ายบท 

สื่อและอุปกรณ์การสอน 
เอกสารค าสอน ภาพเลื่อน คอมพิวเตอร์ โปรแกรม PSPP โปรแกรมสอนออนไลน์ (สอนแบบ

ออนไลน์) และเครื่องฉาย (สอนในชั้นเรียน)  

งานที่มอบหมาย 

 ท าแบบฝึกหัดท้ายบท 

การวัดผลและประเมินผล 

การเข้าชั้นเรียน สังเกตความสนใจจากการเรียน สอบถามความเข้าใจจากการบรรยาย และ

ประเมินจากการท าแบบฝึกหัดท้ายบท 
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เนื้อหา 

หัวใจที่ส าคัญประการหนึ่งของการวัด (measurement) ในการวิจัยเชิงปริมาณด้านสังคมศาสตร์ 

คือ การใช้เครื่องมือวัดก าหนดตัวเลข (numbers) ให้กับปรากฎการณ์ทางสังคมหรือพฤติกรรมของมนุษย์

เพ่ือให้เป็นปริมาณที่สามารถนับได้ (Drost, 2011, Kimberlin & Winterstein, 2008) และเป็นเรื่องที่

ยอมรับได้ในมุมมองของนักปฎิฐานนิยม (positivist) หรือวิธีการวิเคราะห์แบบประจักษ์นิยม (empirical 

analytic approach) (Drost, 2011) 

แบบสอบถามเป็นเครื่องมืออันหนึ่งที่ได้รับความนิยมอย่างแพร่หลายในการส ารวจและรวบรวม

ข้อมูลในการวิจัยเชิงปริมาณด้านสังคมศาสตร์ แม้ว่าเครื่องมือที่ใช้ในการวิจัยด้านสังคมศาสตร์จะไม่

สามารถวัดได้ค่าความถูกต้อง (accurate) 100 เปอร์เซ็นต์ แต่สิ่งที่ส าคัญ คือ ท าอย่างไรให้ผลการวิจัย

ได้รับการยอมรับว่ามีความถูกต้อง (Kumar, 2014: 212-219)  

ในกระบวนการพัฒนาและการตรวจสอบเครื่องมือต้องท าให้เครื่องมือมีคุณภาพ (quality) คือ มี

ทั้งความเที่ยงตรงและความน่าเชื่อถือ เพ่ือให้ได้ข้อมูลที่ตรงกับความเป็นจริงและลดความคลาดเคลื่อน

จากการวัด (Kimberlin & Winterstein, 2008; Taherdoost, 2016) 

1. การวิเคราะห์ความเที่ยงตรง 

ความเที่ยงตรง (Validity) คือ ความสัมพันธ์ระหว่างค าถามการวิจัยหรือค่าที่ได้จากการสังเกต 

(observed value) กับความจริง (objectives) หรือค่าที่เป็นจริง (true value) ที่ท าการศึกษา หรือวัด

แล้วได้สิ่งที่ต้องการจะวัด (measure what is intended to be measured) หรือวัดสิ่งใดก็วัดได้สิ่งนั้น

จริง 

การสร้างเครื่องมือวิจัยในการวิจัยเชิงปริมาณมีความส าคัญเป็นอย่างมาก เพราะความจริง 

(objective) ค าถามการวิจัย (research question) และสมมติฐาน (hypothesis) มีความเชื่อมโยงกัน 

ดังนั้นเครื่องมือที่ใช้วัดต้องมีความเท่ียงตรงหรือความถูกต้องดังต่อไปนี้ 

1. ความเที่ยงตรงด้านข้อเท็จจริง (Face validity) หมายถึง ความถูกต้องที่ตรงกับความเข้าใจ

ทั่วไปของแนวคิด (common understandings of the concept) 
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2. ความเที่ยงตรงในเนื้อหา (Content validity) หมายถึง ความถูกต้องที่ข้อความทั้งหมด

สามารถครอบคลุมขอบข่ายของความหมายของตัวแปรที่เราต้องการจะวัด 

3. ความเที่ยงตรงที่สัมพันธ์กับขอบข่าย (Criteria-related validity) หมายถึง ความถูกต้องใน

การท านาย และในการพิสูจน์ตามแนวคิด 

4. ความเที่ยงตรงในแนวความคิด (Construct validity) หมายถึง ความถูกต้องเชิงทฤษฎีในการ

ใช้เหตุผลแบบนิรนัย (deductive) และอุปนัย (inductive) 

1.1 การวิเคราะห์ความสอดคล้องระหว่างข้อค าถาม-วัตถปุระสงค์ของการวิจัย 

วิธีการวิเคราะห์ความเท่ียงตรงเครื่องมือวิจัยเชิงปริมาณในการวิจัยด้านสังคมศาสตร์วิธีการหนึ่งที่

ได้รับความนิยมอย่างแพร่หลายโดยมีจุดก าเนิดมาจากสาขาวิชาด้านการศึกษาที่พัฒนาโดยริชาร์ด เจ. โร

วิเนลลี (Richard J. Rovinelli) และโรแนล เค. แฮเบิลตัน (Ronald K. Hambleton) คือ ดัชนีความ

สอดคล้องระหว่างข้อค าถาม-วัตถุประสงค์ของการวิจัย (Index of Item-Objective Congruence: IOC)  

โรวิเนลลีและแฮเบิลตัน เชื่อว่าวิธีการตัดสินโดยผู้เชี่ยวชาญมีระดับความเชื่อมั่นสูง (high 

degree of confidence) เพราะเป็นการทดสอบความตรงของดัชนีตามวัตถุประสงค์ของการวัดและการ

ออกแบบเครื่องมือของนักวิจัย และเป็นการวัดแบบอ้างอิงตามเกณฑ์ (criterion-referenced test) โดย

ให้ผู้เชี่ยวชาญในเนื้อหาของแต่ละเรื่องเป็นผู้ตัดสิน (judgements of content specialists) ประมาณ 3-

5 คน และประเมินตามวัตถุประสงค์ในการสร้างเครื่องมือ ( instructional objectives) อีกทั้งไม่ต้องใช้

วิธีการทางสถิติที่ซับซ้อน (Rovinelli and Hambletion, 1967) 

วิธีการตัดสินจากผู้เชี่ยวชาญ คือ ให้คะแนนข้อค าถามที่สอดคล้องกับวัตถุประสงค์ = 1 ไม่

สอดคล้อง = -1 และไม่สามารตัดสินใจได้ = 0 น าคะแนนที่สอดคล้องกับวัตถุประสงค์ (1) มาค านวณแบ่ง

ข้อค าถามท่ี ดี (good) และไม่ดี (bad) ด้วยคะแนนครึ่งหนึ่งหรือร้อยละ 50 (0.5) โดยมีสูตรดังนี้ 

𝐼𝑂𝐶 =
∑𝑅

𝑁
 

IOC    แทน ดัชนีความสอดคล้อง 

R     แทน ผลรวมคะแนนผู้เชี่ยวชาญที่มีความคิดเห็นว่าวัดได้ตรง 

N        แทน จ านวนผู้เชี่ยวชาญ 
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ตัวอย่างแบบประเมินความคิดเห็นของผู้เชี่ยวชาญเกี่ยวกับความเที่ยงตรงของแบบสอบถาม 

ข้อ ข้อค าถาม 
ความเที่ยงตรง 

ข้อเสนอแนะ 
1 0 -1 

1 เว็บไซต์นี้ของหน่วยงานนี้ให้บริการได้ตรงกับความต้องการ     

2 เว็บไซต์นี้มีความรวดเร็วในการแก้ไขปัญหาที่เกิดขึ้น     

3 เว็บไซต์นี้ท างานได้รวดเร็ว     

4 เว็บไซต์นี้ใช้งานได้ง่าย     

5 เว็บไซต์นี้ออกแบบได้สวยงาม     

6 เว็บไซต์นี้มีการบูรณาการข้อมูลกับหน่วยงานที่เกี่ยวข้องได้ดี     

7 เว็บไซต์นี้สามารถใช้งานได้แบบที่เดียวเบ็ดเสร็จ (One-stop-services)      

8 เว็บไซต์นี้ให้ข้อมูลที่เชื่อถือได้     

9 เว็บไซต์นี้ให้บริการข้อมูลที่เป็นปัจจุบัน (Up-to-date)     

10 เว็บไซต์นี้เชื่อมั่นได้ว่ามีการรักษาข้อมูลส่วนตัวของผู้ใช้บริการได้ดี     

 

เกณฑ์การให้คะแนน 

 +1  ข้อค าถามตรงกับวัตถุประสงค์การวิจัย 

   0 ข้อค าถามไม่แน่ใจว่าตรงวัตถุประสงค์การวิจัยหรือไม่ 

 - 1 ข้อค าถามไม่ตรงกับวัตถุประสงค์การวิจัย 

การวิเคราะห์ IOC อาจไม่จ าเป็นต้องใช้โปรแกรมวิเคราะห์ข้อมูลด้านสถิติ เพราะยุ่งยากกว่าการ

วิเคราะห์ด้วยเครื่องคิดเลขหรือโปรแกรมตารางการค านวณ (spreadsheet) แต่ในที่นี้จะแสดงเป็น

ตัวอย่างไว้หากต้องการใช้งาน 
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การใช้โปรแกรมวิเคราะห์ข้อมูล 

๏ เปิดโปรแกรมและสร้างแฟ้มข้อมูล ASPSS_IOC.sav 

๏ สร้างตัวแปร 10 ตัวแปร คือ ESQ1 ถึง ESQ10 โดยมีรายละเอียดดังนี้ 
o ใส่หรือไม่ต้องใส่ Label, Value Labels แต่ต้องก าหนด Measure = Scale  

 

๏ ใส่ค่าตัวแปรหรือข้อมูลโดยมีรายละเอียดดังนี้ 
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๏ เลือกเมนู Analyze -> Descriptive Statistics -> Descriptives… 
๏ ในหน้าต่าง Descriptives 

o Variables: เลือกตัวแปร ESQ1 ถึง ESQ10 จากรายการตัวแปรด้านซ้าย  
o Statistics: ใช้ค่าที่โปรแกรมก าหนด (default) 
o กดปุ่ม OK 

 

ผลการวิเคราะห์ 
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การแปลผลการวิเคราะห์ค่า IOC จากค่า Mean 

 จากการประเมินเครื่องมือวิจัยโดยให้ผู้เชี่ยวชาญตัดสินพบว่า มีข้อค าถามที่มีค่า IOC น้อยกว่า 

0.5 จ านวน 1 ข้อ คือ ข้อ 1 (ESQ2) และมีข้อค าถามที่มีค่า IOC มากกว่า 0.5 จ านวน 9 ข้อ คือ ข้อ 1, 

3-10 (ESQ1, ESQ3 ถึง ESQ10) 

 สรุป มีข้อค าถามที่มีความเที่ยงตรงและสามารถน าไปใช้เก็บรวบรวมข้อมูล 9 ข้อ และมีข้อ

ค าถามทีไ่ม่มีความเที่ยงตรงต้องท าการปรับปรุงหรือตัดออกจากแบบสอบถามจ านวน 1 ข้อ 

ข้อ ค่า IOC การตัดสินใจ 

1 1.00 ใช้ได้ 

2 0.40 ปรับปรุงหรือตัดทิ้ง 

3 0.80 ใช้ได้ 

4 1.00 ใช้ได้ 

5 0.80 ใช้ได้ 

6 0.60 ใช้ได้ 

7 0.80 ใช้ได้ 

8 1.00 ใช้ได้ 

9 1.00 ใช้ได้ 

10 1.00 ใช้ได้ 
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1.2 การวิเคราะห์ความเห็นสอดคล้องกัน  

ในการวิเคราะห์ความเที่ยงตรง อาจท าการประเมินแบบสอบถามด้วยวิธีการวิเคราะห์ความ

เที่ยงตรงภายนอก (face validity) เพ่ือทดสอบความเป็นไปได้ (feasibility) ความเข้าใจจากการอ่าน 

(readability) การใช้ส านวนและรูปแบบของภาษาที่มีความกลมกลืนกัน (consistency of style and 

formatting) และความชัดเจนของภาษา (clarity of the language) จากการให้คะแนนโดยผู้ประเมิน 

(inter-rater) ด้วยมาตรวัดแบบสองค่า (dichotomous scale) คือ ใช่ (Yes) = เหมาะสม และไม่ (No) 

= ไม่เหมาะสม  

จากนั้นวิเคราะห์หาความเที่ยงตรงระหว่างคะแนนของผู้ประเมิน (inter-ratter) ด้วยค่าดัชนีแคป

ปาของโคเฮน (Cohen's Kappa Index: CKI) และใช้ค่า Kappa ตั้งแต่ 0.60 ขึ้นไป เป็นเกณฑ์ในการ

ตัดสินใจยอมรับได้ว่า ผู้ประเมินมีความเห็นสอดคล้องกัน (Taherdoost, 2016) และแปลระดับความ

สอดคล้องจากค่า Kappa ได้จากตารางต่อไปนี้ (McHugh, 2012) 

ตารางที่ 8.1 การแปลค่าแคปปาของโคเฮน 

ค่าแคปปา  

(Value of Kappa) 

ระดับความสอดคล้อง  

(Level of Agreement) 

จ านวนร้อยละของข้อมูลที่เชื่อถือได้ 

(% of Data that are Reliable) 

มากกว่า 0.90 มากที่สุด 82–100% 

0.90-0.80 มาก 64–81% 

0.79-0.60 ปานกลาง 35–63% 

0.59-0.40 น้อย 15–35% 

0.39-0.21 น้อยที่สุด 4–15% 

0.20-0.00 ไม่สอดคล้อง 0–4% 
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ตัวอย่างแบบประเมินความเห็นเกี่ยวกับความเหมาะสมของแบบสอบถาม 

ข้อ ข้อค าถาม 
ความเหมาะสม 

ข้อเสนอแนะ 
ใช่ ไม่ 

1 เว็บไซต์นี้ของหน่วยงานนี้ให้บริการได้ตรงกับความต้องการ    

2 เว็บไซต์นี้มีความรวดเร็วในการแก้ไขปัญหาที่เกิดขึ้น    

3 เว็บไซต์นี้ท างานได้รวดเร็ว    

4 เว็บไซต์นี้ใช้งานได้ง่าย    

5 เว็บไซต์นี้ออกแบบได้สวยงาม    

6 เว็บไซต์นี้มีการบูรณาการข้อมูลกับหน่วยงานที่เกี่ยวข้องได้ดี    

7 
เว็บไซต์นี้สามารถใช้งานได้แบบที่เดียวเบ็ดเสร็จ (One-stop-

services)  

  
 

8 เว็บไซต์นี้ให้ข้อมูลที่เชื่อถือได้    

9 เว็บไซต์นี้ให้บริการข้อมูลที่เป็นปัจจุบัน (Up-to-date)    

10 
เว็บไซต์นี้เชื่อมั่นได้ว่ามีการรักษาข้อมูลส่วนตัวของผู้ใช้บริการได้

ดี 

  
 

การใช้โปรแกรมวิเคราะห์ข้อมูล 

๏ เปิดโปรแกรมและสร้างแฟ้มข้อมูล ASPSS_Kappa.sav 
๏ สร้างตัวแปร 3 ตัวแปร ItemNo, Rater1 และ Rater2 โดยมีรายละเอียดดังนี้ 

o ตัวแปร ItemNo (Label = Item Number และ Measure = Nominal)  
o ตัวแปร Rater1 (Label = First Rater, Value Labels 0 = No และ 1 = Yes และ 

Measure = Nominal) 
o ตัวแปร Rater2 (Label = Second Rater, Value Labels 0 = No และ 1 = Yes และ 

Measure = Nominal)  
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๏ ใส่ค่าตัวแปรหรือข้อมูลโดยมีรายละเอียดดังนี้ 

 

๏ เลือกเมนู Analyze -> Descriptive Statistics -> Crosstabs… 
๏ ในหน้าต่าง Crosstabs 

o Rows: เลือกตัวแปร Ratter1 -> Columns: และเลือกตัวแปร Ratter2  

 

๏ กดปุ่ม Statistics 
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o Statistics เลือกเฉพาะ Kappa  
o กดปุ่ม Continue 

๏ กดปุ่ม Cells 

o Cell Display เลือกเฉพาะ Count, Column และ Total 
o กดปุ่ม Continue 

๏ กดปุ่ม OK 

  

ตารางผลการวิเคราะห์ 

 

 

 

การแปลผลการวิเคราะห์ 

 ผลการวิเคราะห์ความเหมาะสมของแบบสอบถามจ านวน 10 ข้อ ผู้ประเมินให้คะแนนเหมาะสม 

(1) สอดคล้องกันน้อยกว่าไม่สอดคล้อง (Yes x Yes = 40.0%) และได้ค่า Kapp = 0.17 (Sig. =0.53) 

แสดงว่าแบบสอบถามฉบับนี้มีความไม่เหมาะสม  
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2. การวิเคราะห์ความน่าเชื่อถือ 
ความน่าเชื่อถือ (Reliability) คือ ความสามารถในการวัดอย่างคงเส้นคงวา (consistent) หรือ

ความแน่นอน (stability) ในการวัดแต่ละครั้ง เมื่อน าเครื่องมือไปใช้ภายใต้สถานการณ์ที่เหมือนกัน หรือ

ประชากรที่เหมือนกัน ต้องได้ผลลัพธ์ที่เหมือนกัน (Drost, 2011) 

 การวิเคราะห์ความน่าเชื่อถือมีหลายวิธี แต่ละวิธีมีข้อดีและข้อเสียแตกต่างกัน เช่น ประหยัดเวลา

และค่าใช้จ่ายในการเก็บข้อมูลครั้งเดียว หรือต้องใช้เวลาและเสียเวลามากในการเก็บข้อมูลหลายครั้ง แต่

วิธีการทั้งหมดสามารถแบ่งได้เป็น 2 กลุ่ม ดังนี้ 

1. การทดสอบความน่าเชื่อถือภายใน ( Internal reliability) เป็นการทดสอบความสอดคล้อง

ภายในระหว่างข้อค าถามภายในแบบสอบถามแต่ละชุดที่เก็บข้อมูลเพียงครั้งเดียว เช่น การทดสอบแบบ

แบ่งครึ่ง (split-half) และการทดสอบความสอดคล้องภายในด้วยค่าสัมประสิทธิ์แอลฟา  (alpha 

coefficient)  

2. การทดสอบความน่าเชื่อถือภายนอก (External reliability) เป็นการทดสอบความสอดคล้อง

เชิงเปรียบเทียบระหว่างสองช่วงเวลา ระหว่างผู้ประเมิน และระหว่างชุดแบบสอบถาม เช่น การทดสอบ-

ทดสอบซ้ า (test-retest) การให้คะแนนระหว่างผู้ประเมิน (inter-rater) และการทดสอบหลากรูปแบบ

หรือรูปแบบเผื่อเลือก (multiple/alternative forms)  

 วิธีการวิเคราะห์ความน่าเชื่อถือที่นิยมใช้กันทั่วไป คือ การวัดความสอดคล้องภายในด้วยค่า

สัมประสิทธิ์แอลฟาของครอนบัก (Cronbach Alpha Coefficient) ซึ่งเหมาะกับเครื่องมือที่ใช้ข้อค าถาม

แบบให้คะแนน (scored items) แบบสองค่า (dichotomous) เช่น มาตรวัดแบบให้คะแนน 0 และ 1 

และแบบหลายค่า (polychotomous) เช่น มาตรวัดแบบลิเคิร์ต (Likert scale) (Ritter, 2010) ใช้วิธีการ

เก็บข้อมูลเพียงครั้งเดียว และข้อค าถามไม่จ าเป็นต้องมีจ านวนเป็นเลขคู่เหมือนกับวิธีการทดสอบแบบ

แบ่งครึ่ง (split-half 

แม้ว่าจะไม่มีกฎที่แน่นอน แต่มีหลักทั่วไป (rule of thumb) ที่ยอมรับกันอย่างแพร่หลาย คือ ค่า

ความสอดคล้องภายในต้องไม่ต่ ากว่า 0.70 (Taherdoost, 2016) และแปลระดับความน่าเชื่อถือจากค่า 

Cronbach ’s Alpha ส าหรับค าถามแบบสองค่า (dichotomous questions) หรือค าถามแบบลิเคิร์ต 

(Likert scale questions) ได้จากตารางต่อไปนี้ (Glen, 2014) 
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ตารางที่ 8.2 การแปลค่าสัมประสิทธิ์แอลฟาของครอนบัก 

ค่าแอลฟาของครอนบัก  

(Value of Cronbach’ s Alpha) 

ความสอดคล้องภายใน  

(Internal Consistency) 

α >= 0.9 ดีมาก (Excellent) 

0.9 > α >= 0.9 ดี (Good) 

0.8 > α >= 0.7 ยอมรับได้ (Acceptable) 

0.7 > α >= 0.6 ไม่แน่นอน (Questionable) 

0.6 > α >= 0.5 ต่ า (Poor) 

0.5 > 0.7 > α ไม่ยอมรับ (Unacceptable) 

 ตัวอย่างที่น ามาใช้ในการวิเคราะห์ความน่าเชื่อถือ คือ แฟ้มข้อมูลตัวอย่าง  ASPSS_Alpha.sav 

โดยมีวิธีการดังต่อไปนี้ 

การใช้โปรแกรมวิเคราะห์ข้อมูล 

๏ เปิดโปรแกรมและเปิดแฟ้มข้อมูล ASPSS_Alpha.sav 

 

  



160 | ก า ร ใ ช้ โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร์ ท า ง ส ถิ ติ ใ น ด้ า น สั ง ค ม ศ า ส ต ร์  

๏ เลือกเมนู Analyze -> Reliability… 

๏ ในหน้าต่าง Reliability Analysis 
o Items: เลือกตัวแปร ESQ1 ถึง ESQ10 จากรายการตัวแปรด้านซ้ายมาใส่ 
o Model: เลือก Alpha 

o เลือก Show descriptives for scale if item is deleted (แสดงค่าสถิติเพ่ือปรับค่า 
Cronbach ’s Alpha) 

o กดปุ่ม OK 

 

ผลการวิเคราะห์ 
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การแปลผลการวิเคราะห์ 

 ผลการวิเคราะห์ความน่าเชื่อถือข้อค าถามจ านวน 10 ข้อ จากกลุ่มตัวอย่าง 10 คน ได้ค่า 

Cronbach’s Alpha = 0.67 โดยค่าสถิติ Cronbach Alpha if Item Deleted ในตาราง Item-Total 

Statistics แนะน าให้ลบค าถามข้อ ESQ2 (The speed of solving problems) ออกจากการวิเคราะห์

จะได้ค่า Alpha = 0.77  

ท าการวิเคราะห์ความน่าเชื่อถือใหม่ด้วยวิธีการเดิมโดยเอาตัวแปร ESQ2 ออกจากรายการ 

Items: เหลือข้อค าถามที่ใช้ในการวิเคราะห์จ านวน 9 ข้อ  

ผลการวิเคราะห์หลังลบตัวแปร ESQ2 

 

 

 ผลการวิเคราะห์ความน่าเชื่อถือจากการลบตัวแปร ESQ2 ออกจากการวิเคราะห์ ได้ค่า 

Cronbach’s Alpha = 0.77 มากกว่าค่าความสอดคล้องภายใน 0.70 ตามที่กล่าวมา และเป็นเครื่องมือ

วัดมีความน่าเชื่อถือหรือคงเส้นคงวาในการวัดแต่ละครั้ง 

 ส าหรับข้อค าถาม ESQ2 หากมีความส าคัญและต้องใช้เป็นดัชนีในการวัด ต้องท าการปรับปรุง

และน าไปทดสอบกับกลุ่มตัวอย่างใหม่ แล้วจึงน ามาท าการวิเคราะห์หาความน่าเชื่อถือใหม่อีกครั้ง 
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สรุป 

 การวิเคราะห์เครื่องมือการวิจัย คือ การตรวจสอบความมีคุณภาพของเครื่องมือทั้งด้านความ

เที่ยงตรงและความน่าเชื่อถือเพ่ือลดความคลาดเคลื่อนจากการวัด และได้ข้อมูลที่ตรงกับความเป็นจริง

อย่างคงเส้นคงวา  

วิธีการวิเคราะห์ความเที่ยงตรงที่ได้รับความนิยมอย่างแพร่หลาย คือ การทดสอบความตรงของ

ดัชนีตามวัตถุประสงค์ของการวัดและการออกแบบเครื่องมือของนักวิจัยด้วยค่าความสอดคล้องระหว่าง

ข้อค าถาม-วัตถุประสงค์ของการวิจัย ( Index of Item-Objective Congruence: IOC) และดัชนีความ

สอดคล้องระหว่างคะแนนของผู้ประเมินด้วยค่าแคปปาของโคเฮน (Cohen's Kappa Index: CKI) 

วิธีการวิเคราะห์ความน่าเชื่อถือที่นิยมใช้กันทั่วไป คือ การวัดความสอดคล้องภายในด้วยค่า

สัมประสิทธิ์แอลฟาของครอนบัก (Cronbach Alpha Coefficient) 

แบบฝึกหัดท้ายบท 
 ให้ผู้เรียนฝึกวิเคราะห์ความเที่ยงตรงและความน่าเชื่อถือดังต่อไปนี้ 

1. เปิดแฟ้มข้อมูล ASPSS_IOC.sav 

    - เพ่ิมค่าตัวแปร Item4-Item10 และใส่ค่าตัวแปรให้ครบ 

    - วิเคราะห์ค่า IOC และตัดสินใจว่าข้อค าถามใดใช้ได้หรือใช้ไม่ได้  

2. เปิดแฟ้มข้อมูล ASPSS_Kappa.sav 

    - เพ่ิมค่าตัวแปรใน ItemNo, First Rater และ Second Rater ตัวต่อจากข้อที่ 3 ให้ครบ 10 

รายการ  

    - วิเคราะห์ค่า Kappa และประเมินว่าแบบสอบถามมีความเหมาะสมหรือไม่  

3. เปิดแฟ้มข้อมูล hotel.sav แล้วด าเนินการดังนี้ 

   - เพ่ิมตัวแปร V6-V10 หรือข้อค าถามอีก 5 ข้อ ต่อจากตัวแปร V5 และใส่ค่าตัวแปรให้ครบ  

   - วิเคราะห์ความน่าชื่อถือ หากค่า Cronbach’s Alpha ต่ ากว่า 0.70 ให้ตัดข้อค าถามตามท่ี

โปรแกรมแนะน าเพ่ือปรับค่า Cronbach’s Alpha ให้อยู่ในระดับท่ียอมรับได้    

  



 

 

บทที่ 9 

การวิเคราะห์ข้อมูลเชิงส ารวจ 

ความมุ่งหมายของบทเรียน 
ผู้เรียนสามารถตรวจสอบความถูกต้องและความสมบูรณ์ของข้อมูล รวมถึงตรวจสอบลักษณะ

ของข้อมูลตามข้อตกลงเบื้องต้นของสถิติ 

เนื้อหา 
1. การตรวจสอบความถูกต้องและความสมบูรณ์ของข้อมูล 

2. การตรวจสอบข้อมูลตามข้อตกลงเบื้องต้น 

วิธีการสอนและกิจกรรมการเรียนการสอน 
บรรยาย อธิบาย แสดงตัวอย่าง และท าแบบฝึกหัดท้ายบท 

สื่อและอุปกรณ์การสอน 
เอกสารค าสอน ภาพเลื่อน คอมพิวเตอร์ โปรแกรม PSPP โปรแกรมสอนออนไลน์ (สอนแบบ

ออนไลน์) และเครื่องฉาย (สอนในชั้นเรียน)  

งานที่มอบหมาย 

 ท าแบบฝึกหัดท้ายบท 

การวัดผลและประเมินผล 

การเข้าชั้นเรียน สังเกตความสนใจจากการเรียน สอบถามความเข้าใจจากการบรรยาย และ

ประเมินจากการท าแบบฝึกหัดท้ายบท 
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เนื้อหา 

ความถูกต้องและไม่ถูกต้องของข้อมูลเกิดขึ้นได้ตั้งแต่การออกแบบแฟ้มข้อมูลและการน าข้อมูล

เข้าแฟ้มข้อมูล ก่อนการวิเคราะห์ข้อมูลควรท าความสะอาดข้อมูล (data cleansing) เพ่ือตรวจสอบให้

มั่นใจว่าข้อมูลในแฟ้มข้อมูลมีความถูกต้องและตรงกับแบบสอบถาม แม้ว่าข้อมูลในแฟ้มข้อมูลจะมี

ความถูกต้องและตรงกับข้อมูลที่ได้จากการส ารวจแล้ว ก่อนการใช้สถิติทดสอบต้องตรวจสอบข้อมูล 

(data screening) ให้มั่นใจว่าลักษณะของข้อมูลเป็นไปตามข้อตกลงเบื้องต้นของสถิติแต่ละประเภท  

1. การตรวจสอบความถูกต้องและความสมบูรณ์ของข้อมูล 

การตรวจสอบความถูกต้องและความสมบูรณ์ของข้อมูล คือ การตรวจสอบการออกแบบข้อมูล 

(data design) เพ่ือทบทวนการสร้างตัวแปรให้ถูกต้องและตรงกับแบบสอบถาม การตรวจสอบการน าเข้า

ข้อมูล (data entry) เพ่ือตรวจสอบความถูกต้องของข้อมูลระหว่างแบบสอบถามกับแฟ้มข้อมูล และการ

ตรวจความสมบูรณ์ของข้อมูล เพ่ือตรวจสอบข้อมูลมีค่าสูญหายมากน้อยเพียงใด   

1.1 การตรวจสอบการออกแบบข้อมูล 

 การตรวจสอบการออกแบบข้อมูล คือ การทบทวนการออกแบบแฟ้มข้อมูลที่ออกแบบไว้ก่อน

การน าเข้าข้อมูลว่ามีความถูกต้องตรงกับแบบสอบถามหรือไม่ โดยการเปิดแฟ้มข้อมูลและเข้าไปที่

หน้าต่างแสดงตัวแปร (Variable View) แล้วท าการตรวจสอบดังนี้ 

1. การก าหนดชื่อตัวแปร ควรใช้ค าหรือชื่อย่อที่สื่อความหมาย หากเป็นกลุ่มตัวแปรดัชนี ควรใช้

ชื่อเดียวกันแล้วตามด้วยตัวเลข เพ่ือความสะดวกในการใช้ค าสั่งที่ต้องใช้ตัวแปรหลายตัวแปร 

2. การก าหนดความหมายตัวแปร ควรสั้นและเข้าใจง่าย เพ่ือให้การแสดงผลในผลการวิเคราะห์ 

(output) อยู่ภายในบรรทัดเดียวกัน   

3. การก าหนดค่าตัวแปร ให้ความหมายตรงกับค าตอบในแบบสอบถามหรือไม่ โดยเฉพาะตัวแปร

แบบสองค่า (dichotomous variable) ควรให้ค่าแบบ 0 และ 1 หรือ 1 และ 2  

4. การก าหนดค่าสูญหาย มีการก าหนดค่าที่ไม่ต้องการน ามาใช้ในการค านวณหรือไม่ เช่น 

ก าหนดให้เลข 8 = ไม่ตอบ หรือ 9 = ไม่ทราบ เพราะหากไม่ก าหนดเป็นค่าสูญหายจะท าให้ค่าสถิติ

เบี่ยงเบนไปจากค่าที่เป็นจริง 
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5. การก าหนดระดับการวัดตัวแปร ก าหนดตรงกับลักษณะข้อมูลในแบบสอบถามและระดับการ

วัดหรือไม ่

การตรวจสอบความถูกต้องในขั้นตอนนี้แม้ว่าจะเป็นการท างานที่ซ้ าซ้อน แต่ก็ช่วยสร้างความ

มั่นใจของความถูกต้องของข้อมูล และอาจพบข้อผิดพลาดที่ควรท าการแก้ไขก็ได้  

วิธีที่ 1 การตรวจสอบพร้อมกันทุกตัวแปร 

การใช้โปรแกรมวิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูลที่ต้องการตรวจสอบ (ตัวอย่างแฟ้มข้อมูล ASPSS_Data.sav) 
๏ เลือกเมนู File -> Display Data File Information -> Working File 
๏ ดูผลลัพธ์ในหน้าต่าง Output Viewer 

ตัวอย่าง: การตรวจสอบลักษณะตัวแปรทั้งแฟ้มข้อมูล 
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วิธีที่ 2 การตรวจสอบทีละตัวแปร 

การใช้โปรแกรมวิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูลที่ต้องการตรวจสอบ 

๏ เลือกเมนู Utilities -> Variables… 
๏ คลิกเมาส์เลือกดตุัวแปรในเมนูด้านซ้ายตรวจสอบทีละตัวแปร 

ตัวอย่าง: การตรวจสอบลักษณะตัวแปรทีละตัวแปร (ตัวแปร ID) 

 
ตัวอย่าง: การตรวจสอบลักษณะตัวแปรทีละตัวแปร (ตัวแปร Gender) 
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1.2 การตรวจสอบความถูกต้องของข้อมูล 

การตรวจสอบความถูกต้องของข้อมูล คือ การตรวจสอบความผิดพลาดในการบันทึกข้อมูล 

(coding error และความผิดพลาดจากความไม่ตั้งใจในการตอบแบบส ารวจหรือบันทึกข้อมูลระหว่างการ

สัมภาษณ์ (logical error) วิธีการตรวจสอบความถูกต้องของข้อมูลที่กล่าวมามี 2 วิธี ดังนี้ (SPSS, 2005: 

3) 

1. การตรวจสอบแบบตัวแปรเดียว (Single-variable rule) เป็นการค้นหาความผิดพลาดในการ

บันทึกข้อมูล และเป็นการค้นหาค่าที่ไม่อยู่ในช่วงของค่าตัวแปร (out-of-range values) ในแฟ้มข้อมูล 

ซึ่งมีสาเหตุมาจากการพิมพ์ค่าตัวแปรผิดระหว่างการบันทึกข้อมูล หรือมีกลุ่มตัวอย่างที่มีคุณลักษณะของ

ข้อมูลอยู่นอกช่วงของค่าตัวแปรที่ก าหนดไว้ในการออกแบบสอบถาม  

 การใช้โปรแกรมวิเคราะห์ข้อมูล 

๏ เลือกเมนู Analyze -> Descriptive Statistics -> Frequencies…  
o Variable (s): ใส่ตัวแปร Gender และ Edu 
o Statistics: ยก เ ลิ ก ก า ร เ ลื อ ก ค่ า  Mean, Standard deviation, Minimum แ ล ะ 

Maximum 

 

ตัวอย่าง: ผลลัพธ์การตรวจสอบข้อมูลตัวแปรค่าแบ่งกลุ่มแบบตัวแปรเดียว 

 

 
การตรวจสอบ: มีค่าของตัวแปรอยู่นอกเหนือจากค่า (value) ที่ก าหนดไว้หรือไม่ 
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๏ เลือกเมนู Analyze -> Descriptive Statistics -> Descriptives… 
o Variable (s): ใส่ตัวแปร Age 
o Statistics: เลือกค่า Mean, Standard deviation, Minimum และ Maximum 

 

ตัวอย่าง: ผลลัพธ์การตรวจสอบข้อมูลตัวแปรค่าต่อเนื่องแบบตัวแปรเดียว 

 
การตรวจสอบ: มีข้อมูลอยู่นอกขอบเขตหรือไม่ 

2. การตรวจสอบแบบไขว้ตัวแปร (Cross-variable rule) เป็นการค้นหาความผิดพลาดจาก

ความไม่ตั้งใจในการตอบแบบส ารวจหรือผู้สัมภาษณ์บันทึกข้อมูลในแบบสอบถามผิด กล่าวคือ เป็นการ

ค้นหาค่าตัวแปรที่ไม่สอดคล้องกับความเป็นจริงหรือความขัดแย้งของข้อมูลระหว่างตัวแปร เช่น ครัวเรือน

ที่มีสมาชิก 1 คน เป็นเพศชาย เป็นโสด แต่มีบุตรจ านวน 1 คนหรือมากกว่า เป็นต้น 
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กรณีที่ 1 ตัวแปรที่ไม่น่าจะมีความสัมพันธ์กัน เช่น สถานภาพการท างาน กับ ต าแหน่งงาน 

การใช้โปรแกรมวิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล File -> Open -> ASPSS_Data.sav 
๏ สร้างตัวแปร 2 ตัวแปร คือ Work และ Position โดยมีรายละเอียดดังนี้ 

o ตัวแปร Work (Label = Work Status, Value 1 = Employed 2 = 
Unemployed และ Measure = Nominal) 

o ตัวแปร Position (Label = Work Position, Value Labels 0 = Non 1 = 
Manager 2 = Employee 3 = Other และ Measure = Nominal) 

 

๏ ใส่ค่าตัวแปรหรือข้อมูลโดยมีรายละเอียดดังนี้ 
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๏ เลือกเมนู Analyze -> Descriptive Statistics -> Crosstab… 
o Rows ใส่ตัวแปร Work  
o Columns ใส่ตัวแปร Position 
o กดปุ่ม  Statistics… ในกลุ่ มค าสั่ ง  Statistics ยกเลิกการเลือก Chisq -> กดปุ่ม 

Continues 
o กดปุ่ม Cells… ในกลุ่มค าสั่ง Cell Display เลือกเฉพาะ Count -> กดปุ่ม Continues 
o กดปุ่ม OK  

  

ตัวอย่าง: ผลลัพธ์การตรวจสอบข้อมูลแบบไขว้ระหว่างตัวแปรค่าแบ่งกลุ่ม X ตัวแปรค่าแบ่งกลุ่ม 

 

 
การตรวจสอบ: ค่าตัวแปรที่ไม่สอดคล้องกัน เช่น Work Status = Unemployed แต่ Work 

Position ใน Employee = 1 
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กรณีที่ 2 ตัวแปรที่ไม่น่าจะมีความสัมพันธ์กัน เช่น สถานภาพสมรส กับ จ านวนบุตร 

การใช้โปรแกรมวิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล File -> Open -> ASPSS_Data.sav 
๏ สร้างตัวแปร 2 ตัวแปร คือ Married และ Child โดยมีรายละเอียดดังนี้ 

o ตัวแปร Marital (Label = Marital Status, Value Labels 1 = Single 2 = 
Married 3 = Other และ Measure = Nominal) 

o ตัวแปร Child (Label = Child Numbers และ Measure = Scale) 

 

๏ ใส่ค่าตัวแปรหรือข้อมูลโดยมีรายละเอียดดังนี้ 
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๏ เลือกเมนู Analyze -> Compare Mean -> Means… 

เลือกตัวแปรที่คิดว่าไม่น่าจะมีความสัมพันธ์กัน เช่น สถานภาพสมรส กับ จ านวนบุตร 

o Dependent List: เลือกตัวแปร Child จากรายการตัวแปรด้านซ้าย  
o Independent List:  เลือกตัวแปร Married จากรายการตัวแปรด้านซ้าย 
o กดปุ่ม OK 

 

ตัวอย่าง: ผลลัพธ์การตรวจสอบข้อมูลแบบไขว้ระหว่างตัวแปค่าแบ่งกลุ่ม X ตัวแปรค่าต่อเนื่อง 

 

 
การตรวจสอบ: ค่าตัวแปรที่ไม่สอดคล้องกัน เช่น Mairtal Status = Single แต่ค่าเฉลี่ย Child = 1  
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1.3 การตรวจสอบค่าสูญหาย 

ค่าสูญหาย (Missing values) คือ ค่าตัวแปรที่ไม่ทราบค่าภายในแฟ้มข้อมูลมีมากน้อยเพียงใด 

และมีรูปแบบปกติหรือไม่ปกติ เช่น ค่าว่างเปล่า (null) ที่โปรแกรมก าหนดให้เป็นค่าสูญหาย (system 

missing) และค่าที่ผู้ใช้ก าหนดให้เป็นค่าสูญหาย (user missing) เช่น ไม่ทราบ ไม่ตอบ ผลกระทบของค่า

สูญหายมีผลท าให้ผลการวิเคราะห์ผิดพลาด (bias) และค่าสถิติไม่มีอ านาจในการท านายที่ดี (statistical 

power)  

การวิเคราะห์หาข้อมูลสูญหายภายในแฟ้มข้อมูลว่ามีลักษณะดังต่อไปนี้หรือไม่  (Hair and 

Others, 2006: 55-56) 

1. จ านวนค่าสูญหาย มีจ านวนค่าสูญหายของแต่ละชุดข้อมูล (case) และแต่ละตัวแปร 

(variable) ว่ามีค่าสูญหายจ านวนมากน้อยเพียงใด ถ้าก าหนดไม่ให้น าเอาข้อมูลที่มีค่าสูญหายมาใช้ในการ

ค านวณ จ านวนตัวอย่างที่ถูกน าไปใช้ในการค านวณก็จะมีขนาดลดลง หากมีข้อมูลสูญหายจ านวนมาก 

อาจมีผลท าให้มีข้อมูลไม่เพียงพอในการวิเคราะห์แบบหลายตัวแปร (multivariate analysis) ตามมา 

2. รูปแบบค่าสูญหาย  มีรูปแบบการสูญหายอย่างมีระบบหรือสูญหายลักษณะคล้ายกัน 

(nonrandom) ที่เกิดจากผู้ตอบไม่ต้องการเปิดเผยข้อมูลของตน เช่น คนรวยไม่ต้องการบอกรายได้ของ

ตน เป็นต้น รูปแบบการสูญหายอย่างมีระบบที่พบกันอย่างแพร่หลาย เช่น การสูญหายของข้อมูล

เนื่องจากผู้ตอบแบบสอบถามจ านวนหนึ่ งไม่ตอบค าถามข้อใดข้อหนึ่ง หรือส่วนใดส่วนหนึ่ งใน

แบบสอบถาม หรือการสูญหายของข้อมูลเนื่องจากการไม่ตอบที่เพ่ิมมากขึ้นในตอนท้ายของแบบสอบถาม 

เป็นต้น ถ้าค่าสูญหายมีอยู่ในตัวแปรตาม ค่าสูญหายนั้นจะมีผลท าให้ค่าของตัวแปรตามเปลี่ยนตามไปด้วย 

และอาจมีความสัมพันธ์กับค่าของตัวแปรที่สังเกตได้  

การไม่ให้ความสนใจ (ignore) และการแก้ไข (remedy) การสูญหายของข้อมูล มีผลกระทบต่อ

ผลการวิเคราะห์ทั้งสองกรณี สิ่งส าคัญท่ีนักวิจัยควรท าก่อนการวิเคราะห์ข้อมูล คือ ท าความเข้าใจการสูญ

หายของข้อมูลว่า การสูญหายของข้อมูลมีสาเหตุมาจากอะไร และมีผลกระทบอย่างไร เพราะจะท าให้การ

ตัดสินใจแก้ไขการสูญหายของข้อมูลมีความถูกต้องมากกว่า และป้องกันปัญหาความผิดพลาดของผลการ

วิเคราะห์ได้เป็นอย่างดี โดยท าการตรวจสอบจ านวนค่าสูญหายต่อตัวแปร (missing per variable) และ

จ านวนค่าสูญหายต่อชุดข้อมูล (missing per case) มีจ านวนมากน้อยเพียงใด และเกิดการสูญหายอย่าง
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มีระบบหรือสูญหายลักษณะคล้ายกัน (nonrandom) หรือไม่ ตามที่กล่าวมาแล้ว แต่ส าหรับในที่นี้จะ

กล่าวถึงเฉพาะการตรวจสอบจ านวนค่าสูญหายเท่านั้น โดยมีรายละเอียดดังนี้  

1. จ านวนค่าสูญหายของแต่ละตัวอย่าง (Missing values by case) ตัวอย่างที่มีค่าสูญหายต่ า

กว่าร้อยละ 10 ไม่ต้องท าการปรับแก้ แต่หากมากกว่านั้นควรท าการแก้ไข และหากมีจ านวนมากร้อยละ 

50 ควรตัดออกจากกระบวนการวิเคราะห์ข้อมูล  

การใช้โปรแกรมวิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล File -> Open -> ASPSS_Data.sav 
๏ เลือกเมนู Transform -> Compute Variable 

o Target Variable: พิมพ์ชื่อแปร VMissing 
o Function เลือก NMIS (นับเฉพาะค่า System Missing หรือค่าว่างเปล่า และ User 

Missing) 
o เลือกตัวแปรทั้งหมดที่ต้องการตรวจสอบใส่ในวงเล็บ (เฉพาะตัวแปรแบบตัวเลข) 
o กดปุ่ม OK 

 

๏ เลือกเมนู Data -> Sort Cases… 
o Sort by: ใส่ตัวแปร VMissing 
o Sort Order เลือก 

Descending 
o กดปุ่ม OK 
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ตัวอย่าง: ผลลัพธ์การตรวจสอบจ านวนค่าสูญหายของแต่ละชุดข้อมูล 

 
การตรวจสอบ: ดูจ านวนค่าสูญหายในตัวแปร VMissing ตัวอย่างที่ 5 มีค่าสูญหายจ านวน 2 ตัวแปร 

(ร้อยละ 25) และตัวอย่างท่ี 1 มีค่าสูญจ านวน 1 ตัวแปร (ร้อยละ 12.5) 

2. จ านวนค่าสูญหายของแต่ละตัวแปร (Missing values by variable) ตัวแปรที่มีค่าสูญหาย

เล็กน้อยประมาณร้อยละ 15 ไม่ต้องท าการปรับแก้ แต่หากมากกว่านั้นควรท าการแก้ไข และหากมี

จ านวนมากร้อยละ 50 ควรตัดออกจากกระบวนการวิเคราะห์ขอ้มูล 

วิธีที่ 1 การตรวจสอบตัวแปรค่าแบ่งกลุ่ม 

การใช้โปรแกรมวิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล File -> Open -> 
ASPSS_Data.sav 

๏ เ ลื อ ก เ ม นู  Analyze -> Descriptive 
Statistics -> Frequencies 
o Variable (s): ใส่ตัวแปร Gender และ 

Edu 
o ในกลุ่มค าสั่ ง  Statistics: ยกเลิกการ

เลือกค่า Mean, Standard deviation, 
Minimum และ Maximum 

o กดปุ่ม OK 
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ตัวอย่าง: ผลลัพธ์การตรวจสอบค่าสูญหายของตัวแปรค่าแบ่งกลุ่ม 

 

 
การตรวจสอบ: ถ้ามีค่าสูญหายน้อยกว่า 5% เลือกใช้การวิเคราะห์แบบ Listwise และถ้ามีค่าสูญหาย

มากกว่าหรือเท่ากับ 5% ก าหนดค่าสูญหายเป็นกลุ่มใหม่ (new category) 

วิธีที่ 2 การตรวจสอบตัวแปรค่าต่อเนื่อง 

การใช้โปรแกรมวิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล File -> Open -> ASPSS_Data.sav 
๏ เลือกเมนู Analyze -> Descriptive Statistics -> Explore…  

o Dependent List: ใส่ตัวแปร Age และ Child 

 

 

o กดปุ่ม Options… 
- Missing Values เลือก Report values 

- กดปุ่ม Continue 

o กดปุ่ม OK 
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ตัวอย่าง: ผลลัพธ์การตรวจสอบค่าสูญหายของตัวแปรค่าต่อเนื่อง 

 
การตรวจสอบ: ถ้ามีค่าสูญหายน้อยกว่า 5% เลือกใช้การวิเคราะห์แบบ Listwise ถ้ามีค่าสูญหาย

ระหว่าง 5% ถึง 15% การแทนค่าน้อยกว่า 15% ของข้อมูลมีผลกระทบต่อผลลัพธ์เล็กน้อย ให้

ค านวณหาค่าเฉลี่ยและแทนค่าโดยใช้ค าสั่ง Recode into Difference Variables… แต่ถ้าต้องแทน

ค่ามากกว่า 15% ให้พิจารณาตัดตัวแปรออกจากการวิเคราะห์ 

เนื่องจากโปรแกรมทางสถิติส่วนใหญ่จะไม่น าเอาข้อมูล (exclude) ที่มีค่าสูญหาย (missing 

value) มาท าการวิเคราะห์ ซึ่งไม่ตรงกับความสนใจด้านประชากรที่เป็นเป้าหมายในการศึกษา และมีผล

ท าให้ผลการวิเคราะห์มีความคลาดเคลื่อน ดังนั้นจึงวิธีการแก้ไขมีดังนี้ 

1. วิเคราะห์เฉพาะชุดข้อมูลที่ทุกตัวแปรไม่มีค่าสูญหาย (Listwise)  

2. วิเคราะห์เฉพาะชุดข้อมูลที่คู่ตัวแปรไม่มีค่าสูญหาย (Pairwise)  

3. ประมาณค่าที่สูญหายด้วยวิธีความเป็นไปได้สูงสุด (Maximum Likelihood Estimation: MLE)  

4. แทนค่าที่สูญหาย (Imputation) ดังนี้ 

   - แทนค่าด้วยค่าเฉลี่ยของทั้งชุดข้อมูล (Series mean) 

   - แทนค่าด้วยค่าเฉลี่ยของค่าที่อยู่ข้างบนและข้างล่างของค่าสูญหาย (Mean of nearby   

     points) 

   - แทนค่าด้วยค่ามัธยฐานของค่าที่อยู่ข้างบนและข้างล่างของค่าสูญหาย (Median of nearby  

     points) 

   - แทนค่าด้วยค่าที่ได้จากการลากเส้นตรงจากค่าสุดท้ายก่อนค่าสูญหายไปยังค่าแรกหลังค่าสูญ 

     หาย (Linear interpolation) 

   - แทนค่าด้วยค่าท านายที่ได้จากสมการถดถอย (Linear trend at point) 
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1.4 การตรวจสอบค่าผิดปกติและค่าต่างสุด 

ค่าผิดปกติและค่าต่างสุดอาจรวมอยู่ในตัวแปรเดียวกัน แต่ค่าผิดปกติ (outliers) และค่าต่างสุด 

(extremes) ในแต่ละต ารามีนิยามและหลักเกณฑ์ไม่เหมือนกัน ดังนี้  

1. ค่าผิดปกติ บางต ารากล่าวว่าเป็นค่าตัวแปรที่ไม่ถูกต้องที่ปรากฏอยู่ในชุดข้อมูล หรือเป็นค่าที่

ไม่เป็นจริงจากประชากรหรือกลุ่มตัวอย่าง เช่น เงินเดือน 15 บาท/เดือน แต่อีกต าราหมายถึงค่าตัวแปรที่

น้อยกว่า Q1-1.5(IQR) และค่าตัวแปรที่มากกว่า Q3+1.5(IQR)  

2. ค่าต่างสุด บางต ารากล่าวว่าเป็นค่าที่เป็นจริงแต่เบี่ยงเบน (deviates) ออกไปจากค่าปกติที่ได้

จากประชากรหรือกลุ่มตัวอย่าง อาจเป็นค่าที่มากกว่าหรือน้อยกว่าค่าปกติในชุดตัวแปรเดียวกัน เช่น 

เงินเดือน 100,000 บาท/เดือน บางต าราก าหนดให้ค่าต่างสุดอยู่ที่น้อยกว่า Q1-1.5(IQR) และค่าต่างสุด

อยู่ที่มากกว่า Q3+1.5(IQR) แต่บางต าราก าหนดให้ค่าต่างสุดอยู่ที่น้อยกว่า Q1-3(IQR) และค่าต่างสุดอยู่ที่

มากกว่า Q3+3(IQR)  

 

รูปที่ 9.1 ค่าผิดปกติและค่าต่างสุด 

แม้ว่าค่าผิดปกติและค่าต่างสุดจะมีนิยามและเกณฑ์ในการก าหนดค่าผิดปกติและค่าต่างสุดไม่

เหมือนกัน แต่ทั้งสองค่าที่กล่าวมามีสาเหตุการเกิดดังนี ้



ก า ร วิ เ ค ร า ะ ห์ ข้ อ มู ล เ ชิ ง ส า ร ว จ | 179 

1. การกรอกข้อมูล คือ กรอกข้อมูลผิดพลาด (wrong entry) เป็นค่าของตัวแปรที่ไม่อยู่ในช่วง

ของข้อมูลตามแบบสอบถาม 

2. ข้อมูลจากกลุ่มตัวอย่าง มีกลุ่มตัวอย่างบางกลุ่มตัวอย่างมีคุณลักษณะที่แตกต่างไปจากกลุ่ม

ตัวอย่างทั่วไป เช่น สูงมาก มีบุตรมาก มีรายได้สูงมาก  

เนื่องจากในหัวข้อการการตรวจสอบความถูกต้องของข้อมูลได้กล่าวถึงการตรวจสอบค่าตัวแปรที่

ไม่ปกติแล้ว ประกอบกับค าสั่งในโปรแกรมใช้ค าว่า Extremes ดังนั้นเพื่อไม่ให้เกิดความสับสนในที่นี้จะใช้

ค าว่า ค่าต่างสุด (extremes) ซึ่งหมายถึง ค่าของตัวแปรที่มีค่าต่ ากว่าปกติหรือสูงกว่าปกติเม่ือเทียบกับค่า

ปกติท่ีได้มาจากกลุ่มตัวอย่าง  

ค่าต่างสุดมีผลท าให้เกิดความคาดเคลื่อนของค่าสถิติ เช่น ค่าเฉลี่ยต่ าหรือสูงเกินจริง ค่าเบี่ยงเบน

มาตรฐานสูงกว่าปกติ การแจกแจงข้อมูลไม่ปกติ ค่าความเบ้และความโด่งไม่ปกติ ค่าสัมประสิทธิ์

สหสัมพันธ์ (correlation coefficient) เพ่ิมขึ้นหรือลดลง ค่าความชัน (slope) ในการพยากรณ์ความ

ถดถอย (regression) เบี่ยงเบนไป เป็นต้น น าไปสู่การ การตัดสินใจผิดพลาด โดยปฏิเสธและยอมรับ

สมมติฐานไม่ถูกต้อง เช่น ปฏิเสธสมมติฐาน H0 ทั้งที่เป็นสมติฐานที่ถูกต้อง (Type I error) หรือยอมรับ

สมมติฐาน H0 ทั้งท่ีเป็นสมติฐานที่ไม่ถูกต้อง (Type II error) (Struble, 2002; Verma, & Abdel-Salam, 

2019: p. 76-79) 

วิธีการตรวจสอบค่าต่างสุดในเบื้องต้นมี 2 วิธี คือ การตรวจสอบเชิงข้อเท็จจริงจากลักษณะทาง

ประชากร และการตรวจสอบเชิงสถิติจากค่า Tukey’s Hinges ค่าต่างสุด คือ ค่าที่อยู่ต่ ากว่าค่า Lower 

Hinge (HL) และสูงกว่าค่า Upper Hinge (HU) (Hoaglin, 2003) โดยมีวิธีการดังต่อไปนี้ 
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  การใช้โปรแกรมวิเคราะห์ข้อมูล 
๏ เปิดแฟ้มข้อมูล File -> Open -> ASPSS_Data.sav 
๏ เลือกเมนู Analyze -> Descriptive Statistics -> Explore…  

o Dependent List: ใส่ตัวแปร Age  
o กดปุ่ ม  Statistics… -> เ ลื อ กค า สั่ ง  Extremes และ  Percentiles -> กดปุ่ ม 

Continue 

 
 

ตัวอย่าง: ผลลัพธ์การตรวจสอบค่าต่างสุด 

 

 
การตรวจสอบ: 1. ตรวจสอบค่าต่างสุดในตาราง Extreme Value โดยดูค่าสูงสุดและต่ าสุดว่ามีความ

เป็นไปได้หรือสอดคล้องกับลักษณะทางประชากรของตัวอย่างหรือไม่ เช่น กลุ่มตัวอย่างเป็นวัยผู้ใหญ่ มี

ความเป็นไปได้หรือไม่ที่จะมีอายุสูงสุด = 60 ปี หรือถ้ากลุ่มตัวอย่างเป็นวัยหนุ่มสาว มีความเป็นไปได้

หรือไม่ที่จะมีอายุสูงสุด = 60 ปี 2. ตรวจสอบจากค่าต่างสุดในตาราง Percentiles โดยพิจารณาจาก

ค่า Tukey’s Hinges ค่าต่างสุด มีค่าที่ต่ ากว่า HL = 25 และสูงกว่า HU = 45 หรือไม่ จากตัวอย่าง มี

เฉพาะอายุ 60 ปี เท่านั้นที่เป็นค่าต่างสุด แม้ว่าในแฟ้มข้อมูลมีอายุ 14 ปี แต่ถูกก าหนดให้เป็นค่าสูญ

หายแบบ user missing ไม่ให้เอามาค านวณไว้แล้ว  

 ค่าต่างสุดอาจไม่ต้องก าจัดทิ้ง เพราะเป็นค่าท่ีแท้จริงของกลุ่มตัวอย่าง แต่หากเกิดจากความ

ผิดพลาดในการน าเข้าข้อมูล หรือเกิดจากความผิดพลาดในการเก็บข้อมูลที่ได้ข้อมูลมาจากประชากรที่อยู่

นอกกลุ่มตัวอย่างต้องก าจัดทิ้ง 
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2. การตรวจสอบข้อมลูตามขอ้ตกลงเบื้องต้น 

การตรวจสอบข้อมูลตามข้อตกลงเบื้องต้น คือ การตรวจสอบหรือประเมินข้อมูลตามเงื่อนไข

เบื้องต้นของสถิติแต่ละประเภท (basic assumptions) โดยเฉพาะวิเคราะห์ข้อมูล 1 ตัวแปร (univariate 

analysis) และ 2 ตัวแปร (bivariate analysis) ด้วยสถิติเชิงอ้างอิง (inferential statistics) มีข้อตกลง

ทั่วไปที่ต้องตรวจสอบ คือ การแจกแจงปกติ (normality) ความเท่ากันของความแปรปรวน (equality of 

variance) และความสัมพันธ์เชิงเส้นตรง (linearity)  

2.1 การแจกแจงแบบปกติ 

การแจกแจงแบบปกติ (Normality/Normal distribution) หรืออาจเรียกว่า การแจกแจงแบบ

เกาส์ (Gaussian distribution) คือ ลักษณะของข้อมูลที่การแจกแจงแบบความน่าจะเป็น (probability 

distribution) หรือมีค่าแบบสุ่ม (random) ที่แสดงว่า ข้อมูลส่วนใหญ่มีความถี่หรือปรากฏอยู่ใกล้ๆกับ

ค่าเฉลี่ย (mean)  

เงื่อนไขเบื้องต้นของสถิติเชิงอ้างอิงในการทดสอบแบบอิงค่าพารามิเตอร์ (parametric test) 

ต้องทราบลักษณะข้อมูลว่า มีการแจกแจงปกติหรือไม่ ถ้าข้อมูลมีการแจกแจงปกติมีโอกาสน้อยที่จะเกิด

ความคลาดเคลื่อนเชิงสถิติ แต่หากข้อมูลมีการแจกแจงไม่ปกติการทดสอบสมมติฐานและการสรุปก็จะไม่

ถูกต้อง  (Verma, & Abdel-Salam, 2019: p. 66-67) ควรตัดสินใจเลื อกการทดสอบแบบไม่ อิ ง

ค่าพารามิเตอร์ (non-parametric test)  

ผลกระทบที่เกิดจากข้อมูลที่มีความเบี่ยงเบนไปจากการแจกแจงปกติ คือ ถ้าเป็นข้อมูลของกลุ่ม

ตัวอย่างขนาดใหญ่ อาจท าให้เกิดความสัมพันธ์ระหว่างตัวแปรอันอย่างมีนัยส าคัญทางสถิติ  ทั้งที่ในความ

เป็นจริงแล้วอาจไม่ความสัมพันธ์ระหว่างเหตุการณ์ที่เกิดขึ้นหรือเป็นประเด็นปัญหาที่ไม่มีความส าคัญแต่

อย่างใด และถ้าข้อมูลของกลุ่มตัวอย่างมีขนาดเล็ก อาจไม่แสดงความสัมพันธ์ระหว่างตัวแปร 

ข้อมูลที่มีลักษณะแจกแจงปกติ (normal distribution) คือ ข้อมูลที่มีรูปทรงแบบระฆังคว่ าที่

สมมาตร (symmetric bell-shaped curve) ข้อมูลที่มีการแจกแจงปกติตามทฤษฎีมีค่าความเบ้  

(skewness) และความโด่ง (kurtosis) เท่ากับ 0  
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เบ้ขวา (Right-Skewed) ปกติ (Normal or Symmetric) เบ้ซ้าย (Left-Skewed) 

   
ข้อมูลแจกแจงแบบเบ้ขวา 

ค่า Skewness เป็น + แสดงว่า 

ข้อมูลส่วนใหญ่มีค่าต่ ากว่าค่ามัธย

ฐาน 

ข้อมูลแจกแจงแบบปกติ 

ค่า Skewness เป็น 0 แสดงว่า ข้อมูล

ส่วนใหญ่มีค่าใกล้เคียงกับค่ามัธยฐาน 

ข้อมูลแจกแจงแบบเบ้ซ้าย 

ค่า Skewness เป็น – แสดงว่า

ข้อมูลส่วนใหญ่มีค่าสูงกว่า

ค่ามัธยฐาน 

ยอดแบน (Platykurtic) ยอดปานกลาง (Mesokurtic) ยอดสูง (Leptokurtic) 

   
ข้อมูลแจกแจงแบบยอดแบน  

ค่า Kurtosis เป็น – แสดงว่า 

ข้อมูลกระจายมากหรือแปรปรวน

มาก 

ข้อมูลแจกแจงแบบยอดปานกลาง 

ค่า Kurtosis เป็น 0 แสดงว่า 

ข้อมูลกระจายปานกลางหรือ

แปรปรวนปานกลาง 

ข้อมูลแจกแจงแบบยอดสูง  

ค่า Kurtosis เป็น + แสดงว่า 

ข้อมูลกระจายน้อยหรืแปรปรวน

น้อย 

รูปที่ 9. 2 ความเบ้และความโด่ง  

ในความเป็นจริงข้อมูลที่ได้จากการสังเกตและเก็บรวบรวมมาจากปรากฎการทางสังคมหรือคนใน

สังคมไม่น่าจะมีความเป็นไปได้หรือเป็นไปได้น้อยมากที่จะมีการแจกแจงปกติ ขนาดของค่าความเบ้และ

ความโด่งที่ใช้ในการตัดสินว่า ข้อมูลมีการแจกแจงใกล้เคียงโค้งปกติหรือไม่นั้น มีการก าหนดขนาดของ

ค่าที่แตกต่างกัน แต่ส่วนใหญ่ใช้  1 หรือ  2 หรือ  3 (Garson, Online: 2008; Hair and Others, 

2006: 40; Hardy and Bryman, 2004: 44) 

การตรวจสอบการแจกแจงปกติอาจใช้วิทัศน์หรือกราฟ (visual/graphical methods) เช่น 

กราฟแจกแจงความถี่ (histogram) กราฟล าต้นและใบ (stem-and-leaf diagram) กราฟกล่องและ

หนวด (boxplot and whisker plot) กราฟการกระจาย (scatter plot) แต่การใช้สายตาตรวจสอบจาก

ภาพของกราฟอาจไม่รับประกันได้ว่าข้อมูลมีการกระจายปกติหรือไม่ ดังนั้น การใช้วิธีการทางสถิติ น่าจะ
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ได้รับการยอมรับและมีความน่าเชื่อถือมากกว่า โดยมีวิธีการทดสอบที่ส าคัญๆ เช่น ค่าความเบ้ 

(skewness) และค่าความโด่ง (kurtosis) การทดสอบด้วยวิธีการทางสถิติ เช่น กลุ่มตัวอย่างขนาดใหญ่ใช้

การทดสอบแบบคอลมอโกรอฟ-สเมอร์นอฟ  (Kolmogorov-Smirnov test: K-S test) และกลุ่มตัวอย่าง

ขนาดเล็กถึงขนาดกลางใช้การทดสอบแบบแชพิโล-วิลค์ (Shapiro-Wilk test: S-W test) ส าหรับในที่นี้

จะท าเสนอวิธีการตรวจสอบโดยใช้ค่าความเบ้และความโด่งประกอบการใช้กราฟแจกแจงความถี่ และการ

ทดสอบด้วยวิธีการทางสถิติแบบแบบคอลมอโกรอฟ-สเมอร์นอฟเท่านั้น โดยมีรายละเอียดดังนี้ 

2.1.2 การตรวจสอบความเบ้และความโด่ง 

2.1.2.1 การใช้โปรแกรมวิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล File -> Open -> ASPSS_Data.sav 
๏ เลือกเมนู Analyze -> Descriptive Statistics -> Frequencies… 
o Frequencies ใส่ตัวแปร (ค่าต่อเนื่อง) Child 
o กดปุ่ม Chart 

               - Histograms เลือก Draw histograms และ Superimpose normal curve 

               - กดปุ่ม Continue 

o กดปุ่ม Chart 
    - Display frequency tables เลือก Never 
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ตัวอย่าง: ผลลัพธ์การตรวจสอบค่าความเบ้และความโด่ง 

 

 

การตรวจสอบ: ข้อมูลตัวแปร Child (จ านวนบุตร) มีลักษณะเบ้ขวาและยอดแบน แสดงว่า ข้อมูลส่วน

ใหญ่มมีค่าต่ ากว่าค่ามัธยฐาน และมีการกระจายหรือแปรปรวนมาก แต่ค่าความเบ้และความโด่งไม่เกิน 

 2 ยอมรับได้ว่า ข้อมูลมีการแจกแจงใกล้เคียงโค้งปกติ  

2. การทดสอบด้วยวิธีการทางสถิติ 

   2.1 ก าหนดสมมติฐาน 

H0: ข้อมูลมีการแจกแจงปกติ 
   : ตัวแปรอายุมีการแจกแจงปกติ 

H1: ข้อมูลมีการแจกแจงไม่ปกติ 
       : ตัวแปรอายมุีการแจกแจงไม่ปกติ 

เกณฑ์ในการทดสอบสมมุติฐาน คือ หากการทดสอบการแจกแจงของข้อมูลแบบคอลมอโกรอฟ-

สเมอร์นอฟ  (Kolmogorov-Smirnov test: K-S test) ได้ค่าความน่าจะเป็น (p-value) มากกว่าค่า

นัยส าคัญทางสถิติ (α = 0.05) จะยอมรับสมมติฐาน Ho แต่หากได้ค่าความน่าจะเป็น (p-value) เท่ากับ

หรือน้อยกว่าค่านัยส าคัญทางสถิติ (α = 0.05) จะปฏิเสธสมมติฐาน Ho และยอมรับสมมติฐาน Ha 
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   2.2 การใช้โปรแกรมวิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล File -> Open -> ASPSS_Data.sav 
๏ เลือกเมน ูAnalyze -> Non-Parametric Statistics -> 1-Sample K-S… 
o Test Variable List: ใส่ตัวแปร (ตัวแปรค่าต่อเนื่อง) Age 
o Test Distribution เลือกค าสั่งสถิติ Normal   
o กดปุ่ม OK 

 

   2.3 ผลการวิเคราะห์ 

 
    2.4 สรุป 

จากผลการทดสอบแสดงให้เห็นว่า ค่าความน่าจะเป็น (Sig.) = 0.960 มีค่ามากกว่าค่านัยส าคัญ

ทางสถิติท่ีก าหนดไว้ (α = 0.05) จึงยอมรับสมมติฐาน H0: ตัวแปรอายุมีการแจกแจงปกติ 
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2.2 ความเท่ากันของความแปรปรวน  

ความเท่ากันของความแปรปรวน (Equality of variance) หรือเรียกว่า ความเป็นแบบเดียวกัน

ของความแปรปรวน (Homogeneity of variance) คือ ลักษณะของข้อมูลที่อยู่รอบค่าเฉลี่ยของ 2 กลุ่ม

ตัวอย่าง หรือมากกว่า 2 กลุ่มตัวอย่าง มีลักษณะการแจกแจงหรือการกระจายเท่ากัน 

ความไม่เทา่กันของแปรปรวนมีผลท าให้บางค่าหรือบางระดับของตัวแปรอิสระมีความสามารถใน

การท านายได้ดีกว่าค่าอ่ืนของตัวแปรอิสระ รวมถึงมีผลต่อความคาดเคลื่อนมาตรฐาน และการยอมรับ/ไม่

ยอมรับผลของการทดสอบสมมติฐาน ดังนั้นจึงต้องท าการทดสอบความแปรปรวนหรือการกระจายของ

ข้อมูลระหว่างกลุ่มในแต่ละตัวแปรตามมีความแปรปรวนเท่ากันหรือไม่ เช่น การตรวจสอบความเท่ากัน

ของความแปรปรวนระหว่างกลุ่มของแต่ละตัวแปร (homogeneity of variance) การตรวจสอบความ

เท่ากันของความแปรปรวน -ความแปรปรวนร่วมพหุ  (homogeneity of variance-covariance 

matrices) และการตรวจสอบความ เ ท่ า กั นขอ งคว ามแปรปรวนของคว ามคล าด เ คลื่ อ น 

(homoscedasticity) 

ความแปรปรวนเท่ากัน (Equal Variance/homoskedasticity) 

   
ความแปรปรวนไม่เท่ากัน (Unequal Variance/heteroskedasticity) 

   

รูปที่ 9.3 ความแปรปรวน 

การทดสอบความเท่ากันของความแปรปรวนมีทั้งการทดสอบจากข้อมูลระหว่างกลุ่มของตัวแปร

ตามแต่ละตัวหรือตัวแปรเดียว และการทดสอบร่วมของตัวแปรตหลายตัวแปรร่วมกัน ส าหรับในที่นี้จะ
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กล่าวถึงเฉพาะการตรวจสอบความเท่ากันของความแปรปรวนระหว่างกลุ่มของแต่ละตัวแปรตาม 

(homogeneity of variance) เท่านั้น โดยมีวิธีการดังนี้ 

1. ก าหนดสมมติฐาน 

H0: ข้อมูลระหว่างกลุ่มตัวอย่างมีความแปรปรวนหรือการกระจายเท่ากัน 
   : ค่าเฉลี่ยจ านวนบุตรระหว่างกลุ่มเพศมีความแปรปรวนเท่ากัน 

H1: ข้อมูลระหว่างกลุ่มตัวอย่างอย่างน้อย 2 กลุ่มประชากรมีความแปรปรวนไม่เท่ากัน 
   : ค่าเฉลี่ยจ านวนบุตรระหว่างกลุ่มเพศมีความแปรปรวนไม่เท่ากัน 

เกณฑ์ในการทดสอบสมมุติฐาน คือ หากทดสอบความเท่ากันของแปรปรวนระหว่างกลุ่มตัวอย่าง 
(Test of Homogeneity of Variances) ด้วยวิธีการทางสถิติของเลวีน (Levene Statistic) ด้วยค่า

ทดสอบ 0.05 ได้ค่าความน่าจะเป็น (p-value) มากกว่าค่านัยส าคัญทางสถิติ (α = 0.05) จะยอมรับ

สมมติฐาน H0 แต่หากได้ค่าความน่าจะเป็น (p-value) เท่ากับหรือน้อยกว่าค่านัยส าคัญทางสถิติ (α = 
0.05) จะปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 

 2. การใช้โปรแกรมวิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล ASPSS_Data.sav 
๏ Analyze -> Compare Means -> One Way ANOVA…  

o Test Variables(s): ใส่ตัวแปร (ตัวแปรค่าต่อเนื่อง) Age 
o Grouping Variable: ใส่ตัวแปร (ตัวแปรค่าแบ่งกลุ่ม) Gender 
o Statistics เลือก Homomeneity 

 

 3. ผลการวิเคราะห์ 
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 4. สรุป  

จากผลการทดสอบแสดงให้เห็นว่า ค่าความน่าจะเป็น (Sig.) = 0.495 มีค่ามากกว่าค่านัยส าคัญ

ทางสถิติท่ีก าหนดไว้ (α = 0.05) จึงยอมรับสมมติฐาน H0: ค่าเฉลี่ยจ านวนบุตรระหว่างกลุ่มเพศมีความ

แปรปรวนเท่ากัน  

2.3 ความเป็นเส้นตรง 

ความเป็นเส้นตรง (Linearity) คือ ลักษณะความสัมพันธ์ของข้อมูลระหว่าง 2 ตัวแปรที่มีการ

เปลี่ยนแปลงไปในทิศทางเดียวกันในเชิงเส้นตรง เมื่อค่าของตัวแปรหนึ่งมีการเปลี่ยนแปลงเพ่ิมขึ้นค่าของ

อีกตัวแปรหนึ่งมีการเปลี่ยนแปลงเพ่ิมขึ้นด้วย และเมื่อตัวแปรหนึ่งมีค่าเปลี่ยนแปลงลดลงค่าของอีกตัว

แปรหนึ่งก็มีการเปลี่ยนแปลงลดลงด้วยเช่นกัน 

การวิเคราะห์ข้อมูลแบบสองตัวแปร (bivariate analysis) เช่น การวิเคราะห์การถดถอยแบบ

ง่าย (simple regression) และการวิเคราะห์ข้อมูลแบบหลายตัวแปร (multivariate analysis)  เช่น 

การวิเคราะห์การถดถอยแบบพหุหรือหลายตัวแปร (multiple regression) การวิเคราะห์การถดถอย

แบบลอจิสติก (logistic regression) การวิเคราะห์ปัจจัย (factor analysis) และการวิเคราะห์ตัวแบบ

สมการเชิงโครงสร้าง (structural equation model) ข้อมูลที่ใช้ในการวิเคราะห์ต้องมีความสัมพันธ์

ระหว่างกันเชิงเส้นตรง ไม่เป็นความสัมพันธ์เชิงเส้นโค้ง 

ความสัมพันธ์เชิงเส้นตรง (Linear 

relationships) 

ความสัมพันธ์เชิงเส้นโค้ง (Curvilinear 

relationships) 

  

  

รูปที่ 9.4 ความสัมพันธ์เชิงเส้นตรงและเส้นโค้ง 
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การตรวจสอบความเป็นเส้นตรงระหว่างตัวแปรมีหลายวิธีขึ้นอยู่กับจ านวนตัวแปร แต่โดยทั่วไปมี 

2 วิธี ดังนี้ 

1. การตรวจสอบด้วยกราฟหรือแผนภาพ เช่น แผนภาพการกระจาย ( scatterplot) โดย

ก าหนดให้ตัวแปรอิสระ (X) อยู่ในแกนนอน (X Axis) และตัวแปรตาม (Y) อยู่ในแกนตั้ง (Y Axis) ถ้าตัว

แปรมีความสัมพันธ์เชิงเส้นตรง การกระจายของจุดข้อมูลจะมีเป็นรูปทรงรี (oval shape) หรือคล้าย

ซิการ์ (cigar shape) 

2. การตรวจสอบด้วยค่าสถิติ เช่น การตรวจสอบด้วยค่าสัมประสิทธิ์สหสัมพันธ์ (Correlation 

coefficient) ตัวแปรที่มีความสัมพันธ์ระหว่างกัน แสดงว่าเป็นตัวแปรที่มีความสัมพันธ์เชิงเส้น (Hair and 

Others, 2006: 205) โดยค่าสัมประสิทธิ์สหสัมพันธ์ (r) เป็นดัชนีบอกระดับความสัมพันธ์ (degree of 

association) หากมีค่าใกล้ 0 แสดงว่า มีความสัมพันธ์เชิงเส้นระหว่างกันน้อย แต่หากมีค่าใกล้ 1 แสดง

ว่า มีความสัมพันธ์เชิงเส้นระหว่างกันมาก  

ส าหรับในที่นี้จะน าเสนอเฉพาะการตรวจสอบความสัมพันธ์เชิงตรงระหว่าง 2 ตัวแปรด้วยค่า

สัมประสิทธิ์สหสัมพันธ์เท่านั้น โดยมีวิธีการดังนี้ 

๏ เปิดแฟ้มข้อมูล File -> Open -> ASPSS_Data.sav 
๏ สร้างตัวแปร 1 ตัวแปร คือ Income ต่อจากตัวแปร Child โดยมีรายละเอียดดังนี้ 

o คลิกเมาส์ปุ่มขวาที่เลข 9 หน้าตัวแปร Child -> เลือกค าสั่ง Insert Variable 
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o เพ่ิมตัวแปร Income (Label = Income of Responder และ Measure = Scale) 

 

๏ ใส่ค่าตัวแปรหรือข้อมูลโดยมีรายละเอียดดังนี้ 

 

1. ก าหนดสมมติฐาน 

   H0: ไม่มีความสัมพันธ์เชิงเส้นตรงระหว่างตัวแปร 

      : ไม่มีความสัมพันธ์เชิงเส้นตรงระหว่างตังแปรอายุและรายได้ 

   H1: มีความสัมพันธ์เชิงเส้นตรงระหว่างตัวแปร 

      : มีความสัมพันธ์เชิงเส้นตรงระหว่างตังแปรอายุและรายได้ 
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เกณฑ์ในการทดสอบสมมุติฐาน คือ หากการทดสอบสัมประสิทธิ์ความสัมพันธ์เพียร์สันได้ค่า

ความน่าจะเป็น (p-value) มากกว่าค่านัยส าคัญทางสถิติ (α = 0.05) จะยอมรับสมมติฐาน H0 แต่หากได้

ค่าความน่าจะเป็น (p-value) น้อยกว่าหรือเท่ากับค่านัยส าคัญทางสถิติ (α = 0.05) จะปฏิเสธสมมติฐาน 

H0 และยอมรับสมมติฐาน H1 

2. การใช้โปรแกรมวิเคราะห์ข้อมูล 

๏ เลือกเมนู Analyze -> Bivariate Correlation…   
o เลือกตัวแปร Age และ Income (ตัวแปรค่าต่อเนื่อง) จากรายการตัวแปรด้านซ้าย -> ใส่

ช่องว่างด้านขวา 
o Flag Significance Correlations เลือก / 
o กดปุ่ม OK 

 

3. ผลการวิเคราะห์ 

 

4. สรุป  

จากผลการทดสอบแสดงให้เห็นว่า ค่าความน่าจะเป็น (Sig.) = 0.263 มีค่ามากกว่าค่านัยส าคัญ

ทางสถิติที่ก าหนดไว้ (α = 0.05) จึงยอมรับสมมติฐาน H0: ไม่มีความสัมพันธ์เชิงเส้นตรงระหว่างตังแปร

อายุและรายได ้
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สรุป 

 การวิเคราะห์ข้อมูลเชิงส ารวจ คือ กระบวนการท าให้ข้อมูลมีความสมบูรณ์  (data cleansing) 
โดยการตรวจสอบข้อมูลให้มีความถูกต้องและตรงกับความเป็นจริง รวมถึงการตรวจหาค่าต่างสุด และ
การตรวจสอบค่าสูญหาย หากข้อมูลมีความไม่ถูกต้องและไม่สมบูรณ์จะมีผลท าให้การวิเคราะห์เบี่ยงเบน
ไปจากความเป็นจริง แม้ว่าข้อมูลจะมีความถูกต้องและสมบูรณ์แล้ว ก่อนการ ทดสอบแบบอิง
ค่าพารามิเตอร์ยังต้องมีการตรวจสอบ (data screening) ข้อตกลงเบื้องต้นเกี่ยวกับลักษณะของข้อมูล 
เช่น การแจกแจงปกติ ความเท่ากันของความแปรปรวน และความสัมพันธ์เชิงเส้นตรง เพราะการละเมิด
ข้อตกลงเบื้องต้นในการวิเคราะห์ข้อมูลด้วยสถิติแต่ละประเภทมีความเสี่ยงที่จะท าให้ผลวิเคราะห์เกิด
ความคลาดเคลื่อนและได้ข้อสรุปที่ไม่ถูกต้อง 

แบบฝึกหัดท้ายบท 

1. ให้ผู้เรียนตรวจสอบความถูกต้องของข้อมูลแบบไขว้ระหว่างตัวแปรอายุ (age) และระดับ

การศึกษา (edu)  

2. ให้ผู้เรียนวิเคราะห์จ านวนค่าสูญหายของแต่ละตัวอย่างจากตัวแปรเพศ (gender) 

สถานการณ์ท างาน (work) และต าแหน่งงาน (position) 

3. ให้ผู้เรียนวิเคราะห์หาค่าต่างสุดของตัวแปรจ านวนบุตร (child) 

4. ให้ผู้เรียนตรวจสอบการแจกแจงปกติแบบคอลมอโกรอฟ-สเมอร์นอฟ  (Kolmogorov-

Smirnov: K-S Test) ของตัวแปรจ านวนบุตร (child) 

5. ให้ผู้เรียนตรวจสอบความเท่ากันของความแปรปรวนของตัวแปรอายุ (age) ระหว่างกลุ่มเพศ 

(gender) 

6. ให้ผู้เรียนตรวจสอบความสัมพันธ์เชิงเส้นตรงระหว่างตัวแปรอายุ (age) กับจ านวนบุตร 

(child) 
  



 

 

ส่วนที่ 4 

การวิเคราะห์ข้อมูลด้วยสถิติเชิงพรรณนา 
  





 

 

บทที่ 10 
การวิเคราะห์ข้อมูลเชิงพรรณนา 1 ตัวแปร 

ความมุ่งหมายของบทเรียน 
ผู้เรียนสามารถใช้โปรแกรมประมวลผลการแจกแจงข้อมูลของตัวแปร 1 ตัวแปร ด้วยสถิติเชิง

พรรณนา และเขียนบรรยายผลการวิเคราะห์ได ้

เนื้อหา 
1. การวิเคราะห์ตัวแปรแบบค่าแบ่งกลุ่ม 

2. การวิเคราะห์ตัวแปรแบบค่าต่อเนื่อง 

กิจกรรมและวธิีสอน 
บรรยาย อธิบาย แสดงตัวอย่าง และท าแบบฝึกหัดท้ายบท 

อุปกรณ์การสอน 
เอกสารค าสอน ภาพเลื่อน คอมพิวเตอร์ โปรแกรม PSPP โปรแกรมสอนออนไลน์ (สอนแบบ

ออนไลน์) และเครื่องฉาย (สอนในชั้นเรียน) 

งานที่มอบหมาย 

 ท าแบบฝึกหัดท้ายบท 

การวัดผลและประเมินผล 

การเข้าชั้นเรียน สังเกตความสนใจจากการเรียน สอบถามความเข้าใจจากการบรรยาย และ

ประเมินจากการท าแบบฝึกหัดท้ายบท 

  



196 | ก า ร ใ ช้ โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร์ ท า ง ส ถิ ติ ใ น ด้ า น สั ง ค ม ศ า ส ต ร์  

เนื้อหา 

การน าเสนอข้อมูลทั่วไปเกี่ยวของประชากรและกลุ่มตัวอย่างส่วนใหญ่ใช้การวิเคราะห์ข้อมูล 1 

ตัวแปร (univariate analysis) เพ่ือน าเสนอลักษณะของข้อมูลและบรรยายลักษณะของข้อมูลของแต่ละ

ตัวแปร และสถิติที่นิยมใช้คือสถิติเชิงพรรณนา ได้แก่ ค่าความถี่ (frequency) ค่าร้อยละ (percentage)  

ค่าฐานนิยม (mode) ค่าเฉลี่ย (mean) ค่าเบี่ยงเบนมาตรฐาน (standard deviation) และค่าสัมประสิทธิ์

การกระจาย (coefficient of variation)  

1. การวิเคราะห์ตัวแปรแบบค่าจัดประเภท 

การวิเคราะห์ตัวแปรแบบค่าจัดประเภท 1 ตัวแปร เป็นการวิเคราะห์และอธิบายข้อมูลจากตัว

แปรที่มีระดับการวัดเป็นค่าจัดประเภท (categorical variables) เช่น ตัวแปรแบบมาตราจัดกลุ่ม 

(nominal scale) และตั วแปรแบบมาตราจัด อันดับ  ( scale: ordinal) ด้ วยสถิ ติ เ ชิ งพรรณนา 

(descriptive statistics) ดังนี้ 

1. การแจกแจงความถี่ (frequency distribution) ได้แก่ จ านวนนับ ความถี่ และค่าร้อยละ)  

2. การวิเคราะห์ต าแหน่ง (location) หรือแนวโน้มเข้าศูนย์กลาง (central tendency) ได้แก่ ค่า

ฐานนิยม (mode) 

1.1 การวิเคราะห์ข้อมูลด้วยค่าร้อยละ 

 คา่รอ้ยละ (Percentage) คือ สว่นหนึ่ง (a portion) ของผลรวมเมื่อเทียบกบัส่วนรอ้ยท่ีแสดง
เป็นตวัเลขระหวา่ง 0 ถึง 100  

ตัวอย่างค าถามการวิจัย 

จากการส ารวจข้อมูลของพนักงานในหน่วยงานต้องการทราบว่า พนักงานแต่ละต าแหน่งมี

จ านวนมากน้อยเพียงใด 
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1.1.1 ตัวแปร 

ชื่อตัวแปร มาตรการวัด 

ต าแหน่งงาน (jobcat) จัดกลุ่ม 

1.1.2 การใช้โปรแกรมวิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล File -> Open -> Employee Data.sav 
๏ เมนู Analyze -> Descriptive Statistics -> Frequencies… 

o Variable (s): เลือกตัวแปรแบบค่าแบ่งกลุ่ม 1 ตัวแปร หรือมากกว่า จากรายการตัวแปร
ด้านซ้าย  

o ในกลุ่มค าสั่ง Statistic: ไม่เลือกสถิติ Mean, Standard deviation, Minimum และ 
Maximum   

o กดปุ่ม OK 

 

1.1.3 ผลการวิเคราะห์ 
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1.1.4 การสร้างตารางผลการวิเคราะห์ 

ตารางที ่(#) แสดงจ านวนและค่าร้อยละของกลุ่มตัวอย่างพนักงาน จ าแนกตามต าแหน่งงาน 

ต าแหน่งงาน จ านวน ร้อยละ 

เจ้าหน้าที่ปฏิบัติงาน 363 76.6 

หัวหน้างาน 27 5.7 

ผู้จัดการ 84 17.7 

รวม 474 100.0 

1.1.5 การแปลผลและสรุป 

จากตารางที ่(#) แสดงให้เห็นว่า กลุ่มตัวอย่างส่วนใหญ่เป็นเจ้าหน้าที่ปฏิบัติงาน รองลงมา คือ 

ผู้จัดการ และน้อยที่สุดคือ หัวหน้างาน 

ตัวอย่างเพิ่มเติม: การแปลผลและสรุป 

#1 

จากตารางที ่(#) แสดงให้เห็นว่า กลุ่มตัวอย่างจ านวน 474 คน เป็นเจ้าหน้าที่ปฏิบัติงาน จ านวน 

363 คน คิดเป็นร้อยละ 76.6 เป็นหัวหน้างาน จ านวน 27 คน คิดเป็นร้อยละ 5.7 และเป็นผู้จัดการ 

จ านวน 84 คน คิดเป็นร้อยละ 17.7    

#2 

จากตารางที่ (#) แสดงให้เห็นว่า กลุ่มตัวอย่างจ านวน 474 คน เป็นเจ้าหน้าที่ปฏิบัติงาน ร้อยละ 

76.6 (363 คน) เป็นหัวหน้างาน ร้อยละ 5.7 (27 คน) และเป็นผู้จัดการ ร้อยละ 17.7 (84 คน) 

#3 

 จากตารางที ่(#) แสดงให้เห็นว่า กลุ่มตัวอย่างจ านวน 474 คน ส่วนใหญ่เป็นเจ้าหน้าที่

ปฏิบัติงาน ร้อยละ 76.6 (363 คน) รองลงมา คือ ผู้จัดการ ร้อยละ 17.7 (84 คน) และน้อยที่สุดเป็น

หัวหน้างาน ร้อยละ 5.7 (27 คน)  
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1.2 การวิเคราะห์ข้อมูลด้วยค่าฐานนิยม 

 คา่ฐานนิยม (Mode) คือ คา่ท่ีแสดงความถ่ีมากท่ีสดุ (most frequency) ของขอ้มลู 1 ชดุ 
หรือ 1 ตวัแปร ขอ้มลูแตล่ะชดุอาจมีคา่ฐานนิยม 1 คา่ หรือมากกวา่ 1 คา่ หรืออาจไมมี่คา่ฐานนิยม
เลยก็เป็นได ้

ตัวอย่างค าถามการวิจัย 

จากข้อมูลการส ารวจผู้มาใช้บริการต้องการทราบว่า ผู้ใช้บริการให้คะแนนการให้บริการแต่ละ

ด้านอยู่ในระดับมากที่สุด 

1.2.1 ตัวแปร 

ชื่อตัวแปร มาตรการวัด 

ความพึงพอใจกับการให้บริการ (V1) จัดอันดับ 

ความคุ้มค่าของเงินกับการให้บริการ (V2) จัดอันดับ 

ความล่าช้าของพนักงานในการให้บริการ (V3) จัดอันดับ 

ความมีประสิทธิภาพในการให้บริการ (V4) จัดอันดับ 

ความความดังของเสียงรบกวนภายในห้องพัก (V5) จัดอันดับ 

1.2.2 การใช้โปรแกรมวิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล File -> Open -> hotel.sav 

๏ เลือกเมนู Analyze -> Descriptive Statistics -> Frequencies… 
o Variable (s): เลือกตัวแปรแบบค่าแบ่งกลุ่ม 1 ตัวแปร หรือหลายตัวแปร จากรายการตัว

แปรด้านซ้าย  
o ในกลุ่มค าสั่ง Statistic: ไม่เลือกสถิติ Mean, Standard deviation, Minimum, 

Maximum และเลือกสถิติ Mode  
o กดปุม่ Frequency Tables… -> Display frequency tables เลือก Never -> กด

ปุ่ม Continue 
o กดปุ่ม OK   
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1.2.3 ผลการวิเคราะห์ 

 

1.2.4 การสร้างตารางผลการวิเคราะห์ 

ตารางที ่(#) แสดงค่าฐานนิยมของการประเมินการให้บริการของโรงแรม 

ข้อ การบริการ จ านวน ฐานนิยม 

1. ความพึงพอใจกับการให้บริการ 17 ไม่เห็นด้วยอย่างยิ่ง 
2. ความคุ้มค่าของเงินกับการให้บริการ 17 ไม่เห็นด้วย 
3. ความล่าช้าของพนักงานในการให้บริการ 17 เห็นด้วยอย่างยิ่ง 
4. ความมีประสิทธิภาพในการให้บริการ 17 ไม่มีความเห็น 
5. ความดังของเสียงรบกวนภายในห้องพัก 17 ไมเ่ห็นด้วยอย่างยิ่ง 

1.2.5 การแปลผลและสรุป 

 จากตารางที่ (#) แสดงให้เห็นว่า กลุ่มตัวอย่างส่วนใหญ่ประเมินการให้บริการของโรงแรมเกือบ

ทุกข้ออยู่ในระดับไม่พึงพอใจกับการให้บริการ ยกเว้นด้านเสียงภายในห้องพักที่ประเมินให้อยู่ในระดับพึง

พอใจมาก 
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2. การวิเคราะหต์ัวแปรแบบค่าต่อเนื่อง 

การวิเคราะห์ตัวแปรแบบค่าต่อเนื่อง 1 ตัวแปร เป็นการวิเคราะห์และอธิบายข้อมูลจากตัวแปรที่

มีระดับการวัดเป็นค่าต่อเนื่อง (continuous variables) ด้วยสถิติเชิงพรรณนา เช่น การวิเคราะห์

ต าแหน่ง (location) หรือแนวโน้มเข้าศูนย์กลาง (central tendency)  ได้แก่ ค่าเฉลี่ย (mean) การ

วิเคราะห์การกระจาย (dispersion/variation) ได้แก่ ส่วนเบี่ยงเบนมาตรฐาน (standard deviation) 

และการวิเคราะห์รูปร่างของการแจกแจงข้อมูล ( shape of the distributions) ได้แก่ ความเบ้  

(skewness) และความโด่ง (kurtosis) ของข้อมูล  

สถิติเชิงพรรณนาที่นิยมใช้วิเคราะห์ตัวแปรแบบค่าต่อเนื่อง คือ ค่าเฉลี่ย (Mean) ที่เป็นค่าการ

เฉลี่ย (average) หรือค่ากลาง (middle) ของข้อมูลประเภทหนึ่ง โดยการบวก (add) รวมค่าทั้งหมด 

(total) ในชุดข้อมูล และท าการหาร (divided) ด้วยจ านวนค่าของข้อมูลทั้งหมดในชุดข้อมูล 

2.1 การวิเคราะห์ข้อมูลค่าเฉลี่ย (รายตัวแปร) 

 การวิเคราะห์รายตัวแปร คือ การวิเคราะห์ตัวแปรวัดที่ได้จากการวัดมิติเดียว เช่น อายุ เงินเดือน 
ระยะเวลาท างาน น้ าหนัก ส่วนสูง 

ตัวอย่างค าถามการวิจัย 

จากการส ารวจข้อมูลของพนักงานในหน่วยงานต้องการทราบว่า  พนักงานมีค่าเฉลี่ยของ

เงินเดือนปัจจุบัน เงินเดือนเริ่มต้น ระยะเวลาท างาน และประสบการณ์ เป็นอย่างไร 

2.1.1 ตัวแปร 

ชื่อตัวแปร มาตราการวัด 

เงินเดือนปัจจุบัน (salary) ค่าต่อเนื่อง/สเกล 

เงินเดือนเริ่มต้น (salbegin) ค่าต่อเนื่อง/สเกล 

ระยะเวลาท างาน (jobtime) ค่าต่อเนื่อง/สเกล 

ประสบการณ์ (prevexp) ค่าต่อเนื่อง/สเกล 
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2.1.2 การใช้โปรแกรมวิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล File -> Open -> Employee Data.sav 
๏ เลือกเมน ูAnalyze -> Descriptive Statistics -> Descriptives… 

o Variable (s): เลือกตัวแปรแบบค่าต่อเนื่อง 1 ตัวแปร หรือมากกว่า จากรายการตัวแปร
ด้านซ้าย 

o ในกลุ่มค าสั่ง Statistics:  เลือกสถิติ Mean, Standard deviation, Minimum และ 
Maximum  

o กดปุ่ม OK 

 

2.1.3 ผลการวิเคราะห์ 
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2.1.4 การสร้างตารางผลการวิเคราะห์ 

ตารางที ่(#) แสดงค่าเฉลี่ย ค่าเบี่ยงเบนมาตรฐาน และค่าสัมประสิทธิ์การกระจายข้อมูลพ้ืนฐานของ

พนักงาน 

ข้อมูลพื้นฐาน จ านวน ค่าต่ าสุด ค่าสูงสุด ค่าเฉลี่ย S.D. CV16 (%) 

เงินเดือนปัจจุบัน (ดอลล่าร์) 474 15,750 135,000 34,419.57 17,075.661 49.61 

เงินเดือนเริ่มต้น (ดอลล่าร์) 474 9,000 79,980 17,016.09 7,870.638 46.25 

ระยะเวลาท างาน (เดือน) 474 63 98 81.11 10.061 12.40 

ประสบการณ์ก่อนท างาน (เดือน) 474 0 476 95.86 104.586 100.10 

2.1.5 การแปลผลและสรุป 

จากตารางที่ (#) แสดงให้เห็นว่า กลุ่มตัวอย่างจ านวน 474 คน มีเงินเดือนปัจจุบันเฉลี่ย 

34,419.57 ดอลลาร์ มีเงินเดือนเริ่มต้นเฉลี่ย 17,016.09 ดอลลาร์ มีระยะเวลาท างานเฉลี่ย 81.11 เดือน 

และมีประสบการณ์ก่อนท างาน เฉลี่ย 95.86 เดือน  

เมื่อพิจารณาจากค่าสัมประสิทธิ์การกระจาย (coefficient of variation: CV) แสดงให้เห็น กลุ่ม

ตัวอย่างมีเงินเดือนปัจจุบันแตกต่างกันอยู่ในระดับน้อย มีเงินเดือนเริ่มต้นแตกต่างกันอยู่ในระดับน้อย มี

ระยะเวลาท างานแตกต่างกันอยู่ในระดับน้อยมาก และมีประสบการณ์ก่อนท างานแตกต่างกันอยู่ในระดับ

มาก 

  

                                                           
16 สัมประสิทธิ์การกระจาย (Coefficient of Variation: C.V.) คือ ค่าวัดการกระจายของข้อมูลรอบค่าเฉลี่ยจากอัตราส่วน (ratio) ของค่า
เบี่ยงเบนมาตรฐาน (standard deviation) ต่อค่าเฉลี่ย (mean) หรือค านวณจากค่า Standard deviation หารด้วยค่า Mean และคูณด้วย 
100 หากค่า C.V. น้อยกว่า 1 หรือ 100 แสดงว่าข้อมูลมีการกระจายน้อย แต่หากมากกว่า 1 หรือ 100 แสดงว่าข้อมูลมีการกระจายมาก 
สามารถน าไปใช้เปรียบเทียบการกระจายของข้อมูลระหว่างกลุ่มได้ง่ายกว่าค่าเบี่ยงเบนมาตรฐาน  
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ตัวอย่างเพิ่มเติม: การแปลผลและสรุป 

#1 

จากตารางที่ (#) แสดงให้เห็นว่า กลุ่มตัวอย่างจ านวน 474 คน มีเงินเดือนปัจจุบันเฉลี่ย 

34,419.57 ดอลลาร์ โดยมีเงินเดือนปัจจุบันต่ าสุด 15,750 ดอลลาร์ และสูงสุด 135,000 ดอลลาร์ มี

เงินเดือนเริ่มต้น เฉลี่ย 17,016.09 ดอลลาร์ โดยมีเงินเดือนเริ่มต้นต่ าสุด 9,000 ดอลลาร์ และสูงสุด 

79,980 ดอลลาร์ มีระยะเวลาท างาน เฉลี่ย 81.11 เดือน โดยมีระยะเวลาท างานต่ าสุด 63 เดือน และ

สูงสุด 98 เดือน และมีประสบการณ์ก่อนท างาน เฉลี่ย 95.86 เดือน โดยมีประสบการณ์ก่อนท างานต่ าสุด 

0 เดือน และสูงสุด 476 เดือน 

เมื่อพิจารณาจากค่าสัมประสิทธิ์การกระจาย (coefficient of variation: CV) แสดงให้เห็น กลุ่มตัวอย่าง

มีเงินเดือนปัจจุบันแตกต่างกันน้อย (C.V. = 49.61) มีเงินเดือนเริ่มต้นแตกต่างกันน้อย (C.V. = 46.25) มี

ระยะเวลาท างานแตกต่างกันน้อยมาก (C.V. = 12.40) และมีประสบการณ์ก่อนท างานแตกต่างกันมาก 

(C.V. = 100.10)  

#2 

 จากตารางที่ (#) แสดงให้เห็นว่า พนักงานของหน่วยงานนี้มีเงินเดือนเริ่มต้น เงินเดือนปัจจุบัน 

และระยะเวลาท างานแตกต่างกันอยู่ในระดับน้อย แต่มีประสบการณ์ก่อนท างานแตกต่างกันอยู่ในระดับ

มาก 
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2.2 การวิเคราะห์ข้อมูลด้วยค่าเฉลี่ย (ตัวแปรดัชนี) 

 การวิเคราะห์ตัวแปรดัชนี คือ การวิเคราะห์ข้อค าตอบหรือดัชนีของตัวแปรเชิงโครงสร้าง 
(construct variables) หรือตัวแปรแฝง (latent variables) เช่น คุณภาพการให้บริการ ความสุขในการ
ท างาน ความผูกพันต่อองค์การ   

ตัวอย่างค าถามการวิจัย 

จากการส ารวจการให้บริการผู้มาใช้บริการต้องการทราบว่า ผู้ให้บริการให้คะแนนการให้บริการ

รายข้ออยู่ในระดับใด 

2.2.1 ตัวแปร 

ตัวแปรเชิงโครงสร้างหรือตัวแปรแฝง (คุณภาพการให้บริการ) 

ดัชนี ประเภทค าถาม การให้คะแนน 

ความพึงพอใจกับการให้บริการ (V1) + ปกติ (5= มาก <--> 1 = น้อย) 

ความคุ้มค่าของเงินกับการให้บริการ (V2) + ปกติ (5= มาก <--> 1 = น้อย) 

ความล่าช้าของพนักงานในการให้บริการ (V3) - กลับค่า (5= น้อย <--> 1 = มาก) 

ความมีประสิทธิภาพในการให้บริการ (V4) + ปกติ (5= มาก <--> 1 = น้อย) 

ความความดังของเสียงรบกวนภายในห้องพัก (V5) - กลับค่า (5= น้อย <--> 1 = มาก) 

ผลการวิเคราะห์ก่อนกลับค่าของตัวแปร 
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2.2.2 การใช้โปรแกรมวิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล File -> Open -> hotel.sav 
๏ กลับค่าของตัวแปร V3 และ V5 

o เมนู Transform -> Recode in Same Variables 
o Variables: เลือกตัวแปร V3 และ V5 จากรายการตัวแปรด้านซ้าย 
o กดปุ่ม Old and New Values… -> เปลี่ยนค่า 5->1, 4 -> 2, 2 -> 4 และ 1 -> 5 
o กดปุ่ม Continue 
o กดปุ่ม OK  

 

 

๏ สร้างตัวแปร SumService (รวมคะแนนประเมินการให้บริการด้วยค่าเฉลี่ย) 
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๏ เลือกเมนู Analyze -> Descriptive Statistics -> Descriptives… 
o Variable (s): เลือกตัวแปร V1, V2, V3, V4, V5 และ SumService จากรายการตัวแปร

ด้านซ้าย 
o ในกลุ่มค าสั่ง Statistics: เลือกสถิติ Mean และ Standard deviation 
o กดปุม่ OK 

 

2.2.3 ผลการวิเคราะห์ 

 

2.2.4 การสร้างตารางผลการวิเคราะห์ 

ตารางที ่(#) แสดงค่าเฉลี่ย ค่าเบี่ยงเบนมาตรฐาน และค่าสัมประสิทธิ์การกระจายคะแนนการให้บริการ 

การประเมินของผู้ใช้บริการ จ านวน ค่าเฉลี่ย S.D. C.V. (%) 

ความพึงพอใจในการให้บริการ 17 2.53 1.33 58.08 

ความคุ้มค่าของเงินกับการให้บริการ 17 2.29 1.31 57.21 

ความรวดเร็วของพนักงานในการให้บริการ 17 2.53 1.37 54.15 

ความมีประสิทธิภาพในการให้บริการ 17 2.41 1.12 46.47 

ความเงียบของเสียงภายในห้องพัก 17 4.00 1.17 29.25 

รวม 17 2.75 0.59 21.45 
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2.2.5 การแปลผลและสรุป 

จากตารางที่ (#) แสดงให้เห็นว่า กลุ่มตัวอย่างให้คะแนนเฉลี่ยรวมการให้บริการอยู่ที่ 2.75 จาก

คะแนนเต็ม 5 คะแนน โดยให้คะแนนด้านความเงียบของเสียงภายในห้องพักมากที่สุด รองลงมา คือ 

ความพึงพอใจในการให้บริการและความรวดเร็วของพนักงาในการให้บริการ ความมีประสิทธิภาพในการ

ให้บริการ และน้อยที่สุด คือ ความคุ้มค่าของเงินกับการให้บริการ 

 เมื่อพิจารณาจากค่าสัมประสิทธิ์การกระจาย (C.V.) แสดงให้เห็นว่า กลุ่มตัวอย่างให้คะแนนการ

ประเมินโดยรวมและรายข้อทุกข้อแตกต่างกันอยู่ในระดับน้อย  

สรุป 

 การวิเคราะห์ข้อมูล 1 ตัวแปร เป็นการแจกแจงให้เห็นลักษณะของข้อมูลของแต่ละตัวแปร ใน

การวิเคราะห์ต้องเลือกใช้สถิติให้สอดคล้องกับลักษณะของข้อมูลของแต่ละตัวแปร คือ  ตัวแปรแบบค่า

แบ่งกลุ่ม ใช้ค่าความถี่ ค่าร้อยละ และค่าฐานนิยม ส่วนตัวแปรแบบค่าต่อเนื่อง ใช้ค่าเฉลี่ย ค่าเบี่ ยงเบน

มาตรฐาน และค่าสัมประสิทธิ์การกระจาย   

แบบฝึกหัดท้ายบท 

ให้ผู้เรียนเปิดแฟ้มข้อมูล 1991 US. General Social Survey.sav แล้วประมวลผลข้อมูล เพ่ือ

วิเคราะห์และอธิบายผล ดังนี้ 

1. วิเคราะห์และอธิบายผลตัวแปรภูมิภาค (region) อายุ (age) และการศึกษา (educ) ด้วย
ค าสั่ง Frequencies หรือ Descriptive  

ตารางที ่(#) จ านวนและค่าร้อยละของ…………. จ าแนกตาม…………… 
………………… จ านวน ร้อยละ 

   

รวม   
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ตารางที ่(#) แสดงค่าเฉลี่ย ค่าเบี่ยงเบนมาตรฐาน และค่าสัมประสิทธิ์การกระจายของ…………… 

ตัวแปร จ านวน ค่าต่ าสุด ค่าสูงสุด ค่าเฉลี่ย S.D. CV17 (%) 

       

2. วิเคราะห์และอธิบายผลตัวแปรพ่ีน้อง (sibs) และบุตร (childs) ด้วยค าสั่ง Explore แล้ว
อธิบายลักษณะข้อมูลด้วยค่าเฉลี่ย (mean) ค่ามัธยฐาน (median) ค่าต่ าสุด (minimum) 
ค่าสูงสุด (maximum) ค่าพิสัย (range) ค่าความเบ้ (skewness) ค่าความโด่ง (kurtosis) 
และค่าผิดปกติ (outlier) 

ตารางที ่(#) แสดง………………………….. 

ตัวแปร จ านวน ค่าต่ าสุด ค่าสูงสุด ค่าเฉลี่ย ค่ามัธยฐาน ค่าพิสัย ค่าความเบ้ ค่าความโด่ง ค่าผิดปกติ 

          

                                                           
17 สัมประสิทธิ์การกระจาย (Coefficient of Variation) 





 

 

บทที่ 11 

การวิเคราะห์ข้อมูลเชิงพรรณนา 2 ตัวแปร  
ความมุ่งหมายของบทเรียน 

ผู้เรียนสามารถใช้โปรแกรมประมวลผลการเปรียบเทียบข้อมูลของตัวแปร 2 ตัวแปร ด้วยสถิติ

เชิงพรรณนา และเขียนบรรยายผลการวิเคราะห์ได้ 

เนื้อหา 
1. การวิเคราะห์ข้อมูลระหว่างตัวแปรแบบค่าแบ่งประเภท 

2. การวิเคราะห์ข้อมูลระหว่างตัวแปรแบบค่าแบ่งประเภทกับตัวแปรแบบค่าต่อเนื่อง 

กิจกรรมและวธิีสอน 
บรรยาย อธิบาย แสดงตัวอย่าง และท าแบบฝึกหัดท้ายบท 

อุปกรณ์การสอน 

เอกสารค าสอน ภาพเลื่อน คอมพิวเตอร์ โปรแกรม PSPP โปรแกรมสอนออนไลน์ (สอนแบบ

ออนไลน์) และเครื่องฉาย (สอนในชั้นเรียน) 

งานที่มอบหมาย 

 ท าแบบฝึกหัดท้ายบท 

การวัดผลและประเมินผล 

การเข้าชั้นเรียน สังเกตความสนใจจากการเรียน สอบถามความเข้าใจจากการบรรยาย และ

ประเมินจากการท าแบบฝึกหัดท้ายบท 
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เนื้อหา 

การวิเคราะห์ข้อมูล 2 ตัวแปร (bivariate analysis) คือ วิธีการน าเอาตัวแปร 2 ตัวแปร มาไขว้

หรือเปรียบเทียบกันเพื่อหารูปแบบของความสัมพันธ์ระหว่างตัวแปรด้วยสถิติเชิงพรรณนา เช่น ค่าความถี่ 

(frequency) ค่าร้อยละ (percentage) ค่าเฉลี่ย (mean) ค่าเบี่ยงเบนมาตรฐาน (standard deviation) 

และค่าสัมประสิทธิ์การกระจาย (coefficient of variation)  

1. การวิเคราะห์ข้อมูลระหว่างตัวแปรแบบค่าจัดประเภท 

การวิเคราะห์ข้อมูลระหว่างตัวแปรแบบค่าจัดประเภท เป็นการการน าเสนอข้อมูลในรูปของ

ตารางเพ่ือสรุปข้อมูลที่เกิดจากความสัมพันธ์ของตัวแปร 2 ตัวแปร (2x2) หรือมากกว่า (NxN)  

1.1 การวิเคราะห์แบบตารางไขว้ 2 ตัวแปร 

การวิเคราะห์แบบตารางไขว้ 2 ตัวแปร เป็นการวิเคราะห์ข้อมูลระหว่างตัวแปรแบบค่าจัด

ประเภท 2 ตัวแปร  เพ่ือสรุปข้อมูลและเปรียบเทียบความสัมพันธ์ระหว่าง 2 ตัวแปร โดยใช้สถิติเชิง

พรรณนา ได้แก่ ค่าความถี่และค่าร้อยละ 

ตัวอย่างค าถามการวิจัย 

จากการส ารวจข้อมูลของพนักงานในหน่วยงานต้องการทราบว่า พนักงานแต่ละเพศมีต าแหน่ง

งานแตกต่างกันมากน้อยเพียงใด 

1.1.1 ตัวแปร 

ตัวแปรอิสระ 

-> 

ตัวแปรตาม 

ค่าจัดกลุ่ม ค่าจัดกลุ่ม 

เพศ (gender) 
- ชาย 
- หญิง 

ต าแหน่งงาน (jobcat) 

- เจ้าหน้าที่ปฏิบัติงาน 
- หัวหน้างาน 
- ผู้จัดการ 
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1.1.2 การใช้โปรแกรมวิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล Employee Data.sav 
๏ เลือกเมนู Analyze -> Descriptive Statistics -> Crosstabs … 

o Rows: เลือกตัวแปรแบบค่าจัดประเภท 1 ตัวแปร หรือหลายตัวแปร (ตัวแปรที่ต้องการให้
เป็นตัวแปรอิสระ) จากรายการตัวแปรด้านซ้าย  

o Column: เลือกตัวแปรแบบค่าจัดประเภท 1 ตัวแปร หรือหลายตัวแปร (ตัวแปรที่
ต้องการให้เป็นตัวแปรตาม) จากรายการตัวแปรด้านซ้าย  

o กดปุ่ม Statistics… ในกลุ่มค าสั่ง Statistics ไมเ่ลือกสถิติ Chisq -> กดปุ่ม Continue 
o กดปุ่ม Cells… ในกลุ่มค าสั่ง Cell Display เลือกค่าร้อยละเฉพาะ Count และ Row -

> กดปุ่ม Continue 
o กดปุ่ม OK  

 

 

 

1.1.3 ผลการวิเคราะห์ 
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1.1.4 การสร้างตารางแสดงผลการวิเคราะห์ 

ตารางที ่(#) แสดงค่าร้อยละของพนักงาน จ าแนกตามเพศและต าแหน่งงาน 

เพศ 
ต าแหน่งงาน 

รวม 
เจ้าหน้าที่ปฏิบัติงาน หัวหน้างาน ผู้จัดการ 

หญิง 95.4 0.0 4.6 100.0 (216) 

ชาย 60.9 10.5 28.7 100.0 (258) 

รวม 76.6 5.7 17.7 100.0 (474) 

1.15 การแปลผลและสรุป 

จากตารางที่ (#) แสดงให้เห็นว่า กลุ่มตัวอย่างทั้งเพศหญิงและเพศชายส่วนใหญ่เป็นเจ้าหน้าที่

ปฏิบัติงาน เพศหญิงเป็นผู้จัดการน้อยที่สุด ส่วนเพศชายเป็นหัวหน้างานน้อยที่สุด  

เมื่อเปรียบเทียบการด ารงต าแหน่งงานของเพศหญิงและเพศชาย แสดงให้เห็นว่า เพศหญิงเป็น

เจ้าหน้าที่ปฏิบัติงานมากกว่าเพศชาย เพศชายเป็นหัวหน้างานและผู้จัดการมากกว่าเพศหญิง  

สรุป เพศชายมีต าแหน่งงานสูงกว่าเพศหญิง 
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ตัวอย่างเพิ่มเติม: การสร้างตารางแสดงผลการวิเคราะห์ 

#1 

เพศ 
ต าแหน่งงาน 

รวม 
เจ้าหน้าที่ปฏิบัติงาน หัวหน้างาน ผู้จัดการ 

หญิง 205 (95.4) 0 (0.0) 10 (4.6) 216 (100.0) 

ชาย 157 (60.9) 27 (10.5) 74 (28.7) 258 (100.0) 

รวม 363 (76.6) 27 (5.7) 84 (17.7) 474 (100.0) 

#2 

เพศ 
ต าแหน่งงาน 

รวม 
เจ้าหน้าที่ปฏิบัติงาน หัวหน้างาน ผู้จัดการ 

หญิง 95.4 (205) 0.0 (0) 4.6 (10) 100.0 (216) 

ชาย 60.9 (157) 10.5 (27) 28.7 (74) 100.0 (258) 

รวม 76.6 (363) 5.7 (27) 17.7 (84) 100.0 (474) 

ตัวอย่างเพิ่มเติม: การแปลผลและสรุป 

#1 

จากตารางที่ (#) แสดงให้เห็นว่า กลุ่มตัวอย่างที่เป็นพนักงานทั้งหมดจ านวน 474 คน แบ่งเป็น

เพศหญิง จ านวน 216 คน คิดเป็นจ านวนร้อยละ 100.0 เป็นเจ้าหน้าที่ปฏิบัติงาน จ านวน 205 คน คิด

เป็นจ านวนร้อยละ 95.4 เป็นหัวหน้างาน จ านวน 0 คน คิดเป็นจ านวนร้อยละ 0.0 และเป็นผู้จัดการ 

จ านวน 10 คน คิดเป็นจ านวนร้อยละ 4.6 และแบ่งเป็นเพศชาย จ านวน 258 คน คิดเป็นจ านวนร้อยละ 

100.0 เป็นเจ้าหน้าที่ปฏิบัติงาน จ านวน 157 คน คิดเป็นจ านวนร้อยละ 60.9 เป็นหัวหน้างาน จ านวน 27 

คน คิดเป็นจ านวนร้อยละ 10.5 และเป็นผู้จัดการ จ านวน 74 คน คิดเป็นจ านวนร้อยละ 28.7 

#2 

จากตารางที่ (#) แสดงให้เห็นว่า กลุ่มตัวอย่างที่เป็นพนักงานทั้งหมด จ านวน 474 คน แบ่งเป็น

เพศหญิง  จ านวน 216 คน และเพศชาย จ านวน 258 คน เพศหญิงส่วนใหญ่เป็นเจ้าหน้าที่ปฏิบัติงาน 

จ านวนร้อยละ 95.4 รองลงมา คือ ผู้จัดการ จ านวนร้อยละ 4.6 และไม่มีเพศหญิงในต าแหน่งหัวหน้างาน 
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ส่วนกลุ่มตัวอย่างเพศชายส่วนใหญ่เป็นเจ้าหน้าที่ปฏิบัติงาน จ านวนร้อยละ 60.9 รองลงมา คือ ผู้จัดการ 

จ านวนร้อยละ 28.7 และน้อยที่สุด คือ หัวหน้างาน จ านวนร้อยละ 10.5   

เมื่อเปรียบเทียบการด ารงต าแหน่งงานระหว่างเพศหญิงและเพศชาย แสดงให้เห็นว่า เพศหญิง

เป็นเจ้าหน้าที่ปฏิบัติงานมากกว่าเพศชาย เพศชายเป็นหัวหน้างานและผู้จัดการมากกว่าเพศหญิง  

โดยสรุปแสดงให้เห็นว่า เพศชายมีต าแหน่งงานสูงกว่าเพศหญิง   

#3 

จากตารางที่ (#) แสดงให้เห็นว่า กลุ่มตัวอย่างที่เป็นเพศหญิงส่วนใหญ่เป็นเจ้าหน้าที่ปฏิบัติงาน 

รองลงมา คือ ผู้จัดการ และไม่มีเพศหญิงในต าแหน่งหัวหน้างาน ส่วนกลุ่มตัวอย่างที่เป็นเพศชายส่วนใหญ่

เป็นเจ้าหน้าที่ปฏิบัติงาน รองลงมา คือ ผู้จัดการ และน้อยที่สุด คือ หัวหน้างาน  

เมื่อเปรียบเทียบการด ารงต าแหน่งงานระหว่างเพศหญิงและเพศชาย แสดงให้เห็นว่า เพศหญิง

เป็นเจ้าหน้าที่ปฏิบัติงานมากกว่าเพศชาย เพศชายเป็นหัวหน้างานและผู้จัดการมากกว่าเพศหญิง  

สรุป เพศชายมีต าแหน่งงานสูงกว่าเพศหญิง   
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1.2 การวิเคราะห์แบบตารางไขว้ 2 ตัวแปร โดยมีตัวแปรคุม 

การวิเคราะห์แบบตารางไขว้ 2 ตัวแปร โดยมีตัวแปรคุม เป็นการวิเคราะห์ข้อมูลระหว่างตัวแปร

แบบค่าจัดกลุ่ม 2 ตัวแปรเหมือนกันแตม่ีตัวแปรคุมเป็นตัวแปรค่าจัดกลุ่ม เพ่ือสรุปข้อมูลและเปรียบเทียบ

ความสัมพันธ์ระหว่างตัวแปรมากกว่า 2 ตัวแปร ในรูปของตาราง 2x3 หรือ 3x2 หรือมากกว่า (NxN) ด้วย

สถิติเชิงพรรณนา ได้แก่ ค่าความถ่ีและค่าร้อยละ 

ตัวอย่างค าถามการวิจัย 

จากการส ารวจข้อมูลของพนักงานในหน่วยงานต้องการทราบว่า พนักงานแต่ละเพศในแต่ละ

กลุ่มชนมีต าแหน่งงานแตกต่างกันมากน้อยเพียงใด 

1.2.1 ตัวแปร 

ตัวแปรอิสระ 

ตัวแปรคุม 

ค่าจัดกลุ่ม 

กลุ่มชน (minority) 

-> 

ตัวแปรตาม 

ค่าจัดกลุ่ม ค่าจัดกลุ่ม 

เพศ (gender)  

- ชาย 
- หญิง 

ต าแหน่งงาน (jobcat) 

- เจ้าหน้าที่ปฏิบัติงาน 

- หัวหน้างาน 

- ผู้จัดการ 
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1.2.2 การใช้โปรแกรมวิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล Employee Data.sav 
๏ เลือกเมนู Data -> Split File… 

o เลือกค าสั่ง Compare groups. 
o ใน Group base on เลือกตัวแปรแบบค่าจัดประเภทจากรายการเมนูด้านซ้าย 1 ตัวแปร 

หรือมากกว่า 
o กดปุ่ม OK 

 

๏ เมนู Analyze -> Descriptive Statistics -> Crosstabs … 
o Rows: เลือกตัวแปรแบบค่าจัดประเภท 1 ตัวแปร หรือหลายตัวแปร (ตัวแปรที่ต้องการให้

เป็นตัวแปรอิสระ) จากรายการตัวแปรด้านซ้าย 
o Column: เลือกตัวแปรแบบค่าจัดประเภท 1 ตัวแปร หรือหลายตัวแปร (ตัวแปรที่

ต้องการให้เป็นตัวแปรตาม) จากรายการตัวแปรด้านซ้าย 
o กดปุ่ม Statistics… ในกลุ่มค าสั่ง Statistics ไม่เลือกสถิต ิChisq -> กดปุ่ม Continue 
o กดปุ่ม Cells… ในกลุ่มค าสั่ง Cell Display เลือกค่าร้อยละเฉพาะ Count และ Row -

> กดปุ่ม Continue 
o กดปุ่ม OK  
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1.2.3 ผลการวิเคราะห์ 
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1.1.4 การสร้างตารางผลการวิเคราะห์ 

ตารางที ่(#) แสดงค่าร้อยละของต าแหน่งงาน จ าแนกตามกลุ่มชนและเพศ 

กลุ่มชน เพศ 
ต าแหน่งงาน 

รวม 
เจ้าหน้าที่ปฏิบัติงาน หัวหน้างาน ผู้จัดการ 

ชนกลุ่มหลัก หญิง 94.3 0.0 5.7 100.0 (176) 

 ชาย 56.7 7.2 36.1 100.0 (194) 

 รวม 74.6 3.8 21.6 100.0 (370) 

ชนกลุ่มน้อย หญิง 100.0 0.0 0.0 100.0 (40) 

 ชาย 73.4 20.3 6.3 100.0 (64) 

 รวม 83.7 12.5 3.8 100.0 (104) 

1.1.5 การแปลผลและสรุป 

จากตารางที ่(#) สามารถอธิบายต าแหน่งงานของกลุ่มตัวอย่างจ าแนกตามกลุ่มชนและเพศ ได้

ดังนี้ 

1. เปรียบเทียบการด ารงต าแหน่งของชนกลุ่มหลักกับชนกลุ่มน้อย แสดงให้เห็นว่า ชนกลุ่มหลักที่

เป็นเพศหญิง ด ารงต าแหน่งงานเป็นเจ้าหน้าที่ปฏิบัติงานน้อยกว่าชนกลุ่มน้อยที่เป็นเพศหญิง แต่ชนกลุ่ม

หลักท่ีเป็นเพศหญิง ด ารงต าแหน่งงานเป็นผู้จัดการมากกว่าชนกลุ่มน้อยที่เป็นเพศหญิง 

2. เปรียบเทียบการด ารงต าแหน่งของชนกลุ่มหลักกับชนกลุ่มน้อย แสดงให้เห็นว่า ชนกลุ่มหลักที่

เป็นเพศชาย ด ารงต าแหน่งงานเป็นเจ้าหน้าที่ปฏิบัติงานและหัวหน้างานน้อยกว่าชนกลุ่มน้อยที่เป็นเพศ

ชาย แต่ชนกลุ่มหลักท่ีเป็นเพศชาย ด ารงต าแหน่งงานเป็นผู้จัดการมากกว่าชนกลุ่มน้อยที่เป็นเพศชาย 

สรุป ชนกลุ่มหลักท้ังเพศชายและหญิงมีต าแหน่งงานสูงกว่าชนกลุ่มน้อยทั้งเพศชายและหญิง 
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ตัวอย่างเพิ่มเติม: การแปลผลและสรุป 

#1 

จากตารางที ่(#) สามารถอธิบายต าแหน่งงานของกลุ่มตัวอย่างจ าแนกตามกลุ่มชนและเพศ ได้

ดังนี้ 

1. กลุ่มตัวอย่างที่เป็นชนกลุ่มหลักจ านวน 370 คน เป็นพนักงานเพศหญิง จ านวน 179 คน คิด

เป็นร้อยละ 100.0 ด ารงต าแหน่งเป็นเจ้าหน้าที่ปฏิบัติงาน ร้อยละ 94.3 เป็นหัวหน้างาน ร้อยละ 0.0 และ

เป็นผู้จัดการร้อยละ 5.7 ส่วนพนักงานเพศชาย จ านวน 194 คน คิดเป็นร้อยละ 100.0 ด ารงต าแหน่งเป็น

เจ้าหน้าที่ปฏิบัติงาน ร้อยละ 56.7 เป็นหัวหน้างานร้อยละ 7.2 และเป็นผู้จัดการร้อยละ 36.1 

2. กลุ่มตัวอย่างที่เป็นชนกลุ่มน้อยจ านวน 104 คน เป็นพนักงานเพศหญิง จ านวน 40 คน คิด

เป็นจ านวนร้อยละ 100.0 ด ารงต าแหน่งเป็นเจ้าหน้าที่ปฏิบัติงานร้อยละ 100.0 ด ารงต าแหน่งหัวหน้า

งานร้อยละ 0.0 และด ารงต าแหน่งเป็นผู้จัดการร้อยละ 0.0 ส่วนพนักงานเพศชาย จ านวน 64 คน คิดเป็น

จ านวนร้อยละ 100.0 ด ารงต าแหน่งเป็นเจ้าหน้าที่ปฏิบัติงาน ร้อยละ 73.4 เป็นหัวหน้างานร้อยละ 20.3 

และเป็นผู้จัดการร้อยละ 6.3 

สรุป กลุ่มตัวอย่างเพศหญิงทั้งชนกลุ่มหลักและชนกลุ่มน้อยส่วนใหญ่มีต าแหน่งงานต่ ากว่า

พนักงานที่เป็นเพศชายทั้งชนกลุ่มหลักและชนกลุ่มน้อย 

#2 

จากตารางที ่(#) สามารถอธิบายต าแหน่งงานของกลุ่มตัวอย่างจ าแนกตามกลุ่มชนและเพศ ได้

ดังนี้ 

1. กลุ่มตัวอย่างที่เป็นชนกลุ่มหลักและเป็นเพศหญิง จ านวน 176 คน คิดเป็นจ านวนร้อยละ 

100.0 ด ารงต าแหน่งเป็นเจ้าหน้าที่ปฏิบัติงาน ร้อยละ 94.3 เป็นหัวหน้างาน ร้อยละ 0.0 และเป็น

ผู้จัดการ ร้อยละ 5.7 ส่วนพนักงานที่เป็นชนกลุ่มน้อยและเป็นเพศหญิง จ านวน 40 คน คิดเป็นร้อยละ 

100.0 ด ารงต าแหน่งเป็นเจ้าหน้าที่ปฏิบัติงาน ร้อยละ 100.0 เป็นหัวหน้างาน ร้อยละ 0.0 และเป็น

ผู้จัดการ ร้อยละ 0.0 

2. กลุ่มตัวอย่างท่ีเป็นชนกลุ่มหลักและเป็นเพศชาย จ านวน 194 คน คิดเป็นร้อยละ 100.0 ด ารง

ต าแหน่งเป็นเจ้าหน้าที่ปฏิบัติงาน ร้อยละ 56.7 เป็นหัวหน้างาน ร้อยละ 7.2 และเป็นผู้จัดการ ร้อยละ 
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36.1 ส่วนพนักงานที่เป็นชนกลุ่มน้อยและเป็นเพศชาย 64 คน คิดเป็นร้อยละ 100.0 ด ารงต าแหน่งเป็น

เจ้าหน้าที่ปฏิบัติงาน ร้อยละ 73.4 เป็นหัวหน้างาน ร้อยละ 20.3 และเป็นผู้จัดการร้อยละ 6.3 

สรุป กลุ่มชนมีอิทธิพลต่อการด ารงต าแหน่งของพนักงาน กล่าวคือ พนักงานที่เป็นชนกลุ่มหลักมี

แนวโน้มที่จะด ารงต าแหน่งงานในระดับบังคับบัญชามากกว่าพนักงานที่เป็นชนกลุ่มน้อยทั้งเพศชายและ

เพศหญิง  

#3 

จากตารางที่ (#) เปรียบเทียบการด ารงต าแหน่งของกลุ่มตัวอย่างที่เป็นชนกลุ่มหลักและชนกลุ่ม

น้อยทั้งเพศชายและเพศหญิง แสดงให้เห็นว่า ชนกลุ่มหลักทั้งเพศชายและเพศหญิงด ารงต าแหน่งเป็น

เจ้าหน้าที่ปฏิบัติงานน้อยกว่าชนกลุ่มน้อยทั้งเพศชายและเพศหญิง  ชนกลุ่มหลักและชนกลุ่มน้อยที่เป็น

เพศหญิงไม่มีต าแหน่งเป็นหัวหน้างานเลย ส่วนชนกลุ่มหลักที่เป็นเพศชายด ารงต าแหน่งหัวหน้างานน้อย

กว่าชนกลุ่มน้อยที่เป็นเพศชาย แต่ชนกลุ่มหลักที่เป็นเพศชายด ารงต าแหน่งเป็นผู้จัดการมากกว่าชนกลุ่ม

น้อยที่เป็นเพศชาย 

สรุป ชนกลุ่มหลักทั้งเพศชายและเพศหญิงด ารงต าแหน่งงานเป็นผู้บริหารระดับสูงมากกว่าชน

กลุ่มน้อยทั้งเพศชายและเพศหญิง ส่วนชนกลุ่มน้อยทั้งเพศชายและเพศหญิงด ารงต าแหน่งเป็นเจ้าหน้าที่

ปฏิบัติงานและหัวหน้างานมากกว่าชนกลุ่มน้อยทั้งเพศชายและเพศหญิง  
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2. การวิเคราะห์ข้อมูลระหว่างตัวแปรแบบค่าแบ่งประเภทกับตัวแปรแบบค่า

ต่อเนื่อง 

การวิเคราะห์ข้อมูลระหว่างตัวแปรแบบค่าแบ่งประเภท (ตัวแปรเชิงคุณภาพ) กับตัวแปรแบบค่า

ต่อเนื่อง (ตัวแปรเชิงปริมาณ) เป็นการเปรียบเทียบข้อมูลของตัวแปรแบบค่าแบ่งประเภทด้วยค่าเฉลี่ย 

(compare means) การวิเคราะห์แบบนี้มีข้อมูลมีตั้งแต่ 2 กลุ่ม และมากกว่า 2 กลุ่ม อาจเรียกว่า การ

วิเคราะห์เปรียบเทียบค่าเฉลี่ย 2 กลุ่ม และ การวิเคราะห์เปรียบเทียบค่าเฉลี่ยมากกว่า 2 กลุ่ม โดยมี

รายละเอียดดังต่อไปนี้  

2.1 การเปรียบเทียบค่าเฉลี่ย 2 กลุม่ 

 การเปรียบเทียบค่าเฉลี่ย 2 กลุ่ม เป็นวิธีการวิเคราะห์แบบไขว้ตัวแปรแบบหนึ่ง แตต่ัวแปรอิสระ

เป็นตัวแปรแบบค่าจัดกลุ่มส่วนตัวแปรตามเป็นตัวแปรแบบค่าต่อเนื่อง โดยใช้สถิติเชิงพรรณนา ได้แก่ 

ค่าเฉลี่ย ค่าเบี่ยงเบนมาตรฐาน และค่าสัมประสิทธิ์การกระจาย 

ตัวอย่างค าถามการวิจัย 

จากการส ารวจข้อมูลของพนักงานในหน่วยงานต้องการทราบว่า พนักงานแต่ละกลุ่มชนมี

ประสบการณ์ก่อนท างานแตกต่างกันมากน้อยเพียงใด 

2.1.1 ตัวแปร 

ตัวแปรอิสระ 

-> 

ตัวแปรตาม 

ค่าจัดกลุ่ม ค่าต่อเนื่อง 

กลุ่มชน (minority) 

- ชนกลุ่มหลัก 

- ชนกลุ่มน้อย 

ประสบการณ์ก่อนท างาน (prevexp) 
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2.1.2 การใช้โปรแกรมวิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล File -> Open -> Employee data.sav 
๏ เลือกเมน ูAnalyze -> Compare Means -> Means… 

o Dependent List: เลือกตัวแปรแบบค่าต่อเนื่อง 1 ตัวแปร (ตัวแปรที่ต้องการให้เป็นตัว
แปรตาม) จากรายการตัวแปรด้านซ้าย 

o Independent List: เลือกตัวแปรแบบค่าจัดประเภท (2 กลุ่ม) 1 ตัวแปร หรือหลายตัว
แปร (ตัวแปรที่ต้องการให้เป็นตัวแปรอิสระ) จากรายการตัวแปรด้านซ้าย 

o กดปุ่ม OK 

 

2.1.3 ผลการวิเคราะห์ 

 

 

2.1.4 การสร้างตารางผลการวิเคราะห์ 

ตารางที ่(#) แสดงค่าเฉลี่ยประสบการณ์ก่อนท างานของพนักงาน ระหว่างกลุ่มชน 

ประสบการณ์ก่อนท างาน (เดือน) จ านวน ค่าเฉลี่ย S.D. C.V. (%) 

ชนกลุ่มหลัก 370 88 105 119 

ชนกลุ่มน้อย 104 124 100 81 

รวม 474 96 105 109 



ก า ร วิ เ ค ร า ะ ห์ ข้ อ มู ล เ ชิ ง พ ร ร ณ น า  2  ตั ว แ ป ร | 225 

2.1.5 การแปลผลและสรุป 

จากตารางที่ (#) แสดงให้เห็นว่า กลุ่มตัวอย่างที่เป็นชนกลุ่มน้อยมีประสบการณ์ก่อนท างานโดย

เฉลี่ยมากกว่าชนกลุ่มหลัก 

เมื่อพิจารณาจากค่าสัมประสิทธิ์การกระจาย แสดงให้เห็นว่า ประสบการณ์ก่อนการท างานของ

ชนกลุ่มหลักมีความแตกต่างกันอยู่ในระดับมาก ส่วนชนกลุ่มน้อยมีความแตกต่างกันอยู่ในระดับน้อย 
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ตัวอย่างเพิ่มเติม: การแปลผลและสรุป 

#1 

 จากตารางที่ (#) แสดงให้เห็นว่า กลุ่มตัวอย่างทั้งหมด จ านวน 474 คน มีประสบการณ์ก่อน

ท างานต่ าสุด 0 เดือน สูงสุด 476 เดือน เฉลี่ย 96 เดือน และมีค่าสัมประสิทธิ์การกระจาย ร้อยละ 119 

โดยชนกลุ่มหลัก จ านวน 370 คน มีประสบการณ์ก่อนท างานต่ าสุด 0 เดือน สูงสุด 476 เดือน เฉลี่ย 88 

เดือน และมีค่าสัมประสิทธิ์การกระจาย ร้อยละ 119 ส่วนชนกลุ่มน้อย จ านวน 104 คน มีประสบการณ์

ก่อนท างานต่ าสุด 0 เดือน สูงสุด 432 เดือน เฉลี่ย 124 เดือน และมีค่าสัมประสิทธิ์การกระจาย ร้อยละ 

81  

เมื่อพิจารณาจากค่าสัมประสิทธิ์การกระจาย แสดงให้เห็นว่า กลุ่มตัวอย่างทั้งหมดมีประสบการณ์

ก่อนท างานแตกต่างต่างกันมาก (C.V. = 109) โดยชนกลุ่มหลักมีประสบการณ์ก่อนการท างานแตกต่าง

กันมาก (C.V. = 119) ส่วนชนกลุ่มน้อยมีประสบการณ์ก่อนการท างานแตกต่างกันน้อย (C.V. = 81) 

#2 

 จากตารางที่ (#) แสดงให้เห็นว่า กลุ่มตัวอย่างทั้งหมด จ านวน 474 คน มีประสบการณ์ก่อน

ท างาน เฉลี่ย 96 เดือน โดยชนกลุ่มน้อยมีประสบการณ์ก่อนท างานมากกว่าค่าเฉลี่ยรวม คือ 124 เดือน 

และชนกลุ่มหลักท่ีมีประสบการณ์ก่อนท างานน้อยกว่าค่าเฉลี่ยรวม คือ 88 เดือน 

เมื่อพิจารณาจากค่าสัมประสิทธิ์การกระจาย แสดงให้เห็นว่า กลุ่มตัวอย่างทั้งหมดมีประสบการณ์

ก่อนการท างานแตกต่างกันมาก (C.V. = 109) โดยชนกลุ่มหลักมีประสบการณ์ก่อนท างานแตกต่างกัน

มากกว่า (C.V. = 119) ชนกลุ่มน้อย (C.V. = 109) 

#3 

จากตารางที่ (#) แสดงให้เห็นว่า กลุ่มตัวอย่างทั้งหมด จ านวน 474 คน มีประสบการณ์ก่อน

ท างาน เฉลี่ย 96 เดือน โดยชนกลุ่มน้อยมีประสบการณ์ก่อนท างาน เฉลี่ย 124 เดือน มากกว่าชนกลุ่ม

หลักท่ีมีประสบการณ์ก่อนท างาน เฉลี่ย 88 เดือน 

เมื่อพิจารณาจากค่าสัมประสิทธิ์การกระจาย แสดงให้เห็นว่า ประสบการณ์ก่อนการท างานของ

กลุ่มตัวอย่างทั้งหมดมีความแตกต่างกันอยู่ในระดับมาก (C.V. = 109) และชนกลุ่มหลักมีความแตกต่าง

กันอยู่ในระดับมากเช่นกัน (C.V. = 119) ส่วนชนกลุ่มน้อยมีแตกต่างกันอยู่ในระดับน้อย (C.V. = 109) 
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2.2 การเปรียบเทียบค่าเฉลี่ยมากกว่า 2 กลุ่ม 

 การเปรียบเทียบค่าเฉลี่ยมากกว่า 2 กลุ่ม เป็นวิธีการวิเคราะห์แบบเดียวกับการเปรียบเทียบค่า

เฉี่ย 2 กลุ่ม แต่ตัวแปรอิสระเป็นค่าจัดกลุ่มมากกว่า 2 กลุ่มขึ้นไป และตัวแปรตามเป็นค่าต่อเนื่อง โดยใช้

สถิติเชิงพรรณนา ได้แก่ ค่าเฉลี่ย ค่าเบี่ยงเบนมาตรฐาน และค่าสัมประสิทธิ์การกระจาย 

ตัวอย่างค าถามการวิจัย 

จากการส ารวจข้อมูลของพนักงานในหน่วยงานต้องการทราบว่า พนักงานแต่ละต าแหน่งงานมี

ประสบการณ์ก่อนท างานแตกต่างกันมากน้อยเพียงใด 

2.2.1 ตัวแปร 

ตัวแปรอิสระ 

-> 

ตัวแปรตาม 

ค่าจัดกลุ่ม ค่าต่อเนื่อง 

ต าแหน่งงาน (jobcat) 

- เจ้าหน้าที่ปฏิบัติงาน 

- หัวหน้างาน 
- ผู้จัดการ 

ประสบการณ์ก่อนท างาน (prevexp) 
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2.2.2 การใช้โปรแกรมวิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล Employee data.sav 
๏ เลือกเมนู Analyze -> Compare Means -> Means… 

o Dependent List: เลือกตัวแปรแบบค่าต่อเนื่อง 1 ตัวแปร (ตัวแปรที่ต้องการให้เป็นตัว
แปรตาม) จากรายการตัวแปรด้านซ้าย  

o Independent List: เลือกตัวแปรแบบค่าจัดประเภท (มากกว่า 2 กลุ่ม) 1 ตัวแปร หรือ
หลายตัวแปร (ตัวแปรที่ต้องการให้เป็นตัวแปรอิสระ) จากรายการตัวแปรด้านซ้าย 

o กดปุ่ม OK 

 

2.2.3 ผลการวิเคราะห์ 

 

 

2.2.4 การสร้างตารางผลการวิเคราะห์ 

ตารางที ่(#) แสดงค่าเฉลี่ยประสบการณ์ก่อนท างานของพนักงาน 

ต าแหน่งงาน จ านวน ต่ าสุด S.D. C.V. (%) 

เจ้าหน้าที่ปฏิบัติงาน 363 0 95 112 

หัวหน้างาน 27 144 101 34 

ผู้จัดการ 84 3 73 94 

รวม 474 0 105 109 
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2.2.5 การแปลผลและสรุป 

 จากตารางที ่(#) แสดงให้เห็นว่า กลุ่มตัวอย่างท่ีมีประสบการณ์ก่อนท างานโดยเฉลี่ยมากที่สุด คือ 

หัวหน้างาน รองลงมา คือ เจ้าหน้าที่ปฏิบัติงาน และน้อยที่สุด คือ ผู้จัดการ  

เมื่อพิจารณาจากค่าสัมประสิทธิ์การกระจายแสดงให้เห็นว่า ประสบการณ์ก่อนท างานของ

เจ้าหน้าที่ปฏิบัติงานมีความแตกต่างกันอยู่ในระดับมาก ส่วนหัวหน้างานและผู้จัดการมีความแตกต่างกัน

อยู่ในระดับน้อย 
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ตัวอย่างเพิ่มเติม: การแปลผลและสรุป 

#1 

 จากตารางที ่(#) แสดงให้เห็นว่า กลุ่มตัวอย่างท้ังหมด 474 คน มีประสบการณ์ก่อนท างาน เฉลี่ย 

96 เดือน โดยต าแหน่งงานมีประสบการณ์ก่อนท างานเฉลี่ยมากที่สุด คือ หัวหน้างาน เฉลี่ย 298  เดือน 

รองลงมา คือ เจ้าหน้าที่ปฏิบัติงาน เฉลี่ย 85 เดือน และน้อยที่สุด คือ ผู้จัดการ เฉลี่ย 78 เดือน  

เมื่อพิจารณาจากค่าสัมประสิทธิ์การกระจาย แสดงให้เห็นว่า ประสบการณ์ก่อนท างานของกลุ่ม

ตัวอย่างทั้งหมดมีความแตกต่างกันอยู่ในระดับมาก (C.V. = 109) และเจ้าหน้าที่ปฏิบัติงานมีความ

แตกต่างกันอยู่ในระดับมากเช่นกัน (C.V. = 112) ส่วนหัวหน้างานและผู้จัดการมีความแตกต่างกันอยู่ใน

ระดับน้อย (C.V. = 34 และ C.V. = 94) 
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2.3 การเปรียบเทียบค่าเฉลี่ยโดยมตีัวแปรคุม 

 การเปรียบเทียบค่าเฉลี่ยโดยมีตัวแปรคุม เป็นการวิเคราะห์เหมือนกับการเปรียบเทียบค่าเฉลี่ย 2 

กลุ่ม และมากกว่า 2 กลุ่ม แต่มีตัวแปรคุมเป็นค่าจัดกลุ่ม 2 กลุ่มหรือมากกว่า แต่เพ่ือไม่ให้ซับซ้อนควร

เลือกตัวแปรแบบค่าจัดกลุ่มไม่เกิน 2 กลุ่ม โดยใช้สถิติเชิงพรรณนา ได้แก่ ค่าเฉลี่ย ค่าเบี่ยงเบนมาตรฐาน 

และค่าสัมประสิทธิ์การกระจาย 

ตัวอย่างค าถามการวิจัย 

จากการส ารวจข้อมูลของพนักงานในหน่วยงานต้องการทราบว่า พนักงานแต่กลุ่มชนที่มีเพศ

แตกต่างกันมปีระสบการณ์ก่อนท างานแตกต่างกันมากน้อยเพียงใด 

2.3.1 ตัวแปร 

ตัวแปรอิสระ 
ตัวแปรคุม 

เพศ (gender) 

ตัวแปรตาม 

ค่าจัดกลุ่ม ค่าต่อเนื่อง 

กลุ่มชน (minority) 

- ชนกลุ่มหลัก 

- ชนกลุ่มน้อย 

ประสบการณ์ก่อนท างาน (prevexp) 
-> 
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2.3.2 การใช้โปรแกรมวิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล Employee Data.sav 
๏ เมนู Data -> Split File… 

o เลือกค าสั่ง Compare groups. 
o ใน Group base on เลือกตัวแปรแบบค่าจัดประเภทจากรายการเมนูด้านซ้าย 1 ตัวแปร 

หรือมากกว่า 
o กดปุ่ม OK 

 

๏ เลือกเมนู Analyze -> Compare Means -> Means… 
o Dependent List: เลือกตัวแปรแบบค่าต่อเนื่อง 1 ตัวแปร (ตัวแปรที่ต้องการให้เป็นตัว

แปรตาม) จากรายการตัวแปรด้านซ้าย 
o Independent List: เลือกตัวแปรแบบค่าจัดประเภท (มากกว่า 2 กลุ่ม) 1 ตัวแปร หรือ

หลายตัวแปร (ตัวแปรที่ต้องการให้เป็นตัวแปรอิสระ) จากรายการตัวแปรด้านซ้าย  
o กดปุ่ม OK 
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2.3.3 ผลการวิเคราะห์ 

  

2.3.4 การสร้างตารางผลการวิเคราะห์ 

ตารางที ่(#) แสดงค่าเฉลี่ยประสบการณ์ก่อนท างานของพนักงาน ระหว่างเพศและกลุ่มชน 

เพศ กลุ่มชน จ านวน ค่าเฉลี่ย S.D. C.V. (%) 

หญิง ชนกลุ่มหลัก 176 72 98 136 

 ชนกลุ่มน้อย 40 99 78 79 

รวม 216 77 95 123 

ชาย ชนกลุ่มหลัก 194 102 109 107 

 ชนกลุ่มน้อย 64 140 109 78 

รวม 258 112 110 98 

2.3.5 การแปลผลและสรุป 

จากตารางที่ (#) แสดงให้เห็นว่า กลุ่มตัวอย่างเพศหญิงที่เป็นชนกลุ่มหลักมีประสบการณ์ก่อน

ท างานโดยเฉลี่ย 72 เดือน น้อยกว่าเพศหญิงที่เป็นชนกลุ่มน้อยที่มีประสบการณ์ก่อนท างานโดยเฉลี่ย 99 

เดือน ส่วนกลุ่มตัวอย่างเพศชายที่เป็นชนกลุ่มหลักมีประสบการณ์ก่อนท างานโดยเฉลี่ย 102 เดือน น้อย

กว่าเพศชายที่เป็นชนกลุ่มน้อยที่มีประสบการณ์ก่อนท างานโดยเฉลี่ย 140 เดือน  

อาจกล่าวได้ว่า เพศหญิงและเพศชายที่เป็นชนกลุ่มหลักมีประสบการณ์ก่อนท างานโดยเฉลี่ยน้อย

กว่าเพศหญิงและเพศชายที่เป็นชนกลุ่มน้อย หรือชนกลุ่มหลักมีประสบการณ์ก่อนท างานโดยเฉลี่ยน้อย

กว่าชนกลุ่มน้อย  
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เมื่อพิจารณาจากค่าสัมประสิทธิ์การกระจายแสดงให้เห็นว่า ประสบการณ์ก่อนการท างานของชนกลุ่ม

หลักทั้งเพศชายและเพศหญิงมีความแตกต่างกันอยู่ในระดับมาก ส่วนชนกลุ่มน้อยทั้งเพศชายและเพศ

หญิงมีความแตกต่างกันอยู่ในระดับน้อย 

สรปุ 

 การวิเคราะห์ข้อมูล 2 ตัวแปร หากเป็นตัวแปรแบบค่าแบ่งประเภทตั้งแต่ 2 กลุ่ม และมากกว่า 

ใช้การเปรียบเทียบความสัมพันธ์ระหว่างกลุ่มด้วยค่าความถี่ และค่าร้อยละ แต่ถ้าตัวแปรหนึ่งเป็นตัวแปร

แบบค่าจัดประเภทและอีกตัวแปรหนึ่งเป็นตัวแปรแบบค่าต่อเนื่อง ใช้การเปรียบเทียบข้อมูลระหว่างกลุ่ม

ด้วยค่าเฉลี่ย ค่าเบี่ยงเบนมาตรฐาน และค่าสัมประสิทธิ์การกระจาย   

แบบฝึกหัดท้ายบท 

ให้ผู้เรียนเปิดแฟ้มข้อมูล 1991 US. General Social Survey.sav แล้วประมวลผลข้อมูล เพ่ือ

วิเคราะห์และอธิบายผล ดังนี้ 

1. วิเคราะห์และอธิบายผลตัวแปรอิสระคือ ภูมิภาค (region) กับตัวแปรตามคือ ประเภทของ

อาชีพ (occcat80) ด้วยค าสั่ง Crosstabs  

2. วิเคราะห์และอธิบายผลตัวแปรอิสระคือ ภูมิภาค (region) กับตัวแปรตามคือ ความคิดเห็น

เกี่ยวกับภาษี (tax) และคุมด้วยตัวแปรกลุ่มสีผิว (race) ด้วยค าสั่ง Crosstabs  

3. วิเคราะห์และอธิบายผลตัวแปรภูมิภาค (region) กับจ านวนพี่น้อง (sibs) ด้วยค าสั่ง Means  

4. วิเคราะห์และอธิบายผลตัวแปรภูมิภาค (region) กับจ านวนพ่ีน้อง (sibs) และคุมด้วยตัวแปร

กลุ่มสีผิว (race) ด้วยค าสั่ง Means  

 

  



 

 

ส่วนที่ 5 

การวิเคราะห์ข้อมูลด้วยสถิติเชิงอ้างอิง 

  





 

 

บทที่ 12 
การทดสอบข้อมูลแบบอิงค่าพารามิเตอร์ 

ความมุ่งหมายของบทเรียน 
ผู้เรียนสามารถใช้โปรแกรมประมวลผลทดสอบข้อมูลของตัวแปรด้วยสถิติเชิงอ้างอิงแบบอิง

ค่าพารามิเตอร์และเขียนบรรยายผลการทดสอบได้ 

เนื้อหา 
1. การทดสอบค่าเฉลี่ยของกลุ่มตัวอย่าง 1 กลุ่ม  

2. การทดสอบค่าเฉลี่ยของกลุ่มตัวอย่างที่ไม่เป็นอิสระจากกัน 2 กลุ่ม 

3. การทดสอบค่าเฉลี่ยของกลุ่มตัวอย่างที่เป็นอิสระจากกัน 2 กลุ่ม 

4. การทดสอบค่าเฉลี่ยของกลุ่มตัวอย่างที่เป็นอิสระจากกันมากกว่า 2 กลุ่ม 

5. การทดสอบความสัมพันธ์รายคู่แบบเพียร์สัน 

กิจกรรมและวธิีสอน 
บรรยาย อธิบาย แสดงตัวอย่าง และท าแบบฝึกหัดท้ายบท 

อุปกรณ์การสอน 
เอกสารค าสอน ภาพเลื่อน คอมพิวเตอร์ โปรแกรม PSPP โปรแกรมสอนออนไลน์ (สอนแบบ

ออนไลน์) และเครื่องฉาย (สอนในชั้นเรียน) 

งานที่มอบหมาย 

 ท าแบบฝึกหัดท้ายบท 

การวัดผลและประเมินผล 

การเข้าชั้นเรียน สังเกตความสนใจจากการเรียน สอบถามความเข้าใจจากการบรรยาย และ

ประเมินจากการท าแบบฝึกหัดท้ายบท  
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เนื้อหา 

เมื่อข้อมูลเป็นไปตามข้อตกลงเบื้องต้น (meet basic assumptions) และใช้การทดสอบแบบอิง

ค่าพารามิเตอร์ (parametric test) ผลการทดสอบให้อ านาจจ าแนกทางสถิติ (statistical power) สูง

กว่าการทดสอบแบบไม่อิงค่าพารามิเตอร์  

แม้ว่าการทดสอบแบบอิงค่าพารามิเตอร์ส่วนใหญ่วางอยู่บนฐานของข้อมูลที่มีระดับการวัดตั้งแต่

มาตราแบบช่วงขึ้นไปหรือเป็นค่าต่อเนื่อง และข้อมูลต้องมีการแจกแจงแบบปกติ (normal distribution) 

แล้ว แต่การทดสอบแต่ละประเภทยังมีข้อตกลงเฉพาะเพ่ิมเติมอีก เช่น การทดสอบค่าเฉลี่ยระหว่างกลุ่ม

ตัวอย่าง ข้อมูลแต่ละกลุ่มตัวอย่างต้องมาจากประชากรที่มีความแปรปรวนเท่ากัน (homogeneity of 

variance) การทดสอบค่าเฉลี่ยแบบทดสอบซ้ า ข้อมูลของแต่ละตัวอย่างต้องมีความเป็นอิสระจากกัน 

(independence) 

1. การทดสอบค่าเฉลี่ยของกลุ่มตัวอย่าง 1 กลุ่ม  

การทดสอบค่าเฉลี่ยของกลุ่มตัวอย่าง 1 กลุ่ม (One Sample t Test) คือ การเปรียบเทียบข้อมูล

ของตัวอย่าง 1 กลุ่ม ที่สุ่มมาจากประชากร กับค่าทดสอบ (value test) ของประชากรที่ทราบจ านวน 

(know populations) หรือเป็นค่าของสมมติฐาน (hypothesized) เพ่ือตัดสินใจว่า ค่าเฉลี่ยของข้อมูลมี

ความแตกต่างกันหรือไม่แตกต่างกัน 

การทดสอบแบบนี้อาจมีชื่อเรียกอีกชื่อหนึ่งว่า Single Sample t Test 

ตัวอย่างค าถามการวิจัย 

จากรายงานผลการส ารวจของส านักงานสถิติด้านสังคมและเศรษฐกิจของประเทศพบว่า ผู้จบ

การศึกษาในทุกระดับการศึกษา มีการย้ายหรือเปลี่ยนงานหลังจากได้งานครั้งแรกแล้วโดยเฉลี่ย

ประมาณ 5 ปี (60 เดือน) ดังนั้นจากข้อมูลการส ารวจพนักงานในหน่วยงานต้องการทราบว่า พนักงาน

มีค่าเฉลี่ยของประสบการณ์ก่อนท างานแตกต่างไปจากค่าเฉลี่ยตามรายงานผลการส ารวจของส านักงาน

สถิติหรือไม ่
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1.1 ข้อตกลงเบื้องต้น 

ขั้นตอน ข้อตกลง 

การออกแบบการวิจัย 1. กลุ่มตัวอย่างได้มาจากประชากรที่ทราบจ านวน (know population) โดย
การสุ่มตัวอย่างแบบสุ่ม (independence random sampling)  

 2. มีกลุ่มตัวอย่างมากกว่าหรือน้อยกว่า 30 ตัวอย่าง 
 3. ตัวแปรทดสอบเป็นตัวแปรแบบค่าต่อเนื่อง (continuous variable) หรือ

คะแนน (scores) 

การวิเคราะห์ข้อมูล 1. ข้อมูลมีการแจกแจงแบบปกติ (normal distribution) 

 2. ข้อมูลไม่มีค่าผิดปกติ (outliers) หรือค่าต่างสุด (extremes) 

1.2 รูปแบบการทดสอบตัวแปร 

ตัวแปร 
-> 

ค่าทดสอบ 

ค่าต่อเนื่อง ค่าเฉลี่ย 
ประสบการณ์ก่อนท างาน (prevexp) 60 เดือน 

1.3 การก าหนดสมมติฐานและเกณฑ์การทดสอบ 

ตารางที ่(#) แสดงค่าเฉลี่ยประสบการณ์ก่อนท างานของพนักงาน 

ประสบการณ์ท างาน จ านวน ค่าต่ าสุด ค่าสูงสุด ค่าเฉลี่ย S.D. C.V. (%) 

ก่อนท างาน (เดือน) 474 0 476 95.86 104.59 109.11 

จากตารางที่ (#) แสดงให้เห็นว่า พนักงานจ านวน 474 คน มีประสบการณ์ก่อนท างานเฉลี่ย 

95.86 เดือน มีประสบการณ์ก่อนท างานต่ าสุด 0 เดือน และมีประสบการณ์สูงสุด 476 เดือน เมื่อ

พิจารณาจากค่าสัมประสิทธิ์การกระจายแสดงให้เห็นว่า พนักงานมีประสบการณ์ก่อนท างานแตกต่างกัน

มาก    

จากข้อมูลค่าเฉลี่ยประสบการณ์ก่อนท างานของพนักงาน ต้องการทดสอบว่า พนักงานของ

หน่วยงานมีค่าเฉลี่ยของประการณ์ก่อนท างานเท่ากับหรือไม่เท่ากับค่าเฉลี่ยจากผลการส ารวจ จึงท าการ

ทดสอบด้วยวิธีการทางสถิติ โดยมีสมมติฐานดังนี้ 
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H0: กลุ่มตัวอย่างที่เป็นพนักงานของหน่วยงานมีประสบการณ์ก่อนท างานเท่ากับ 60 เดือน 

H1: กลุ่มตัวอย่างที่เป็นพนักงานของหน่วยงานมีประสบการณ์ก่อนท างานไม่เท่ากับ 60 เดือน 

เกณฑ์ในการทดสอบสมมติฐาน คือ หากการทดสอบความแตกต่างระหว่างค่าเฉลี่ยของกลุ่ม

ตัวอย่างกับค่าทดสอบ (one-sample t-test) ได้ค่าความน่าจะเป็น (p-value) มากกว่าค่านัยส าคัญทาง

สถิติ (α = 0.05) จะยอมรับสมมติฐาน H0 แต่หากได้ค่าความน่าจะเป็น (p-value) น้อยกว่าหรือเท่ากับ

ค่านัยส าคัญทางสถิติ (α = 0.05) จะปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 

1.4 การใช้โปรแกรมคอมพิวเตอร์วิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล File -> Open -> Employee data.sav 
๏ เลือกเมน ูAnalyze -> Compare Means -> One Sample T Test… 

o Test Variable(s): เลือกตัวแปรทดสอบ (ตัวแปรแบบค่าต่อเนื่อง) 1 ตัวแปร หรือ
มากกว่า 1 ตัวแปร จากรายการตัวแปรด้านซ้าย  

o Test Value: ใส่ค่าทดสอบในช่อง (ค่าทดสอบมาจากข้อมูลในอดีต ความรู้ที่มีอยู่  ทฤษฎี 
หรืองานวิจัย) 

o กดปุ่ม Options 
- Confidence Interval Percentage: ก าหนดช่วงความเชื่อมั่นในช่อง (ค่าปกติ 0.95)  
- ในชุดค าสั่ง Missing Values เลือกวิธีการค านวณค่าสูญหาย 
 Exclude cases analysis by analysis (วิเคราะห์ตัวอย่างที่ไม่มีข้อมูลสูญหายในแต่

ละตัวแปรทดสอบ) 
 Exclude cases listwise (วิเคราะห์ตัวอย่างที่ไม่มีข้อมูลสูญหายในทุกตัวแปร

ทดสอบ) 
o กดปุ่ม Continue 
o กดปุ่ม OK 
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1.5 ผลการวิเคราะห์ 

 

1.6 การสร้างตารางแสดงผลการทดสอบ 

ตารางที ่(#) แสดงการทดสอบการเปรียบเทียบค่าเฉลี่ยประสบการณ์ก่อนท างานของพนักงาน 

ค่าทดสอบ = 60 เดือน 

ประสบการณ์

ท างาน 

จ านวน 

(คน) 
ค่าเฉลี่ย t df Sig. 

Mean 

Difference 

95% Confidence Level 

Lower Upper 

ก่อนท างาน 474 95.86 7.47 473 0.00 35.86 26.42 45.30 

1.7 การแปลผลและสรุป 

จากตารางที่ (#) ผลการทดสอบแสดงให้เห็นว่า ค่าความน่าจะเป็น (Sig.) = 0.00 มีค่าน้อยกว่า

ค่านัยส าคัญทางสถิติท่ีก าหนดไว้ (α = 0.05) จึงปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน Ha  

สรุป พนักงานของหน่วยงานมีประสบการณ์ก่อนท างานโดยเฉลี่ยไม่เท่ากับ 60 เดือน กล่าวคือ มี

ค่าเฉลี่ยแตกต่างจากค่าทดสอบประมาณ 35.86 เดือน โดยมีความเชื่อมั่นว่าความแตกต่างของค่าเฉลี่ยมี

ค่าต่ าสุดไม่เกิน 26.42 เดือน และสูงสุดไม่เกิน 45.30 เดือน 
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2. การทดสอบค่าเฉลี่ยของกลุ่มตัวอย่างที่ไม่เป็นอิสระจากกัน 2 กลุม่  

 การทดสอบค่าเฉลี่ยของกลุ่มตัวอย่างที่ไม่เป็นอิสระจากกัน 2 กลุ่ม (Paired Samples t Test) 

คือ การเปรียบเทียบข้อมูลของกลุ่มตัวอย่างทีส่ัมพันธ์กันหรือเกี่ยวข้องกัน (ได้มาจากสถานการณ์/บุคคล/

สิ่งของเดียวกันแต่เป็นเรื่องที่มีความเกี่ยวข้องกันอาจเกิดขึ้นในช่วงเวลาหรือสถานที่ที่แตกต่างกันที่ ) เพ่ือ

ตัดสินใจว่า ค่าเฉลี่ยของข้อมูลมีความแตกต่างกันหรือไม่แตกต่างกัน เช่น รายได้เฉลี่ยของครัวเรือนในแต่

ละชุมชนระหว่างปี พ.ศ. 2555 กับ ปี พ.ศ. 2560 จ านวนประชากรในแต่ละจังหวัดระหว่างปี พ.ศ. 2553 

กับ ปี พ.ศ. 2563 เงินเดือนของพนักงานในหน่วยงานระหว่างปีปัจจุบันกับเมื่อ 5 ปีที่แล้ว   

การทดสอบแบบนี้อาจมีชื่อเรียกเป็นอย่างอ่ืน ได้แก่ Dependent t Test, Related t Test และ 

Repeated Measures t Test 

ตัวอย่างค าถามการวิจัย 

จากการส ารวจข้อมูลของพนักงานในหน่วยงานต้องการทราบว่า พนักงานมีค่าเฉลี่ยของ

เงินเดือนเริ่มต้นแตกต่างกับเงินเดือนปัจจุบันหรือไม่ 

2.1 ข้อตกลงเบื้องต้น 

ขั้นตอน ข้อตกลง 

การออกแบบการวิจัย 1. กลุ่มตัวอย่างได้มาจากประชากรที่ทราบจ านวน (know population) โดย
การสุ่มตัวอย่างแบบสุ่มที่เป็นอิสระจากกัน (independence random 
sampling) 

 2. กลุ่มตัวอย่างอาจมีขนาดมากกว่าหรือน้อยกว่า 30 ตัวอย่าง 

 3. ข้อมูลได้มาจากกลุ่มตัวอย่างมีความสัมพันธ์หรือเกี่ยวข้องกัน 
(dependent/paired sample) 

 4. ข้อมูลของตัวแปรทดสอบทั้งคู่เป็นมีระดับการวัดแบบค่าต่อเนื่อง 
(continuous level)  

การวิเคราะห์ข้อมูล 1. ข้อมูลของตัวแปรทดสอบทั้งคู่มีการแจกแจงปกติ (normal distribution)   

 2. ข้อมูลของตัวแปรทดสอบทั้งคู่ไม่มีค่าผิดปกติ (outliers) หรอืค่าต่างสุด 
(extremes) 
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2.2 รูปแบบการทดสอบตัวแปร 

ตัวแปรทดสอบ (การวัดครั้งที่ 1) วัดซ้ า ตัวแปรทดสอบ (การวัดครั้งที่ 2) 

ค่าต่อเนื่อง -> ค่าต่อเนื่อง 
เงินเดือนเริ่มต้น (salbegin)  เงินเดือนปัจจุบัน (salary) 

2.3 การก าหนดสมมติฐานและเกณฑ์การทดสอบ 

ตารางที ่(#) แสดงการเปรียบเทียบค่าเฉลี่ยเงินเดือนปัจจุบันกับเงินเดือนเริ่มต้น 

เงินเดือน จ านวน ค่าเฉลี่ย S.D. C.V. (%) 

เงินเดือนเริ่มต้น 474 17,016.09 7,870.64 46.25 

เงินเดือนปัจจุบัน 474 34,419.57 17,075.66 49.61 

จากตารางที่ (#) แสดงให้เห็นว่า กลุ่มตัวอย่างที่เป็นพนักงานจ านวน 474 คน มีเงินเดือนเริ่มต้น

เฉลี่ย 17,016.09 ดอลลาร์สหรัฐ ส่วนเงินเดือนปัจจุบันเฉลี่ย 34,419.57 ดอลลาร์สหรัฐ กล่าวคือ ค่าเฉลี่ย

ของเงินเดือนปัจจุบันมากกว่าค่าเฉลี่ยของเงินเดือนเริ่มต้น  

ดังนั้น เพ่ือเป็นการยืนยันว่า ค่าเฉลี่ยของเงินเดือนปัจจุบันแตกต่างจากค่าเฉลี่ยของเงินเดือน

เริ่มต้น จึงท าการทดสอบด้วยวิธีการทางสถิติ โดยมีสมมติฐาน ดังนี้ 

H0: ค่าเฉลี่ยของเงินเดือนปัจจุบันกับค่าเฉลี่ยของเงินเดือนเริ่มต้นของพนักงานไม่แตกต่างกัน 

H1: ค่าเฉลี่ยของเงินเดือนปัจจุบันกับค่าเฉลี่ยของเงินเดือนเริ่มต้นของพนักงานแตกต่างกัน 

เกณฑ์ในการทดสอบสมมติฐาน คือ หากการทดสอบความแตกต่างระหว่างค่าเฉลี่ยของกลุ่ม

ตัวอย่างที่มีความสัมพันธ์กันหรือไม่เป็นอิสระจากกัน (paired sample t-test) ได้ค่าความน่าจะเป็น (p-

value) มากกว่าค่านัยส าคัญทางสถิติ (α = 0.05) จะยอมรับสมมติฐาน H0 แต่หากได้ค่าความน่าจะเป็น 

(p-value) น้อยกว่าหรือเท่ากับค่านัยส าคัญทางสถิติ (α = 0.05) จะปฏิเสธสมมติฐาน H0 และยอมรับ

สมมติฐาน H1 
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2.4 การใช้โปรแกรมคอมพิวเตอร์วิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล File -> Open -> Employee data.sav 
๏ เลือกเมนู Analyze -> Compare Means -> Paired Samples T Test… 

o เลือกตัวแปรทดสอบตัวที่ 1 (ตัวแปรแบบค่าต่อเนื่อง/เหตุการณ์ก่อน) จากช่องรายการตัว
แปร -> ใส่ในช่อง Var1 ของ Test Pair(s): 

o เลือกตัวแปรทดสอบตัวที่ 2 (ตัวแปรแบบค่าต่อเนื่อง/เหตุการณ์หลัง) จากช่องรายการตัว
แปร -> ใส่ในช่อง Var2 ของ Test Pair(s): 

o กดปุ่ม Options 
- ก าหนดช่วงความเชื่อมั่นในช่อง Confidence Interval Percentage: (ค่าปกติ .95) 
- เลือกวิธีการค านวณค่าสูญหายในชุดค าสั่ง Missing Values 
 Exclude cases analysis by analysis (วิเคราะห์ตัวอย่างที่ไม่มีข้อมูลสูญหายในแต่

ละตัวแปรทดสอบ) 
 Exclude cases listwise (วิเคราะห์ตัวอย่างที่ไม่มีข้อมูลสูญหายในทุกตัวแปร

ทดสอบ) 
o กดปุ่ม Continue 
o กดปุ่ม OK 

 

 

2.5 ผลการวิเคราะห์ 
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2.6 การสร้างตารางแสดงผลการทดสอบ 

ตารางที ่(#) แสดงการทดสอบเปรียบเทียบค่าเฉลี่ยเงินเดือนปัจจุบันกับเงินเดือนเริ่มต้น 

เงินเดือน 
Mean 

Difference 

Std. Error 

Difference 

S.E. 

Mean 

95% Confidence Level 
t df Sig. 

Lower Upper 

เริ่มต้น-ปัจจุบัน -1,7403.48 10,814.62 496.73 -18,379.6 -16,427.4 -35.04 473 0.000 

2.7 การแปลผลและสรุป 

จากตารางที่ (#) ผลการทดสอบแสดงให้เห็นว่า ค่าความน่าจะเป็น (Sig.) = 0.00 มีค่าน้อยกว่า

ค่านัยส าคัญทางสถิติท่ีก าหนดไว้ (α = 0.05) จึงปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 

สรุป ค่าเฉลี่ยของเงินเดือนปัจจุบันกับค่าเฉลี่ยของเงินเดือนเริ่มต้นของพนักงานแตกต่างกัน โดย

ค่าเฉลี่ยของเงินเดือนปัจจุบันแตกต่างจากค่าเฉลี่ยของเงินเดือนเริ่มต้นประมาณ 1,7403.48 ดอลล่าร์

สหรัฐ โดยมีความเชื่อมั่นว่าความแตกต่างของค่าเฉลี่ยมีค่าต่ าสุดไม่เกิน 16427.41 ดอลลาร์สหรัฐ และ

สูงสุดไม่เกิน 18,379.59 ดอลลาร์สหรัฐ 
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ตัวอย่างเพิ่มเติม: การแปลผลและสรุป 

#1 

จากการทดสอบความแตกต่างระหว่างค่าเฉลี่ยของกลุ่มตัวอย่างที่มีความสัมพันธ์กัน (paired 

sample t-test) ได้ค่านัยส าคัญทางสถิติ (Sig.) = 0.000 ซึ่งน้อยกว่าเกณฑ์ที่ก าหนดไว้ จึงปฏิเสธ

สมมติฐาน H0 และยอมรับสมมติฐาน H1 คือ ค่าเฉลี่ยของเงินเดือนปัจจุบันกับค่าเฉลี่ยของเงินเดือน

เริ่มต้นของพนักงานแตกต่างกันประมาณ 1,7403.48 ดอลล่าร์สหรัฐ โดยมีความเชื่อมั่นว่าความ

แตกต่างของค่าเฉลี่ยมีค่าต่ าสุดไม่เกิน 16427.41 ดอลลาร์สหรัฐ และสูงสุดไม่เกิน 18,379.59 ดอลลาร์

สหรัฐ 

#2 

จากการทดสอบความแตกต่างระหว่างค่าเฉลี่ยของเงินเดือนปัจจุบันกับค่าเฉลี่ยของเงินเดือน

เริ่มต้นของพนักงานแสดงให้เห็นว่า มีแตกต่างกันอย่างมีนัยส าคัญทางสถิติ 

 

  



ก า ร ท ด ส อ บ ข้ อ มู ล แ บ บ อิ ง ค่ า พ า ร า มิ เ ต อ ร์ | 247 

3. การทดสอบค่าเฉลี่ยของกลุ่มตัวอย่างที่เป็นอิสระจากกัน 2 กลุ่ม  

 การทดสอบค่าเฉลี่ยของกลุ่มตัวอย่างที่เป็นอิสระจากกัน 2 กลุ่ม (2 Samples t Tests) คือ การ

เปรียบเทียบข้อมูลของกลุ่มตัวอย่างที่ไม่มีความสัมพันธ์กัน 2 กลุ่ม เพ่ือตัดสินใจว่า ค่าเฉลี่ยของข้อมูลมี

ความแตกต่างกันหรือไม่แตกต่างกัน  

การทดสอบแบบนี้อาจมีชื่อเรียกเป็นอย่างอ่ืน ได้แก่ Independent t Test, Independent 

Measures t Test, Independent Two-sample t Test, Student t Test, Uncorrelated Scores t 

Test, Unpaired t Test และ Unrelated t Test 

ตัวอย่างค าถามการวิจัย 

จากข้อมูลการส ารวจพนักงานในหน่วยงานต้องการทราบว่า พนักงานระหว่างชนกลุ่มหลักกับ

ชนกลุ่มน้อยมีค่าเฉลี่ยของประสบการณ์ก่อนท างานแตกต่างกันหรือไม่ 

3.1 ข้อตกลงเบื้องต้น 

ขั้นตอน ข้อตกลง 

การออกแบบการวิจัย 1. กลุ่มตัวอย่างได้มาจากประชากรที่ทราบจ านวน (know population) โดย
การสุ่มตัวอย่างแบบสุ่มที่เป็นอิสระจากกัน (independence random 
sampling) 

 2. กลุ่มตัวอย่างมีขนาดใหญ่ (มากกว่า 30) 

 3. ตัวแปรอิสระเป็นตัวแปรแบบค่าจัดประเภท (categorical variable) มีอย่าง
น้อย 2 กลุ่ม  

 4. ตัวแปรตามเป็นตัวแปรแบบค่าต่อเนื่อง (continuous variable) 

การวิเคราะห์ข้อมูล 1. ข้อมูลทั้งสองกลุ่มมีการแจกแจงแบบปกติ (normal distribution) 

 2. ข้อมูลระหว่างกลุ่มมีความแปรปรวนเท่ากัน (homogeneity of Variance)  
3. ข้อมูลทั้งสองกลุ่มไม่มีค่าผิดปกติ (outliers) หรือค่าต่างสุด (extremes) 

 

 



248 | ก า ร ใ ช้ โ ป ร แ ก ร ม ค อ ม พิ ว เ ต อ ร์ ท า ง ส ถิ ติ ใ น ด้ า น สั ง ค ม ศ า ส ต ร์  

3.2 รูปแบบการทดสอบตัวแปร 

ตัวแปรอิสระ 

-> 

ตัวแปรตาม 

ค่าจัดประเภท ค่าต่อเนื่อง 

กลุ่มชน (minority) 
- ชนกลุ่มหลัก 
- ชนกลุ่มน้อย 

ประสบการณ์ก่อนท างาน (prevexp) 

3.3 การก าหนดสมมติฐานและเกณฑ์การทดสอบ 

ตารางที ่(#) แสดงการเปรียบเทียบค่าเฉลี่ยประสบการณ์ก่อนท างานของพนักงานระหว่างกลุ่มชน 

กลุ่มชน จ านวน ค่าเฉลี่ย S.D. C.V. 

ชนกลุ่มหลัก 370 87.84 104.56 119.04 

ชนกลุ่มน้อย 104 124.38 100.07 80.46 

รวม 474 95.86 104.59 109.11 

จากตารางที่ (#) แสดงให้เห็นว่า พนักงานที่เป็นกลุ่มตัวอย่างจ านวน 474 คน เป็นชนกลุ่มหลัก 

จ านวน 370 คน มีประสบการณ์ก่อนท างานเฉลี่ย 87.84 เดือน ส่วนกลุ่มตัวอย่างที่เป็นกลุ่มน้อย จ านวน 

104 คน มีประสบการณ์ก่อนท างานเฉลี่ย 124.38 เดือน  

จากการเปรียบเทียบพนักงานที่เป็นชนกลุ่มหลักมีประสบการณ์ก่อนการท างานน้อยกว่าพนักงาน

ที่เป็นชนกลุ่มน้อย 

ดังนั้น เพ่ือเป็นการยืนข้อสรุปที่ว่า กลุ่มตัวอย่างที่เป็นพนักงานชนกลุ่มหลักมีประสบการณ์ก่อน

การท างานแตกต่างกับกลุ่มตัวอย่างที่เป็นพนักงานชนกลุ่มน้อย จึงท าการทดสอบความแตกต่างระหว่าง

กลุ่มตัวอย่าง โดยก าหนดสมมติฐาน ดังนี้ 

H0: พนักงานที่เป็นชนกลุ่มหลักและชนกลุ่มน้อยมีค่าเฉลี่ยของประสบการณ์ก่อนท างานเท่ากัน 

H1: พนักงานที่เป็นชนกลุ่มหลักค่าเฉลี่ยของประสบการณ์ก่อนท างานน้อยกว่าพนักงานที่เป็นชน

กลุ่มน้อย 
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เกณฑ์ในการทดสอบสมมติฐาน คือ หากการทดสอบความแตกต่างของค่าเฉลี่ยระหว่างกลุ่ม

ตัวอย่างที่เป็นอิสระจากกัน (Independent sample t-test) ได้ค่าความน่าจะเป็น (p-value) มากกว่า

ค่านัยส าคัญทางสถิติ (α = 0.05) จะยอมรับสมมติฐาน H0 แต่หากได้ค่าความน่าจะเป็น (p-value) น้อย

กว่าหรือเท่ากับค่านัยส าคัญทางสถิติ (α = 0.05) จะปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 

3.4 การใช้โปรแกรมคอมพิวเตอร์วิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล File -> Open -> Employee data.sav 
๏ เลือกเมนู Analyze -> Compare Means -> Independent Samples T Test… 
o Test Variable (s): เลือกตัวแปรค่าต่อเนื่อง 1 ตัวแปร หรือมากกว่า 1 ตัวแปร จากรายการตัว

แปรด้านซ้าย  
o Grouping Variable: เลือกตัวแปรค่าแบ่งกลุ่ม 1 ตัวแปร   
o กดปุ่ม Define Groups…  

- Use specified values: ก าหนดค่าของตัวแปรค่าแบ่งกลุ่มใน Group 1: และ Group2: หรือ 

- Cut point: ก าหนดจุดแบ่งกลุ่มใน (กรณีต้องการรวมกลุ่มที่มีลักษณะเป็นค่าต่อเนื่องเป็น 2 กลุ่ม)  

o กดปุ่ม Continue 
o กดปุ่ม Options 

- Confidence Interval Percentage: ก าหนดช่วงความเชื่อม่ันในช่อง (ค่าปกติ .95) 

- Missing Values เลือกวิธีการค านวณค่าสูญหายในชุดค าสั่ง  

 Exclude cases analysis by analysis (วิเคราะห์ตัวอย่างที่ไม่มีข้อมูลสูญหายในแต่ละตัวแปร
ทดสอบ) 

 Exclude cases listwise (วิเคราะห์ตัวอย่างที่ไม่มีข้อมูลสูญหายในทุกตัวแปรทดสอบ) 
o กดปุ่ม Continue 
o กดปุ่ม OK 
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3.5 ผลการวิเคราะห์ 

 

 

3.6 การสร้างตารางแสดงผลการทดสอบ 

ตารางที ่(#) แสดงผลการทดสอบการเปรียบเทียบค่าเฉลี่ยประสบการณ์ก่อนท างานของพนักงานระหว่าง

กลุ่มชน 

ประสบการณ์ 

ระหว่างกลุ่มชน 

Leven’s Test 
t df Sig. 

Mean 

Difference 

95% Confidence Level 

F Sig. Lower Upper 

ประสบการณ์ก่อนท างาน 0.107 0.74 -3.18 472 0.002 -36.54 -59.13 -13.95 

3.7 การแปลผลและสรุป 

 จากตารางที่ (#) แสดงให้เห็นว่า ค่าความน่าจะเป็น (Sig.) = 0.002 มีค่าน้อยกว่าค่านัยส าคัญ

ทางสถิติท่ีก าหนดไว้ (α = 0.05) จึงปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1  

สรุป พนักงานที่เป็นชนกลุ่มหลักมีค่าเฉลี่ยของประสบการณ์ก่อนท างานน้อยกว่าพนักงานที่เป็น

ชนกลุ่มน้อยประมาณ 36.54 เดือน โดยมีความเชื่อมั่นว่าความแตกต่างของค่าเฉลี่ยมีค่าต่ าสุดไม่เกิน 

56.13 เดือน และสูงสุดไม่เกิน 13.95 เดือน 
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Tips: การแปลผลและสรุป 

#1 

จากตารางที่ (#) ผลการทดสอบแสดงให้เห็นว่า พนักงานที่เป็นชนกลุ่มหลักมีประสบการณ์

ก่อนท างานน้อยกว่าพนักงานที่เป็นชนกลุ่มน้อยโดยเฉลี่ย 36.54 เดือน อย่างมีนัยส าคัญทางสถิติ 

#2 

จากตารางที่ (#) ผลการทดสอบแสดงให้เห็นว่า พนักงานที่เป็นชนกลุ่มหลักค่าเฉลี่ยของ

ประสบการณ์ก่อนท างานน้อยกว่าพนักงานที่เป็นชนกลุ่มน้อย อย่างมีนัยส าคัญทางสถิติ 

#3 

จากตารางที่ (#) ผลการทดสอบแสดงให้เห็นว่า กลุ่มตัวอย่างที่เป็นพนักงานชนกลุ่มหลักมี

ประสบการณ์ก่อนท างานแตกต่างกับกลุ่มตัวอย่างที่เป็นพนักงานชนกลุ่มน้อย อย่างมีนัยส าคัญทาง

สถิติ 
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4. การทดสอบค่าเฉลี่ยของกลุ่มตัวอย่างที่เป็นอิสระจากกันมากกว่า 2 กลุ่ม  

การทดสอบค่าเฉลี่ยของกลุ่มตัวอย่างที่เป็นอิสระจากกันมากกว่า 2 กลุ่ม (One Way Analysis 

of Variance of Analysis: One-way ANOVA) คือ การเปรียบเทียบข้อมูลของกลุ่มตัวอย่างที่เป็นอิสระ

จากกันมากกว่า 2 กลุ่ม เพ่ือตัดสินใจว่า ค่าเฉลี่ยของข้อมูลมีความแตกต่างกันหรือไม่แตกต่างกัน 

การทดสอบแบบนี้อาจมีชื่อเรียกเป็นอย่างอ่ืน ได้แก่ One-Factor ANOVA, One-Way Analysis 

of Variance และ Between Subjects ANOVA 

ตัวอย่างค าถามการวิจัย 

จากข้อมูลการส ารวจพนักงานในหน่วยงานต้องการทราบว่า พนักงานที่มีต าแหน่งงานแตกต่าง

กันมีค่าเฉลี่ยของประสบการณ์ก่อนท างานแตกต่างกันหรือไม่ 

4.1 ข้อตกลงเบื้องต้น 

ขั้นตอน ข้อตกลง 

การออกแบบการวิจัย 1. กลุ่มตัวอย่างได้มาจากประชากรที่ทราบจ านวน (know population) โดย
การสุ่มตัวอย่างแบบสุ่มที่เป็นอิสระจากกัน (independence random 
sampling) 

 2. กลุ่มตัวอย่างมีขนาดใหญ่ (มากกว่า 30) 

 3. ตัวแปรอิสระเป็นตัวแปรแบบค่าจัดประเภท (categorical variable) มีการ
แบ่งประเภทอย่างน้อย 3 กลุ่ม 

 4. ตัวแปรตามเป็นตัวแปรแบบค่าต่อเนื่อง (continuous variable) 

การวิเคราะห์ข้อมูล 1. ข้อมูลของแต่ละกลุ่มมีการแจกแจงแบบปกติ (normal distribution) 

 2. ข้อมูลของแต่กลุ่มมีความแปรปรวนเท่ากัน (homogeneity of variance) 

 3. ข้อมูลของแต่ละกลุ่มไม่มีค่าผิดปกติ (outliers) หรือค่าต่างสุด (extremes) 
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4.2 รูปแบบการทดสอบตัวแปร 

ตัวแปรอิสระ 

-> 

ตัวแปรตาม 
ค่าจัดประเภท  

(มาตราแบบจัดอันดับ 3 กลุ่มหรือมากกว่า) 
ค่าต่อเนื่อง 

ต าแหน่งงาน (jobcat) 
- เจ้าหน้าที่ปฏิบัติงาน 
- หัวหน้างาน 
- ผู้จัดการ 

ค่าเฉลี่ยของประสบการณ์ก่อนท างาน (prevexp) 

4.3 การก าหนดสมมติฐานและเกณฑ์การทดสอบ 

ตารางที ่(#) แสดงการเปรียบเทียบค่าเฉลี่ยประสบการณ์ก่อนท างานของพนักงานระหว่างต าแหน่งงาน 

ต าแหน่งงาน จ านวน ต่ าสุด สูงสด ค่าเฉลี่ย S.D. 

เจ้าหน้าที่ปฏิบัติงาน 363 0 476 85.04 95.27 

หัวหน้างาน 27 144 460 298.11 101.43 

ผู้จัดการ 84 3 285 77.62 73.26 

รวม 474 0 476 95.86 104.59 

 จากตารางที่ (#) แสดงให้เห็นว่า กลุ่มตัวอย่างพนักงานที่เป็นหัวหน้างานมีประสบการณ์ก่อน

ท างานมากที่สุด คือ 298.11 เดือน รองลงมาเป็นเจ้าหน้าที่ปฏิบัติงาน คือ 85.04 เดือน และผู้จัดการมี

ประสบการณ์ก่อนท างานน้อยที่สุด คือ 77.62 เดือน หรือสรุปได้ว่า พนักงานที่มีต าแหน่งงานแตกต่างกัน

มีประสบการณ์การก่อนท างานแตกต่างกัน 

 ดังนั้น เพ่ือเป็นการยืนยันว่า พนักงานที่มีต าแหน่งงานแตกต่างกันมีประสบการณ์การก่อนท างาน

แตกต่างกัน จึงท าการทดสอบด้วยวิธีการทางสถิติ โดยมีสมมติฐาน ดังนี้ 

 H0: กลุ่มตัวอย่างท่ีมีต าแหน่งงานแตกต่างกันมีค่าเฉลี่ยของประสบการณ์ก่อนท างานไม่แตกต่างกัน 

 H1: กลุ่มตัวอย่างท่ีมีต าแหน่งงานแตกต่างกันมีค่าเฉลี่ยของประสบการณ์ก่อนท างานแตกต่างกัน 

เกณฑ์ในการทดสอบสมมติฐาน คือ หากการทดสอบความแตกต่างของค่าเฉลี่ยระหว่างกลุ่ม

ตัวอย่างมากกว่า 2 กลุ่ม (One-way ANOVA) ได้ค่าความน่าจะเป็น (p-value) มากกว่าค่านัยส าคัญทาง
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สถิติ (α = 0.05) จะยอมรับสมมติฐาน H0 แต่หากได้ค่าความน่าจะเป็น (p-value) น้อยกว่าหรือเท่ากับ

ค่านัยส าคัญทางสถิติ (α = 0.05) จะปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 

4.4 การใช้โปรแกรมคอมพิวเตอร์วิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล File -> Open -> Employee data.sav 
๏ เลือกเมน ูAnalyze -> Compare Means -> One-Way ANOVA… 

o Dependent List: เลือกตัวแปรแบบค่าต่อเนื่อง 1 ตัวแปร หรือมากกว่า 1 ตัวแปร 
จากรายการตัวแปรด้านซ้าย  

o Factor: เลือกตัวแปรแบบค่าจัดประเภท 1 ตัวแปร จากรายการตัวแปรด้านซ้าย  
o ในกลุ่มค าสั่ง Statistics เลือกค่าสถิติ Descriptives  
o กดปุ่ม OK 

 

4.5 ผลการวิเคราะห์ 

 

 



ก า ร ท ด ส อ บ ข้ อ มู ล แ บ บ อิ ง ค่ า พ า ร า มิ เ ต อ ร์ | 255 

4.6 การสร้างตารางแสดงผลการทดสอบ 

ตารางที ่(#) แสดงผลการทดสอบการเปรียบเทียบค่าเฉลี่ยประสบการณ์ก่อนท างานของพนักงานระหว่าง

ต าแหน่งงาน 

ต าแหน่งงาน จ านวน ค่าเฉลี่ย S.D. F df Sig. 

เจ้าหน้าที่ปฏิบัติงาน 363 85.04 95.27 

69.19 2 0.00 
หัวหน้างาน 27 298.11 101.43 

ผู้จัดการ  84 77.62 73.26 

รวม 474 95.86 104.59 

4.7 การแปลผลและสรุป 

จากตารางที่ (#) ผลการทดสอบแสดงให้เห็นว่า ค่านัยความน่าจะเป็น (Sig.) = 0.000 มีค่าน้อย

กว่าค่านัยส าคัญทางสถิติท่ีก าหนดไว้ (α = 0.05) จึงปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1  

สรุป กลุ่มตัวอย่างท่ีมีต าแหน่งงานแตกต่างกันมีค่าเฉลี่ยของประสบการณ์ก่อนท างานแตกต่างกัน 

โดยหัวหน้างานมีค่าเฉลี่ยของประสบการก่อนท างานมากที่สุด รองลงมา คือ เจ้าหน้าที่ปฏิบัติงาน และ

ผู้จัดการ ตามล าดับ 

จากการทดสอบสมมติฐานพบว่า กลุ่มตัวอย่างที่มีต าแหน่งงานแตกต่างกันมีค่าเฉลี่ยของ

ประสบการณ์ก่อนท างานแตกต่างกัน นั่นแสดงว่า มีกลุ่มตัวอย่างที่มีต าแหน่งงานแตกต่างกันอย่างน้อย 1 

คู่ ที่มีค่าเฉลี่ยของประสบการณ์ก่อนท างานแตกต่างกัน  

เนื่องจากกลุ่มตัวอย่างพนักงานที่มีต าแหน่งงานแตกต่างกันแต่ละกลุ่มมีจ านวนไม่เท่ากัน จึงท า

การทดสอบความแปรปรวนระหว่างกลุ่มด้วยสถิติของเลวีน (Levene Statistic) เพ่ือตัดสินใจเลือกการ

วิเคราะห์เปรียบเทียบความแตกต่างของค่าเฉลี่ย (Post Hoc Tests) ของประสบการณ์ก่อนการท างาน

ของพนักงานที่มีต าแหน่งงานแตกต่างกัน โดยมีสมมติฐานดังนี้ 
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 H0: ความแปรปรวนของค่าเฉลี่ยประสบการณ์ก่อนการท างานของพนักงานที่มีต าแหน่งงาน

แตกต่างกันเท่ากัน 

H1: ความแปรปรวนของค่าเฉลี่ยประสบการณ์ก่อนการท างานของพนักงานที่มีต าแหน่งงาน

แตกต่างกันไม่เท่ากัน 

 เกณฑ์ในการทดสอบสมมติฐาน คือ หากการทดสอบความแปรปรวนด้วยวิธีของเลวีน 

(Levene’s Test) ได้ค่าความน่าจะเป็น (p-value) มากกว่าค่านัยส าคัญทางสถิติ (α = 0.05) จะยอมรับ

สมมติฐาน H0 แต่หากได้ค่าความน่าจะเป็น (p-value) น้อยกว่าหรือเท่ากับค่านัยส าคัญทางสถิติ (α = 

0.05) จะปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 

4.7.1 การทดสอบความแปรปรวน 

๏ เลือกเมน ูAnalyze -> Compare Means -> One-Way ANOVA… 
o Dependent List: เลือกตัวแปรแบบค่าต่อเนื่อง 1 ตัวแปร หรือมากกว่า 1 ตัวแปร จาก

รายการตัวแปรด้านซ้าย  
o Factor: เลือกตัวแปรแบบค่าจัดประเภท 1 ตัวแปร ใส่ในช่อง  
o ในกลุ่มค าสั่ง Statistics เลือกค่าสถิติ Homogeneity  
o กดปุ่ม OK 

 

4.7.1.1 ผลการทดสอบความแปรปรวน 
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4.7.1.2 การสร้างตารางแสดงผลการทดสอบความแปรปรวน 

ตารางที ่(#) แสดงผลการทดสอบความแปรปรวนของค่าเฉลี่ยประสบการณ์ก่อนการท างานของพนักงาน

ที่มีต าแหน่งงานแตกต่างกัน 

Levene Statistic df1 df2 Sig. 

2.54 2 471 .080 

จากตารางที่ (#) ผลการทดสอบแสดงให้เห็นว่า ค่าความน่าจะเป็น (Sig.) = 0.80 มีค่ามากกว่า

ค่านัยส าคัญทางสถิติท่ีก าหนดไว้ (α = 0.05) จึงยอมรับสมมติฐาน H0  

สรุป ความแปรปรวนของค่าเฉลี่ยประสบการณ์ก่อนการท างานของพนักงานที่มีต าแหน่งงาน

แตกต่างกันเท่ากัน 
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4.7.2 การทดสอบเปรียบเทียบค่าเฉลี่ยรายคู่หลังการทดสอบรวม 

๏ เลือกเมนู Analyze -> Compare Means -> One-Way ANOVA… 
o Dependent List: เลือกตัวแปรแบบค่าต่อเนื่อง 1 ตัวแปร หรือมากกว่า 1 ตัวแปร 

จากรายการตัวแปรด้านซ้าย  
o Factor: เลือกตัวแปรแบบค่าจัดประเภท 1 ตัวแปร จากรายการตัวแปรด้านซ้าย  
o กดปุ่ม Post-Hoc… (ทดสอบค่าเฉลี่ยรายคู่) 

- เลือกค่าสถิติ Bonferroni หรือ Fisher’s LSD หรือ Scheffé, Šídák หรือ Turkey 

HSD (ค่าความแปรปรวนของทั้งสองกลุ่มเท่ากัน)18 

- เลือกค่าสถิติ Games Howell (ค่าความแปรปรวนของทั้งสองกลุ่มไม่เท่ากัน) 

o กดปุ่ม Continue 
o กดปุ่ม OK 

  

 จากการทดสอบความแปรปรวนของค่าเฉลี่ยประสบการณ์ก่อนท างานระหว่างกลุ่มพนักงานที่มี

ต าแหน่งแตกต่างกัน พบว่ามีความแปรวนเท่ากัน จึงท าการทดสอบความแตกต่างของค่าเฉลี่ยรายคู่ (Post 

Hoc Tests) ด้วยวิธีของทูกี้ (Tukey HSD: Tukey Honestly Significant Difference) โดยมีสมมติฐาน

ดังนี้ 

 H0: ค่าเฉลี่ยของประสบการณ์ก่อนท างานไม่แตกต่างกัน 

 H1: มีค่าเฉลี่ยของประสบการณ์ก่อนท างานแตกต่างกันอย่างน้อย 1 คู่  

                                                           
18

 ค่าสถิติที่นิยมใช้กันอย่างแพร่หลาย คือ Scheffé เพราะเป็นการทดสอบเชิงอนุรักษ์ (ค่านัยส าคัญทางสถิติของอัตรา

ความคลาดเคลื่อนน้อยกว่า 0.05) มีโอกาสท าให้เกิดความผิดพลาดชนิดที่ 1 (Type I Error) น้อยกว่าสถิติเชิงก้าวหน้า 
(ค่านัยส าคัญทางสถิติของอัตราความคลาดเคลื่อนมากกว่า 0.05) เหมาะกับข้อมูลที่มีขนาดตัวอย่างเท่ากันและไม่เท่ากัน 
และมีการเปรียบเทียบรายคู่มากกว่า 3 กลุ่ม แต่หากท าการเปรียบเทียบรายคู่ 2-3 กลุ่ม มีขนาดกลุ่มตัวอย่างเท่ากันและ
ไม่เท่ากัน นิยมใช้ Tukey HSD เพราะจะใช้การทดสอบเชิงอนุรักษ์  
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 เกณฑ์ในการทดสอบสมมติฐาน คือ หากการทดสอบความแตกต่างของค่าเฉลี่ย (Mean 

difference) ได้ค่าความน่าจะเป็น (p-value) มากกว่าค่านัยส าคัญทางสถิติ (α = 0.05) จะยอมรับ

สมมติฐาน H0 แต่หากได้ค่าความน่าจะเป็น (p-value) น้อยกว่าหรือเท่ากับค่านัยส าคัญทางสถิติ (α = 

0.05) จะปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 

4.7.2.1 ผลการทดสอบเปรียบเทียบค่าเฉลี่ยรายคู่ 

 

4.7.2.2 การสร้างตารางแสดงผลการทดสอบค่าเฉลี่ยรายคู่ 

ตารางที ่(#) แสดงผลการทดสอบการเปรียบเทียบค่าเฉลี่ยของประสบการณ์ก่อนท างานระหว่างต าแหน่งงาน 

ประสบการณ์ก่อน

ท างาน(ค่าเฉลี่ย) 

เจ้าหน้าที่ปฏิบัติงาน 

(85.04) 

หัวหน้างาน 

(298.11) 

ผู้จัดการ 

(77.62) 

เจ้าหน้าที่ปฏิบัติงาน

(85.04) 

- -213.073* 7.420 

หัวหน้างาน 

(298.11) 

 - 220.492* 

ผู้จัดการ 

(77.62) 

  - 

* มีค่าความน่าจะเป็น (Sig.) = 0.000 

 จากตารางที่ (#) ผลการทดสอบแสดงให้เห็นว่า การเปรียบเทียบค่าเฉลี่ยประสบการณ์ก่อน

ท างานรายคู่ระหว่างเจ้าหน้าที่ปฏิบัติงานกับหัวหน้างาน และหัวหน้างานกับผู้จัดการ มีค่าความน่าจะเป็น 

(Sig.) = 0.000 น้อยกว่าค่านัยส าคัญทางสถิติที่ก าหนดไว้ (α = 0.05) จึงปฏิเสธสมมติฐาน H0 และ

ยอมรับสมมติฐาน H1 
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 สรุป มีกลุ่มตัวอย่างท่ีมีค่าเฉลี่ยของประสบการณ์ก่อนท างานแตกต่างกันอย่างน้อย 1 คู่ ต าแหน่ง

งานที่มีค่าเฉลี่ยของประสบการณ์ก่อนท างานแตกต่างกัน คือ เจ้าหน้าที่ปฏิบัติงานกับหัวหน้างาน และ

หัวหน้างานกับผู้จัดการ ส่วนเจ้าหน้าที่ปฏิบัติงานกับผู้จัดการ มีค่าเฉลี่ยของประสบการณ์ก่อนท างานไม่

แตกต่างกัน 
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ตัวอย่างเพิ่มเติม: การทดสอบ การแปลผลและสรุป 

#1 

ตารางที ่(#) แสดงผลการทดสอบเปรียบเทียบค่าเฉลี่ยประสบการณ์ก่อนท างานของพนักงาน 

ต าแหน่งงาน จ านวน ค่าเฉลี่ย S.D. F Df Sig. 

เจ้าหน้าที่ปฏิบัติงาน 363 85.04 95.27 

69.19 2 0.00 
หัวหน้างาน 27 298.11 101.43 

ผู้จัดการ  84 77.62 73.26 

รวม 474 95.86 104.59 

Levene Statistic = 2.54, df1=2, df2=471, Sig.=0.08 

 จากตารางที่ (#) ผลการทดสอบแสดงให้เห็นว่า กลุ่มตัวอย่างที่เป็นพนักงานต าแหน่งหัวหน้างาน

มีประสบการณ์ก่อนท างานมากที่สุด รองลงมา คือ เจ้าหน้าที่ปฏิบัติงาน และผู้จัดการ ตามล าดับ  

สรุป พนักงานที่มีต าแหน่งงานแตกต่างกันมีประสบการณ์การก่อนท างานแตกต่างกันอย่างมี

นัยส าคัญทางสถิติ โดยมีความแปรปรวนของค่าเฉลี่ยของประสบการณ์ก่อนท างานไม่แตกต่างกัน ดังนั้น

จึงท าการทดสอบความแตกต่างของค่าเฉลี่ยรายคู่ (Post Hoc Tests) ด้วยวิธีของเชฟเฟ่ (Scheffe's 

Method) 

ตารางที่ (#) แสดงผลการทดสอบเปรียบเทียบค่าเฉลี่ยประสบการณ์ก่อนท างานของพนักงานที่มีต าแหน่ง

แตกต่างกัน 

ประสบการณ์ก่อนท างาน 

(ค่าเฉลี่ย) 

เจ้าหน้าที่ปฏิบัติงาน 

(85.04) 

หัวหน้างาน 

(298.11) 

ผู้จัดการ 

(77.62) 

เจ้าหน้าที่ปฏิบัติงาน 

(85.04) 
- -213.073* 7.420 

หัวหน้างาน 

(298.11) 
 - 220.492* 

ผู้จัดการ 

(77.62) 
  - 

* มีค่าความน่าจะเป็น (Sig.) = 0.000 
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 จากตารางที่ (#) ผลการทดสอบแสดงให้เห็นว่า กลุ่มตัวอย่างที่เป็นพนักงานต าแหน่งเจ้าหน้าที่

ปฏิบัติงานมีประสบการณ์ก่อนท างานโดยเฉลี่ยแตกต่าง (น้อยกว่า) กับต าแหน่งหัวหน้างาน และพนักงาน

ต าแหน่งหัวหน้างานมีประสบการณ์ก่อนท างานโดยเฉลี่ยแตกต่าง (มากกว่า) กับต าแหน่งผู้จัดการ อย่างมี

นัยส าคัญทางสถิติ ส่วนกลุ่มตัวอย่างพนังงานต าแหน่งเจ้าหน้าที่ปฏิบัติงานมีประสบการณ์ก่อนท างานไม่

แตกต่างกับต าแหน่งผู้จัดการ หรือกล่าวได้ว่า กลุ่มตัวอย่างพนักงานต าแหน่งหัวหน้างานมีประสบการณ์

ก่อนท างานโดยเฉลี่ยมากกว่าต าแหน่งเจ้าหน้าที่ปฏิบัติงานและผู้จัดการ 

#2 

ตารางค่าเฉลี่ยเงินเดือนปัจจุบันของพนักงาน 

ต าแหน่งงาน จ านวน ค่าเฉลี่ยของเงินเดือนปัจจุบัน (ดอลลาร์สหรัฐ) S.D. 

เจ้าหน้าที่

ปฏิบัติงาน 

363 27,838.54 7,567.995 

หัวหน้างาน 27 30,938.89 2,114.616 

ผู้จัดการ 84 63,977.80 18,244.776 

รวม 474 34,419.57 17,075.661 

F = 434.481, df = 2, Sig. = 0.000, Levene Statistic = 59.733, df1=2, df2=471, Sig.=0.000 

 จากตารางที่ (#) ผลการทดสอบแสดงให้เห็นว่า กลุ่มตัวอย่างที่เป็นพนักงานจ านวน 474 คน 

ต าแหน่งงานที่มีเงินเดือนปัจจุบันเฉลี่ยสูงสุดคือ ต าแหน่งผู้จัดการ รองลงมาเป็น หัวหน้างาน และ

ต าแหน่งที่มีเงินเดือนปัจจุบันเฉลี่ยต่ าที่สุด คือ ต าแหน่งเจ้าหน้าที่ปฏิบัติงาน จากการทดสอบเปรียบ

ค่าเฉลี่ยของเงินเดือนปัจจุบันด้วยวิธีการทางสถิติ พบว่า พนักงานที่มีต าแหน่งงานแตกต่างกันอย่างน้อย 1 

คู่ จะมีเงินเดือนปัจจุบันเฉลี่ยแตกต่างกัน อย่างมีนัยส าคัญทางสถิติ และจากการทดสอบความแปรปรวน

ระหว่างกลุ่มพบว่า ค่าเฉลี่ยของเงินเดือนปัจจุบันมีความแปรปรวนแตกต่างกัน จึงท าการทดสอบความ

แตกต่างของค่าเฉลี่ยรายคู่ (Post Hoc Tests) ด้วยวิธีของทามเฮน (Tamhane's Method)  
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ตารางที่ (#) แสดงผลการทดสอบเปรียบเทียบค่าเฉลี่ยเงินเดือนปัจจุบันของพนักงานที่มีต าแหน่งแตกต่างกัน 

เงินเดือนปัจจุบัน 

(ค่าเฉลี่ย) 

เจ้าหน้าที่ปฏิบัติงาน 

($27,838.54) 

หัวหน้างาน 

($30,938.89) 

ผู้จัดการ 

($63,977.80) 

เจ้าหน้าที่ปฏิบัติงาน 

($27,838.54) 
- -$3,100.349* -$36,139.258* 

หัวหน้างาน 

($30,938.89) 
 - -$33,038.909* 

ผู้จัดการ 

($63,977.80) 
  - 

* มีค่าความน่าจะเป็น (Sig.) = 0.000 

จากตารางที่ (#) ผลการทดสอบแสดงให้เห็นว่า กลุ่มตัวอย่างที่เป็นพนักงานต าแหน่งงานเป็น

เจ้าหน้าที่ปฏิบัติงาน มีเงินเดือนปัจจุบันเฉลี่ยน้อยกว่า กลุ่มตัวอย่างพนักงานที่มีต าแหน่งงานเป็นหัวหน้า

งานและผู้จัดการ และกลุ่มตัวอย่างพนักงานที่มีต าแหน่งงานเป็นหัวหน้างานมีเงินเดือนปัจจุบันเฉลี่ยน้อย

กว่า กลุ่มตัวอย่างพนักงานที่มีต าแหน่งงานเป็นผู้จัดการ อย่างมีนัยส าคัญทางสถิติ ดังนั้นจึงสรุปได้ว่า กลุ่ม

ตัวอย่างพนักงานที่มีต าแหน่งงานแตกต่างกัน มีเงินเดือนปัจจุบันเฉลี่ยแตกต่างกันทุกต าแหน่ง 
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5. การทดสอบความสมัพันธ์รายคู่แบบเพียร์สัน  

การทดสอบความสัมพันธ์รายคู่แบบเพียร์สัน (Pearson’s Correlation) คือ การวัดความสัมพันธ์

เชิงเส้นตรง (linear relationship) จากค่าสัมประสิทธิ์สหสัมพันธ์ (correlation coefficient) ระหว่างคู่

ตัวแปร (2 ตัวแปร) ที่เป็นตัวแปรแบบค่าต่อเนื่อง (continuous variables) จะมีความสัมพันธ์กันอย่างมี

นัยส าคัญทางสถิติหรือไม่ เพ่ืออธิบายความเข้ม/ขนาด (strength) และทิศทาง (direction)  

ความสัมพันธ์เชิงเส้นตรง คือ ลักษณะของความสัมพันธ์ระหว่างตัวแปรเมื่อตัวแปรหนึ่งมีการ

เปลี่ยนแปลงจะมีความเก่ียวข้องกับสัดส่วนการเปลี่ยนแปลงในอีกตัวแปรหนึ่ง 

การทดสอบแบบนี้อาจมีชื่อเรียกในชื่ออ่ืน เช่น Pearson correlation coefficient, Pearson’s 

correlation และ Pearson product-moment correlation (PPMC) 

การแปรผลค่าความสัมพันธ์ขึ้นอยู่ กับบริบท (context) และจุดประสงค์/ความต้องการ 

(purposes) ค่า  r = 0.90 อาจสูงมากในสาขาวิชาด้านสังคมศาสตร์ แต่อาจมีค่าต่ ามากในสาขาวิชา

ฟิสิกส์ที่มีการใช้เครื่องมือวัดที่มีคุณภาพสูง (Araújo Jr, A.H.A. et al., 2011) ค่าที่ค านวณได้อาจมีค่าเป็น 

+ หรือ – แสดงถึงความสัมพันธ์ที่แตกต่างกันดังนี้  

ค่า r เป็น + แสดงว่า ตัวแปรทั้งสองตัวแปร (ตัวแปรอิสระและตัวแปรตาม) มีความสัมพันธ์ใน

ทิศทางเดียวกัน 

ค่า r เป็น – แสดงว่า ตัวแปรทั้งสองตัวแปร (ตัวแปรอิสระและตัวแปรตาม) มีความสัมพันธ์ใน

ทิศทางตรงกันข้าม 

ค่า r เป็น 0 แสดงว่า ตัวแปรทั้งสองตัวแปร (ตัวแปรอิสระและตัวแปรตาม) ไม่มีความสัมพันธ์กัน

เลย 

ค่า r มีค่าเข้าใกล้ 1 แสดงว่า ตัวแปรทั้งสองตัวแปร (ตัวแปรอิสระและตัวแปรตาม) มี

ความสัมพันธ์กันมาก 

ค่า r มีค่าเข้าใกล้ 0 แสดงว่า ตัวแปรทั้งสองตัวแปร (ตัวแปรอิสระและตัวแปรตาม)  มี

ความสัมพันธ์กันน้อย 
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ตารางที่ 12.1 การแปลค่าสัมประสิทธิ์สหสัมพันธ์แบบเพียร์สัน 

ค่าสัมประสิทธิ์สหสัมพันธ์ (Correlation Coefficient) 

ค่าของความสัมพันธ์ ความเข้มและทิศทางของความสัมพันธ์ 

1.00 ถึง 0.80 มีความสัมพันธ์เชิงบวกระดับมากอย่างยิ่ง 

0.79 ถึง 0.60 มีความสัมพันธ์เชิงบวกระดับมาก 

0.59 ถึง 0.40 มีความสัมพันธ์เชิงบวกระดับปานกลาง 

0.39 ถึง 0.20 มีความสัมพันธ์เชิงบวกระดับน้อย 

0.19 ถึง 0.01 มีความสัมพันธ์เชิงบวกระดับน้อยมาก 

0.00 ไม่มีความสัมพันธ์ 

-0.01 ถึง -0.19 มีความสัมพันธ์เชิงลบระดับน้อยมาก 

-0.39 ถึง -0.20 มีความสัมพันธ์เชิงลบระดับน้อย 

-0.59 ถึง -0.40 มีความสัมพันธ์เชิงลบระดับปานกลาง 

-0.79 ถึง -0.60 มีความสัมพันธ์เชิงลบระดับมาก 

-1.00 ถึง 0.-80 มีความสัมพันธ์เชิงลบระดับมากอย่างยิ่ง 

ปรับปรุงมาจาก: Evans, J. D. (1996). Straightforward statistics for the behavioral sciences. 

Pacific Grove, CA: Brooks/Cole Publishing. 
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5.1 การทดสอบความสมัพันธ์แบบง่าย  

 การทดสอบความสัมพันธ์แบบง่าย (Simple correlation) คือ การทดสอบความสัมพันธ์ของ

ข้อมูล 1 คู่ เช่น การวิเคราะห์หาความสัมพันธ์ระหว่างประสบการณ์ก่อนท างานกับเงินเดือนเริ่มต้น 

ตัวอย่างค าถามการวิจัย 

จากการส ารวจข้อมูลของพนักงานในหน่วยงานต้องการทราบว่า ประสบการณ์ก่อนการท างานกับ

เงินเดือนเริ่มต้นของพนักงานมีความสัมพันธ์กันหรือไม่ 

5.1.2 ข้อตกลงเบื้องต้น 

ขั้นตอน ข้อตกลง 

การออกแบบการวิจัย 1. กลุ่มตัวอย่างได้มาจากประชากรที่ทราบจ านวน (know population) โดย
การสุ่มตัวอย่างแบบสุ่มที่เป็นอิสระจากกัน (independence random 
sampling) 

 2. มีตัวแปรอิสระ (independent variable) 1 ตัว และตัวแปรตาม 
(dependent variable) 1 ตัว 

 3. ตัวแปรอิสระและตัวแปรตามเป็นตัวแปรแบบค่าต่อเนื่อง (continuous 
variable) 

การวิเคราะห์ข้อมูล 1. ข้อมูลมีการแจกแจงแบบปกติทั้งสองตัวแปร (bivariate normal 
distribution) 

 2. ข้อมูลมีความคงที่ของความแปรปรวนของค่าความคาดเคลื่อน 
(homoscedasticity) ถ้า n = 30 หรือมากกว่า ไม่ต้องทดสอบ 

 3. ข้อมูลทั้ง 2 ตัวแปร ไม่มีค่าสูญหาย (missing values) 

 4. ข้อมูลมีความสัมพันธ์เชิงเส้นตรง (linear relationship) 

5.1.3 รูปแบบการทดสอบตัวแปร 

ตัวแปรอิสระ 

<-> 

ตัวแปรตาม 

ค่าต่อเนื่อง  ค่าต่อเนื่อง 

ประสบการณ์ก่อนท างาน (prevexp) เงินเดือนเริ่มต้น (salbegin) 
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5.1.4 การก าหนดสมมติฐานและเกณฑ์การทดสอบ 

ตารางที ่(#) แสดงค่าเฉลี่ยของประสบการณ์ก่อนท างาน และเงินเดือนเริ่มต้น 

ตัวแปร จ านวน ค่าเฉลี่ย S.D. 

ประสบการณ์ก่อนท างาน (เดือน) 474 95.86 104.586 

เงินเดือนเริ่มต้น (ดอลลาร์สหรัฐ ) 474 17,016.09 7,870.638 

 จากตารางที่ (#) แสดงให้เห็นว่า พนักงาน 474 คน มีประสบการณ์ก่อนท างานเฉลี่ย 95.86 

เดือน และมีเงินเดือนเริ่มต้นเฉลี่ย 17,016.09 ดอลลาร์สหรัฐ  

 จากข้อมูลที่กล่าวมาน่าจะมีความสัมพันธ์ระหว่างตัวแปรประสบการณ์ก่อนท างานและเงินเดือน

เริ่มต้น ดังนั้นจึงท าการทดสอบความสัมพันธ์รายคู่โดยมีสมมติฐานดังนี้ 

 H0: ไมม่ีความสัมพันธ์ระหว่างประสบการณ์ก่อนท างานกับเงินเดือนเริ่มต้นของพนักงาน 

 H1: มีความสัมพันธ์ระหว่างประสบการณ์ก่อนท างานกับเงินเดือนเริ่มต้นของพนักงาน 

 เกณฑ์ในการทดสอบสมมุติฐาน คือ หากการทดสอบความสัมพันธ์ด้วยวิธีของเพียร์สันได้ค่าความ

น่าจะเป็น (p-value) มากกว่าค่านัยส าคัญทางสถิติ (α = 0.05) จะยอมรับสมมติฐาน H0 แต่หากได้ค่า

ความน่าจะเป็น (p-value) น้อยกว่าหรือเท่ากับค่านัยส าคัญทางสถิติ (α = 0.05) จะปฏิเสธสมมติฐาน 

H0 และยอมรับสมมติฐาน H1 
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5.1.5 การใช้โปรแกรมคอมพิวเตอร์วิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล File -> Open -> Employee data.sav 

๏ เลือกเมน ูAnalyze -> Bivariate Correlation… 

o เลือกตัวแปรค่าต่อเนื่อง (continuous variables) 2 ตัวแปร จากรายการตัวแปรในช่อง
ด้านซ้าย -> ช่องด้านขวา  

o ในกลุ่มค าสั่ง Test of Significance เลือกประเภทการทดสอบนัยส าคัญ  
- Two-tailed (สมมติฐานแบบสองหาง r = 0) 

- One-tailed (สมมติฐานแบบหางเดียว r > 0 หรือ r < 0) 

o Flag significant correlations (แสดงเครื่องหมาย * หากมีความสัมพันธ์อย่าง
นัยส าคัญทางสถิติ) เลือก /   

o คลิกปุ่ม OK 

 

5.1.6 ผลการวิเคราะห์ 
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5.1.7 การสร้างตารางแสดงผลการทดสอบ 

ตารางที ่(#) แสดงผลการทดสอบความสัมพันธ์ระหว่างประสบการณ์ก่อนท างานกับเงินเดือนเริ่มต้น 

ตัวแปร จ านวน เงินเดือนเริ่มต้น (r) Sig. (2-tailed) 

ประสบการณ์ก่อนท างาน (เดือน) 474 .05 0.327 

5.1.8 การแปลผลและสรุป 

จากการทดสอบสมมติฐานด้วยการวิเคราะห์ค่าสัมประสิทธิ์สหสัมพันธ์เพียร์สัน พบว่า 

ประสบการณ์ก่อนท างานกับเงินเดือนเริ่มต้นของพนักงาน มีค่าความน่าจะเป็น (Sig.) = 0.327 มากกว่า

ค่านัยส าคัญทางสถิติท่ีก าหนดไว้ (α = 0.05) จึงยอมรับสมมติฐาน H0  

สรุป ไม่มีความสัมพันธ์ระหว่างประสบการณ์ก่อนท างานกับเงินเดือนเริ่มต้นของพนักงาน  

5.2 การทดสอบความสมัพันธ์แบบหพุ  

 การทดสอบความสัมพันธ์แบบพหุ (Multiple correlation) คือ การทดสอบความสัมพันธ์ของ

ข้อมูลรายคู่มากกว่า 1 คู่ เช่น การวิเคราะห์หาความสัมพันธ์ระหว่างระดับการศึกษากับเงินเดือนเริ่มต้น 

ประสบการณ์ก่อนท างานกับเงินเดือนเริ่มต้น   

ตัวอย่างค าถามการวิจัย 

จากข้อมูลการส ารวจพนักงานในหน่วยงานต้องการทราบว่า ระดับการศึกษาและประสบการณ์

ก่อนท างานของพนักงานมีความสัมพันธ์กับเงินเดือนเริ่มต้นหรือไม่ และเงินเดือนเริ่มต้นและระยะเวลา

ท างานของพนักงานมีความสัมพันธ์กับเงินเดือนปัจจุบันหรือไม่ 
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5.2.1 ข้อตกลงเบื้องต้น 

ขั้นตอน ข้อตกลง 

การออกแบบการวิจัย 1. กลุ่มตัวอย่างได้มาจากประชากรที่ทราบจ านวน (know population) โดย
การสุ่มตัวอย่างแบบสุ่มที่เป็นอิสระจากกัน (independence random 
sampling) 

 2. มีตัวแปรอิสระ (independent variable) อย่างน้อย 1 ตัว และตัวแปร
ตาม (dependent variable) อย่างน้อย 1 ตัว 

 3. ตัวแปรอิสระและตัวแปรตามเป็นตัวแปรแบบค่าต่อเนื่อง (continuous 
variable) 

การวิเคราะห์ข้อมูล 1. ข้อมูลมีการแจกแจงแบบปกติทั้งสองตัวแปร (bivariate normal 
distribution) 

 2. ข้อมูลมีความคงที่ของความแปรปรวนของค่าความคาดเคลื่อน 
(homoscedasticity) ถ้า n = 30 หรือมากกว่า ไม่ต้องทดสอบ 

 3. ข้อมูลมีความสัมพันธ์เชิงเส้นตรง (linear relationship) 

5.2.2 รูปแบบการทดสอบตัวแปร 

ตัวแปรอิสระ 

<-> 

ตัวแปรตาม 
ค่าต่อเนื่อง  ค่าต่อเนื่อง 

ระดับการศึกษา: ปี (educ) เงินเดือนเริ่มต้น: ดอลลาร์สหรัฐ (salbegin) 

ประสบการณ์ก่อนท างาน: เดือน (prevexp) เงินเดือนเริ่มต้น: ดอลลาร์สหรัฐ (salbegin) 
เงินเดือนเริ่มต้น: ดอลลาร์สหรัฐ (salbegin) เงินเดือนปัจจุบัน: ดอลลาร์สหรัฐ (salary) 

ระยะเวลาท างาน: เดือน (jobtime) เงินเดือนปัจจุบัน: ดอลลาร์สหรัฐ (salary) 
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5.2.3 การก าหนดสมมติฐานและเกณฑ์การทดสอบ 

ตารางที ่(#) แสดงค่าเฉลี่ยระดับการศึกษา เงินเดือนเริ่มต้น เงินเดือนปัจจุบัน ระยะเวลาท างาน และ

ประสบการณ์ก่อนท างาน 

ตัวแปร จ านวน (คน) ค่าเฉลี่ย S.D. 

ระดบัการศึกษา (ปี) 474 13.49 2.89 

เงินเดือนเริ่มต้น (ดอลลาร์สหรัฐ) 474 17,016.09 7,870.64 

เงินเดือนปัจจุบัน (ดอลลาร์สหรัฐ) 474 34,419.57 17,075.66 

ระยะเวลาท างาน (เดือน) 474 81.11 10.06 

ประสบการณ์ก่อนท างาน (เดือน) 474 95.86 104.59 

 จากตารางที ่(#) แสดให้เห็นว่า พนักงาน 474 คน มีการศึกษาเฉลี่ย 13.49 ปี มีเงินเดือนเริ่มต้น

เฉลี่ย 17,016.09 ดอลลาร์สหรัฐ  มีเงินเดือนปัจจุบันเฉลี่ย 34,419.57 ดอลลาร์สหรัฐ  มีระยะเวลา

ท างานเฉลี่ย 81.11 เดือน และมีประสบการณ์ก่อนท างานเฉลี่ย 65.86 เดือน   

 จากข้อมูลที่กล่าวมาน่าจะมีความสัมพันธ์ระหว่างตัวแปรบางคู่ ดังนั้นจึงท าการทดสอบ

ความสัมพันธ์รายคู่โดยมีสมมติฐานดังนี้ 

 H1: มีความสัมพันธ์ระหว่างระดับการศึกษากับเงินเดือนเริ่มต้นของพนักงาน 

 H2: มีความสัมพันธ์ระหว่างประสบการณ์ก่อนท างานกับเงินเดือนเริ่มต้นของพนักงาน 

 H3: มีความสัมพันธ์ระหว่างเงินเดือนเริ่มต้นกับเงินเดือนปัจจุบันของพนักงาน 

 H4: มีความสัมพันธ์ระหว่างระยะเวลาท างานกับเงินเดือนปัจจุบันของพนักงาน 

 เกณฑ์ในการทดสอบสมมุติฐาน คือ หากการทดสอบความสัมพันธ์ด้วยวิธีของเพียร์สัน ได้ค่า

ความน่าจะเป็น (p-value) มากกว่าค่านัยส าคัญทางสถิติ (α = 0.05) จะปฏิเสธสมมติฐาน H1 , H2 , H3 

และ H4 แต่หากได้ค่าความน่าจะเป็น (p-value) น้อยกว่าหรือเท่ากับค่านัยส าคัญทางสถิติ (α = 0.05) 

จะยอมรับสมมติฐาน H1 , H2 , H3 และ H4 
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5.2.4 การใช้โปรแกรมคอมพิวเตอร์วิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล File -> Open -> Employee data.sav 

๏ เมน ูAnalyze -> Bivariate Correlation… 
o เลือกตัวแปรค่าต่อเนื่อง (continuous variables) 3 ตัวแปร หรือมากกว่า จาก

รายการตัวแปรในช่องด้านซ้ายใส่ในช่องด้านขวา  
o ในกลุ่มค าสั่ง Test of Significance เลือกประเภทการทดสอบนัยส าคัญ  

- Two-tailed (สมมติฐานแบบสองหาง) 

- One-tailed (สมมติฐานแบบหางเดียว) 

o Flag significant correlations (แสดงเครื่องหมาย * หากมีความสัมพันธ์อย่าง
นัยส าคัญทางสถิติ) เลือก /  

o คลิกปุ่ม OK 

 

5.2.5 ผลการวิเคราะห์ 
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5.2.6 การสร้างตารางแสดงผลการทดสอบ 

ตารางที ่(#) แสดงผลการทดสอบความสัมพันธ์ระหว่างระดับการศึกษา ประสบการณ์ก่อนท างาน 

เงินเดือนเริ่มต้น ระยะเวลาท างาน และเงินเดือนปัจจุบัน 

ความสัมพันธ์ระหว่างตัวแปร จ านวน r Sig. (2-tailed) 

ระดับการศึกษา เงินเดือนเริ่มต้น 474 .63 0.000 

ประสบการณ์ก่อนท างาน เงินเดือนเริ่มต้น 474 .05 0.327 

เงินเดือนเริ่มต้น เงินเดือนปัจจุบัน 474 .88 0.000 

ระยะเวลาท างาน เงินเดือนปัจจุบัน 474 .08 0.067 

5.2.7 การแปลผลและสรุป 

จากตารางที่ (#) ผลการทดสอบแสดงให้เห็นว่า ระดับการศึกษากับเงินเดือนเริ่มต้นของพนักงาน 

และเงินเดือนเริ่มต้นและเงินเดือนปัจจุบัน มีค่าความน่าจะเป็น (Sig.) = 0.00 น้อยกว่าค่านัยส าคัญทาง

สถิติที่ก าหนดไว้ (α = 0.05) ส่วนประสบการณ์ก่อนท างานและเงินเดือนเริ่มต้น มีค่านัยส าคัญทางสถิติ  

(Sig.) = 0.327 มากกว่าค่านัยส าคัญทางสถิติที่ก าหนดไว้ (α = 0.05) และระยะเวลาท างานกับเงินเดือน

ปัจจุบัน มีค่านัยส าคัญทางสถิติ (Sig.) = 0.067 มากกว่าค่านัยส าคัญทางสถิติที่ก าหนดไว้ (α = 0.05) จึง

ยอมรับสมมติฐาน H1 และ H3 แต่ปฏิเสธสมมติฐาน H2 และ H4  

สรุป การศึกษาของพนักงานมีความสัมพันธ์เชิงบวกระดับปานกลางกับเงินเดือนเริ่มต้น เงินเดือน

เริ่มต้นของพนักงานมีความสัมพันธ์เชิงบวกระดับปานกลางกับเงินเดือนปัจจุบันของพนักงาน (พนักงานที่

มีระดับการศึกษาสูงจะได้รับเงินเดือนเริ่มต้นสูงกว่าพนักงานที่มีการศึกษาต่ ากว่า และพนักงานที่ได้รับ

เงินเดือนเริ่มต้นสูงจะได้รับเงินเดือนปัจจุบันสูงกว่าพนักงานที่ได้รับเงินเดือนเริ่มต้นต่ ากว่า) 

สรุป 

   การทดสอบแบบอิงค่าพารามิเตอร์มีค่าตัวเลขทางประชากรที่ใช้ในการอ้างอิงไปสู่คุณลักษณะ 

(characteristics) ของประชากร ก่อนใช้การทดสอบแบบอิงค่าพารามิเตอร์ต้องท าการตรวจสอบข้อตกลง

เบื้องต้นของการทดสอบแต่ละวิธี การละเมิดข้อตกลงบางครั้งอาจไม่มีผลต่อข้อสรุปหรือผลการวิเคราะห์

แต่อย่างไร แต่บางครั้งอาจมีผลต่อการแปลความหมายเป็นอย่างมากและอาจท าให้ได้ข้อสรุปที่ไม่ถูกต้อง 
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แบบฝึกหัดท้ายบท 

ให้ผู้เรียนเปิดแฟ้มข้อมูล 1991 US. General Social Survey.sav แล้วประมวลผลข้อมูล เพ่ือ

ทดสอบและแปลผล ดังนี้ 

1. การทดสอบค่าเฉลี่ย 1 กลุ่ม และ 2 กลุ่ม 

   1.1 วิเคราะห์และอธิบายผล โดยการทดสอบเปรียบเทียบว่า กลุ่มตัวอย่างมีพ่ีน้อง (sib) 

มากกว่าหรือน้อยกว่า 4 คน  

   1.2 วิเคราะห์และอธิบายผล โดยการทดสอบเปรียบเทียบว่า กลุ่มตัวอย่างที่อยู่ภาค ( region) 

ตะวันออกกับตะวันตก (สร้างตัวแปรใหม่เป็นตัวแปร region_group) มีพ่ีน้อง (sibs) แตกต่างกันหรือไม่  

   1.3 วิเคราะห์และอธิบายผล โดยการทดสอบเปรียบเทียบว่า การศึกษาของบิดา (paeduc) 

และมารดา (maeduc) แตกต่างกันหรือไม่  

2. การทดสอบค่าเฉลี่ยของกลุ่มตัวอย่างมากกว่า 2 กลุ่ม 

วิเคราะห์เปรียบค่าเฉลี่ย ทดสอบสมมติฐาน และทดสอบเปรียบเทียบค่าเฉลี่ยรายคู่ คะแนน

ความมีเกียรติในอาชีพ (prestg80) ของคนในแต่ละภูมิภาค (region) 

3. สหสัมพันธ์แบบเพียร์สัน 

   3.1 วิเคราะห์และอธิบายผลความสัมพันธ์แบบง่ายระหว่างการศึกษาของผู้ตอบ (edu) และ

จ านวนพี่น้อง (sibs)  

   3.2 วิเคราะห์และอธิบายผลความสัมพันธ์แบบพหุระหว่างการศึกษาของผู้ตอบ (edu) กับ

จ านวนพี่น้อง (sibs) และจ านวนบุตร (childs) 

  



 

 

บทที่ 13 
การทดสอบข้อมูลแบบไม่อิงค่าพารามิเตอร์ (1 ตัวแปร) 

ความมุ่งหมายของบทเรียน 
ผู้เรียนสามารถใช้โปรแกรมประมวลผลทดสอบข้อมูลของตัวแปร 1 ตัวแปร ด้วยสถิติเชิงอ้างอิง

แบบไมอิ่งค่าพารามิเตอร์ และเขียนบรรยายผลการทดสอบได้ 

เนื้อหา 
1. การทดสอบการแจกแจงของตัวอย่าง 

2. การทดสอบสัดส่วนของตัวอย่าง 

กิจกรรมและวธิีสอน 
บรรยาย อธิบาย แสดงตัวอย่าง และท าแบบฝึกหัดท้ายบท 

อุปกรณ์การสอน 
เอกสารค าสอน ภาพเลื่อน คอมพิวเตอร์ โปรแกรม PSPP โปรแกรมสอนออนไลน์ (สอนแบบ

ออนไลน์) และเครื่องฉาย (สอนในชั้นเรียน) 

งานที่มอบหมาย 

 ท าแบบฝึกหัดท้ายบท 

การวัดผลและประเมินผล 

การเข้าชั้นเรียน สังเกตความสนใจจากการเรียน สอบถามความเข้าใจจากการบรรยาย และ

ประเมินจากการท าแบบฝึกหัดท้ายบท  
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เนื้อหา 

การทดสอบข้อมูลด้วยสถิติเชิงอ้างอิงหากข้อมูลมีลักษณะหนึ่งดังต่อไปนี้ คือ มีจ านวนตัวอย่าง

น้อยกว่า 30 ตัวอย่าง หรือเป็นกลุ่มตัวอย่างขนาดเล็ก (small sample size) ข้อมูลมีการแจกแจงไม่ปกติ 

ข้อมูลเป็นมาตราแบบจัดกลุ่มหรือจัดอันดับ ข้อมูลมีค่าผิดปกติ (outlier) ที่ไม่สามารถก าจัดออกไปได้ 

ควรตัดสินใจเลือกการทดสอบแบบไม่อิงค่าพารามิเตอร์ (non-parametric test) หรือการทดสอบแบบ

แจกแจงอิสระ (distribution-free test) การฝืนใช้การทดสอบแบบอิงค่าพารามิเตอร์โดยละเมิดข้อตกลง

เบื้องต้นมีความเสี่ยงท าให้ผลลัพธ์และข้อสรุปที่ไม่ถูกต้องตามมา 

การทดสอบข้อมูลแบบไม่อิงพารามิเตอร์ สมมติฐานไม่มีความเกี่ยวข้องกับค่าพารามิเตอร์ของ

ประชากร (population parameters) เช่น สมมติฐานหลัก μ=50 เป็นการเปรียบเทียบข้อมูลของ

ตัวอย่างที่ได้มาจากประชากรกับค่าอ้างอิงที่ใช้ในการทดสอบว่าเท่ากันหรือไม่เท่ากัน หรือ μ1=μ2 เป็น

การเปรียบเทียบต าแหน่งของข้อมูลระหว่าง 2 กลุ่มตัวอย่างมีแนวโน้มเข้าสู่ส่วนกลาง (central 

tendency) เหมือนกันหรือแตกต่างกัน 

แม้ว่าการทดสอบด้วยสถิติแบบไม่อิงค่าพารามิเตอร์จะเป็นอิสระจากข้อตกลง (assumption-

free test) แต่มีข้อตกลงทั่วไป (common assumptions) ดังนี้ (Verma, & Abdel-Salam, 2019: 141-

142) 

1. ความเป็นสุ่มหรือความไม่เป็นแบบแผน (Randomness) คือ กลุ่มตัวอย่างได้มาจากประชากร

แบบสุ่ม (random sampling) หรือเลือกแบบปราศจากความล าเอียง (bias)   

2. ความเป็นอิสระ ( Independence) คือ ค่าสั ง เกตแต่ละค่ามีความเป็นอิสระจากกัน 
(independence of observations) หรือค่าสังเกตได้มาจากแต่ละตัวอย่างที่มีความเป็นอิสระจากกัน ไม่
ได้มาจากบุคคลที่เป็นคนเดียวกัน (independent sample) 

การทดสอบแบบอิงค่าพารามิเตอร์มีวิธีการทดสอบข้อมูล 1 ตัวแปร คือ การทดสอบค่าเฉลี่ยของ

กลุ่มตัวอย่าง 1 กลุ่ม (One-sample t-test) ใช้ส าหรับทดสอบกับค่าทดสอบ (value test) ที่เป็นค่าเฉลี่ย

จากประชากรที่ทราบจ านวน (know populations) ส่วนการทดสอบแบบไม่อิงค่าพารามิเตอร์มีการ

ทดสอบข้อมูล 1 ตัวแปรเช่นกัน แต่เป็นการทดสอบการแจกแจงของข้อมูล (มีการแจกแจงปกติหรือไม่ มี
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การแจกแจงเป็นไปอย่างสุ่มหรือไม่) และการทดสอบสัดส่วน (เปรียบเทียบสัดส่วนระหว่างกลุ่มตัวอย่าง 

เช่น กลุ่มตัวอย่างมีสัดส่วนระหว่างเพศชายกับเพศหญิงเช่นเดียวกับสัดส่วนประชากรของประเทศหรือไม่)  

1. การทดสอบการแจกแจงของข้อมูล 

 การทดสอบการแจกแจงข้อมูล (Distribution Tests)  คือ การทดสอบลักษณะข้อมูลของกลุ่ม

ตัวอย่างที่ได้มาจากประชากรมีการแจกแจงปกติ (normal distributions) หรือไม่ และมีการแจกเป็นไป

อย่างสุ่ม (randomness) หรือไม ่ 

1.1 การทดสอบการแจกแจงของข้อมูลแบบรันส์  

 การทดสอบการแจกแจงข้อมูลแบบรันส์ (Runs test/ Wald–Wolfowitz runs test) คือ การ

ทดสอบข้อมูลภายในกลุ่ม (one group) และระหว่างกลุ่ม (two group) ของกลุ่มตัวอย่างที่มีลักษณะ

การจัดเรียง (sequence) มีการแจกแจงเป็นไปอย่างสุ่มหรือไม่ (randomness) โดยใช้ค่ามัธยฐาน 

(median) ค่าฐานนิยม (mode) ค่าเฉลี่ย (mean) และค่าท่ีผู้ทดสอบก าหนดเอง (custom) 

ตัวอย่างค าถามการวิจัย 

จากการส ารวจข้อมูลของพนักงานในหน่วยงานต้องการทราบว่า ระดับการศึกษาของพนักงาน

มีการแจกแจกแบบสุ่มหรือไม่ 

1.1.1 ข้อตกลงเบื้องต้น 

ขั้นตอน ข้อตกลง 

การออกแบบการวิจัย 1. ข้อมูลได้มาจากการสุ่มตัวอย่างแบบสุ่ม (random sampling) และเป็นอิสระ

จากกัน (independent sample) 

 2. ข้อมูลเป็นตัวแปรแบบสองประเภท (dichotomous variables)  

การวิเคราะห์ข้อมูล ข้อมูลประเภทตัวอักษร (string data) ต้องแปลงค่า (recode) ให้เป็นข้อมูล

ประเภทตัวเลข (numeric data) 
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1.1.2 ตัวแปรและวิธีการทดสอบ 

ตัวแปร 

-> 

การทดสอบ 

ค่าต่อเนื่อง การแจกแจงข้อมูล 

การศึกษา: ปี (educ) แจกแจงแบบสุ่ม 

1.1.3 การก าหนดสมมติฐานและเกณฑ์การทดสอบ 

จากข้อมูลที่ท าการส ารวจจากพนักงานในหน่วยงาน ผู้วิจัยต้องการทราบว่า ข้อมูลการศึกษาของ
พนักงานมีการแจกแจงแบบสุ่มหรือไม่ โดยมีสมมติฐานดังนี้ 

 H0: ข้อมูลการศึกษาของพนักงานมีการแจกแจงแบบสุ่ม 

H1: ข้อมูลการศึกษาของพนักงานมีการแจกแจงแบบไม่สุ่ม 

เกณฑ์ในการทดสอบสมมุติฐาน คือ หากการทดสอบการแจกแจงข้อมูลแบบรันส์ (Runs Test) 

ได้ค่าความน่าจะเป็น (p-value) มากกว่าค่านัยส าคัญทางสถิติ (α = 0.05) จะยอมรับสมมติฐาน H0 แต่

หากได้ค่าความน่าจะเป็น (p-value) น้อยกว่าหรือเท่ากับค่านัยส าคัญทางสถิติ (α = 0.05) จะปฏิเสธ

สมมติฐาน H0 และยอมรับสมมติฐาน H1 

1.1.4 การใช้โปรแกรมคอมพิวเตอร์วิเคราะห์ข้อมูล 

๏ เปิดเมนู File -> Open -> Employee data.sav 
๏ เลือกเมน ูAnalyze -> Non-Parametric Statistics -> Runs … 

o Test Variable List: เลือกตัวแปรทดสอบที่เป็นตัวแปรแบบค่าจัดประเภทหรือตัวแปร
แบบค่าต่อเนื่อง 1 ตัวแปร จากรายการตัวแปรด้านซ้าย  

o Cut Point: ก าหนดกลุ่มวิธีการแบ่งกลุ่มในกลุ่มค าสั่ง  
o กดปุ่ม OK 
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1.1.5 ผลการวิเคราะห์ 

 

1.1.6 การสร้างตารางแสดงผลการทดสอบ 

ตารางผลการทดสอบรันส์แบบฐานนิยม (Mode) 

 ระดับการศึกษา (ปี) 

ค่าทดสอบ (Test Value) 12 

จ านวนตัวอย่างที่มีค่าน้อยกว่าค่าทดสอบ (Cases < Test Value) 53 

จ านวนตัวอย่างที่มีค่ามากกว่าหรือเท่ากับค่าทดสอบ (Cases >= Test Value) 421 

จ านวนตัวอย่างทั้งหมด (Total Cases) 474 

จ านวนของรันส์ (Number of Runs) 97 

Z .430 

Asymp. Sig. (2-tailed) .667 

1.1.7 การแปลผลและสรุป 

 จากตารางที่ (#) ผลการทดสอบแสดงให้เห็นว่า ค่าความน่าจะเป็น (Asymp. Sig.) = .667 มีค่า

มากกว่าค่านัยส าคัญทางสถิติท่ีก าหนดไว้ (α = 0.05) จึงยอมรับสมมติฐาน H0  

สรุป ข้อมูลการศึกษาของพนักงานมีการแจกแจงเป็นไปอย่างสุ่ม การทดสอบการแจกแจงข้อมูล

ความเป็นสุ่มของข้อมูลตัวแปรการศึกษาของพนักงานมีค่าทดสอบ (ระดับการศึกษา) ที่ 12 ปี แสดงว่า 

จ านวนตัวอย่างที่มีค่าน้อยกว่าค่าทดสอบมีจ านวน 53 คน จ านวนตัวอย่างที่มีค่ามากกว่าหรือเท่ากับค่า

ทดสอบมีจ านวน 421 คน ระดับการศึกษาที่อยู่ตรงกลางของผู้ตอบแบบสอบถามหรือมีค่าฐานนิยม 

(mode) 12 ปี และจากค่าการทดสอบแสดงให้เห็นว่า ผู้ตอบแบบสอบถามมีการศึกษาต่ ากว่า 12 ปี 

จ านวน 53 คน และมีการศึกษาเท่ากับและมากกว่า 12 ปี มีจ านวน 421 คน  
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1.2 การทดสอบการแจกแจงของข้อมูลแบบคอลมอโกรอฟ-สเมอร์นอฟ  

 การทดสอบการแจกแจงข้อมูลแบบคอลมอโกรอฟ-สเมอร์นอฟ (Kolmogorov-Smirnov: K-S 

Test) คือ การทดสอบการแจกแจงข้อมูลแบบสะสม (cumulative distributions) ระหว่างข้อมูลที่ได้

จากการสังเกต (observed) กับการแจกแจงเชิงทฤษฎี (theoretical) ซึ่งอาจเป็นการแจกแจงแบบปกติ 

(normal/gaussian distribution)19 การแจกแจงแบบเอกรูปหรือสม่ า เสมอหรือสี่ เหลี่ยมผืนผ้า 

(uniform/rectangular distribution)20 การแจกแจงแบบปัวซอง (poisson distribution)21 การแจก

แจงแบบเอ็กโปเนนเชียลหรือแบบเลขชี้ก าลัง (exponential distribution)22 

  
 

 

การแจกแจงแบบปกติ การแจกแจงแบบเอกรูป การแจกแจงแบบปัวซอง การแจกแจงแบบเลขยกก าลัง 

รูปที่ 13.1 การแจกแจงความถี่ 

ตัวอย่างค าถามการวิจัย 

จากการส ารวจข้อมูลของพนักงานในหน่วยงานต้องการทราบว่า เงินเดือนเริ่มต้นของพนักงาน

ในหน่วยงานมีการแจกแจกแบบปกติหรือไม่ 

                                                           
19 การแจกแจงของข้อมูลจากเหตุการณ์ท่ีเกิดซ้ าๆกัน 
20 การแจกแจงของข้อมูลจากเหตุการณ์ท่ีเกิดขึ้นเหมือนๆกัน หรือแต่ละเหตุการณ์มีช่วงเท่ากัน เช่น จ านวนสมาชิกเฉลี่ยของแต่ละครอบครัว หรือ
จ านวนน้ าหนักเฉลี่ยที่เพิ่มขึ้นของแต่ละคนในฤดูหนาว (ประมาณ 0-30 ปอนด์) 
21 การแจกแจงของข้อมูลจากหลายเหตุการณ์และไม่ต่อเน่ืองกันหรือเป็นอิสระจากกัน เช่น จ านวนรถยนต์ที่ผ่านด่านแต่ละนาที 
22 การแจกแจงของข้อมูลจากเหตุการณ์ท่ีเกิดขึ้นแบบสะสมตั้งแต่เริ่มต้นจนถึงเกิดเหตุการณ์ เช่น จ านวนเงินที่เก็บสะสม ระยะเวลาการเกิด
แผ่นดินไหม 
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1.2.1 ข้อตกลงเบื้องต้น 

ขั้นตอน ข้อตกลง 

การออกแบบการวิจัย 1. ข้อมูลได้มาจากการสุ่มตัวอย่างแบบสุ่ม (random sampling) และเป็นอิสระ

จากกัน (independent sample) 

 2. ข้อมูลเป็นตัวแปรแบบค่าต่อเนื่อง (continuous variable) หรือตัวแปรแบบ

มาตราจัดอันดับ (ordinal variable) บางต าราบอกว่า ตัวแปรมาตราแบบจัด

กลุ่ม (nominal variable) 

การวิเคราะห์ข้อมูล - 

1.2.2 ตัวแปรและวิธีการทดสอบ 

ตัวแปร 

-> 

การทดสอบ 

ค่าต่อเนื่อง การแจกแจงของข้อมูล 

เงินเดือนเริ่มต้น: ดอลลาร์ (salbegin) แจกแจงแบบปกติ 

1.2.3 การก าหนดสมมติฐานและเกณฑ์การทดสอบ 

จากข้อมูลที่ท าการส ารวจจากพนักงานในหน่วยงาน ผู้วิจัยต้องการทราบว่า ข้อมูลเงินเดือน

เริ่มต้นของพนักงานมีการแจกแจกปกติหรือไม่ โดยมีสมมติฐานดังนี้ 

 H0: ข้อมูลเงินเดือนเริ่มต้นของพนักงานมีการแจกแจงปกติ 

 H1: ข้อมูลเงินเดือนเริ่มต้นของพนักงานมีการแจกแจงไม่ปกติ 

 เกณฑ์ในการทดสอบสมมุติฐาน คือ หากการทดสอบการแจกแจงของข้อมูลแบบคอลมอโกรอฟ-

สเมอร์นอฟ  (Kolmogorov-Smirnov Test: K-S Test) ได้ค่าความน่าจะเป็น (p-value) มากกว่าค่า

นัยส าคัญทางสถิติ (α = 0.05) จะยอมรับสมมติฐาน H0 แต่หากได้ค่าความน่าจะเป็น (p-value) น้อย

กว่าหรือเท่ากับค่านัยส าคัญทางสถิติ (α = 0.05) จะปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 
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1.2.4 การใช้โปรแกรมคอมพิวเตอร์วิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล File -> Open -> Employee data.sav 
๏ เลือกเมนู Analyze -> Non-Parametric Statistics -> 1-Sample K-S… 

o Test Variable List: เลือกตัวแปรทดสอบที่เป็นตัวแปรแบบค่าต่อเนื่อง 1 ตัวแปร หรือ
หลายตัวแปร จากรายการตัวแปรด้านซ้าย  

o ในกลุ่มค าสั่ง Test Distribution เลือกสถิต ิNormal 
o กดปุ่ม OK 

 

1.2.5 ผลการวิเคราะห์ 
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1.2.6 การสร้างตารางแสดงผลการทดสอบ 

ตารางที ่(#) แสดงผลการทดสอบข้อมูล 1 กลุ่ม แบบคอลมอโกรอฟ-สเมอร์นอฟ 

  เงินเดือนเริ่มต้น (ดอลลาร์) 

จ านวน (N)  474 

ค่าพารามิเตอร์การทดสอบการแจกแจง

ปกติ (Normal Parameters) 

ค่าเฉลี่ย (Mean) 

ค่าเบี่ยงเบนมาตรฐาน  

(Std. Deviation) 

17,016.09 

7,870.64 

 

ความแตกต่างของค่าโต่งมากที่สุด  

(Most Extreme Differences) 

ค่าสัมบูรณ์ (Absolute) 

ค่าบวก (Positive) 

ค่าลบ (Negative) 

.25 

.25 

-.170 

Kolmogorov-Smirnov Z  5.48 

Asymp. Sig. (2-tailed)  .000 

1.2.7 การแปลผลและสรุป 

 จากตารางที่ (#) ผลการทดสอบแสดงให้เห็นว่า ค่าความน่าจะเป็น (Asymp. Sig.) = 0.000 มีค่า

น้อยกว่าค่านัยส าคัญทางสถิติท่ีก าหนดไว้ (α = 0.05) จึงปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน Ha  

สรุป ข้อมูลเงินเดือนเริ่มต้นของพนักงานมีการแจกแจงไม่ปกต ิ
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2. การทดสอบสดัส่วนของกลุ่มตัวอย่าง 

 การทดสอบสัดส่วนของกลุ่มตัวอย่าง  (Sample Proportion Test) คือ การทดสอบสัดส่วนของ

ข้อมูลจากตัวอย่างกับสัดส่วนที่แท้จริงของประชากรทั้งหมดหรือค่าอ้างอิง สมมติฐานในการทดสอบอาจ

ระบุเป็นสัดส่วน (proportions) แตกต่าง (difference) อัตราส่วน (ratio) หรืออัตราส่วนที่จะเกิด (odds 

ratio) 

2.1 การทดสอบความแนบสนิทแบบไคสแควร ์

 การทดสอบความแนบสนิทแบบไคสแควร์ (X2 goodness of fit) คือ การทดสอบสัดส่วนของ

กลุ่มตัวอย่าง 2 กลุ่ม หรือมากกว่า 2 กลุ่ม ที่ได้จากการสังเกต (observed value) กับค่าที่คาดหวัง 

(expected value) หรือค่าตามทฤษฎี  

ตัวอย่างของข้อมูล เช่น ต าแหน่งงาน มีค าตอบคือ เจ้าหน้าที่ปฏิบัติงาน หัวหน้างาน และ

ผู้จัดการ ตัวแปรการศึกษา มีค าตอบคือ ประถมศึกษา มัธยมศึกษา และอุดมศึกษา ตัวแปรศาสนา มี

ค าตอบคือ พุทธ คริสต์ และอิสลาม เป็นต้น 

ตัวอย่างค าถามการวิจัย 

จากข้อมูลการส ารวจพนักงานในหน่วยงานต้องการทราบว่า พนักงานของหน่วยงานมีสัดส่วน

ของต าแหน่งงานเท่ากันหรือไม่ 

2.1.1 ข้อตกลงเบื้องต้น 

ขั้นตอน ข้อตกลง 

การออกแบบการวิจัย 1. ข้อมูลได้มาจากการสุ่มตัวอย่างแบบสุ่ม (random sampling) และเป็นอิสระ

จากกัน (independent sample) 

 2. มีค่าสังเกตอย่างน้อย 5 ตัวอย่าง ในแต่ละระดับของตัวแปร (level of the 

variable) 

 3. ตัวแปรเป็นตัวแปรแบบค่าจัดประเภท (categorical variables) 1 ตัวแปร  

การวิเคราะห์ข้อมูล - 
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2.1.2 ตัวแปรและวิธีการทดสอบ 

ตัวแปร 

-> 

การทดสอบ 

ค่าจัดประเภท สัดส่วน 

ต าแหน่งงงาน (Jobcat) 

- เจ้าหน้าที่ปฏิบัติงาน 

- หัวหน้างาน 

- ผู้จัดการ 

เท่ากัน (Equal) หรือ 

ไม่เท่ากัน (Unequal) 

2.1.3 การก าหนดสมมติฐานและเกณฑ์การทดสอบ 

จากตารางที่ (#) ผลการศึกษาพบว่า กลุ่มตัวอย่างมีต าแหน่งงานเป็นเจ้าหน้าที่ปฏิบัติงานมาก

ที่สุด คือ ร้อยละ 76.6 รองลงมามีต าแหน่งงานเป็นผู้จัดการ คือ ร้อยละ 17.7 และมีต าแหน่งงานเป็น

หัวหน้างานน้อยที่สุด คือ ร้อยละ 5.7 ดังตารางที่ (#) 

ตารางที ่(#) แสดงจ านวนและค่าร้อยละของกลุ่มตัวอย่าง จ าแนกตามต าแหน่งงาน 

ต าแหน่งงาน จ านวน ร้อยละ 

เจ้าหน้าที่ปฏิบัติงาน 363 76.6 

หัวหน้างาน 27 5.7 

ผู้จัดการ 84 17.7 

รวม 474 100.0 

 จากตารางที่ (#) แสดงให้เห็นว่า กลุ่มตัวอย่างมีต าแหน่งเป็นเจ้าหน้าที่ปฏิบัติงานมากที่สุด 

รองลงมาเป็นผู้จัดการ และเป็นหัวหน้างานน้อยที่สุด ดังนั้นจึงท าการทดสอบว่า พนักงานแต่ละต าแหน่งมี

สัดส่วนเท่ากันหรือไม่ โดยมีสมมติฐานดังนี้ 

 H0: สัดสว่นของต าแหน่งงานเท่ากัน  หรือ Σ(O - E)2 = 0 

 H1: สัดสว่นของต าแหน่งงานไม่เท่ากัน หรือ Σ(O - E)2 ≠ 0 

เกณฑ์ในการทดสอบสมมุติฐาน คือ หากการทดสอบสัดส่วนของข้อมูลด้วยวิธีไคสแควร์ (X2 Test) 

ได้ค่าความน่าจะเป็น (p-value) มากกว่าค่านัยส าคัญทางสถิติ (α = 0.05) จะยอมรับสมมติฐาน H0 แต่
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หากได้ค่าความน่าจะเป็น (p-value) น้อยกว่าหรือเท่ากับค่านัยส าคัญทางสถิติ (α = 0.05) จะปฏิเสธ

สมมติฐาน H0 และยอมรับสมมติฐาน H1 

2.1.4 การใช้โปรแกรมวิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล File -> Open -> Employee Data.sav 
๏ เลือกเมน ูAnalyze -> Non-Parametric Statistics -> Chi-square… 

o Test Variable: เลือกตัวแปรทดสอบที่เป็นตัวแปรแบบจัดประเภท 1 ตัวแปร หรือหลาย
ตัวแปร จากรายการตัวแปรด้านซ้าย  

o ในกลุ่มค าสั่ง Expected Range ก าหนดค่าตัวแปรหรือกลุ่มข้อมูล  
- Get from data (ทัง้หมดจากข้อมูล) 

- Use specified range (ก าหนดช่วงข้อมูลกรณีเป็นตัวแปรแบบค่าต่อเนื่อง) 

o ในกลุ่มค าสั่ง Expected Values ก าหนดสัดส่วน  
- All categories equal (ทุกกลุ่มเท่ากัน) 

- Values: (ก าหนดสัดส่วนในช่องว่างและเพ่ิมจ านวนให้สัมพันธ์กับกลุ่มของตัวแปร เช่น มี 

2 กลุ่ม ก าหนดเป็น 2 ค่า มี 3 กลุ่ม ก าหนดเป็น 3 ค่า) 

o กดปุ่ม OK 

หมายเหตุ ค่าคาดหวัง (Expected frequencies) มาจากข้อมูลในอดีต ความรู้ที่มีอยู่  ทฤษฎี หรืองานวิจัย  
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2.1.5 ผลการวิเคราะห์ 

 

2.1.6 การสร้างตารางแสดงผลการทดสอบ 

ตารางที่ (#) แสดงผลการทดสอบเปรียบเทียบสัดส่วนระหว่างค่าสังเกตและค่าคาดหวังของต าแหน่งงาน 

ต าแหน่งงาน 
ค่าสังเกต 

(Observed N) 

ค่าคาดหวัง 

(Expected N) 

ส่วนเหลือ 

(Residual) 

สถิติทดสอบ 

(Test Statistics) 

เจ้าหน้าที่ปฏิบัติงาน 363 158.0 205.0 X2 = 409.25 

หัวหน้างาน 27 158.0 -131.0 df = 2 

ผู้จัดการ 84 158.0 -74.0 Asymp. Sig. = .000 

รวม 474    

2.1.7 การแปลผลและสรุป 

จากตารางที่ (#) ผลการทดสอบแสดงให้เห็นว่า ค่าความน่าจะเป็น (Asymp. Sig.) = 0.00 น้อย

กว่าค่านัยส าคัญทางสถิติท่ีก าหนดไว้ (α = 0.05) จึงปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1  

สรุป ต าแหน่งงานของพนักงานมีสัดส่วนไม่เท่ากัน 
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2.2 การทดสอบสดัส่วนของกลุ่มตวัอย่างแบบทวินาม  

 การทดสอบสัดส่วนของกลุ่มตัวอย่าง (Sample Proportion Test) แบบทวินาม (Binomial 

Test) คือ การทดสอบสัดส่วนของข้อมูลที่ได้จากการสังเกต (observed value) ของตัวแปรแบบค่าจัด

ประเภท 2 ประเภท (dichotomous variables) หรือตัวแปรแบบค่าทวิลักษณะ (binary variables) กับ

ค่าพารามิเตอร์ที่ เป็นค่าสัดส่วนที่คาดหวัง (expected value) หรือค่าสัดส่วนที่ใช้ทดสอบ ( test 

proportion)   

ตัวอย่างค าถามการวิจัย 

จากการส ารวจข้อมูลของพนักงานในหน่วยงานต้องการทราบว่า พนักงานมีสัดส่วนระหว่าง

เพศชายกับเพศหญิงคล้องกับสัดส่วนประชากรของประเทศหรือไม่ (ชาย:หญิง = 49:51) 

2.2.1 ข้อตกลงเบื้องต้น 

ขั้นตอน ข้อตกลง 

การออกแบบการวิจัย 1. ข้อมูลได้มาจากการสุ่มตัวอย่างแบบสุ่ม (random sampling) และเป็นอิสระ

จากกัน (independent sample) 

 2. ตัวแปรเป็นตัวแปรแบบค่าสองประเภท (dichotomous variables) 

การวิเคราะห์ข้อมูล - 

2.2.2 ตัวแปรและวิธีการทดสอบ 

ตัวแปร 

-> 

การทดสอบ 

ค่าจัดประเภท สัดส่วน 

เพศ (gender) 

- ชาย 

- หญิง 

ชาย:หญิง = 49:51 
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2.2.3 การก าหนดสมมติฐานและเกณฑ์การทดสอบ 

จากผลศึกษาพบว่า กลุ่มตัวอย่างส่วนใหญ่เป็นพนักงานเพศชาย มีจ านวนร้อยละ 54.43  

มากกว่าพนักงานเพศหญิง ที่มีจ านวนร้อยละ 45.57 ดังตารางที ่(#)  

ตารางที ่(#) แสดงจ านวนและร้อยละของพนักงาน จ าแนกตามเพศ 

เพศ จ านวน ร้อยละ 

หญิง 216 45.57 

ชาย 258 54.43 

รวม 474 100.0 

 จากตารางที ่(#) แสดงให้เห็นว่า กลุ่มตัวอย่างเป็นพนักงานเพศชายมากกว่าเพศหญิง ดังนั้นจึง

ท าการทดสอบว่า พนักงานเพศชายมีสัดส่วนเท่ากับพนักงานเพศหญิงหรือไม่ โดยมีสมมติฐานดังนี้ 

 H0: สัดสว่นของพนักงานเพศชายกับเพศหญิงเท่ากับ 49:51 (P1=0.49) 

H1: สัดสว่นของพนักงานเพศชายกับเพศหญิงไม่เท่ากับ 49:51 (P≠0.49) 

เกณฑ์ในการทดสอบสมมุติฐาน คือ หากทดสอบสัดส่วนของข้อมูลแบบทวินาม (Binomial 

Test)ได้ค่าความน่าจะเป็น (p-value) มากกว่าค่านัยส าคัญทางสถิติ (α = 0.05) จะยอมรับสมมติฐาน 

H0 แต่หากได้ค่าความน่าจะเป็น (p-value) น้อยกว่าหรือเท่ากับค่านัยส าคัญทางสถิติ (α = 0.05) จะ

ปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 
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2.2.4 การใช้โปรแกรมคอมพิวเตอร์วิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล File -> Open -> Employee data.sav  
o สร้างตัวแปร gender_new โดยใช้ค าสั่ง Recode into Different Variables จากตัว

แปร gender ก าหนดให้ค่า m = 1 และ f = 2  
o ก าหนดค่าตัวแปร 1 = Male และ 2 = Female 

  
 

๏ เลือกเมน ูAnalyze -> Non-Parametric Statistics -> Binomial … 
o Test Variable List: เลือกตัวแปรทดสอบที่เป็นตัวแปรแบบค่าจัดประเภทหรือตัวแปร

แบบค่าต่อเนื่อง 1 ตัวแปร จากรายการตัวแปรด้านซ้าย  
o ในกลุ่มค าสั่ง Define Dichotomy ก าหนดกลุ่มข้อมูล 

- Get from data (เฉพาะตัวแปรที่มีค่า 2 กลุ่ม) 

- Cut point (ใส่ค่าแบ่งข้อมูลของตัวแปรให้เป็น 2 กลุ่ม)  

o Test Proportion: ก าหนดสัดส่วนในการทดสอบ  
o กดปุ่ม OK 
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2.2.5 ผลการวิเคราะห์ 

 

2.2.6 การสร้างตารางแสดงผลการทดสอบ 

ตาราง (#) แสดงการทดสอบสัดส่วนเพศของพนักงาน 

เพศ 
จ านวน  

(N) 

สัดส่วนค่าสังเกต 

(Observed Prop.) 

สัดส่วนการทดสอบ 

(Test Prop.) 
Exact Sig. 

ชาย 258 .54 

.49 .01 หญิง 216 .46 

รวม 474 1.00 

2.2.7 การแปลผลและสรุป 

 จากตารางที่ (#) ผลการทดสอบแสดงให้เห็นว่า ค่าความน่าจะเป็น (Exact Sig.) = 0.01 น้อย

กว่าค่านัยส าคัญทางสถิติท่ีก าหนดไว้ (α = 0.05) จึงปฏิเสธรับสมมติฐาน H0 และยอมรับสมมติฐาน H1 

 สรุป สัดส่วนของพนักงานเพศชายเท่ากับพนักงานเพศหญิงไม่เท่ากับ 49:51 

สรุป 
 การทดสอบข้อมูล 1 ตัวแปร คือ การใช้ค่าของตัวแปรหรือข้อมูลภายในตัวแปรเดียวที่เป็นข้อมูล

จริงที่ได้จากการส ารวจหรือเป็นข้อมูลที่มีอยู่ (observed value) แล้วมาท าการทดสอบค่าที่คาดหวัง 

(expected value) ซึ่งอาจเป็นข้อมูลในอดีต ความรู้ที่มีอยู่ ทฤษฎี หรืองานวิจัย  

แบบฝึกหัดท้ายบท 

ให้ผู้เรียนเปิดแฟ้มข้อมูล 1991 US. General Social Survey.sav แล้วประมวลผลข้อมูล เพ่ือ

ทดสอบและแปลผล ดังนี้ 
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1. เปรียบเทียบกลุ่มตัวย่างแต่ละภูมิภาค (region) มีสัดส่วนที่เท่ากันหรือไม่ 

2. ใช้ตัวแปรกลุ่มชน (race) สร้างเป็นตัวแปรใหม่ชื่อ กลุ่มชนใหม่ (newrace) มี 2 กลุ่ม คือ ผิวขาว 

และไม่ใช่ผิวขาว และเปรียบเทียบว่ากลุ่มชนผิวขาวมีสัดส่วนเท่ากับ 0.72 ของกลุ่มตัวอย่างทั้งหมดหรือไม่ 

3. ทดสอบข้อมูลการศึกษาของผู้ตอบ (educ) มีการแจกแจงเป็นไปอย่างสุ่มหรือไม่ 

4. ทดสอบข้อมูลการศึกษาของผู้ตอบ (educ) มีการแจกแจงปกติหรือไม่ 



 

 

บทที่ 14 

การทดสอบข้อมูลแบบไม่อิงค่าพารามิเตอร์ (2 ตัวแปร) 

ความมุ่งหมายของบทเรียน 
ผู้เรียนสามารถใช้โปรแกรมประมวลผลทดสอบข้อมูลของตัวแปร 2 ตัวแปร ด้วยสถิติเชิงอ้างอิง

แบบไมอิ่งค่าพารามิเตอร์ และเขียนบรรยายผลการทดสอบได้ 

เนื้อหา 
1. การทดสอบความเป็นอิสระของกลุ่มตัวอย่าง 

2. การทดสอบค่ากลางของกลุ่มตัวอย่างที่เป็นอิสระจากกัน 2 กลุ่ม 

3. การทดสอบค่ากลางของกลุ่มตัวอย่างที่เป็นอิสระจากกันมากกว่า 2 กลุ่ม 

4. การทดสอบค่ากลางของกลุ่มตัวอย่างที่ไม่เป็นอิสระจากกัน 2 กลุ่ม 

5. การทดสอบค่ากลางของกลุ่มตัวอย่างที่ไม่เป็นอิสระจากกันมากกว่า 2 กลุ่ม 

6. การทดสอบความสัมพันธ์รายคู่แบบสเปียร์แมน 

กิจกรรมและวธิีสอน 
บรรยาย อธิบาย แสดงตัวอย่าง และท าแบบฝึกหัดท้ายบท 

อุปกรณ์การสอน 
เอกสารค าสอน ภาพเลื่อน คอมพิวเตอร์ โปรแกรม PSPP โปรแกรมสอนออนไลน์ (สอนแบบ

ออนไลน์) และเครื่องฉาย (สอนในชั้นเรียน) 

งานที่มอบหมาย 

 ท าแบบฝึกหัดท้ายบท 

การวัดผลและประเมินผล 

การเข้าชั้นเรียน สังเกตความสนใจจากการเรียน สอบถามความเข้าใจจากการบรรยาย และ

ประเมินจากการท าแบบฝึกหัดท้ายบท  
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เนื้อหา 

การวิเคราะห์ความสัมพันธ์ระหว่างตัวแปรอิสระกับตัวแปรตามหากมีตัวแปรใดตัวแปรหนึ่งเป็น

ตัวแปรแบบค่าแบ่งกลุ่มต้องเลือกใช้การทดสอบแบบไม่อิงค่าพารามิเตอร์ตามลักษณะของตัวแปร

ดังต่อไปนี้   

1. การทดสอบความเปน็อิสระของกลุ่มตัวอย่าง  

 การทดสอบความเป็นอิสระของกลุ่มตัวอย่าง (Test of Independence) คือ การทดสอบความ
แนบสนิท (goodness-of-fit test) โดยใช้ตารางไขว้ (contingency table) ท าการทดสอบค่าที่ได้จาก
การสังเกต (observed values) กับค่าที่คาดหวัง (expected values) หรือค่าที่ควรจะเป็นตามทฤษฎี 
เพ่ือตัดสินใจว่า ค่าสังเกตแต่ละค่ามีความเป็นอิสระจากกันหรือไม่เป็นอิสระจากกัน 

 การทดสอบความเป็นอิสระของกลุ่มตัวอย่างเป็นการทดสอบความสัมพันธ์ (related) ระหว่างตัว
แปรที่มีระดับการวัดแบบจัดประเภท 2 ตัวแปร เพ่ือดูว่าตัวแปร 2 ตัว มีความสัมพันธ์กันหรือมีความเป็น
อิสระจากกันหรือไม่ มีหลายวิธีดังนี้ 

1. ไคสแควร์ (Chi-square หรือ X2) ใช้วิเคราะห์ตารางข้อมูลที่ตัวแปรอิสระมีค่าเป็นข้อมูล 2 
กลุ่ม และตัวแปรตามมีค่าเป็นข้อมูล 2 กลุ่ม หรือที่เรียกว่า ตาราง 2x2 มีสถิติทดสอบดังนี้  

   1.1 ไคสแควร์แบบเพียร์สัน (Pearson chi-square) 
   1.2 ไคสแควร์แบบความเป็นไปได้หรือความน่าจะเป็นของอัตราส่วน (The likelihood-ratio 

chi-square)     
   1.3 ความเที่ยง/แม่นย าของฟิชเชอร์ (Fisher's exact test) 
   1.4 ไคสแควร์แบบแก้ไขของเยตส์ (Yates' corrected chi-square) 
2. สหสัมพันธ์ (Correlations) ใช้วิเคราะห์ตารางข้อมูลที่ตัวแปรอิสระมีค่าเป็นข้อมูลจัดอันดับ 

(อันดับมาตรา) และตัวแปรอิสระมีค่าเป็นข้อมูลแบบจัดอันดับ (มาตราแบบจัดอันดับ) มีสถิติทดสอบดังนี้ 
   2.1 สัมประสิทธิ์สหสัมพันธ์ของสเปียร์แมน (Spearman's correlation coefficient)  
   2.2 โรท์ (rho) เฉพาะข้อมูลที่เป็นตัวเลข (numeric data only) 
3. ข้อมูลแบบจัดกลุ่ม (Nominal) ใช้วิเคราะห์ข้อมูลจัดกลุ่ม (nominal data) มีสถิติทดสอบ

ดังนี้ 
   3.1 สัมประสิทธิ์ของสถานการณ์ที่สอดคล้องกัน (Contingency coefficient) 
   3.2 ฟีและแครมเมอร์ วี (Phi and Cramer’s V) 
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   3.3 แลมดา (Lambda) 
   3.4 สัมประสิทธิ์ความไม่แน่นอน (Uncertainty coefficient) 
4. ข้อมูลแบบจัดอันดับ (Ordinal) ใช้วิเคราะห์ข้อมูลที่ตัวแปรอิสระและตัวแปรตามเป็นมีค่าจัด

อันดับ (ordinal value) มีสถิติทดสอบดังนี้ 
   4.1 แกรมมา (Gamma) ลบคู่ที่ไม่สอดคล้องกันออกและนับเฉพาะคู่ท่ีสอดคล้องกันในตารางไขว้ 
   4.2 เดลต้าของโสเมอร์ส (Somers’ d) 
   4.3 สัมประสิทธิ์สหสัมพันธ์ของเคนดอล์ล (Kendall's coefficient) ค านวณเหมือนแกรมมา 

แต่มีการแบ่งส่วน (denominator) ที่ซับซ้อนกว่า และให้ค่าสถิติที่ต่ ากว่าค่าแกรมมา 
        - แบบทาว-บี (Kendall’s tau-b) ตารางแบบ 2x2 (square table) 
        - แบบทาว-ซี (Kendall’s tau-c) ตารางแบบ NxN (rectangular tables) 
5. ข้อมูลแบบจัดกลุ่มกับข้อมูลแบบช่วง (Nominal by Interval) ใช้วิเคราะห์ข้อมูลเมื่อตัวแปร

หนึ่ งเป็นตัวแปรแบบค่าแบบจัดประเภท (categorical) ส่วนอีกตัวแปรเป็นตัวแปรเชิงปริมาณ 
(quantitative) มีสถิติทดสอบดังนี้ 

   5.1 อีตา (Eta) วัดความสัมพันธ์ระหว่าง 0-1 โดย 0 แสดงว่าไม่มีความสัมพันธ์ระหว่างตัวแปร
แถว (row) และสดมภ์ (column) 1 แสดงว่ามีความสัมพันธ์มาก เหมาะกับการวัดตัวแปรตามที่มีการวัด
เป็นมาตราแบบช่วง และตัวแปรอิสระที่มีการวัดเป็นมาตราแบบจัดกลุ่ม 

6. แคปปา (Kappa) หรือสัมประสิทธิ์แคปปาของโคเฮน (Cohen's kappa coefficient) ใช้
วิเคราะห์ความคิดเห็น (agreement) จากผู้ให้คะแนน 2 ฝ่าย (two raters) ในเรื่องเดียวกัน โดย
ก าหนดให้ค่า 1 หมายถึง เห็นด้วยทั้งหมด (perfect agreement) และให้ค่า 0 หมายถึง ไม่เห็นด้วย
ทั้งหมด ตัวแปรที่น ามาวิเคราะห์ทั้งสองตัวแปรต้องเป็นตัวแปรแบบค่าจัดประเภทเหมือนกันและมีการ
แบ่งจ านวนกลุ่มของค่าตัวแปรเท่ากันด้วย 

7. ความเสี่ยง (Risk) ใช้วิเคราะห์ความเข้มของความสัมพันธ์ในรูปของตารางแบบ 2x2 ในการ
น าเสนอปัจจัยหนึ่งกับเหตุการณ์ที่เกิด หากค่าสถิติที่ได้มีช่วงของความเชื่อมั่นเป็น 1 แสดงว่า ปัจจัยนั้นไม่
มีความสัมพันธ์กับเหตุการณ์ที่ เกิด อัตราส่วนของโอกาสที่จะเกิด (odds ratio) สามารถใช้ในการ
ประมาณการ (estimate) ความเสี่ยงที่เหตุการณ์นั้นยากที่จะเกิดข้ึนมาจากปัจจัยนั้นๆ 

8. แมคนีมาร์ (McNemar) ใช้วิเคราะห์ความสัมพันธ์ของตัวแปรสองค่า (dichotomous) เพ่ือ
ทดสอบการตอบสนองต่อการเปลี่ยนแปลงจากปัจจัยแทรกในการทดลอง (experimental intervention) 
ที่ออกแบบเป็นก่อนการทดลองและหลังการทดลอง 

9. คอครานและแมนเทล-แฮนส์เซล (Cochran's and Mantel-Haenszel) ใช้ในการวิเคราะห์
ความเป็นอิสระระหว่างตัวแปรปัจจัยแบบสองค่า (dichotomous factor variable) และตัวแปร
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ตอบสนองแบบสองค่า (dichotomous response variable) บนเงื่อนไขทีก่ าหนดให้เป็นรูปแบบของ
การใช้ตัวแปรร่วม (covariate patterns) โดยมีตัวแปรควบคุม 1 ตัวแปรหรือมากกว่า 1 ตัวแปร 

วิธีการทดสอบความเป็นอิสระของกลุ่มตัวอย่างระหว่างตัวแปรแบบจัดประเภท 2 ตัวแปรที่นิยม
กันอย่างแพร่หลาย คือ การทดสอบความเป็นอิสระของกลุ่มตัวอย่างแบบไคสแควร์ (X2 Test for 
Independence) 

 

ตัวอย่างค าถามการวิจัย 

จากข้อมูลการส ารวจพนักงานในหน่วยงานต้องการทราบว่า พนักงานที่มีเพศแตกต่างกันมี

ต าแหน่งงานแตกต่างกันหรือไม่ หรือเพศมีความสัมพันธ์กับต าแหน่งงานหรือไม่ 

1.1 ข้อตกลงเบื้องต้น 

ขั้นตอน ข้อตกลง 

การออกแบบการวิจัย 1. ตัวอย่างได้มาจากการสุ่มแบบสุ่ม (random sampling) และเป็นอิสระ
จากกัน (independent sample)  

 2. ค่าสังเกตแต่ละค่ามีความเป็นอิสระจากกัน (independence of 
observations) หรอืค่าของตัวแปรแบ่งเป็นกลุ่มและไม่มีความสัมพันธ์
ระหว่างกัน 

 3. มีกลุ่มตัวอย่างไม่น้อยกว่า 10 ตัวอย่าง หรือมีขนาดใหญ่พอให้แต่ละเซลล์
มีอย่างน้อย 1 ตัวอย่าง และเซลล์ส่วนใหญ่มีอย่างน้อย 5 ตัวอย่าง 

 4. ตัวแปรเป็นแบบค่าจัดประเภท (categorical) 

การวิเคราะห์ข้อมูล 1. ข้อมูลมีการแจกแจงไม่ปกติ (asymmetrical distribution) 

 2. ตัวแปรแบบค่าจัดประเภท 2 กลุ่ม แต่ละเซลล์ต้องมีความถี่อย่างน้อย 5 
ตัวอย่าง และตัวแปรแบบค่าจัดประเภทที่มีจ านวนมากกว่า 2 กลุ่ม แต่ละ
เซลล์ต้องมีความถี่ไม่น้อยกว่า 1 ตัวอย่าง และความถี่ที่น้อยกว่า 5 
ตัวอย่าง ต้องไม่เกินร้อยละ 20 
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1.2 รูปแบบการทดสอบตัวแปร 

ตัวแปรอิสระ 

-> 

ตัวแปรตาม 

ค่าจัดประเภท ค่าจัดประเภท 

เพศ (gender) 
- ชาย 
- หญิง 

ต าแหน่งงาน (jobcat) 
- เจ้าหน้าที่ปฏิบัติงาน 
- หัวหน้างาน 
- ผู้จัดการ 

1.3 การก าหนดสมมติฐานและเกณฑ์การทดสอบ 

ตารางที่ (#) แสดงจ านวนและค่าร้อยละของพนักงาน จ าแนกตามเพศและต าแหน่งงาน 

เพศ 
ต าแหน่งงาน 

รวม 
เจ้าหน้าที่ปฏิบัติงาน หัวหน้างาน ผู้จัดการ 

หญิง 205 (95.4) 0 (0.0) 10 (4.6) 216 (100.0) 

ชาย 157 (60.9) 27 (10.5) 74 (28.7) 258 (100.00) 

รวม 363 (76.6) 27 (5.7) 84 (17.7) 474 (100.0) 

 จากตารางที่ (#) แสดให้เห็นว่า เพศหญิงส่วนใหญ่เป็นเจ้าหน้าที่ปฏิบัติงาน รองลงมา คือ 

ผู้จัดการ และไม่มีผู้ด ารงต าแหน่งหัวหน้างานเลย ส่วนเพศชายส่วนใหญ่เป็นเจ้าหน้าที่ปฏิบัติงาน 

รองลงมา คือ ผู้จัดการ และหัวหน้างาน ตามล าดับ  

เมื่อเปรียบเทียบต าแหน่งระหว่างเพศชายกับเพศหญิงแสดงให้เห็นว่า เพศหญิงชายมีต าแหน่ง

งานเป็นเจ้าหน้าที่ปฏิบัติงานมากกว่าเพศชาย ส่วนเพศชายมีต าแหน่งงานเป็นหัวหน้างานและผู้จัดการ

มากกว่าเพศหญิง หรืออาจกล่าวได้ว่า เพศชายมีต าแหน่งงานแตกต่างกับเพศหญิง (เพศชายมีต าแหน่ง

งานและสูงกว่าเพศหญิง)  

ดังนั้น เพ่ือเป็นการยืนยันข้อสรุปดังกล่าว จึงน าข้อสรุปมาท าการทดสอบความเป็นอิสระของ

ข้อมูลด้วยวิธีการทางสถิติแบบไคสแควร์ (Chi-square หรือ X2) โดยก าหนดสมมติฐาน ดังนี้  

H0: เพศชายกับเพศหญิงมีต าแหน่งงานไม่แตกต่างกัน 

H1: เพศชายกับเพศหญิงมีต าแหน่งงานแตกต่างกัน 
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เกณฑ์ในการทดสอบสมมุติฐาน คือ หากการทดสอบความสัมพันธ์ (เปรียบเทียบความแตกต่าง)

ด้วยวิธีไคสแควร์ (Chi-square Test) ได้ค่าความน่าจะเป็น (p-value) มากกว่าค่านัยส าคัญทางสถิติ (α 

= 0.05) จะยอมรับสมมติฐาน H0 แต่หากได้ค่าความน่าจะเป็น (p-value) น้อยกว่าหรือเท่ากับค่า

นัยส าคัญทางสถิติ (α = 0.05) จะปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 

1.4 การใช้โปรแกรมคอมพิวเตอร์วิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล File -> Open -> Employee data.sav 
๏ เลือกเมน ูAnalyze -> Descriptive Statistics -> Crosstabs…  

o Rows: เลือกตัวแปรแบบค่าจัดประเภท 1 ตัวแปร หรือหลายตัวแปร (ที่ต้องการให้เป็นตัว
แปรอิสระ) จากรายการตัวแปรด้านซ้าย 

o Column: เลือกตัวแปรแบบค่าจัดประเภท 1 ตัวแปร หรือหลายตัวแปร (ที่ต้องการให้
เป็นตัวแปรตาม) จากรายการตัวแปรด้านซ้าย 

o กดปุ่ม Statistics เลือกสถิต ิChisq -> กดปุ่ม Continue 
o กดปุ่ม Cells… ในกลุ่มค าสั่ง Percentages (เลือก Row) -> กดปุ่ม Continue 
o กดปุ่ม OK 
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1.5 ผลการวิเคราะห์ 

 

 

1.6 การสร้างตารางแสดงผลการทดสอบ 

ตารางที ่(#) แสดงผลการทดสอบเปรียบเทียบต าแหน่งงานจ าแนกตามเพศ 

เพศ 
ต าแหน่งงาน 

รวม 
เจ้าหน้าที่ปฏิบัติงาน หัวหน้างาน ผู้จัดการ 

หญิง 206 (95.4) 0 (0.0) 10 (4.6) 216 (100.0) 

ชาย 157 (60.9) 27 (10.5) 74 (28.7) 258 (100.00) 

รวม 363 (76.6) 27 (5.7) 84 (17.7) 474 (100.0) 

X2 =79.28 df = 2 Sig = 0.00 

1.7 การแปลผลและสรุป 

จากตารางที่ (#) ผลการทดสอบแสดงให้เห็นว่า ค่าความน่าจะเป็น (Sig.) = 0.00 มีค่าน้อยกว่า

ค่านัยส าคัญทางสถิติท่ีก าหนดไว้ (α = 0.05) จึงปฏิเสธ H0 ยอมรับสมมติฐาน H1  

สรุป เพศชายกับเพศหญิงมีต าแหน่งงานแตกต่างกัน 
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ตัวอย่างเพิ่มเติม: การทดสอบ การแปลผลและสรุป 

#1 

ตารางที ่(#) แสดงผลการทดสอบเปรียบเทียบต าแหน่งานจ าแนกตามระดับการศึกษา 

ระดับ

การศึกษา 

ต าแหน่งงาน 
รวม 

เจ้าหน้าที่ปฏิบัติงาน หัวหน้างาน ผู้จัดการ 

ต่ ากว่าปริญญา 88.9 (216) 10.7 (26) 0.4 (1) 100.0 (243) 

ปริญญา 63.6 (147) 0.4 (1) 35.9 (83) 100.0 (231) 

รวม 76.6 (363) 5.7 (27) 17.7 (84) 100.0 (474) 

X2 =116.08 df = 2 Sig = 0.00 

 จากตารางที่ (#) แสดงให้เห็นว่า กลุ่มตัวอย่างพนักงานที่มีการศึกษาต่ ากว่าปริญญา ส่วนใหญ่

ด ารงต าแหน่งงานเป็นเจ้าหน้าที่ปฏิบัติงาน รองลงมา เป็นหัวหน้างาน และผู้จัดการ ส่วนกลุ่มตัวอย่าง

พนักงานที่มีการศึกษาระดับปริญญา ส่วนใหญ่ด ารงต าแหน่งงานเป็นเจ้าหน้าที่ปฏิบัติงาน รองลงมา เป็น

ผู้จัดการ และหัวหน้างาน และเมื่อเปรียบเทียบต าแหน่งงานระหว่างพนักงานที่มีการศึกษาแตกต่างกัน 

แสดงให้เห็นว่า พนักงานที่มีการศึกษาระดับปริญญา มีต าแหน่งงานแตกต่างกับพนักงานที่มีการศึกษาต่ า

กว่าปริญญา ดังนั้นเพ่ือเป็นการยืนยันข้อสรุปที่ว่า พนักงานที่มีการศึกษาระดับปริญญา มีต าแหน่งงาน

แตกต่างกับพนักงานที่มีการศึกษาต่ ากว่าปริญญา จึงท าการทดสอบด้วยวิธีการทางสถิติ โดยก าหนด

สมมติฐาน ดังนี้ 

H0: พนักงานที่มีการศึกษาระดับปริญญากับพนักงานที่มีการศึกษาต่ ากว่าปริญญามีต าแหน่งงาน

ไม่แตกต่างกัน 

H1: พนักงานที่มีการศึกษาระดับปริญญากับพนักงานที่มีการศึกษาต่ ากว่าปริญญามีต าแหน่งงาน

แตกต่างกัน 

 เกณฑ์ในการทดสอบสมมุติฐาน คือ หากการทดสอบความสัมพันธ์ (เปรียบเทียบความแตกต่าง)

ด้วยวิธีไคสแควร์ (Chi-square Test) ได้ค่าความน่าจะเป็น (p-value) มากกว่าค่านัยส าคัญทางสถิติ (α 

= 0.05) จะยอมรับสมมติฐาน H0 แต่หากได้ค่าความน่าจะเป็น (p-value) น้อยกว่าหรือเท่ากับค่า

นัยส าคัญทางสถิติ (α = 0.05) จะปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 
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 จากตารางที่ (#) ผลการทดสอบแสดงให้เห็นว่า ค่าความน่าจะเป็น (Sig.) = 0.00 มีค่าน้อยกว่า

ค่านัยส าคัญทางสถิติที่ก าหนดไว้ (α = 0.05) จึงปฏิเสธ H0 ยอมรับสมมติฐาน H1 กล่าวคือ พนักงานที่มี

การศึกษาระดับปริญญากับพนักงานที่มีการศึกษาต่ ากว่าระดับปริญญามีต าแหน่งงานแตกต่างกัน 

#2 

ตารางที ่(#) แสดงผลการทดสอบเปรียบเทียบต าแหน่งานจ าแนกตามระดับการศึกษา 

ระดับ

การศึกษา 

ต าแหน่งงาน 
รวม 

เจ้าหน้าที่ปฏิบัติงาน หัวหน้างาน ผู้จัดการ 

ต่ ากว่าปริญญา 88.9 (216) 10.7 (26) 0.4 (1) 100.0 (243) 

ปริญญา 63.6 (147) 0.4 (1) 35.9 (83) 100.0 (231) 

รวม 76.6 (363) 5.7 (27) 17.7 (84) 100.0 (474) 

X2 =116.08 df = 2 Sig = 0.00 

 จากตารางที่ (#) แสดงให้เห็นว่า กลุ่มตัวอย่างพนักงานที่มีการศึกษาต่ ากว่าปริญญา ส่วนใหญ่

ด ารงต าแหน่งงานเป็นพนักงาน รองลงมา เป็นหัวหน้างาน และผู้จัดการ ส่วนกลุ่มตัวอย่างพนักงานที่มี

การศึกษาระดับปริญญา ส่วนใหญ่ด ารงต าแหน่งงานเป็นเจ้าหน้าที่ปฏิบัติงาน รองลงมา เป็นผู้จัดการ และ

หัวหน้างาน และเมื่อเปรียบเทียบต าแหน่งงานระหว่างพนักงานที่มีการศึกษาแตกต่างกัน แสดงให้เห็นว่า 

พนักงานที่มีการศึกษาระดับปริญญา มีต าแหน่งงานสูงกว่าพนักงานที่มีการศึกษาต่ ากว่าปริญญา อย่างมี

นัยส าคัญทางสถิติ 

#3 

ตารางที ่(#) แสดงผลการเปรียบเทียบต าแหน่งงานจ าแนกตามระดับการศึกษา 

ระดับ

การศึกษา 

ต าแหน่งงาน 
รวม 

เจ้าหน้าที่ปฏิบัติงาน หัวหน้างาน ผู้จัดการ 

ต่ ากว่าปริญญา 88.9 (216) 10.7 (26) 0.4 (1) 100.0 (243) 

ปริญญา 63.6 (147) 0.4 (1) 35.9 (83) 100.0 (231) 

รวม 76.6 (363) 5.7 (27) 17.7 (84) 100.0 (474) 

X2 =116.08 df = 2 Sig = 0.00 

 จากตารางที่ (#) แสดงให้เห็นว่า กลุ่มตัวอย่างพนักงานที่มีการศึกษาต่ ากว่าปริญญา ส่วนใหญ่

ด ารงต าแหน่งงานเป็นเจ้าหน้าที่ปฏิบัติงาน รองลงมา เป็นหัวหน้างาน และผู้จัดการ ส่วนกลุ่มตัวอย่าง
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พนักงานที่มีการศึกษาระดับปริญญา ส่วนใหญ่ด ารงต าแหน่งงานเป็นเจ้าหน้าที่ปฏิบัติงาน รองลงมา เป็น

ผู้จัดการ และหัวหน้างาน  

ผลการศึกษาดังกล่าว เมื่อพิจารณาจากสมมติฐานการศึกษาตามทฤษฎีที่ก าหนดไว้ว่า พนักงานที่

มีการศึกษาแตกต่างกันมีต าแหน่งงานที่แตกต่างกัน แสดงให้เห็นว่า พนักงานที่มีการศึกษาระดับปริญญา 

มีต าแหน่งงานแตกต่างกับพนักงานที่มีการศึกษาต่ ากว่าปริญญา อย่างมีนัยส าคัญทางสถิติ ดังนั้นจึง

ยอมรับสมมติฐานดังกล่าว 
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2. การทดสอบค่ากลางของกลุ่มตัวอย่างที่เป็นอิสระจากกัน 2 กลุ่ม  

การทดสอบแบบไม่อิงค่าพารามิเตอร์มีข้อสมมติพ้ืนฐาน (assumption) คือ ข้อมูลมีการแจกแจง

ไม่ปกติ (non-normal distribution) ท าให้ไม่สามารถใช้วิธีการเปรียบเทียบความแตกต่างระหว่างกลุ่ม

ตัวอย่างด้วยค่าเฉลี่ย (mean) เหมือนกับวิธีการทดสอบแบบอิงค่าพารามิเตอร์ ดังนั้นในการทดสอบข้อมูล

ระหว่างกลุ่มตัวอย่างจึงใช้วิธีการเปรียบเทียบจากค่ากลาง (median) 

 การทดสอบค่ากลางของกลุ่มตัวอย่างที่เป็นอิสระจากกัน 2 กลุ่ม (2 Independent Samples 

Test) คือ การเปรียบเทียบต าแหน่งข้อมูล (location) โดยใช้ค่ากลาง (median) ของกลุ่มตัวอย่างที่ไม่มี

ความสัมพันธ์กันหรือเป็นอิสระจากกัน 2 กลุ่ม เพ่ือตัดสินใจว่าข้อมูลระหว่าง 2 กลุ่มตัวอย่างมีความ

เหมือนกันหรือแตกต่างกัน  

วิธีการทดสอบแบบนี้ใช้แทนกรณีที่ข้อมูลไม่เป็นไปตามข้อตกลงเบื้องต้นของการทดสอบค่าเฉลี่ย

แบบ Independent t-Test โดยมีวิธีดังนี้ 

1. การทดสอบของแมน-วิทนี ยู (Mann-Whitney U Test) อาจเรียกอีกอย่างว่า การทดสอบ

ของแมน-วิทนี-วิลคอกซัน (Mann-Whitney-Wilcoxon Test) หรือการทดสอบแบบผลรวมของอันดับที่

ของวิลคอกซัน (Wilcoxon rank-sum Test) เป็นการทดสอบความเท่ากันของการกระจายของข้อมูล

จากต าแหน่งหรือแนวโน้มเข้าสู่ส่วนกลางของข้อมูลจากกลุ่มตัวอย่าง 2 กลุ่มท่ีเป็นอิสระจากกัน 
2. การทดสอบของคอลมอโกรอฟ-สเมอร์นอฟ (Kolmogorov-Smirnov Z) เป็นการทดสอบ

ความแตกต่างกันของการกระจายทั้งจากต าแหน่งและรูปร่างของข้อมูลจากกลุ่มตัวอย่าง 2 กลุ่มที่เป็น

อิสระจากกัน จากค่าสูงสุดสัมบูรณ์ (absolute maximum) ของข้อมูลการกระจายสะสม (cumulative 

distribution) 
3. การทดสอบค่าต่างสุดของโมเซส  (Moses extreme reactions) เป็นการทดสอบความ

แตกต่างกันของการกระจาย (distribution) ของตัวแปรแบบสองทิศในทางตรงข้าม (opposite 

direction) ที่ได้จากการทดลอง 2 กลุ่ม โดยน าเอาข้อมูลที่ได้จากการสังเกตมารวมกัน (combined) และ

ท าการจัดต าแหน่ง (ranked) เพ่ือวัดช่วง (span) ของต าแหน่งสูงสุดและต่ าสุด แล้วท าการเปรียบเทียบ

ค่าต่างสุดกับกลุ่มทดลอง 
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4. การทดสอบของวอร์ค–วูล์ฟอวิทซ์ (Wald-Wolfowitz runs) เป็นการทดสอบความแตกต่าง

กันของการกระจายทั้งจากต าแหน่งและรูปร่างของข้อมูลจากกลุ่มตัวอย่าง 2 กลุ่มท่ีเป็นอิสระจากกัน จาก

การน าเอาข้อมูลจากกลุ่มตัวอย่าง 2 กลุ่มมารวมกัน (combines) และจัดต าแหน่ง (ranks) แล้วนับ

จ านวนความต่อเนื่อง (runs)  

วิธีการทดสอบค่ากลางของกลุ่มตัวอย่างที่เป็นอิสระจากกัน 2 กลุ่ม ที่นิยมกันอย่างแพร่หลาย คือ 
การทดสอบแบบแมน-วิทนี ยู (Mann-Whitney U Test) 

ตัวอย่างค าถามการวิจัย 

จากข้อมูลการส ารวจพนักงานในหน่วยงานต้องการทราบว่าพนักงานที่มีเป็น กลุ่มชนแตกต่าง

กันมีประสบการณ์ก่อนการท างานแตกต่างกันหรือไม่ 

2.1 ข้อตกลงเบื้องต้น 

ขั้นตอน ข้อตกลง 

การออกแบบการ

วิจัย 

1. ตัวอย่างได้มาจากการสุ่มแบบสุ่ม (random sampling) และเป็นอิสระ
จากกัน (independent sample) 

 2. ค่าสังเกตแต่ละค่ามีความเป็นอิสระจากกัน (independence of 
observations) หรือค่าของตัวแปรแบ่งเป็น 2 กลุ่มและไม่มีความสัมพันธ์
ระหว่างกัน 

 3. ตัวแปรอิสระมีการวัดแบบมาตราจัดอันดับ (ordinal level) หรือเป็นค่า
ต่อเนื่อง (continuous level) 

การวิเคราะห์ข้อมูล 1. ข้อมูลของแต่ละกลุ่มมีการแจกแจงไม่ปกติ (asymmetrical distribution) 

 2. ข้อมูลของแต่ละกลุ่มมีรูปแบบการแจกแจงเหมือนกัน (same 
distribution) 

 

 

 

 



ก า ร ท ด ส อ บ ข้ อ มู ล แ บ บ ไ ม่ อิ ง ค่ า พ า ร า มิ เ ต อ ร์  ( 2  ตั ว แ ป ร ) | 305 

2.2 รูปแบบการทดสอบตัวแปร 

ตัวแปรอิสระ 

-> 

ตัวแปรตาม 
ค่าจัดประเภท (มาตราแบบจัดกลุ่ม 2 กลุ่ม) ค่าต่อเนื่อง 

กลุ่มชน (minority) 
- ชนกลุ่มหลัก 
- ชนกลุ่มน้อย 

ประสบการณ์ก่อนท างาน (prevexp) 

2.3 การก าหนดสมมติฐานและเกณฑ์การทดสอบ 

H0: พนักงานชนกลุ่มหลักกับพนักงานชนกลุ่มน้อยมีประสบการณ์ก่อนท างานไม่แตกต่างกัน 

 H1: พนักงานชนกลุ่มหลักกับพนักงานชนกลุ่มน้อยมีประสบการณ์ก่อนท างานแตกต่างกัน 

เกณฑ์ในการทดสอบสมมุติฐาน คือ หากการทดสอบความแตกต่างของการกระจายของข้อมูล

โดยใช้วิธีของแมน-วิทนี ยู (Mann-Whitney U Test) ได้ค่าความน่าจะเป็น (p-value) มากกว่าค่า

นัยส าคัญทางสถิติ (α = 0.05) จะยอมรับสมมติฐาน H0 แต่หากได้ค่าความน่าจะเป็น (p-value) น้อย

กว่าหรือเท่ากับค่านัยส าคัญทางสถิติ (α = 0.05) จะปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 

2.4 การใช้โปรแกรมคอมพิวเตอร์วิเคราะห์ข้อมูล 

๏ วิเคราะห์ผ่าน Syntax Editor ด้วยค าสั่งดังนี้ 
NPAR TESTS 

[ /MANN-WHITNEY = var_list BY var (group1, group2) ] 

๏ เปิดแฟ้มข้อมูล File -> Open -> Employee data.sav 
๏ เลือกเมนู File -> New -> Syntax  

o NPAR TESTS 
/MANN-WHITNEY = var list (พิมพ์ชื่อตัวแปรทดสอบหรือตัวแปรตามที่เป็นตัวแปร

แบบค่าต่อเนื่องแทนค าว่า var list) BY var (พิมพ์ชื่อตัวแปรอิสระที่เป็นตัวแปรแบบค่า

จัดประเภทแทนค าว่า var) และ (group1 เช่น 1 หรือ 4, group2 เช่น 2 หรือ 5). 

o เมนู Run -> All 
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2.5 ผลการวิเคราะห์ 

 

2.6 การสร้างตารางแสดงผลการทดสอบ 

ตารางที ่(#) แสดงผลการทดสอบเปรียบเทียบล าดับที่ค่าเฉลี่ยของประสบการณ์ก่อนท างานของพนักงาน

ระหว่างกลุ่มชน 

กลุ่มชน 
ล าดับที่ค่าเฉลี่ย 

(Mean Rank) 

ผลรวมของล าดับที่ 

(Sum of Ranks) 

Mann-Whitney U 

Test 
Z Sig. 

กลุ่มหลัก 222.70 82399.50 
13764.50 -4.44 .000 

กลุ่มน้อย 290.15 30175.50 

2.7 การแปลผลและสรุป 

จากตารางที่ (#) ผลการทดสอบการเปรียบเทียบล าดับที่ค่าเฉลี่ยของประสบการณ์ก่อนท างาน

ของพนักงานระหว่างกลุ่มชน แสดงให้เห็นว่ า พนักงานที่เป็นชนกลุ่มหลักมีล าดับที่ค่าเฉลี่ยของ

ประสบการณ์ก่อนท างานน้อยกว่าพนักงานที่เป็นชนกลุ่มน้อย และจากผลการทดสอบความแตกต่างของ

การกระจายของข้อมูลโดยวิธีของแมน-วิทนี ยู (Mann-Whitney U Test) ได้ค่าความน่าจะเป็น (Sig.) = 

0.00 ซึ่งมีค่าน้อยกว่าค่านัยส าคัญทางสถิติที่ก าหนดไว้ (α = 0.05) จึงปฏิเสธสมมติฐาน H0 และยอมรับ

สมมติฐาน H1  

สรุป พนักงานชนกลุ่มหลักกับพนักงานชนกลุ่มน้อยมีประสบการณ์ก่อนท างานแตกต่างกัน  
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3. การทดสอบค่ากลางของกลุ่มตัวอย่างที่เป็นอิสระจากกันมากกว่า 2 กลุ่ม  
 การทดสอบค่ากลางของกลุ่มตัวอย่างที่เป็นอิสระจากกันมากกว่า 2 กลุ่ม (K Independent 

Samples Test) คือ การเปรียบเทียบต าแหน่งของข้อมูล (location) โดยใช้ค่ากลาง (median) ของกลุ่ม

ตัวอย่างที่ไม่มีความสัมพันธ์กันหรือเป็นอิสระจากกันมากกว่า 2 กลุ่ม เพ่ือตัดสินใจว่าข้อมูลระหว่างกลุ่ม

ตัวอย่างมีความเหมือนกันหรือแตกต่างกัน 

วิธีการทดสอบแบบนี้ใช้แทนกรณีที่ข้อมูลไม่เป็นไปตามข้อตกลงเบื้องต้นของการทดสอบค่าเฉลี่ย

ด้วยวิธีการวิเคราะห์ความแปรปรวนแบบจ าแนกทางเดียว (One-way Analysis of Variance: One-

way ANOVA) โดยมีวิธีดังนี้ 

1. การทดสอบของครัสคาลและวัลลิส (Kruskal Wallis Test) เป็นการทดสอบความเหมือนกัน

ของรูปร่างของข้อมูลที่ไม่มีการจัดเรียง (no a priori ordering) จากกลุ่มตัวอย่างมากกว่า 2 กลุ่มที่เป็น

อิสระจากกัน (multiple/several independent)  
2. การทดสอบของจองฮีรี (Jonckheere Test) หรืออาจเรียกว่า การทดสอบแนวโน้มของจองฮี

รี (Jonckheere’s Trend Test) หรือการทดสอบของจองฮีรี-เทิร์พสตรา (Jonckheere-Terpstra Test) 

เป็นการทดสอบความเหมือนกันของรูปร่างของข้อมูลที่มีการจัดเรียง (priori ordered) จากกลุ่มตัวอย่าง

มากกว่า 2 กลุ่มที่เป็นอิสระจากกัน ข้อมูลที่มีการจัดเรียงจากกลุ่มตัวอย่างอาจเป็นการจัดเรียงแบบจาก

น้อยไปมาก (ascending) หรือจากมากไปน้อย (descending) ก็ได้ เช่น การเพ่ิมข้ึนของอุณหภูมิ การลด

ของอุณหภูมิ เป็นต้น 
3. การทดสอบค่ามัธยฐาน (Median Test) เป็นการทดสอบความเหมือนกันของค่ามัธยฐาน 

(median) ของข้อมูลจากกลุ่มตัวอย่างมากกว่า 2 กลุ่มที่เป็นอิสระจากกัน 

วิธีการทดสอบข้อมูลเชิงคุณภาพของกลุ่มตัวอย่างที่เป็นอิสระจากกันมากกว่า 2 กลุ่ม ที่นิยมกัน
อย่างแพร่หลาย คือ การทดสอบแบบครัสคาลและวัลลิส (Kruskal Wallis Test) โดยใช้วิธีการ
เปรียบเทียบค่ามัธยฐาน (median) ของแต่ละกลุ่มตัวอย่าง 

ตัวอย่างค าถามการวิจัย 

จากข้อมูลการส ารวจพนักงานในหน่วยงานต้องการทราบว่า พนักงานที่มีต าแหน่งงานแตกต่าง

กันมีประสบการณ์ก่อนการท างานแตกต่างกันหรือไม่ 
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3.1 ข้อตกลงเบื้องต้น 

ขัน้ตอน ข้อตกลง 

การออกแบบการวิจัย 1. ตัวอย่างได้มาจากการสุ่มแบบสุ่ม (random sampling) และเป็นอิสระ
จากกัน (independent sample) 

 2. ค่าสังเกตแต่ละค่ามีความเป็นอิสระจากกัน (independence of 
observations) หรือค่าของตัวแปรแบ่งเป็น 3 กลุ่ม หรือมากกว่า และไม่
มีความสัมพันธ์ระหว่างกัน 

 3. ตัวแปรตามมีการวัดแบบมาตราจัดอันดับ (ordinal level) หรือเป็นค่า
ต่อเนื่อง (continuous level) 

การวิเคราะห์ข้อมูล 1. ข้อมูลของแต่ละกลุ่มมีการแจกแจงไม่ปกติ (asymmetrical 
distribution) 

 2. ข้อมูลของแต่ละกลุ่มมีการแจกแจงเหมือนกัน (same distribution) 

3.2 รูปแบบการทดสอบตัวแปร 

ตัวแปรอิสระ 

-> 

ตัวแปรตาม 
ค่าจัดประเภท  

(มาตราแบบจัดอันดับ 3 กลุ่มหรือมากกว่า) 
ค่าต่อเนื่อง 

ต าแหน่งงาน (jobcat) 
- เจ้าหน้าที่ปฏิบัติงาน 
- หัวหน้างาน 
- ผู้จัดการ 

ค่าเฉลี่ยของประสบการณ์ก่อนท างาน (prevexp) 

3.3 การก าหนดสมมติฐานและเกณฑ์การทดสอบ 

H0: พนักงานที่มีต าแหน่งงานแตกต่างกันมีประสบการณ์ก่อนท างานไม่แตกต่างกัน 

 H1: พนักงานที่มีต าแหน่งงานแตกต่างกันมีประสบการณ์ก่อนท างานแตกต่างกัน 

เกณฑ์ในการทดสอบสมมุติฐาน คือ หากการเปรียบเทียบรูปร่างของข้อมูลโดยใช้วิธีของครัสคาล

และวัลลิส (Kruskal Wallis Test) ได้ค่าความน่าจะเป็น (p-value) มากกว่าค่านัยส าคัญทางสถิติ (α = 
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0.05) จะยอมรับสมมติฐาน H0 แต่หากได้ค่าความน่าจะเป็น (p-value) น้อยกว่าหรือเท่ากับค่านัยส าคัญ

ทางสถิติ (α = 0.05) จะปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 

3.4 การใช้โปรแกรมคอมพิวเตอร์วิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล File -> Open -> Employee data.sav 
๏ เลือกเมนู Analyze -> Non-Parametric Statistics -> K Independent Samples… 

o Test Variable List: เลือกตัวแปรทดสอบ (ตัวแปรตาม) ที่เป็นตัวแปรแบบค่าจัดอันดับ
หรือค่าต่อเนื่อง 1 ตัวแปร หรือมากกว่า 1 ตัวแปร จากรายการตัวแปรด้านซ้าย  

o Grouping Variable: เลือกตัวแปรอิสระท่ีเป็นตัวแปรแบบค่าจัดประเภท 1 ตัวแปร จาก
รายการตัวแปรด้านซ้าย 

o กดปุ่ม Define Range… 
o ก าหนดค่าของตัวแปรแบบค่าจัดประเภทในช่อง Lower limit: (ค่าต่ าสุดของกลุ่ม) และ 

Upper limit: (ค่าสูงสุดของกลุ่ม) -> กดปุ่ม Continue 
o ในกลุ่มค าสั่ง Test Type เลือกสถิติ Kruskal-Wallis H  
o กดปุ่ม OK 

 

 

3.5 ผลการวิเคราะห์ 
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3.6 การสร้างตารางแสดงผลการทดสอบ 

ตารางที ่(#) แสดงผลการทดสอบเปรียบเทียบล าดับที่ค่าเฉลี่ยของประสบการณ์ก่อนท างานของพนักงาน

ระหว่างต าแหน่งงาน 

ต าแหน่งงาน จ านวน ค่าเฉลี่ย 
ค่าเบี่ยงเบน 

มาตรฐาน 

ล าดับที่ค่าเฉลี่ย 

(Mean Rank) 

Kruskal Wallis 

Test 

เจ้าหน้าที่ปฏิบัติงาน 363 85.04 95.275 224.53 X2 = 57.466  

df = 2  

Asymp. Sig = 0.00 

หัวหน้างาน 27 298.11 101.426 431.26 

ผู้จัดการ  84 77.62 73.260 231.27 

รวม 474 95.86 104.586   

3.7 การแปลผลและสรุป 

จากการเปรียบเทียบล าดับที่ค่าเฉลี่ยของประสบการณ์ก่อนท างานของพนักงานระหว่างต าแหน่ง

งาน แสดงให้เห็นว่า พนักงานที่เป็นชนกลุ่มหลักมีล าดับที่ค่าเฉลี่ยของประสบการณ์ก่อนท างานหัวหน้า

งานมีล าดับที่ค่าเฉลี่ยของประสบการณ์ก่อนท างานมากที่สุด รองลงมา คือ เจ้าหน้าที่ปฏิบัติงาน และน้อย

ที่สุด คือ ผู้จัดการ และจากการทดสอบการเปรียบเทียบรูปร่างของข้อมูลโดยใช้วิธีของครัสคาลและวัลลิส 

(Kruskal Wallis Test) ได้ค่าความน่าจะเป็น (Sig.) = 0.00 ซึ่งมีค่าน้อยกว่าค่านัยส าคัญทางสถิติที่

ก าหนดไว้ (α = 0.05) จึงปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1  

สรุป พนักงานที่มีต าแหน่งงานแตกต่างกันมีประสบการณ์ก่อนท างานแตกต่างกัน 
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4. การทดสอบค่ากลางของกลุ่มตัวอย่างที่มีความสัมพันธ์กัน 2 กลุ่ม 

 การทดสอบค่ากลางของกลุ่มตัวอย่างที่มีความสัมพันธ์กัน 2 กลุ่ม (2 Related Samples Test) 

คือ การทดสอบเปรียบเทียบต าแหน่งข้อมูล (location) โดยใช้ค่ากลาง (median) ของกลุ่มตัวอย่างที่มี

ความสัมพันธ์กันหรือไม่เป็นอิสระจากกันมากกว่า 2 กลุ่ม เพ่ือตัดสินใจว่าข้อมูลระหว่างกลุ่มตัวอย่างมี

ความเหมือนกันหรือแตกต่างกัน 

การทดสอบแบบนี้อาจมีชื่อเรียกในชื่ออ่ืน เช่น Paired Samples Test, Matched Samples 

Test และ Dependent Samples Test  

วิธีการทดสอบแบบนี้ใช้แทนกรณีที่ข้อมูลไม่เป็นไปตามข้อตกลงเบื้องต้น (not meet  basic 

assumptions) ของการทดสอบค่าเฉลี่ย 2 กลุ่มที่สัมพันธ์กัน (Pair Sample t-test) โดยมีวิธีการดังนี้ 

1. การทดสอบแบบเครื่องหมาย (Sign Test) เป็นการทดสอบความแตกต่างกันของค่ามัธยฐาน 

(median) ของข้อมูลต่อเนื่อง (continuous data) จากเครื่องหมาย + และเครื่องหมาย – ที่ได้จาก

ข้อมูลที่น ามาจับคู่กัน (Xi > Yi ได้เครื่องหมาย + แต่ถ้า Xi < Yi จะได้เครื่องหมาย -) 
2. การทดสอบแบบวิลคอกชัน (Wilcoxon Test หรือ Wilcoxon Singed Ranks Test) เป็น

การทดสอบความเหมือนกันของค่ามัธยฐาน (median) ของข้อมูลต่อเนื่อง (continuous data) ที่มี

ความสัมพันธ์กัน (related) จากกลุ่มตัวอย่างเดียวกันหรือคู่เดียวกัน (same/matched sample) ที่

พัฒนามาจากการทดสอบเครื่องหมาย โดยการน าค่าของความแตกต่างมาจัดอันดับในการทดสอบ 
3. การทดสอบแบบแมคนีมาร์  (McNemar Test) เป็นการทดสอบความไม่เปลี่ยนแปลง 

(unchanged) ของข้อมูลแบบ 2 ค่า (binary response) หรือตัวแปรที่มีค่า 2 ค่า (data: binary) เป็น

การทดสอบที่สามารถใช้ได้ท้ังตัวแปรแบบมาตราจัดกลุ่ม (nominal) และจัดอันดับ (ordinal) 
4. การทดสอบความเป็นเอกพันธ์ของส่วนเพ่ิม (Marginal Homogeneity Test) เป็นการ

ทดสอบความเหมือนกันของการกระจายของส่วนเพ่ิมของตัวแปรพหุวิภาคหรือตัวแปรหลายค่า 

(polytomous variables) จากกลุ่มตัวอย่าง 2 กลุ่มท่ีมีความสัมพันธ์กัน 

วิธีการทดสอบกลุ่มตัวอย่าง 2 กลุ่มที่มีความสัมพันธ์กันที่นิยมกันอย่างแพร่หลาย คือ การ
ทดสอบแบบวิลคอกชัน (Wilcoxon Test หรือ Wilcoxon Singed Ranks Test)  
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ตัวอย่างค าถามการวิจัย 

จากข้อมูลการส ารวจพนักงานในหน่วยงานต้องการทราบว่า พนักงานที่ท างานอยู่ขณะนี้ได้รับ

เงินเดือนแตกต่างไปจากเงินเดือนเริ่มต้นหรือไม่ 

4.1 ข้อตกลงเบื้องต้น 

ขัน้ตอน ข้อตกลง 

การออกแบบการวิจัย 1. ตัวอย่างได้มาจากการสุ่มแบบสุ่ม (random sampling) และเป็นอิสระจาก
กัน (independent sample) 

 2. ข้อมูลได้มาจากกลุ่มตัวอย่างเดียวกันหรือคู่เดียวกัน (same/matched 
sample) และเป็นสถานการณ์ที่มีความเกี่ยวข้องกันหรือสัมพันธ์กัน  2 
สถานการณ์ (2 related samples or dependent/paired sample) หรือ
เป็นการวัดซ้ า (repeated measures data) 

 3. ตัวแปรต้องมีระดับการแบบค่าจัดอันดับหรือค่าต่อเนื่อง (ordinal or 
continuous level)  

 4. ตัวแปรทั้งคู่ต้องมีระดับการวัดอยู่ในระดับเดียวกัน (มาตราแบบจัดอันดับ
กับมาตราแบบจัดอันดับ หรือค่าต่อเนื่องกับค่าต่อเนื่อง) 

การวิเคราะห์ข้อมูล 1. ข้อมูลของ 2 ตัวแปร มีการแจกแจงไม่ปกติ (asymmetrical distribution) 
 2. ข้อมูลของ 2 ตัวแปร มีการแจกแจงเหมือนกัน (same distribution) 

4.2 รูปแบบการทดสอบตัวแปร 

ตัวแปรทดสอบ (การวัดครั้งที่ 1) วัดซ้ า ตัวแปรทดสอบ (การวัดครั้งที่ 2) 
ค่าต่อเนื่อง -> ค่าต่อเนื่อง 

เงินเดือนเริ่มต้น (salbegin)  เงินเดือนปัจจุบัน (salary) 

4.3 การก าหนดสมมติฐานและเกณฑ์การทดสอบ 

H0: พนักงานมีเงินเดือนปัจจุบันเท่ากับเงินเดือนเริ่มต้น 

 H1: พนักงานมีเงินเดือนปัจจุบันไม่เท่ากับเงินเดือนเริ่มต้น 

เกณฑ์ในการทดสอบสมมุติฐาน คือ หากการทดสอบเปรียบเทียบค่ามัธยฐานโดยใช้วิธีของวิลค

อกชัน (Wilcoxon Test) ได้ค่าความน่าจะเป็น (p-value) มากกว่าค่านัยส าคัญทางสถิติ (α = 0.05) จะ
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ยอมรับสมมติฐาน H0 แต่หากได้ค่าความน่าจะเป็น (p-value) น้อยกว่าหรือเท่ากับค่านัยส าคัญทางสถิติ 

(α = 0.05) จะปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 

4.4 การใช้โปรแกรมคอมพิวเตอร์วิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล File -> Open -> Employee data.sav 
๏ เลือกเมนู Analyze -> Non-Parametric Statistics -> 2 Related Samples… 

o Test Pair(s): เลือกตัวแปรทดสอบตัวที่ 1 (ตัวแปรแบบค่าต่อเนื่อง/เหตุการณ์ก่อน) จาก
ช่องรายการตัวแปรใส่ในช่อง Var1   

o Test Pair(s): เลือกตัวแปรทดสอบตัวที่ 2 (ตัวแปรแบบค่าต่อเนื่อง/เหตุการณ์หลัง) จาก
ช่องรายการตัวแปรใส่ในช่อง Var2  

o ในกลุ่มค าสั่ง Test Type เลือกสถิติ Wilcoxon  
o กดปุ่ม OK 

 

4.5 ผลการวิเคราะห์ 
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4.6 การสร้างตารางแสดงผลการทดสอบ 

ตารางที ่(#) แสดงผลการทดสอบเปรียบเทียบล าดับที่ค่าเฉลี่ยระหว่างเงินเดือนเริ่มต้นกับ

เงินเดือนปัจจุบัน 

เงินเดือน จ านวน 
ล าดับที่ค่าเฉลี่ย 

(Mean Rank) 

ผลรวมของล าดับที่ 

(Sum of Ranks) 

Wilcoxon 

Test 

เงินเดือนปัจจุบัน-

เงินเดือนเริ่มต้น 

อันดับค่าที่มีค่าน้อยกว่า  

(Negative Ranks) 
474 237.50 112575.00 

Z = -18.86 

Sig = 0.00  อันดับค่าที่มีค่ามากกว่า  

(Positive Ranks) 
0 0 .00 

 อันดับค่าที่มีค่าเท่ากัน 

(Ties) 
0   

 

รวม  474    

4.7 การแปลผลและสรุป 

จากตารางที่ (#) ผลการทดสอบการเปรียบเทียบค่ามัธยฐานโดยใช้วิธีของวิลคอกชัน (Wilcoxon 

Test) ได้ค่าความน่าจะเป็น (Sig.) = 0.00 มีค่าน้อยกว่าค่านัยส าคัญทางสถิติที่ก าหนดไว้ (α = 0.05) จึง

ปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1  

สรุป พนักงานมีเงินเดือนปัจจุบันมากกว่าเงินเดือนเริ่มต้น พนักงานมีเงินเดือนปัจจุบันมากกว่า

เงินเดือนเริ่มต้นจ านวน 474 คน ไม่มีพนักงานที่มีเงินเดือนปัจจุบันน้อยกว่าเงินเดือนเริ่มต้น และไม่มี

พนักงานที่มีเงินเดือนปัจจุบันเท่ากับเงินเดือนเริ่มต้น 
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5. การทดสอบค่ากลางของกลุ่มตัวอย่างที่มีความสัมพันธ์กันมากกว่า 2 กลุ่ม 

 การทดสอบค่ากลางของกลุ่มตัวอย่างที่มีความสัมพันธ์กันมากกว่า 2 กลุ่ม (K Related Samples 

Tests) คือ การเปรียบเทียบต าแหน่ง (location) โดยใช้ค่ากลาง (median) ของกลุ่มตัวอย่างที่ มี

ความสัมพันธ์กันมากกว่า 2 กลุ่ม เพ่ือตัดสินใจว่าข้อมูลระหว่างกลุ่มตัวอย่างมีความเหมือนกันหรือ

แตกต่างกัน 

วิธีการทดสอบแบบนี้ใช้แทนกรณีที่ข้อมูลไม่เป็นไปตามข้อตกลงเบื้องต้น (not meet  basic 

assumptions) ของการทดสอบค่าเฉลี่ยมากกว่า 2 กลุ่มท่ีสัมพันธ์กัน (One-Way repeated-measures 

ANOVA) โดยมีวิธีดังนี้ 

1. การทดสอบแบบฟรีดแมน (Friedman Test) เป็นการทดสอบความเหมือนของข้อมูลจากตัว

แปรแบบมาตราจัดอันดับแบบพหุ (multiple ordinal responses) ที่ได้จากการวัดซ้ าแบบเดียวกัน 

(same measure) จากกลุ่มตัวอย่างเดียวกันแบบพหุ (multiple matched samples) 
2. การทดสอบแบบเคนดอลล์ (Kendall’s W Test) เป็นวิธีการทดสอบสัมประสิทธิ์ของความ

สอดคล้องในการจัดล าดับที่ (coefficient of concordance for ranks: W) จากค าตอบความคิดเห็น 

(agreement) ของผู้ตอบที่มีค่าแบบมาตราจัดอันดับช่วง 0 ถึง n-1 โดยค่า 0 = ไม่เห็นด้วย (no 

agreement) และ 1 = เห็นด้วยทั้งหมด (complete agreement) เช่น ค่า 1=0 ค่า 2=1 และค่า 9=8 

เป็นต้น  
3. การทดสอบแบบคอคราน (Cochran’s Q Test) เป็นการทดสอบความเหมือนกันของสัดส่วน

ของข้อมูลจากตัวแปรแบบสองค่า (dichotomous) ที่มีความสัมพันธ์กันแบบพหุ (multiple related) ที่

พัฒนามาจากการทดสอบแบบแมคนีมาร์ (McNemar) ที่ใช้ในการทดสอบข้อมูล 2 ค่า 

วิธีการทดสอบความสัมพันธ์ของกลุ่มตัวอย่างมากกว่า 2 กลุ่มที่ใช้เป็นตัวอย่างการทดสอบ คือ 

การทดสอบแบบฟรีดแมน (Friedman Test)  

ตัวอย่างค าถามการวิจัย 

จากคะแนนการตัดสินของคณะกรรมการทั้งหมดการทราบว่า คณะกรรมการของประเทศอิตาลี 

ประเทศเกาหลีใต้ และประเทศโรมาเนีย ให้คะแนนแตกต่างกันหรือไม่ 
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5.1 ข้อตกลงเบื้องต้น 

ขั้นตอน ข้อตกลง 

การออกแบบการวิจัย 1. ตัวอย่างได้มาจากการสุ่มแบบสุ่ม (random sampling) และเป็นอิสระ
จากกัน (independent sample) 

 2. ข้อมูลของตัวแปรทดสอบมีความเก่ียวข้องหรือสัมพันธ์กันมากกว่า 2 
สถานการณ์ (K related sample)  

 3. ข้อมูลของตัวแปรทดสอบมีระดับการวัดด้วยมาตราแบบจัดอันดับหรือค่า
ต่อเนื่อง (ordinal or continuous level)  

 4. ข้อมูลของตัวแปรทดสอบทุกตัวต้องมีระดับการวัดอยู่ในระดับเดียวกัน 
(มาตราแบบจัดอันดับทุกตัวแปร หรือค่าต่อเนื่องทุกตัวแปร) 

การวิเคราะห์ข้อมูล ข้อมูลมีการแจกแจงไม่ปกติ (asymmetrical distribution) 

5.2 รูปแบบการทดสอบตัวแปร 

ตัวแปรทดสอบ (การวัดครั้งที่ 1) ตัวแปรทดสอบ (การวัดครั้งที่ 2) ตัวแปรทดสอบ (การวัดครั้งที่ n) 

ค่าต่อเนื่อง ค่าต่อเนื่อง ค่าต่อเนื่อง 
คะแนนของกรรมการคนที่ 1 

อิตาลี่ (judge1) 
คะแนนของกรรมการคนที่ 2 

เกาหลีใต้ (judge3) 
คะแนนของกรรมการคนที่ n 

โรมาเนีย (judge3) 

5.3 การก าหนดสมมติฐานและเกณฑ์การทดสอบ 

 จากการแข่งขันยิมนาสติก ต้องการทดสอบความเหมือนกันของคะแนนการตัดสินนักยิมนาสติก

ของกรรมการจากประเทศอิตาลี เกาหลีใต้ และโรมาเนีย 

 H0: คะแนนการตัดสินของกรรมการจากประเทศอิตาลี เกาหลีใต้ และโรมาเนียเหมือนกัน 

 H1: คะแนนการตัดสินของกรรมการจากประเทศอิตาลี เกาหลีใต้ และโรมาเนียไม่เหมือนกัน 

เกณฑ์ในการทดสอบสมมุติฐาน คือ หากการทดสอบความเหมือนกันของล าดับที่คะแนนโดยใช้

วิธีของฟรีดแมน (Friedman Test) ได้ค่าความน่าจะเป็น (p-value) มากกว่าค่านัยส าคัญทางสถิติ (α = 

0.05) จะยอมรับสมมติฐาน H0 แต่หากได้ค่าความน่าจะเป็น (p-value) น้อยกว่าหรือเท่ากับค่านัยส าคัญ

ทางสถิติ (α = 0.05) จะปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 
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5.4 การใช้โปรแกรมคอมพิวเตอร์วิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล File -> Open -> judges.sav 
๏ เลือกเมนู Analyze -> Non-Parametric Statistics -> K Related Samples… 

o Test Variables: เลือกตัวแปรทดสอบ 3 ตัวแปรหรือมากกว่า (ตัวแปรแบบค่าต่อเนื่อง/
เหตุการณ์เหมือนกันหรือเป็นการวัดซ้ า 3 เหตุการณ์หรือมากกว่า เช่น การให้คะแนนของ
กรรมการ 3 คนหรือมากกว่า) จากรายการตัวแปรด้านซ้าย  

o ในกลุ่มค าสั่ง Test Type เลือกสถิติ Friedman  
o กดปุ่ม OK 

 

5.5 ผลการวิเคราะห์ 
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5.7 การสร้างตารางแสดงผลการทดสอบ 

ตารางที ่(#) แสดงผลการทดสอบเปรียบเทียบล าดับที่ค่าเฉลี่ยของคะแนนจากกรรมการ 3 ประเทศ 

กรรมการ ล าดับที่ค่าเฉลี่ย (Mean Rank) Friedman Test 

อิตาลี 1.99 
N = 300 

X2 = 497.803 df = 2 Sig = 0.000 
เกาหลีใต้ 2.90 

โรมาเนีย 1.11 

5.8 การแปลผลและสรุป 

จากตารางที่ (#) ผลการทดสอบแสดงให้เห็นว่า ค่าความน่าจะเป็น (Sig.) = 0.00 มีค่าน้อยค่า

นัยส าคัญทางสถิติที่ก าหนดไว้ (α = 0.05) จึงปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1  

สรุป คะแนนการตัดสินของกรรมการจากประเทศอิตาลี เกาหลีใต้ และโรมาเนียแตกต่างกัน โดย

กรรมการจากประเทศเกาหลีใต้ให้คะแนนมากที่สุดเป็นอันดับ 1 กรรมการจากประเทศอิตาลีให้คะแนน

น้อยรองลงมาเป็นอันดับที่ 2 และกรรมการจากประเทศโรมาเนียให้คะแนนน้อยที่สุดเป็นอันดับที่ 3 
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ตัวอย่างเพิ่มเติม: การทดสอบ การแปลผลและสรุป 

#1 

 H0: คะแนนการตัดสินของกรรมการจากประเทศอิตาลี เกาหลีใต้ และโรมาเนียไม่แตกต่างกัน 

 H1: คะแนนการตัดสินของกรรมการจากประเทศอิตาลี เกาหลีใต้ และโรมาเนียแตกต่างกัน 

เกณฑ์ในการทดสอบสมมุติฐาน คือ หากการทดสอบความสอดคล้องด้วยโดยใช้วิธีของเคนดอลล์ 

(Kendall’s W Test)ได้ค่าความน่าจะเป็น (p-value) มากกว่าค่านัยส าคัญทางสถิติ (α = 0.05) จะ

ยอมรับสมมติฐาน H0 แต่หากได้ค่าความน่าจะเป็น (p-value) น้อยกว่าหรือเท่ากับค่านัยส าคัญทางสถิติ 

(α = 0.05) จะปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 

ตารางที ่(#) แสดงผลการทดสอบเปรียบเทียบล าดับที่ค่าเฉลี่ยของคะแนนจากกรรมการ 3 ประเทศ 

กรรมการ  ล าดับที่ค่าเฉลี่ย Kendall’s W Test 

อิตาลี  1.99 N = 300 Kendall’s W = .830 

X2 = 497.803 df = 2  

Asymp. Sig = 0.000 

เกาหลีใต้  2.90 

โรมาเนีย  1.11 

จากตารางที่ (#) ผลการทดสอบแสดงให้เห็นว่า ค่าความน่าจะเป็น (Sig.) = 0.00 มีค่าน้อยกว่า

ค่านัยส าคัญทางสถิติที่ก าหนดไว้ (α = 0.05) จึงปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1  

สรุป คะแนนการตัดสินของกรรมการจากประเทศอิตาลี เกาหลีใต้ และโรมาเนียแตกต่างกัน โดย

มีค่า Kendall’s W = .830 หรือมีความสอดคล้องของคะแนนอยู่ระดับมาก กรรมการจากประเทศเกาหลี

ใต้ให้คะแนนมีล าดับที่ค่าเฉลี่ยมากที่สุด รองลงมาคือ กรรมการจากประเทศอิตาลี และน้อยที่สุดคือ 

กรรมการจากประเทศโรมาเนีย 
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6. การทดสอบความสมัพันธ์รายคู่แบบสเปียร์แมน 

 การทดสอบความสัมพันธ์กรณีข้อมูลของตัวแปรไม่เป็นค่าต่อเนื่อง มีวิธีการทดสอบความสัมพันธ์

ระหว่างตัวแปร 2 ตัว ที่เป็นตัวแปรแบบค่าไม่ต่อเนื่อง (discontinuous  variable) กับตัวแปรแบบค่าไม่

ต่อเนื่อง (discontinuous  variable) ด้วยการจัดอันดับของข้อมูล (ranks of the data) โดยมีวิธีดังนี้ 

1. การทดสอบความสัมพันธ์ด้วยสัมประสิทธิ์สหสัมพันธ์อันดับที่ของสเปียร์แมนหรือสเปียร์แมน

โรท์ (Spearman's Rank Correlation Coefficient or Spearman's rho (ρ) Test) หรือ เป็นการวัด

ระดับความสัมพันธ์ (association) โดยตัวแปรมีการเรียงล าดับไปในทิศทางเดียวกัน (monotonicity) 

เหมาะกับตัวแปรแบบค่าต่อเนื่อง (continuous variable) ตัวแปรแบบค่าไม่ต่อเนื่อง (discrete 

variable) และตัวแปรแบบมาตราจัดอันดับ (order variable) 

2. การทดสอบความสัมพันธ์ด้วยสัมประสิทธิ์สหสัมพันธ์อันดับของเคนดอล์ล (Kendall rank 

correlation coefficient)  หรื อ  สั มประสิทธิ์ แบบเทาว์ ของ เคนดอล์ล  ทาว  ( Kendall Tau (τ) 

coefficient) เป็นการวัดระดับความสอดคล้อง (correspondence) ที่เกิดจากความแตกต่างระหว่าง

จ านวนคู่ที่เป็นสัดส่วน (concordant) หรือคู่ของล าดับที่มีลักษณะตรงกันกับจ านวนคู่ที่ไม่เป็นสัดส่วน 

(discordant) ประกอบด้วย 

   2.1 ทาว-เอ (Tau-a) เป็นสถิติทดสอบความเข้มของความสัมพันธ์ (strength of association) 

ของตารางไขว้ (cross tabulations) ตัวแปรทั้งสองเป็นตัวแปรแบบมาตราจัดอันดับ โดยการทดสอบ

แบบทาว-บี จะไม่ท าการปรับค่ามีค่าเท่ากัน (ties) 

   2.2 ทาว-บี (Tau-b) เป็นสถิติทดสอบที่แตกต่างจากสถิติทดสอบแบบทาว-เอ เพราะท าการ

ปรับค่าที่มีค่าเท่ากัน (ties) ที่ได้จากการทดสอบความสัมพันธ์ของข้อมูลที่อยู่ในรูปของตารางสี่เหลี่ยม

จตุรัส (square tables) ค่าของทาว-บี อยู่ในช่วง -1 (มีความสัมพันธ์เชิงลบ 100% หรือตรงข้ามอย่าง

สมบูรณ์) ถึง +1 (มีความสัมพันธ์เชิงบวก 100% หรือเห็นด้วยอย่างสมบูรณ์) และค่า 0 เป็นดัชนีของการ

ไม่มีความสัมพันธ์  

   2.3 ทาว-ซี (Tau-c) แตกต่างจากทาว-บี คือ เหมาะกับการทดสอบข้อมูลที่อยู่ในรูปของตาราง

แบบสี่เหลี่ยมผืนผ้า (rectangular table) มากกว่าตารางแบบสี่เหลี่ยมจตุรัส (square tables) 
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การวิเคราะห์ความสัมพันธ์ระหว่างตัวแปรหากข้อมูลไม่เป็นไปตามข้อตกลงของการวิเคราะห์

ความสัมพันธ์แบบเพียร์สันสามารถใช้วิธีการทดสอบความสัมพันธ์แบบสเปียร์แมนแทน ผลการวิเคราะห์

ให้ค่าความเข้มของความสัมพันธ์มากหรือน้อย และบอกทิศทางของความสัมพันธ์เชิงบวกหรือเชิงลบดังนี้ 

ตารางที่ 14.1 การแปลค่าสัมประสิทธิ์สหสัมพันธ์แบบสเปียร์แมน 

ค่าสัมประสิทธิ์สหสัมพันธ์ (Correlation Coefficient) 

ค่าของความสัมพันธ์ ความเข้มและทิศทางของความสัมพันธ์ 

1.00 ถึง 0.80 มีความสัมพันธ์เชิงบวกระดับมากอย่างยิ่ง 

0.79 ถึง 0.60 มีความสัมพันธ์เชิงบวกระดับมาก 

0.59 ถึง 0.40 มีความสัมพันธ์เชิงบวกระดับปานกลาง 

0.39 ถึง 0.20 มีความสัมพันธ์เชิงบวกระดับน้อย 

0.19 ถึง 0.01 มีความสัมพันธ์เชิงบวกระดับน้อยมาก 

0.00 ไม่มีความสัมพันธ์ 

-0.01 ถึง -0.19 มีความสัมพันธ์เชิงลบระดับน้อยมาก 

-0.39 ถึง -0.20 มีความสัมพันธ์เชิงลบระดับน้อย 

-0.59 ถึง -0.40 มีความสัมพันธ์เชิงลบระดับปานกลาง 

-0.79 ถึง -0.60 มีความสัมพันธ์เชิงลบระดับมาก 

-1.00 ถึง 0.-80 มีความสัมพันธ์เชิงลบระดับมากอย่างยิ่ง 

ปรับปรุงมาจาก: Evans, J. D. (1996). Straightforward statistics for the behavioral sciences. 

Pacific Grove, CA: Brooks/Cole Publishing. 
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6.1 การทดสอบความสมัพันธ์อันดับที่แบบง่าย 

การทดสอบความสัมพันธ์อันดับที่แบบง่าย (Simple correlation) คือ การวิเคราะห์หา

ความสัมพันธ์ตัวแปร 1 คู่ โดยตัวแปรอิสระหรือตัวแปรตามที่ใช้ในการวิเคราะห์ความสัมพันธ์มีระดับการ

วัดแบบมาตราจัดอันดับหรือเป็นตัวแปรที่มีระดับการวัดแบบค่าต่อเนื่องแต่ข้อมูลไม่เป็นไปตามข้อตกลง

เบื้องต้นของการวิเคราะห์ความสัมพันธ์แบบเพียร์สัน  

ตัวอย่างค าถามการวิจัย 

จากข้อมูลการส ารวจพนักงานในหน่วยงานต้องการทราบว่า ระดับการศึกษาของพนักงานมี

ความสัมพันธ์กับเงินเดือนเริ่มต้นหรือไม่ 

6.1.1 ข้อตกลงเบื้องต้น 

ขั้นตอน ข้อตกลง 

การออกแบบการวิจัย 1. ตัวอย่างได้มาจากการสุ่มแบบสุ่ม (random sampling) และเป็นอิสระจาก
กัน (independent sample) 

 2. ตัวแปรอิสระเป็นตัวแปรแบบมาตราจัดอันดับ หรือตัวแปรแบบค่าต่อเนื่อง 
รวมถึงตัวแปรแบบค่าไม่ต่อเนื่อง (discrete variables) 1 ตัว 

 3. ตัวแปรตามเป็นตัวแปรแบบมาตราจัดอันดับ หรือตัวแปรแบบค่าต่อเนื่อง 
รวมถึงตัวแปรแบบค่าไม่ต่อเนื่อง (discrete variables) 1 ตัว 

การวิเคราะห์ข้อมูล ข้อมูลมีการแจกแจงไม่ปกติ (asymmetrical distribution) 

6.1.2 รูปแบบการทดสอบตัวแปร 

ตัวแปรอิสระ 

-> 

ตัวแปรตาม 

ค่าจัดประเภท (จัดอันดับ) ค่าต่อเนื่อง 
การศึกษา (educ) 

- ประถมศึกษา 
- มัธยมศึกษา 
- อุดมศึกษา 

เงินเดือนเริ่มต้น (salbegin) 
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6.1.3 การก าหนดสมมติฐานและเกณฑ์การทดสอบ 

ตารางที ่(#) แสดงค่าเฉลี่ยของเงินเดือนเริ่มต้น จ าแนกตามระดับการศึกษา 

ระดับการศึกษา จ านวน ค่าเฉลี่ยเงินเดือนเริ่มต้น S.D. 

มัธยมศึกษาตอนต้น 53 13,064.15 2,408.147 

มัธยมศึกษาตอนปลาย 190 13,241.87 2,653.896 

อุดมศึกษา 231 21,027.14 9,421.873 

รวม 474 17,061.09 7870.638 

 จากตารางที่ (#) แสดงให้เห็นว่า พนักงานมีเงินเดือนเฉลี่ย 17,061.09 ดอลลาร์สหรัฐ โดย

พนักงานที่มีการศึกษาระดับอุดมศึกษามีเงินเดือนเฉลี่ยมากที่สุด รองลงมา คือ มัธยมศึกษาตอนปลาย 

และมัธยมศึกษาตอนต้น ตามล าดับ 

 จากข้อมูลที่กล่าวมาน่าจะมีความสัมพันธ์ระหว่างระดับการศึกษากับเงินเดือนเริ่มต้น ดังนั้นจึงท า

การทดสอบความสัมพันธ์ด้วยสัมประสิทธิ์สหสัมพันธ์อันดับที่ของสเปียร์แมน  (Spearman's Rank 

Correlation Coefficient Test) โดยมีสมมติฐานดังนี้ 

 H0: ระดับการศึกษากับเงินเดือนเริ่มต้นไม่มีความสัมพันธ์กัน 

 H1: ระดับการศึกษากับเงินเดือนเริ่มต้นมีความสัมพันธ์กัน 

เกณฑ์ในการทดสอบสมมุติฐาน คือ หากการทดสอบความสัมพันธ์ด้วยวิธีของสเปียร์แมน 

(Spearman's Test) ได้ค่าความน่าจะเป็น (p-value) มากกว่าค่านัยส าคัญทางสถิติ (α = 0.05) จะ

ยอมรับสมมติฐาน H0 แต่หากได้ค่าความน่าจะเป็น (p-value) น้อยกว่าหรือเท่ากับค่านัยส าคัญทางสถิติ 

(α = 0.05) จะปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 
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6.1.4 การใช้โปรแกรมคอมพิวเตอร์วิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล File -> Open -> Employee data.sav 
๏ เลือกเมนู Analyze -> Descriptive Statistics -> Crosstabs…  

o Rows: เลือกตัวแปรแบบค่าจัดประเภท (จัดอันดับ) หรือตัวแปรแบบค่าต่อเนื่อง/ตัวแปร
แบบค่าไม่ต่อเนื่อง (discrete variables) 1 ตัวแปร หรือมากกว่า 1 ตัวแปร (ท่ีต้องการให้
เป็นตัวแปรตาม) ช่องรายการตัวแปรด้านซ้าย  

o Column: เลือกตัวแปรแบบค่าจัดประเภท (จัดอันดับ) หรือตัวแปรแบบค่าต่อเนื่อง 1 ตัว
แปร หรือมากกว่า 1 ตัวแปร (ที่ต้องการให้เป็นตัวแปรตาม) จากรายการตัวแปรด้านซ้าย  

o กดปุ่ม Statistics… ไมเ่ลือกสถิติ Chisq และเลือกสถิติ Corr แทน -> กดปุ่ม Continue 
o กดปุ่ม Cells… ไมเ่ลือก Count, Row, Column, Total และเลือก None -> กดปุ่ม 

Continue  
o กดปุ่ม OK  

 

 

 

6.1.5 ผลการวิเคราะห์ 
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6.1.6 การสร้างตารางแสดงผลการทดสอบ 

ตาราง (#) แสดงการทดสอบความสัมพันธ์ระหว่างระดับการศึกษากับเงินเดือนเริ่มต้น 

6.1.7 การแปลผลและสรุป 

จากตารางที่ (#) ผลการทดสอบแสดงให้เห็นว่า ค่าความน่าจะเป็น (Sig.) = 0.03 มีค่าน้อยกว่า

ค่านัยส าคัญทางสถิติที่ก าหนดไว้ (α = 0.05) จึงปฏิเสธสมมติฐาน H0 และยอมรับสมมติฐาน H1 คือ 

ระดับการศึกษากับเงินเดือนเริ่มต้นมีความสัมพันธ์กัน  

 สรุป ระดับการศึกษาของพนักงานมีความสัมพันธ์เชิงบวกระดับปานกลางกับเงินเดือนเริ่มต้น 

  

ตัวแปร จ านวน เงินเดือนเริ่มต้นของผู้ตอบ (ρ) Sig. (2-tailed) 

ระดับการศึกษา 474 .69 .03 
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6.2 การทดสอบความสมัพันธ์อันดับที่แบบพห ุ

 การทดสอบความสัมพันธ์ อันดับที่แบบพหุ (Multiple correlation) คือ การวิเคราะห์หา

ความสัมพันธ์ระหว่างตัวแปรมากกว่า 1 คู่ โดยตัวแปรอิสระหรือตัวแปรตามที่ใช้ในการวิเคราะห์

ความสัมพันธ์มีระดับการวัดแบบมาตราจัดอันดับหรือเป็นตัวแปรที่มีระดับการวัดแบบค่าต่อเนื่องแต่

ข้อมูลไม่เป็นไปตามข้อตกลงเบื้องต้นของการวิเคราะห์ความสัมพันธ์แบบเพียร์สัน 

ตัวอย่างค าถามการวิจัย 

จากข้อมูลการส ารวจพนักงานในหน่วยงานต้องการทราบว่า ระดับการศึกษาและประสบการณ์

ก่อนการท างานของพนักงานมีความสัมพันธ์กับเงินเดือนเริ่มต้นหรือไม่ 

6.2.1 ข้อตกลงเบื้องต้น 

ขั้นตอน ข้อตกลง 

การออกแบบการวิจัย 1. ตัวแปรอิสระเป็นตัวแปรแบบมาตราจัดอันดับ หรือตัวแปรแบบค่าต่อเนื่อง 
รวมถึงตัวแปรแบบค่าไม่ต่อเนื่อง (discrete variables) 1 ตัวแปร หรือ
หลายตัวแปร  

 2. ตัวแปรตามเป็นตัวแปรแบบมาตราจัดอันดับ หรือตัวแปรแบบค่าต่อเนื่อง 
รวมถึงตัวแปรแบบค่าไม่ต่อเนื่อง (discrete variables) มากกว่า 1 ตัวแปร 

การวิเคราะห์ข้อมูล ข้อมูลมีการแจกแจงไม่ปกติ (asymmetrical distribution) 
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6.2.2 รูปแบบการทดสอบตัวแปร 

ตัวแปรอิสระ 

-> 

ตัวแปรตาม 
ค่าจัดประเภท (จัดอันดับ) ค่าต่อเนื่อง 

การศึกษา (educ) 
- ประถมศึกษา 
- มัธยมศึกษา 
- อุดมศึกษา 

ประสบการณ์ก่อนท างาน (prevexp_group) 
- ไม่มีประสบการณ์ 
- มีประสบการณ์น้อย 
- มีประสบการณ์ปานกลาง 
- มีประสบการณ์มาก 

เงินเดือนเริ่มต้น (salbegin) 

6.1.3 การก าหนดสมมติฐานและเกณฑ์การทดสอบ 

ตารางที ่(#) แสดงค่าเฉลี่ยของเงินเดือนเริ่มต้น จ าแนกตามระดับการศึกษาและต าแหน่งงาน 

ตัวแปร จ านวน ค่าเฉลี่ยเงินเดือนเริ่มต้น S.D. 

ระดับการศึกษา    

- มัธยมศึกษาตอนต้น 53 13,064.15 2,408.147 

- มัธยมศึกษาตอนปลาย 190 13,241.87 2,653.896 

- อุดมศึกษา 231 21,027.14 9,421.873 

รวม 474 17,061.09 7870.638 

ประสบการณ์ก่อนท างาน    

- ไม่มีประสบการณ์ 24 11,331.25 1,308.402 

- มีประสบการณ์น้อย (1-36 เดือน) 153 16,504.93 6,287.574 

- มีประสบการณ์ปานกลาง (37-60 เดือน) 75 16,691.60 6,218.312 

- มีประสบการณ์มาก (61 เดือนขึ้นไป) 222 18,092.57 9,347.561 

รวม 474 17,016.09 7,870.638 
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 จากตาราแสดงให้เห็นว่า พนักงานมีเงินเดือนเฉลี่ย 17,061.09 ดอลลาร์สหรัฐ โดยพนักงานที่มี

การศึกษาระดับอุดมศึกษามีเงินเดือนเฉลี่ยมากที่สุด รองลงมาคือ มัธยมศึกษาตอนปลาย และมีเงินเดือน

เฉลี่ยน้อยที่สุดคือ มัธยมศึกษาตอนต้น และเม่ือพิจารณาจากประสบการณ์ก่อนท างานของพนักงานแสดง

ให้เห็นว่า พนักงานที่มีประสบการณ์มากมีเงินเดือนเฉลี่ยมากที่สุด รองลงมาคือ มีประสบการณ์ปานกลาง 

มีประสบการณ์น้อย และมีเงินเดือนเฉลี่ยน้อยที่สุดคือ ไม่มีประสบการณ์ 

 จากข้อมูลที่กล่าวมาน่าจะมีความสัมพันธ์ระหว่างระดับการศึกษาและประสบการณ์การท างาน

กับเงินเดือนเริ่มต้น ดังนั้นจึงท าการทดสอบความสัมพันธ์ด้วยสัมประสิทธิ์สหสัมพันธ์อันดับที่ของสเปีย ร์

แมน (Spearman's Rank Correlation Coefficient Test) โดยมีสมมติฐานดังนี้ 

 H1: ระดับการศึกษากับเงินเดือนเริ่มต้นมีความสัมพันธ์กัน 

 H2: ประสบการณ์การท างานกับเงินเดือนเริ่มต้นมีความสัมพันธ์กัน 

 เกณฑ์ในการทดสอบสมมุติฐาน คือ หากการทดสอบความสัมพันธ์ด้วยวิธีของสเปียร์แมน 

(Spearman's Test) ได้ค่าความน่าจะเป็น (p-value) มากกว่าค่านัยส าคัญทางสถิติ (α = 0.05) จะ

ปฏิเสธสมมติฐาน H1 และ H2 แต่หากได้ค่าความน่าจะเป็น (p-value) น้อยกว่าหรือเท่ากับค่านัยส าคัญ

ทางสถิติ (α = 0.05) จะยอมรับสมมติฐาน H1 และ H2 
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6.2.4 การใช้โปรแกรมคอมพิวเตอร์วิเคราะห์ข้อมูล 

๏ เปิดแฟ้มข้อมูล File -> Open -> Employee data.sav 
๏ สร้างตัวแปรกลุ่มประสบการณ์ก่อนท างาน 

o เลือกเมนู Transform -> Recode in Different Variables 
o เลือกตัวแปร prevexp ใส่ในช่อง Variables: 
o ใต้ค าว่า Old ในช่อง Variables: คลิกเมาส์ที่ชื่อตัวแปรเก่า 
o ในกลุ่มค าสั่ง Output Variable ช่อง Name:  พิมพ์ prevexp_group -> กดปุ่ม 

Change  
o กดปุ่ม Old and New Values… 

เปลี่ยนค่า 0->1, 1-36 -> 2, 37-60 -> 3 และ 61-Highest  -> 4 

o กดปุ่ม Continue 
o กดปุ่ม OK  
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๏ เลือกเมนู Analyze -> Descriptive Statistics -> Crosstabs…  
o Rows: เลือกตัวแปรแบบค่าจัดประเภท (จัดอันดับ) หรือตัวแปรแบบค่าต่อเนื่อง/ตัวแปร

แบบค่าไม่ต่อเนื่อง (discrete variables) 1 ตัวแปร หรือมากกว่า 1 ตัวแปร (ท่ีต้องการให้
เป็นตัวแปรตาม) จากรายการตัวแปรด้านซ้าย 

o Column: เลือกตัวแปรแบบค่าจัดประเภท (จัดอันดับ) หรือตัวแปรแบบค่าต่อเนื่อง 1 ตัว
แปร หรือมากกว่า 1 ตัวแปร (ที่ต้องการให้เป็นตัวแปรตาม) จากรายการตัวแปรด้านซ้าย 

o กดปุ่ม Statistics… ไม่เลือกสถิติ Chisq และเลือกสถิติ Corr แทน -> กดปุ่ม Continue 
o กดปุ่ม Cells… ไมเ่ลือก Count, Row, Column, Total และเลือก None -> กดปุ่ม 

Continue  
o กดปุ่ม OK 

 

 

 

6.2.5 ผลการวิเคราะห์ 
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6.2.6 การสร้างตารางแสดงผลการทดสอบ 

ตารางที ่(#) แสดงผลการทดสอบความสัมพันธ์ระหว่างระดับการศึกษากับเงินเดือนเริ่มต้นและ

ประสบการณ์ก่อนท างาน 

6.2.7 การแปลผลและสรุป 

 จากตารางที่ (#) ผลการทดสอบแสดงให้เห็นว่า ความสัมพันธ์ระหว่างระดับการศึกษากับ

เงินเดือนเริ่มต้น และความสัมพันธ์ระหว่างประสบการณ์ก่อนท างานกับเงินเดือนเริ่มต้น ได้ค่าความน่าจะ

เป็น (Sig.) = 0.00 มีค่าน้อยกว่าค่านัยส าคัญทางสถิติที่ก าหนดไว้ (α = 0.05) จึงยอมรับสมมติฐาน H1 

และ H2  

 สรุป ระดับการศึกษาของพนักงานมีความสัมพันธ์เชิงบวกระดับปานกลางกับเงินเดือนเริ่มต้น 

และประสบการณ์ก่อนท างานมีความสัมพันธ์เชิงบวกระดับน้อยมากกับเงินเดือน 

สรุป 

การวิเคราะห์ข้อมูลเพ่ือทดสอบสมมติฐานหากข้อมูลไม่เป็นไปตามข้อตกลงเบื้องต้น (not meet 

basic assumption) ของการทดสอบแบบอิงค่าพารามิเตอร์ (parametric tests) เช่น ข้อมูลมีการแจก

แจงแบบไม่ปกติ ข้อมูลเป็นมาตราแบบจัดกลุ่ม (nominal scale) หรือจัดอันดับ (ordinal scale) หรือ

ตัวอย่างที่สุ่มมีขนาดเล็กเกินไป (น้อยกว่า 30) ควรเลือกใช้การทดสอบแบบไม่อิงค่าพารามิเตอร์ (non-

parametric statistics) เพราะเป็นวิธีการทดสอบที่มีข้อตกลงเพียงเล็กน้อยหรือไม่มีข้อตกลง 

(assumption-free test) เช่น ข้อมูลมีการวัดระดับใดก็ได้ ไม่จ าเป็นต้องมีการแจกแจงเป็นโค้งปกติ 

ข้อมูลแต่ละกลุ่มไม่จ าเป็นต้องมีการกระจายเท่ากัน และ/หรือไม่มีความเป็นเส้นตรงในการวิเคราะห์การ

ถดถอยไม่ใช่เชิงเส้นตรง (nonlinear regression analysis) 

 

ตัวแปร จ านวน เงินเดือนเริ่มต้น (rs) Sig. (2-tailed) 

ระดับการศึกษา 474 .69 .03 

ประสบการณ์ก่อนท างาน 474 .20 .05 
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แบบฝึกหัดท้ายบท 

ให้ผู้เรียนเปิดแฟ้มข้อมูล 1991 US. General Social Survey.sav แล้วประมวลผลข้อมูล เพ่ือ

ทดสอบและแปลผล ดังนี้ 

1. ทดสอบความเป็นอิสระของข้อมูลระหว่างตัวแปรกลุ่มชนใหม่ (newrace) กับภูมิภาค 

(region) โดยใช้ตัวแปรกลุ่มชน (race) สร้างเป็นตัวแปรใหม่ชื่อ กลุ่มชนใหม่ (newrace) มี 2 กลุ่ม คือ ผิว

ขาว และไม่ใช่ผิวขาว เพ่ือหาค าตอบว่า แต่ละภูมิภาคมีกลุ่มชนที่มีผิวขาวและไม่ใช่ผิวขาวแตกต่างกัน

หรือไม ่

2. ทดสอบล าดับที่ค่าเฉลี่ยของตัวแปรระดับความสุข (happy) ด้วยตัวแปรเพศ (sex) โดยใช้

วิธีการทดสอบของแมน-วิทนี ยู (Mann-Whitney U Test) 

3. ทดสอบล าดับที่ค่าเฉลี่ยของตัวแปรระดับความสุข (happy) ด้วยตัวแปรภูมิภาค (region) โดย

ใช้วิธีการทดสอบของครัสคาลและวัลลิส (Kruskal Wallis Test) 

4. ทดสอบความเหมือนกันของระดับการศึกษาสูงสุดของผู้ตอบแบบส ารวจ  (edu) และบิดา 

(paeduc) ของผู้ตอบแบบสอบส ารวจ โดยใช้วิธีเครื่องหมาย (Sign Test) 

5. ทดสอบความเหมือนกันของระดับการศึกษาสูงสุดของผู้ตอบแบบส ารวจ (edu) บิดา 

(paeduc) และมารดา (maeduc) ของผู้ตอบแบบส ารวจ โดยใช้วิธีฟรีดแมน (Friedman Test) 

6. ทดสอบความสัมพันธ์ระหว่างจ านวนบุตร (childs) กับจ านวนพี่น้อง (sibs) กับระดับความสุข 

(happy) 

7. ทดสอบความสัมพันธ์ระหว่างจ านวนบุตร (childs) กับจ านวนพ่ีน้อง (sibs) และระดับ

ความสุข (happy) 
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